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I Introduction to R-Studio

R-Studio is a family of powerful and cost-effective undelete and data recovery software. Empowered by new
unique data recovery technologies, it is the most comprehensive data recovery solution for recovering files from
FAT/exFAT, NTFS, NTFS5, ReFS/ReFS2+ (Windows), HFS/HFS+ and APFS (Macintosh), Little and Big
Endian variants of UFS1/?UFS2 (FreeBSD/?OpenBSD/?NetBSD/?Solaris), Ext2/3/4FS and XFS (Linux) partitions.
It functions on local and network disks, even if such partitions are formatted, damaged or deleted. Flexible
parameter settings give you absolute control over the data recovery.

R-Studio Features
System Requirements
Contact Information and Technical Support
Data Recovery Using R-Studio
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs

Data Recovery over Network
R-Studio Technician/T80+
Text/?hexadecimal editor
Technical Information and Troubleshooting
R-Studio Emergency
R-Studio Agent Emergency

Window s 9x/?ME/?NT4.0/Window s 2000, XP, Vista, 7,8/8.1, 10, 11, Window s Server 2003, 2008, 2012, 2016, 2019, 2022 are registered

trademarks of Microsoft Corporation.

Mac OS X, OS X, and macOS are registered trademarks of Apple Inc.

All other trademarks are the property of their respective ow ners.

1.1 R-Studio Features

R-Studio is a family of file restoring utilities. It recovers files both on local drives and on drives on remote
computers over network, even if their partition structures are damaged. A unique IntelligentScan technology and
flexible parameter settings give you real control over the fastest data recovery ever seen.

R-Studio features:

· Standard "Windows Explorer" - style interface.
· Host OS: An Intel-compatible platform running Windows 10 /8.1/8 /7 /Vista /XP /2000 Windows Server

2019 /2016 /2012 /2008 /2003.
· Automatic check for updates.
· Remotely recovers data over network. Data can be recovered on network computers running Windows,

MacOS X, Linux, and some other UNIX OS. 
· Supported file systems:

Windows: FAT12, FAT16, FAT32, exFAT, NTFS, NTFS5, ReFS/ReFS2+ file (Resilient File System);
ReFS for Windows Server 2019 (including deduplication).

macOS: HFS, HFS+, HFSX, APFS, FAT/exFAT;

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-disk-format.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-a-File-System.html
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Linux and UNIX: Ext2/3/4FS and XFS (created by Linux or other OS), and UFS1, UFS2, UFS
BigEndian (used by the FreeBSD, OpenBSD, and NetBSD operating systems);

CD/DVD/Images: ISO9660;
Magnetic tape devices: UStar/Tar/CPIO/Pax (R-Studio Technician/T80+).
Please note, that when a file is being deleted on the HFS, HFS+, HFSX file systems, the computer
completely removes all system information on it, and there is no way to recover the deleted file except by
using the Extra Search for Known File Types option. Nevertheless, R-Studio is able to read existing files
from HFS, HFS+, and HFSX disks.

· Support for known file types. R-Studio searches for files with known typical features of their structures
allowing the user to search for files on devices with unknown files systems, including an HD, CD, DVD,
floppy disk, Compact Flash Card, USB drive, ZIP drive, Memory Sticks, and other removable media.

· Scan process visualization. While scanning an object, R-Studio graphically shows items that have been
found, including files of known types, FAT and NTFS MFT records, boot records, etc.

· Mass file recovery support.
· Support for estimation of chances for successful recovery.
· Support for file recovery lists - lists of files that can be exported from R-Studio, manually edited, and then

loaded back. Files from such lists will be automatically marked for recovery. 
· APM, Basic and GPT support. R-Studio supports all three partition schemes used to define the low-level

organization of data on drives formatted for use with Macintosh computers.
· Dynamic disk support.
· Software RAID, volume set, and stripe set support. Support for RAID 6, RAID 5, and RAID 4 layouts.

Support for custom RAID layouts. Parameters like block size and order, offsets, and even the number of
stripe blocks can be explicitly specified. Custom RAID configurations can be saved.

· Support for Windows Storage Spaces, created by Windows 8/8.1 and Windows 10/?Threshold 2/?
Anniversary/?Fall Creators updates.

· Support for Apple software RAIDs
· Support for Apple CoreStorage/?FileVault/?Fusion Drive Volumes
· Support for Linux mdadm Volumes
· Support for Linux LVM/LVM2
· Support for Intel Software RAID.
· Hardware RAID, volume set, and stripe set support.
· RAID consistency check (check for valid data parity values).
· Automatic RAID parameter recognition.
· Virtual objects can be mounted in the host system as read-only virtual drives. They can remain mounted even

then R-Studio has been closed.
· Creates image files for an entire drive, logical disk, or its part. Such image files can be processed like regular

drives. Images can be either simple exact object copies (Plain images), compatible with VmWare Virtual
Machine disks (in the Corporate and Technician/T80+ versions), or R-Drive Image compatible that can
be compressed, split into several parts, and password-protected. Images may be saved either on the local or
remote computer. Image creation can be stopped and then resumed. R-Studio can scan objects while
creating their images. R-Studio Technician/T80+ supports multi-pass and runtime imaging. Images can be
mounted in the operating system as devices which makes their content accessible to any program including
any other data recovery software.

· Recovers files on damaged or deleted partitions.

https://www.r-studio.com/What-is-Raw-File-Recovery.html
https://www.r-studio.com/What-is-disk-format.html
https://www.r-studio.com/What-is-Logical-Disk.html
http://www.drive-image.com/
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· Recovers compressed files (NTFS, NTFS5).
· Recovers encrypted files (NTFS5).
· Recovers alternative data streams (NTFS, NTFS5).
· Support for NTFS deduplication, including Windows Server 2019.
· Support for file system journal on the HFS+ and Ext3/4fs file systems.
· Support for soft updates journal on the UFS file system.
· Support for extended attributes on the HFS+, Ext3/4fs, XFS, and UFS file systems.
· Support for compressed files on the HFS+ file system.
· Recognizes localized names.
· Recovered files can be saved on any (including network) drives visible to the host operating system.
· A hexadecimal disk and file viewer/editor supporting NTFS file non-resident attribute editing. Data alteration

is available on the Technician/T80+ and Corporate versions only.
· Patterns (or templates) in the hexadecimal editor allowing for parsing the data according to specific data

structure. Such patterns may be custom-created.
· File preview. Most of the file types can be previewed to estimate recovery chances.
· Enhanced remote host scanning procedure. In the R-Studio network versions, data is analyzed on the

remote host rather than on the home host, thereby the speed of recovery procedure greatly increases. The
scan information may be saved either on the local or remote computer.

· Recovered files may be saved on a drive on a connected remote computer rather than be transferred over
network to the local one. Saving recovered files on a remote computer may be useful when the remote
computer has a healthy drive because you do not have to transfer files over network. It may be an external
USB drive, for example.

· Support for S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) attribute monitoring.
· R-Studio Emergency*. The R-Studio Emergency version starts from a floppy or compact disc when it is

necessary to recover data on a computer, on which Windows cannot start up because its system files are
corrupted or deleted.

*The R-Studio Emergency is a part of the R-Studio software package. When you buy an R-Studio single
license you may run the R-Studio Emergency or/and install the R-Studio Windows version on one PC only
and you may not transfer the licensed software to another PC. 

R-Studio features available in the Technician/T80+ versions:

· Magnetic tape devices file system: UStar/Tar/CPIO/Pax.
· Extended file information 
· Symbolic link recovery options
· Drive Copy Wizard to copy any object in the Drives panel to any other object. In addition to byte to byte

copy of any object visible in the Drives panel, smart copy of partitions and drives is available.
· Mounting Virtual Objects to the System as Virtual Drives
· I/O Monitor and Sector Map files.
· Multi-pass and Runtime imaging
· Reverse RAIDs: A technique that decomposes real drive objects into virtual RAIDs. Then those components

of reverse RAID scan be processed like real objects. They can be viewed, edited, imaged, copied to
physical

· Support for third-party hardware.
· Forensic mode.

https://www.r-studio.com/What-are-alternate-data-streams.html
https://www.r-studio.com/What-is-SMART.html
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· File recovery over Internet.

R-Studio recovers files:

· That have been removed without the Recycle Bin, or when the Recycle Bin has been emptied;
· Removed by virus attack or power failure;
· After the partition with the files was reformatted, even for a different file system;
· When the partition structure on a drive was changed or damaged. In this case, R-Studio can scan the drive

trying to find previously existed partitions and recover files from found partitions.
· From drives with bad sectors. In this case, R-Studio can first copy the entire drives or its part into an image

file and then process such image file.

R-Studio can create image files for an entire drive, logical disk, or its part. Such image files can be processed
like regular drives. Images are very useful if there is a risk of total data loss due to hardware malfunction. If bad
blocks are constantly appearing on a drive, the only way to save the data is to immediately create an image of
that drive. All data search, scan and recovery can be done from this image.

To learn more about the IntelligentScan technology, go to the IntelligentScan topic .

1.2 System Requirements

· An Intel-compatible platform running Windows 11, 10 /8.1/8 /7 /Vista /XP /2000 Windows Server 2022,
2019 /2016 /2012 /2008 /2003

· At least 256 MB of RAM, a mouse, and enough disk space for recovered files, image files, etc. 
· The administrative privileges are required to install and run R-Studio utilities.
· A network connection for data recovering over network. 

1.3 Contact Information and Technical Support

To obtain the latest version of R-Studio, go to:

Product Site: http://www.r-tt.com
Sales Department: sales@r-tt.com

R-Studio Technical Support Team is available 24 hours a day, seven days a week, and has an average response
time less than 4 hours.

Tech. Support: support@r-tt.com
Send your support request to: http://www.r-tt.com/SupportRequest.shtml 

File Recovery FAQ: http://www.r-tt.com/File_Recovery_FAQ.shtml

R-tt Forum: http://forum.r-tt.com

https://www.r-studio.com/What-are-Bad-Sectors.html
http://www.r-tt.com
mailto:sales@r-tt.com
mailto:support@r-tt.com
http://www.r-tt.com/SupportRequest.shtml
http://www.r-tt.com/File_Recovery_FAQ.shtml
http://forum.r-tt.com
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1.4 R-Studio Main Panel

When R-Studio starts, its main panel appears on the Windows desktop.
R-Studio Main panel

Drives panel:

You can select an object by clicking it.
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A logical disk may be represented by its name or its partition. 

Properties tab:

This tab shows the properties of an object selected in the Drives panel.

Depending on the selected object, information on this Properties tab may vary.

The Properties tab names and values are described in detail on the Properties tab topic.

Log panel

S.M.A.R.T. Info for a Drive

R-Studio shows drive S.M.A.R.T. states using their icons. You may copy all S.M.A.R.T. attributes and paste
them into a text editor.

Drive S.M.A.R.T. states and icons

https://www.r-studio.com/What-is-SMART.html
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Normal: This state indicates that
the drive is in good conditions. 

Warning: This state indicates that
some small problems with the
drive are possible in the future,
you may work with it but with
cautions and regular check of
these parameters. Drive imaging
is strongly recommended.



Introduction to R-Studio 8

© 2023 R-Tools Technology Inc.

Critical: This state indicates that
the drive conditions are critical
and chances of hardware failure
are great. The best
recommendation for this case is
to stop working with the drive
and bring it to professional data
recovery specialists. You may
though continue to work with the
drive at your own risk, but drive
imaging is very strongly
recommended.

When a drive is selected in the R-Studio main panel, an additional S.M.A.R.T. tab will appear. You may view the
detailed S.M.A.R.T. data of the drive.  

S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) is a technology widely-used in drives and
solid-state devices that monitors their reliability conditions to predict possible hardware failures. 

Changing the program language

You may select the language of R-Studio main panel and its help. To do so, select an available language on
Change Language on the Help menu.

Panel view options

You may set which panels and bars to enable/?disable.
To enable/disable:

Toolbar Select/clear Toolbar on the View menu

Status bar Select/clear Status bar on the View menu

Drive pane Select/clear Device View on the View menu

Properties pane Select/clear Properties View on the View menu

Log panel Select/clear Event Log on the View menu

If you have several tabs in the right pane, you may easily switch to any of the tab by selecting on the View

menu
Properties Tab to view the Properties tab
Scan Information
Tab

to view the Scan Information Tab tab

Parents Tab to view the Parents tab
Properties Select data types in which the data will be represented

http://en.wikipedia.org/wiki/S.M.A.R.T.
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Connect

Click this button to connect to a remote computer on a
network.

Refresh

Click this button to refresh the panels.

Scan

Click this button to start scanning a selected
object.

Partition Search

Click this button to start fast searching for lost and deleted
partitonsi.

Show Files

Click this button to start enumerating files on a selected
object.

Open Image

Click this button to open a previously created
image.

Create Image

Click this button to create an image of a selected area.

Create Region

Click this button to create a region on a selected
disk.

RAIDs

Click this button to create a virtual volume set or
RAID.

Select an appropriate type from the menu.

Start runtime image

Click this button to start runtime imaging of the selected
object.

(Technician/T80+ versions only)

Remove

Click this button to remove a selected object in the main
panel.

The button may change its appearance and title depending
on the context.
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Stop

Click this button to stop the current
operation.

Sometimes, there may be a lot of similar objects in the Drives panel. Those may be components of a RAID, for
example. You may turn numerical indexes for such objects to distinguish them better. Those indexes will appear
before the object names in the Drives panel.

To turn the numerical indexes on/off, go to the Device item on the View menu, and select/clear:

Show Physical Drives Indexes to display the indexes only for drives
Show All Objects Indexes to display the indexes for all objects in the Drives panel

You may select the units in which object's start and size are displayed

To select the units

1 Select Devices on the View menu

2 Select the units in which you want to see object sizes.

You may select
Show as Bytes
Show as Sectors
Show as Bytes and Sectors

Depending on the task R-Studio performs, its panel may vary. Those panels are described in appropriate topics.
The Properties tab names and values are described in detail on the Properties tab topic.

The general settings can be set on the Settings dialog box.

You may also copy the object's information displayed in the  Drives panel. Right-click the object on the
necessary column and select Copy Device/disk, Copy Label, and so on.

R-Studio has two operation modes:

File search on a partition (including recently found during drive scan).

In this mode, R-Studio analyzes MFTs on NTFS partitions, FATs on FAT partitions, and SuperBlocks on
Ext2/3/4FS partitions. Then it displays all files which records have been found in the analyzed tables. Then
recently deleted files, which records still remain, can be recovered. If files have not been found, that means that
their records have been deleted. In this case, the drive must be scanned.

https://www.r-studio.com/What-is-Disk-Partition.html
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File search supports file masks and regular expressions. Multiple files in different folders can be found and
recovered in one recover session.

R-Studio supports mass file recovery. There is no limit in the number of files that may be recovered during one
session.

File content may be previewed before recovery. 

File or drive binary data can be viewed and edited in the Text/?hexadecimal editor. Also can be viewed and
changed all attributes for NTFS files. 

Drive scan, searching for partitions.

In this mode, R-Studio scans the entire drive or its part. Using a number of statistic and deterministic criteria
known as IntelligentScan technology, it determines existing or existed partitions on the drive, and their file
systems. It is also possible to add new partitions, by setting manually all required parameters.

A drive can be scanned through several successive scans, each with its own parameters. R-Studio
accumulates the information from successive scans and keeps track of changes in the information obtained from
different scans. The information obtained from the disc scan can be stored in a file. It may be loaded and
processed later at any convenient time.

1.5 R-Studio Settings

You may specify some global setting for R-Studio on the Settings dialog box. You may reach it by selecting
Settings on the Tools menu.

Main 

Main dialog box

Main settings

System Options

Check for update If this box is selected, R-Studio will automatically check for updates.

Debug Mode

If this check box is selected, R-Studio displays an additional
command Create FS Snapshot on the shortcut menu for an object
with a file system. An FS Snapshot contains system data for the file
system only (file descriptions without file contents). If a problem
appears, this snapshot can be sent to R-Studio technical support to
identify the problem. This option greatly slows R-Studio. 

https://www.r-studio.com/What-is-a-File-System.html
https://www.r-studio.com/What-is-a-File-System.html
https://www.r-studio.com/What-is-a-File-System.html
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Auto-refresh Drive Tree

If this box is selected, R-Studio automatically refreshes the list of
connected drives. You may disable it if R-Studio experiences
problems with connected devices.

Enable Write
If this check box is selected, R-Studio enables you to write any
changes made in the Text/?hexadecimal editor.

Max changes buffer size
Maximum amount of data stored for the Undo command in the Text/?
hexadecimal editor.

Notifications

Reset all hidden notifications
This button enables all previously disabled notification and warning
messages.

User's file types

File name

Specifies a file name and path to the file where the descriptions of
user's known file types are stored. You need to re-start R-Studio or
click the Reload User's File Types button on the Known File Types tab
for the new file to take effect.

User's RAID layout

File name
Specifies a file name and path to the file where the descriptions of
user's RAID layouts are stored

User's Text/?hexadecimal editor templates

Location
Specifies the path for pattern description files for Text/?hexadecimal
editor.

User's file mask presets

File name: Specifies a file name and path to the file with file mask presets.

File Systems 

File Systems dialog box

File Systems

Default encoding for HFS volumes Select the national encoding for the HFS partitions.

Default encoding for Ext2/?Ext3/?
Ext4/?UFS volumes

Select the national encoding for the Ext2, Ext3, Ext4, and UFS
partitions.

https://www.r-studio.com/What-is-Disk-Partition.html
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Disable any sorting
Select this option if the number of files on the drive is so large that
R-Studio sorts files in selected folders for too long time.

Minimize drive access

Select this option if a lot of bad sectors are on the drive. R-Studio
will reduce access to internal files in the file system to speed up the
interpretation of file system data.

Show deleted empty folders Select this option if you want to view empty deleted folders.

Symbolic Links

Settings are available in the Technician/T80+ version only!

Symbolic links (of symlinks for short) are object that contains references to other files or folders directory in the
form of absolute or relative paths and that affect pathname resolution. For example, if a symlink C:
\ProgramData\Documents points to D:\Recovered Files\Root\Users\Public\Documents, entering it
will result in entering D:\Recovered Files\Root\Users\Public\Documents.

Symbolic Links dialog box

Symbolic Links

Don't show symbolic links by default
(Technician/T80+ version)

If this option is selected, R-Studio hides all symbolic links by
default. Only real objects will be visible. You may make them
visible by clearing the Hide symbolic links option on the Mask
dialog box.

Show symbolic links as links to their
targets, without target content

Only links to their target will be shown in the right pane (Contents).
They target content can be reached by clicking those links.

Link conversion (Default) 

Both an object and its symbolic link
are selected for recovery:

If both an object and its symbolic link are selected for recovery,
both the object and its symbolic link will be recovered. The file
path in that symbolic link will be converted from absolute to
relative. Example: If the object C:\ProgramData\Documents is
a symbolic link to C:\Users\Public\Documents, it will be
converted to a symbolic link to ..\Users\Public\Documents.
Therefore, the symbolic link will point to its object regardless of
the place to which the object has been recovered.

https://www.r-studio.com/What-are-Bad-Sectors.html
http://en.wikipedia.org/wiki/Symbolic_link
https://www.r-studio.com/What-are-Hard-Soft-Links.html
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Only an object is selected for
recovery:

Only the selected object will be recovered.

Only a symbolic link is selected for
recovery:

The selected symbolic link will be recovered as a real object.

Recovery as it is (Only in the Technician/T80+ version)

Both an object and its symbolic link
are selected for recovery:

If both an object and its symbolic link are selected for recovery,
both the object and its symbolic link will be recovered. The file
path in that symbolic link will remain the same. 
Example: 
The place to store recovered data: D:\Recovered Files. 
The object to recover: C:\Users\Public\Documents
The symbolic link: C:\ProgramData\Documents
After recovery:
The recovered object: D:\Recovered
Files\Root\Users\Public\Documents

The recovered symbolic link: D:\Recovered

Files\Root\ProgramData\Documents pointing to C:

\Users\Public\Documents.
Therefore, if someone tries to enter to the symbolic link, the
system will open the object C:\Users\Public\Documents,
rather than recovered D:\Recovered

Files\Root\Users\Public\Documents.

Only an object is selected for
recovery:

Only the selected object will be recovered.

Only a symbolic link is selected for
recovery:

The symbolic link will be recovered as a symbolic link which may
contain a path to a nonexistent object.

The Data Recovery Topics topic explains processing of symbolic links recovery in more detail.

Log 

Log dialog box

 Log options

Logging
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Maximum
messages in the
Event Log

Specifies the maximum number of messages R-Studio will keep in the event log

Save log to file
If this check box is selected, R-Studio writes its log into a log file specified in the File

name field.

File name Specifies the file name in which the log will be saved.

Type

File If this check box is selected, R-Studio logs all events with recovered files.

File System If this check box is selected, R-Studio logs all events with the file system.

Partition If this check box selected, R-Studio logs all events with partitions.

Recover If this check box is selected, R-Studio logs all events with the recovering processes.

Drive If this check box is selected, R-Studio logs all events with drives.

Network If this check box is selected, R-Studio logs all events with network operation.

Severity

Error If this check box is selected, R-Studio adds error messages into its log.

Warning If this check box is selected, R-Studio adds warning messages into its log.

Information If this check box is selected, R-Studio adds information messages into its log.

Success If this check box is selected, R-Studio adds success messages into its log.

NEVER WRITE A LOG FILE ON THE DISK FROM WHICH YOU RECOVER DATA!!!
Or you may obtain unpredictable results and lose all your data.

Note: If in the Recover dialog box the Condense successful restoration events check box is selected, the
Log will display only Error, Warning, and Information event messages.

Known File Types 

Known File Types dialog box

You may specify which Known File Types will be enabled/?disabled by default. You may also specify know
file types to search for during a specific scan session on the Scan dialog box.
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Known File Types

Reset
Click this button to reset the settings to the previous state. Active until the Apply

button is clicked.

Select All Click this button to select all file types in the list.

Clear All Click this button to clear all file types in the list except some predefined ones.

Reload User's File
Types

Click this button to apply new file types after the user's file types file has been
changes from the Main tab.

Edit User's File
Types

Click this button to add a new customer's Known File Type, or to edit already
existing ones. See the Customizing File Types help page for more details.

You may search for required file types if necessary

Search for the doc pattern

Bad Sectors 

Bad Sectors dialog box
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Bad Sectors settings

Default read retries count

Specifies a default value for I/O Tries, or how many times R-Studio will try to
read a bad sector. You may specify this parameter for each drive separately
on the Properties tab.
R-Studio treats bad sectors in the following way:
It reads a certain part of drive (predefined by Windows) and
· If Default read attempts is set to 0, the entire part with bad sectors will be

filled with the specified pattern. 
· If Default read attempts is set to a non-zero value, R-Studio reads again that

part sector by sector, repeating the attempts the specified number of times.
If R-Studio still cannot read a bad sector, it fills the sectors with the
specified pattern. In this case only the bad sectors will be filled with the
pattern, but that extremely slows the drive read process.

For example, if you set Default read retries count to 1, a bad sector will be
read 2 times.

Set default read retries
count for all drives

Click this button to reset Default read retries count for all drives to the default
value.

Pattern to fill bad blocks

Specifies a default pattern R-Studio will use to fill bad sectors in files to
recover, in images, or when showing data in the Text/?hexadecimal editor.
You may specify the pattern either in the ANSI or Hex data format.
Note: R-Studio will never ever try to write anything on the drive from which
data is to recover or an image is to create. 

Memory Usage

Memory Usage dialog box

These settings control how much memory R-Studio uses for its work. They help preventing R-Studio from
locking when trying to perform very memory-consuming tasks like scanning large drives or processing file
systems with a lot of files.

Memory Usage settings

Disable memory control If this option is selected, the memory control is disabled.
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Automatic

If this option is selected, R-Studio will automatically stop performing the task
when the amount of used memory reaches the specified value. You may
specify the limit for either the virtual or physical memory. 

You may see how much memory R-Studio actually uses on the Memory Usage dialog box.

II Data Recovery Using R-Studio

Many specific data recovery cases are discussed in the R-TT's Data Recovery Guide.

Depending on the situation, data recovery may vary:

1. Recovery of deleted files that have resided on an existing logical disk

This can be done using Basic File Recovery.

2. Recovery of files that have resided on a data disk with a damaged file system, or on a previously
deleted or re-formatted partition

If the file system on such logical disk is damaged, the operating system sees that logical disk as a partition
without a valid file system. Such partition should be previously scanned. Also, it should be scanned if you
want to recover data on a previously deleted or reformatted partition.

You may use Fast Search for Lost partitions if you want only to find partitions previously existed on the
drive. It's much faster.

When the partition is scanned, a number of recognized partitions will appear. R-Studio shows them in
different colors depending on which elements of the partition have been found.

An existing logical disk or partition

An existing logical disk or partition after drive scan

A recognized partition. Both boot records and file entries are found for this partition

A recognized partition. Only file entries are found for this partition

A recognized partition. Only boot records are found for this partition

A fast found partition

Empty space on the object
A deleted partition
Files that have been found using scan for known file types (raw file search).

Although such recognized partitions are virtual objects, files can be searched for and recovered from
recognized partitions as from real logical disks using Basic File Recovery.

To successfully recover files from a recognized partition, it is necessary to find a right one which corresponds
to the real logical disk on which the files resided. No strict rules can be applied to that, but the following
considerations should be taken into account:

· If you are going to recover files from a drive with a damaged file system, most likely the right
recognized partition will be a green one.

· If you are going to recover files from a previously deleted or re-formatted partition, most likely the
right recognized partition will be a yellow one.

Also always check the recognized partition's file system, start point, and size. They should be the same for
the recognized partition and real logical disk/?partition. When in doubt, try to preview a couple of files from
the recognized partition. If the files are seen correctly, this is the right partition.

http://www.r-studio.com/Data_Recovery_Guide.shtml
https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-a-File-System.html
https://www.r-studio.com/What-is-disk-format.html
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3. Data recovery from a damaged system disk. The computer does not start up.

· If this computer is on a network, create an R-Studio Agent Emergency startup disk for the computer,
install R-Studio on another computer on the network, and recover data over network.

· If this computer is stand-alone, create an R-Studio Emergency startup disk and use it to start up the
computer and recover data. You may use external USB drives to store recovered files.

R-Studio Features
Contact Information and Technical Support
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs

Data Recovery over Network
Text/?hexadecimal editor
Technical Information and Troubleshooting
R-Studio Emergency
R-Studio Agent Emergency

2.1 Basic File Recovery

NEVER TRY TO SAVE RECOVERED FILES/?FOLDERS TO THE SAME LOGICAL DISK WHERE
THEY RESIDE!!!

Or you may obtain unpredictable results and lose all of your data. 

See the Data Recovery Issues topic for details.

Basic file recovery can be made for deleted files that has resided on an existing logical disk visible to the
operating system. In all other cases, Advanced Data Recovery is required. 

To recover deleted files from a logical disk (recognized partition),

1 Double-click a logical disk in the R-Studio's Drives panel to enumerate files on the disk

 Other ways to enumerate files

· Select the disk and click the Open Drive Files button, 
or
· Right-click the selected disk and select Open Drive Files on the shortcut menu, 
or
· Select the disk and press the F5 key.
or
· Select Open Drive Files on the Drive menu

If you try to enumerate files on a drive or another object without a valid file system on it, a Double-click a

logical disk... message will appear. Select a logical disk on the object or scan the object.

> R-Studio will change its panel showing the disk's folders/?files structure

R-Studio analyzes data on the object and displays all files for which records have been found in the analyzed
tables. If files have not been found, that means that their records have been deleted. To find such files,
Advanced Data Recovery is required.

Please note that R-Studio shows only those files/?folders that match a specified file mask.

https://www.r-studio.com/What-is-system-disk.html
https://www.r-studio.com/What-is-Logical-Disk.html
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 R-Studio Main panel

Panel view options

You may set which panels and bars to enable/?disable. To enable/?disable

The Toolbar Select/?clear Toolbar on the View menu

The Status bar Select/?clear Status bar on the View menu

The Folders panel Select/?clear Folders View on the View menu

The Files panel Select/?clear Contents View on the View menu

The Log panel Select/?clear Event Log on the View menu

The Find Results panel Select/?clear Find Results on the View menu

You may also arrange the data as required. On the View menu, select Arrange and them a required
arrangement.
You may specify which columns will be visible in the Files panel. On the View menu, select Contents

Columns, and select the columns you want to see.
Files can be shown as a list or as icons/?tiles of different sizes.

Files shown as icons/?tiles
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Recovery chances
R-Studio shows its estimates of chances for successful file recovery in the Rec column. 

Recovery chances

Undefined

Good

Above average

Average

Below average

Bad

When R-Studio has enumerated files, those estimates may not be accurate and aren't available for most
files. You may improved them by right-clicking the root folder on the left pane, selecting Recheck Recovery

Chances on the shortcut menu, and specifying required parameters.

The best estimations are though after scanning the disk/partition.

File Information
You may view some information about a file. Right-click the file and select Get Info on the context menu.

File Information

R-Studio Technician/T80+ shows much more information about a file. See the Information about a File
topic for more details.
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Folders panel

Deleted folder
Marked folder (all child
objects in this folder are
marked)
Partially marked folder
(some child objects in
this folder are marked)
Target of a symlinked
folder
Symlink to a folder
Cross-linked folder (A
FAT folder containing
data which also belongs
to other FAT folders.)
Questionable cross-
linked deleted folder (A
FAT folder found by
R-Studio, but with
apparently invalid
content.)
Symbolic link

Files panel:

Deleted file:

Marked deleted file

Selected deleted file

Target of a hard link

Hard link to a file
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You may also arrange the data as required: by their extensions, creation/?modification time, or as a real file
structure

See Find and Mark Multiple Files for more details

Find Results panel

Select Drive

Click this button to return to the R-Studio main panel to select another drive.

Reopen Drive Files

Click this button to list files again.

Recover

Click this button to recover selected folders/?
files.

Recover Marked

Click this button to recover marked folders/?
files.

Find

Click this button to find or/and mark a particular file/?folder. 

Find Next

Click this button to find the next object specified in the Find/?Mark

dialog box

Find Previous

Click this button to find the previous object specified in the Find/?Mark

dialog box.

File Mask

Click this button to specify a file mask.
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The Unmask button appears when a
mask is applied. 

Click this button to remove the applied
mask.

Up

Click this button to move highlighting one folder
up.

Options

Click this button to change Recovery
Options.

Stop

Click this button to stop the current
operation.

The Log panel will show how many files and folders are on the object, and their size. You may specify which
events will be shown in the log pane by setting a log filter.

Note: Metafiles are the file system's internal files invisible to any user, or file system data, which R-Studio
represents as files. These files do not contain user data directly. Unless you want to scrutinize a disk file
system, do not restore them.

If the Too many files... message appears, you may temporally stop file listing and browse through found files.
Then you can resume file listing. You also may skip this file topic and continue. R-Studio will keep
information about the entire file structure.

You may also copy the information about folders and files. 

For the folder (the Folders pane):

Click Copy Folder: To copy the folder's name

Click Copy Path: To copy the path to the folder

For the file (the Contents pane):

Click Copy (Column

Name):
To copy the file's Name, Size, Created, etc., depending on which column is
selected

Click Copy Path: To copy the file path.

Click Copy Selected

Text:
To copy all the columns of the selected file.

Symbolic Link processing

R-Studio recognizes symlinks and processes them as specified in the R-Studio Settings panel. Go to the
Data Recovery Issues topic for  details.

You may open several disks/partitions in one tab. Read the Opening several disks/partitions in one tab
help page for more details.

2 Select a file/??folder to recover

You may select several files/?folders in the same parent folder by pressing the Shift button and clicking the
objects simultaneously.

https://www.r-studio.com/What-are-Hard-Soft-Links.html
https://www.r-studio.com/What-is-Disk-Partition.html
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 Marking multiple files/?folders from different parent folders manually:

Mark a file/folder to recover by clicking the box left to the object, or select Mark on the shortcut menu.
You may mark several files/folders in different parent folders. You may mark all objects in the folder by
selecting Mark All on the Tools or shortcut menu. To unmark an object, click the box left to the object
once more or select Unmark on the shortcut menu. You may unmark all objects in the folder by selecting
Unmark All on the Tools or shortcut menu.
The Log panel will show how many files and folders you have marked, and their total size.

R-Studio can search for a particular file. Go to the Searching for a File topic for details. If you need to find
and mark many files, go to the Find and Mark Multiple Files topic for details.

File content may be previewed before recovery. Go to the Previewing Files topic for details.

If you do not find files that you want to recover:

Sometimes R-Studio can find the files but not the entire file paths to them. It puts such files into the Extra
Found Files folder. Try to search for the files there. If that does not help, try to find them by using file search
globally on the entire drive. Go to the Searching for a File topic for details

If you still cannot find files that you want to recover but are sure they have existed on the logical disk, you
need to use Advanced Data Recovery to find them.

3 Click the Recover or Recover Marked button

 Other ways to recover selected files

· Right-click the selected file/?folder and select Recover or Recover Marked on the shortcut menu, 
or
· Select Recover or Recover Marked on the File menu
or
· Press the F2 button.

4 Specify recover options and output folder on the Recover dialog box and click the OK button

Recover dialog box
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Recover (Advanced) dialog box

If you have another computer connected to R-Studio over network, the Recover dialog box will be slightly

different. See Data recovery over network for details.

 Recover options

Recover all marked files All files, regardless of the applied mask, will be recovered.
Recovered only masked marked files Only files matching the applied mask will be recovered.
Condense successful restoration events If this check box is selected, R-Studio will display only error and

warning messages in its Log

Restore folder structure If this check box is selected, R-Studio recovers the entire path to
the selected object.

Restore from root If this check box is selected, R-Studio recovers the entire path to
the selected object starting from the root folder of the disk.

Recover metafiles If this check box is selected, R-Studio recovers disk metafiles.
Metafiles are the file system's internal files invisible to any user, or
file system data, which R-Studio represents as files. These files do
not contain user data directly. Unless you want to scrutinize a disk
file system, do not restore them.

Recover alternative data streams If this check box is selected, R-Studio recovers alternative data
streams for file systems that support them. Has no effect on FAT
files. See Extended Information Recovery for the NTFS file
system, and Data Recovery on HFS/?HFS+ File System for the
Mac computers.

Recover security If this check box is selected, R-Studio recovers security attributes
for NTFS files. Has no effect on FAT files. See Extended
Information Recovery for details.

Recover extended attributes If this check box is selected, R-Studio recovers extended file
attributes in the file system.

Recover real folders structure Enabled when the files are sorted by their extensions or date. See
Find and Mark Multiple Files for details. If this check box is
selected, R-Studio recovers the real folders/?files structure on the
disk rather than that of sorted files.

https://www.r-studio.com/What-are-alternate-data-streams.html
https://www.r-studio.com/What-are-alternate-data-streams.html
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Skip files with bad sectors If this check box is selected, R-Studio skips files with bad sectors
and displays their list on the Files with bad sectors dialog box
when the recovery has been completed. You may separately
decide later what to do with those files. See Bad sectors for
details. 
If this check box is cleared, R-Studio tries to read those sectors
several times (specified on the Settings/?Bad Sectors dialog
box), and, if fails, fills bad sectors in the recovered file with the
pattern specified on the same box. Information about such files will
appear in the Log.

Do not recover duplicate files from
Extra Found Files

If this check box is selected, R-Studio does not recover files from
Extra Found Files (raw files) that are duplicates of the files found
in file system (Root).

Ignore file mask If this check box is selected, R-Studio recovers all content of a
selected folder, ignoring a specified File Mask.

Open local folder (folders) when done If this check box is selected, the folder with recovered files will be
opened upon recovery completion.

Advanced Specifies options for mass file recovery

If you want to recover multiple files at once, go to the Recover Multiple Files for more information.

R-Studio Technician/T80+

Recover (Additional Output Folders) dialog box

https://www.r-studio.com/What-are-Bad-Sectors.html
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Additional Output Folders

Additional Output Folders Additional output folders where recovered files will be stored when R-Studio
runs out of space.

NEVER TRY TO SAVE RECOVERED FILES/?FOLDERS TO THE SAME LOGICAL DISK WHERE
THEY RESIDE!!!

Or you may obtain unpredictable results and lose all of your data.

Recover (Post Actions) dialog box

Post Actions Options

Shutdown the computer on
task completion

If this check box is selected, R-Studio will shut down your computer when
file recovery has been completed. The program will warn you if any option on
the Advanced tab is set to Prompt.

E-Mail notifications If this check box is selected, R-Studio will inform you about the outcome of
the operation via email. 

If a file to be recovered appears to have an invalid name, a Broken File Name dialog box will appear. You
may correct the name and resume file recovery.

Broken File Name dialog box

 Broken File Name properties

File name Shows the current incorrect file name.
New name Field for a new file name.
Edit broken symbols only If this check box is selected, only invalid symbols may be

corrected
Change all invalid symbols to If this check box is selected, all invalid symbols will be changed to

the specified symbol
Buttons

Rename Click to resume file recovery
Rename All Click to resume file recovery. All other files will be renamed

according to the specified rule.
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Skip Click to skip this file
Skip All Click to skip all files and stop file recovery

If there is no space available for the recovered files, the There is not enough space on the disk dialog box
will appear. You may either select other place to store the files, skip that particular file or abort the recovery
process.

There is not enough space on the disk dialog box

> R-Studio will recover the selected/?marked files/?folders to the specified folder and show the results in

the Log pane

The Recovery progress indicator will show the log and progress of recovery process.

Recovery progress indicator

You may change some options during the process of file recovery and see I/O Monitor to inspect the process of
drive input/output operations in real time

You may change some options during the process of file recovery

Only in the Technician version

Note: R-Studio recovers files from Ext2/3/4FS partitions, but writes it to FAT or NTFS local disks. Or you
may write such files to network drives. R-Studio successfully recovers files from Ext2/3/4FS partitions
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except its security attributes. R-Studio recovers symlinks as files containing the path to files which symlinks
point to.

See Data Recovery on HFS/?HFS+ file system for details on recovering data from disks with the
HFS/HFS+ file system

Opening several disk/partitions in one tab
Searching for a File
Finding Previous File Versions
Previewing Files
File Masks
Regular Expressions
Event Log
2.1.1 Opening several disks/partitions in one tab

You may open several disks/partitions in one tab. Then you may search for files and recover them from several
disks/partitions at once. This is especially useful if files are to be recovered from several recognized partitions
found on one real disk/partition or a drive.

To open several disks/partitions in one tab,

1 Open one partition in a usual way (double-click a logical disk, for example).

2 Right-click the next partition, select Show Files In Tab, and select the tab you want the partition appear
in, or

drag the disk/partition from the Device view to the required tab.

Several partitions in one tab

https://www.r-studio.com/What-are-Hard-Soft-Links.html
https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Disk-Partition.html
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> R-Studio will show files from several partitions in one tab

Several partitions in one tab

Now files may be searched for, marked for recovery, and recovered.

To remove a disk/partition from the tab,

1 Right-click the required disk/partition in the tab and select Close drive in the shortcut menu.

Several partitions in one tab

> R-Studio remove the selected disk/partition from the  tab

2.1.2 Searching for a File

R-Studio can find a particular file, if it is difficult to find it manually in the Folders or Files panel. You can also
automatically mark/?unmark all found files.

To search for a file,

1 Click the Find button

 Other ways to search for the file

· Right-click a folder and select Find on the shortcut menu, 
or
· Select a folder and select Find on the Tools menu
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2 Specify a file to be found and its options on the Find dialog box, and click the OK button

Note that a File Mask may be applied.

Find/?Mark (Main) dialog box

 Find/?Mark options

You may specify how to treat specified strings. Please note that R-Studio stores previously entered search
strings.
All Files and
Folders

If this option is selected, R-Studio applies Advanced Options to all files.

File Extensions If this option is selected, R-Studio treats specified strings as file extensions
Files and Folders If this option is selected, R-Studio treats specified strings as file names. Use ? for one

unspecified character  and * for an unlimited number of them to specify file masks. 
Regular
Expressions

If this option is selected, R-Studio treats specified strings as regular expressions

File Id Specifies File Id that R-Studio assigns to a file.
Match case If this check box is selected, R-Studio makes a case-sensitive search
Look at

Files If this check box is selected, R-Studio includes files into a search.
Folders If this check box is selected, R-Studio includes folders into a search. Disables when

the Mark/Unmark All option is selected.
Deleted files If this check box is selected, R-Studio makes a search among deleted files/?folders.
Existing files If this check box is selected, R-Studio makes a search among existing files/?folders.
Look in Specifies where R-Studio searches for, and marks, files. It can look for them on the

Entire partition, or in/from a certain folder.
If several partitions are opened in one tab, the places will be: All opened partitions,

Selected partition, or in/from a certain folder.
You may specify the starting folder for the search.

https://www.r-studio.com/What-is-Disk-Partition.html
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  identifies current opened folder.

  identifies current starting folder for the search.

 sets starting folder to the current opened folder.

 sets back current starting folder.
Advanced options If this check box is selected, R-Studio will use the advanced options. 
Size from/up to Specifies file size limits. See the Data Formats and Multipliers topic for more details

on data formats.
Bad sectors Specifies whether there are bad sectors in the files. Not known: it's unclear if there are

bad sectors in the files. 
Runtime image Specifies whether the files have already been included into the runtime image.
Recovery
Chances

Specifies files with certain recovery chances. 

Date Specifies file date boundaries. Dates for Modified, Created, and Last Accessed

timestamps may be set separately. 

The Set for all button sets the specified data for all fields.

Find/?Mark options Specify what R-Studio does with the found files. 
The Find first/previous/next/last options. R-Studio stops at the first/previous/next/last file
that matches the specified search criteria.
Find all files. R-Studio searches for all files that matches the specified search criteria..
The search results appear in the Find Results panel.
Mark/Unmark All. R-Studio marks/unmarks all files that match the search criteria. When
these options are selected, R-Studio  marks/unmarks files only, not folders, regardless
of what Look at: Folders specifies.
Please note, that when performing a new find and mark/?unmark task, R-Studio does
not takes into consideration the previous marked/?unmarked state of files. For example,
if you first mark all doc files, and then all txt files, all doc files remain marked, too. To
unmark them, you should specify doc once again and select Unmark files.

Find/mark
objects only in
real paths, ignore
links to folders

If this check box is selected, links to folders will be treated as real folders: they will
appear among search results or marked objects.

> R-Studio will show/?mark the found file(s)

If you need to find and mark many files, go to the Find and Mark Multiple Files topic for details.

https://www.r-studio.com/What-are-Bad-Sectors.html
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To repeat the search, 

* Click the Find Next or Find Previous buttons

 Other ways to repeat the search

· Right-click a folder and select Find Next or Find Previous on the shortcut menu
or
· Select a folder and select Find Next or Find Previous on the Tools menu 

To find all files and show them in the Find Results panel, 

* Select Find all on the on the Find dialog box,

or

select Find all on the Tools menu

> R-Studio will show the found files in the Find Results panel

You may do the following actions on the found files:

Recover, Mark, Preview

by right-clicking the found file and selecting the appropriate item in the shortcut menu.

2.1.3 Finding Previous File Versions

R-Studio can find previous versions of files. It searches for them in the file's current folder and in Extra Found

Files.

File versions are searched for using file size. If the size of a files is within 10% of the original filesize, the following
conditions are checked: 

Conditions Legend

File name N

File extension E

Recognized file type T

To search for previous file versions,

1 Right-click the file and select Find Previous Versions of the File on the shortcut menu

* R-Studio will show the files in the list:

File versions

This technique can be used to find deleted original files after attacks of file encrypting viruses.

2.1.4 Previewing Files

R-Studio has a built-in file previewer that allows you to preview both existing and deleted files. You may use this
feature to estimate chances for successful file recovery or to find a file to recover. 

While previewing a file in the external viewer, you may recover it or mark the file for recovery using Previewer
buttons.
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Previewer buttons

Mark for recovery, Previous file, Next file, Recover

To preview a file

1 Right-click a file to preview in the Files panel and select Preview on the shortcut menu

 Other ways to preview the file

· Select the file in the Files panel and click the Preview button,
or
· Select the file in the Files panel and select Preview on the File menu

> R-Studio will show the content of the file

If you have several files open in the previewer, you may instantly close all of them by selecting Close All

Previews on the File menu.

File Previewer for Pictures:

Pictures can be previewed either as tiles within the main window of R-Studio or in an external previewer.

Within the main window as tiles:

Tile size can be changed..

Pictures as tiles

In the external viewer:

Picture files can be zoomed in/out and rotated.
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Picture file previewer

File Previewer for Video and Audio files:

Video and audio files can be played even without their respective application installed.

Video file previewer

File Previewer for Microsoft/?Open/?Libre Office Documents:

Documents can be shown (including embedded pictures) even without their respective applications installed.
They can be zoomed in/out for better viewing.

Microsoft/?Open/?Libre Office document previewer
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File Previewer for Adobe Acrobat PDF Files:

Files can be shown even without Adobe Acrobat installed.

The previewer allows the users to jump to a required page, zoom the document, and search for a required text.

Adobe Acrobat pdf document previewer

Supported File Types:

Documents:

MS Office and Open/?Libre Office files, even without the programs installed: 
· Word/?Writer documents: docx;
· Excel/?Calc spreadsheets: xlsx;
· PowerPoint presentation: pptx.

Office 97-2003, without the program installed:
· Word documents: doc;
· Excel spreadsheets xls;
· PowerPoint presentation ppt.

Adobe Acrobat document: pdf.

Multimedia Files

Video formats: 
AIFF, ASF, AVI, BFI, CAF, FLV, GIF, GXF, HLS, QuickTime, 3GP, MP4, Matroska, Maxis XA,
MPEG-DASH, MPEG program stream, MPEG transport stream (including AVCHD), MXF, Material
eXchange Format, SMPTE, MSN Webcam stream, NUT, Ogg, OMA, RL2, TXD, WTV.

Audio formats: 
8SVX, AAC, AAC+, AC-3, ADPCM, AMR-NB, AMR-WB, Amazing Studio PAF Audio, Apple
lossless audio, QuickTime, ATRAC, CELT, DCA (DTS Coherent Acoustics), DPCM, DSD (Direct
Stream Digitial), DSP Group TrueSpeech, DST (Direct Stream Transfer), DV audio, FLAC (Free Lossless
Audio Codec), G.723.1, G.729, GSM, IAC (Indeo Audio Coder), iLBC (Internet Low Bitrate Codec),
IMC (Intel Music Coder), Interplay ACM, MACE (Macintosh Audio Compression/?Expansion), MACE
(Macintosh Audio Compression/?Expansion), MLP (Meridian Lossless Packing), Monkey’s Audio, MP1
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(MPEG audio layer 1), MP2 (MPEG audio layer 2), MP3 (MPEG audio layer 3), MPEG-4 Audio
Lossless Coding (ALS), Musepack SV7/SV8, Nellymoser Asao, AVC (Audio for Video Codec), PCM
A-law/?mu-law, QCELP/?PureVoice, QDesign Music Codec, RealAudio, Vorbis, Voxware MetaSound,
WavPack, Westwood Audio, Windows Media Audio, Xbox Media Audio

Graphic files (with file extensions)

3DS Max thumbnail (max), AAA logo (bpr), ACE texture (ace), ADEX (img, rle), AIM Grey Scale (ima,
im), AIPD image (aipd), ARF (arf), AT&T Group 4 (att), AT&T multigen (icn), AVHRR Image (sst), AVT
RAW (raw), AWD (awd), Ability Photopaint Image (apx), Access (g4, acc), Aces200 (ace), Acorn Sprite
(acorn), AdTech perfectfax (adt), Adobe Illustrator (ai), Adobe PhotoParade(images) (php), Adobe
Photoshop (psd), Advanced Art Studio (ocp, art, pic), AirNav (anv), Album bébé (frm), Alias Image File
(pix, als, alias), Alpha Microsystems BMP (bmp), Amapi (2d), Amica Paint (ami, [b]), Amiga IFF (iff, blk),
Amiga icon (info), Amstrad Cpc Screen (cpc), Analyze (avw), Analyze-7 (img), Andrew Toolkit raster
object (atk), Apollo HDRU (hdru, hdr, gn), ArcInfo Binary (hdr), Art Director (art), Artisan (art), Artist 64
(a64), Artrage (ptg), Artweaver Document (awd), Astronomical Research Network (arn), Atari grafik
(pcp), Aurora (sim), Auto F/X (afx), AutoCAD DWG (dwg, dwt), AutoCAD DXF (dxf), Autocad CAD-
Camera (img), Autodesk Animator (fli, flc), Autodesk QuickCAD thumbnail (cad), Autodesk SKETCH
thumbnail (skf), Autodesk SketchUp component (skp, skb), Autologic (gm, gm2, gm4), Award Bios Logo
(epa), Axialis Screensaver(images) (ssp), B3D(images) (b3d), BFLI (bfl, bfli, fli, flp, afl), BIAS
FringeProcessor (msk, img, raw, flt), BLP textures (blp), BMF (bmf), BSB/KAP (kap), BYU SIR (sir),
Bert's Coloring (bmg, ibg), Bfx Bitware (bfx), Bio-Rad confocal (pic), Blazing Paddles (pi), Bob Raytracer
(bob), Brender (pix), Brooktrout 301 (brk, 301, brt), Brother Fax (uni), Buttonz & Tilez texture (til),
CALS Raster (cal, cals, gp4, mil), CDU Paint (cdu), CGM (cgm), CImage (dsi), CMU Window Manager
(cmu), CP8 256 Gray Scale (cp8), CSV (csv), Calamus (cpi, crg), Camera RAW (raw), Canon EOS-1D
Mark II RAW (cr2), Canon Navigator Fax (can), Canon PowerShot (crw), Cartes Michelin (big), Casio
QV-10/100 Camera (cam), Casio RAW (bay, raw), Chinon ES-1000 digital camera (cmt), Cisco IP
Phone (cip), Cloe Ray-Tracer (clo, cloe), ColoRIX (rix, sci, scx, sc?), CompW (wlm), CompuServe GIF
(gif, giff), Computer Eyes, Digital Vision (ce), ComputerEyes Raw (ce1, ce2), Contax RAW (bay, raw),
Core IDC (idc), Corel Draw Bitmap(preview) (cdr), Corel Draw Pattern(preview) (pat), Corel
Flow(preview) (bmf), Corel Metafile Exchange(preview) (cmx), Corel PhotoPaint 6.0 (cpt),
CoverDesigner(images) (ncd), CoverDesigner Template(images) (nct), Crayola (art), Creative PC-CAM
RAW (bay, raw), DBW Render (), DIV Game Studio Map (map), DIV Game Studio Multi Map (fpg),
DKB Ray-Tracer (dis), DNG (dng), DPX (dpx), Dali Raw (sd0, sd1, sd2), Datacopy (img), Degas &
Degas Elite (pi1, pc1, pi2, pc2, pi3, pc3, pi4, pi5, pi6), Deluxe Paint, Electronic Arts (lbm, ilbm), Dicom
(dcm, acr, dic, dicom, dc3), Digital F/X (tdim), Digital Research(GEM Paint) (img, gem), Direct Draw
Surface (dds), Discorp CMP Image (cmp), DjVu (djvu, djv, iw4), DolphinEd (dol), Doodle Atari (doo),
Doodle C64 (dd), Doodle C64(Compressed) (jj), Dr Halo (cut), Draz Paint (drz), EA Sports FSH (fsh),
EPS Interchange Format (epi, ept), ERI-chan(Entis Rasterized Image) (eri), ESM Software Pix (pix), Ecchi
(ecc), Eclipse (tile), Edmics (c4), Egg Paint (trp), Electric Image (ei, eidi), Embroidery (bmc), Encapsulated
Postscript (ps, eps), Encapsulated Postscript (Preview) (eps), Enhance Simplex (esm), Enhanced
Compressed Wavelet (ecw), Epson RAW (erf), Eroiica (eif), Everex Everfax (efx, ef3), Explore(TDI) &
Maya (iff, tdi), FIF(Iterated System) (fif), FIT (fit), Face Painter (fpt), Fast Piecewise-constant (pwc), Fax
Group 3 (g3, fax), Fax man (fmf), Faxable PCX (fcx), Faxable TIFF (ftf), Fenix Map (map), Fenix Multi
Map (fpg), FileMagic (mag), Flash Image (fi), FlashCam Frame (ncy), FlashPix Format (fpx), Flexible
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Image Transport System (fts, fits, fit), Foculus RAW (bay, raw), Fontasy Grafik (bsg), Fremont Fax96
(f96), Fugawi Map (fx3), Fuji S2 RAW (raf), Fun Painter II (fp2, fun), Fun Photor (fpr), Fuzzy bitmap
(fbm, cbm), GRS16 (g16), Gamma Fax (gmf), GeoPaint (geo), Gfa Raytrace (sul), GigaPaint Hi-res (gih),
GigaPaint Multi (gig), Gimp Bitmap (xcf), Gimp Brush (gbr), Gimp Icon (ico), Gimp Pattern (pat), GoDot
(4bt, 4bit, clp), GunPaint (gun, ifl), HD Photo (wdp, hdp), HDRI (hdr, hdri), HF (hf), HP-48/49 GROB
(gro, grb), HP-49 OpenFire (gro2, gro4), HPGL-2 (hp, hpg, hgl, plt, hpgl, hpgl2, gl2, prn, prt, spl), HRU
(hru), HSI Raw (raw), Half-Life Model (mdl), Hasselblad RAW (3fr), Hayes JTFax (jtf), Hemera Photo
Image (hpi), Hemera Thumbs (hta), Heretic II MipMap (m8), Hi-Eddi (hed), Hires C64 (hir, hbm),
Homeworld Texture (lif), IBM Kips (kps), IBM Printer Page Segment (pse), IM5(Visilog) (im5), IMNET
Image (imt), IOCA (ica, ioca, mod), IPLab (ipl), IPod thumb (ithmb), ISS (iss), IcoFX (ifx), Icon Library
(icl), Imacon/?Hasselblad RAW (fff), Image Capture Board (icb), Image Magick file (mif, miff), Image
Speeder (ish), Image System(Hires) (ish), Image System(Multicolor) (ism), Image Systems RLC2 Graphic
(rlc), ImageLab (b&w, b_w), ImagePro Sequence (seq), Imaging Fax (g3n), Imaging Technology (img),
Img Software Set (img), Inshape (iim), InterPaint(Hires) (iph), InterPaint(Multicolor) (ipt), Intergraph
Format (itg, cit, rle), Interleaf (iimg), Iris CT (ct), Iris Graphics (iris), J Wavelet Image Codec (wic), JBIG
(jbg, bie, jbig), JBIG-2 (jb2), JFIF based file (jb2), JPEG/?JFIF (jpg, jpeg, jif, jfif, J, jpe), JPEG 8BIM
header(Mac) (jpg, jpeg, jif, jfif, J, jpe), JPEG XR (jxr), JPEG-2000 Code Stream (jpc), JPEG-2000 JP2
File Format (jp2, j2k, jpx, jpf), JPEG-LS (jls), Jeff's Image Format (jif), Jigsaw (jig), Jovian VI (vi), Jpeg
Network Graphics (jng), JustButtons animated bitmap (btn), KONTRON (img), Khoros Visualization
Image file (vif, viff, xv), KinuPix Skin (thb), Kiss Cel (cel), Koala Paint (koa, kla), Koala
Paint(Compressed) (gg), Kodak Cineon (cin), Kodak DC120 Digital Camera (kdc), Kodak DC25
Camera (k25), Kodak Photo CD (pcd), Kodak Pro Digital RAW (dcr), Kofax Group 4 (kfx), Kolor Raw
Format (kro), Konica Camera File (kqp), LSS16 (lss, 16), LView Pro (lvp), LaserData (lda), Leaf RAW
(mos), Leica RAW (bay, raw), Light Work Image (lwi), LucasFilm Format (lff), Lumena CEL (cel),
LuraDocument Format (ldf), LuraDocument.jpm Format (jpm), LuraWave Format (lwf), LuraWave JPEG-
2000 Code Stream (jpc), LuraWave JPEG-2000 Format (jp2, j2k, jpx, jpf), MAKIchan Graphics (mag),
MGI Photosuite Project(images) (pzp), MGR bitmap (mgr), MRC(Medical Research Council) (mrc),
MTV Ray-Tracer (mtv), Mac Paint (mac, mpnt, macp, pntg, pnt, paint), Mac icon (icns), Macintosh
Quickdraw/?Pict (pic, pict, pict2, pct), Mac OSX Resource (rsc, rsrc), Maggi Hairstyles & Cosmetics (fff),
Male MRI (pd, t1, t2), Male Normal CT (fre), Mamiya RAW (mef), Marks Russel File (mrf), Mavica
(411), Maw-Ware Textures (mtx), Mayura Draw (pdx), MegaPaint (bld), Megalux Frame (frm), Micro
Dynamics MARS (pbt), Micro Illustrator Uncompressed (mil), Micrografx Picture Publisher 4.0 (pp4),
Micrografx Picture Publisher 5.0 (pp5), Micron RAW (bay, raw), Microsoft Image Composer (mic),
Microsoft Paint (msp), Microtek Eyestar (img), Mindjongg Format (ipg), Minolta DiMAGE RAW (mrw),
Mobile FAX (rfa), MonkeyCard (pdb), MonkeyLogo (pdb), MonkeyPhoto (mph), MrSid (sid), Msx 2
Screen (sc2), Multiple Network Graphics (mng), NCR Image (ncr), NIST ihdr (pct), National Imagery
Transmission F. (ntf, nitf), NeoBook Cartoon (car), Neochrome(ST & TT) (neo), Neopaint Mask (npm),
Neopaint Stamp (stw), NewsRoom (nsr, ph, bn), Nifti (img), Nikon RAW (nef), Nokia Group Graphics
(ngg), Nokia Logo File (nlm), Nokia OTA bitmap (otb), Nokia Operator Logo (nol), OAZ Fax (oaz, xfx),
OS/2 Bitmap (bmp, bga), Olicom Fax (ofx), Olympus RAW (orf), Open Image Library Format (oil),
OpenEXR (exr), Optigraphics (ctf), Optigraphics Tiled (ttf), Optocat (abs), Oric Hires (hir), Oric TAP
(tap), OS/2 Warp (bga), PABX background (pix), PAX (pax), PC Paint/?Pictor Page (pic, clp), PCO
(b16), PM (pm), Page Control Language (pcl), Paint Magic (pmg), PaintShopPro Browser Cache File
(jbf), PaintShopPro Brush (pspbrush), PaintShopPro Brush (jbr), PaintShopPro Frame (pfr, pspframe),
PaintShopPro Image (psp, pspimage), PaintShopPro Mask (pspmask), PaintShopPro Mask (msk),
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PaintShopPro Pattern (pat), PaintShopPro Picture Tube (tub, psptube), PaintShopPro Texture (tex), Palm
Pilot (pdb), Panasonic DMC-LC1 RAW (srf), Panasonic LX3 RAW (rw2), Panasonic RAW (bay, raw),
Pegs (pxs, pxa), Pentax *ist D (pef), Pfs Art Publisher (art), Photo Deluxe (pdd, pdb), Photo Filtre Studio
(pfi), PhotoFantasy Image (fsy), PhotoFrame (frm), PhotoStudio File (psf), PhotoStudio Stamp (stm),
Photomatrix (cat), Pic2 (p2), Picasso 64 (p64), Picture Gear Pocket (prc), Picture It! (mix), Pixar picture
file (pic, pxr, picio, pixar), Pixel Power Collage (ib7, i17, i18, if9), Pixia (pxa), Pixibox (pxb), Planetary
Data System (pds, img), Playback Bitmap Sequence (bms), Pocket PC Bitmap (2bp), Pocket PC
Themes(images) (tsk), Polychrome Recursive Format (prf), Portable Bitmap (pbm, rpbm, ppma), Portable
Document Format (pdf), Portable Greyscale (pgm, rpgm), Portable Image (pnm, rpnm, pbm, rpbm, pgm,
rpgm, ppm, rppm), Portable Network Graphics (png, apng), Portable Pixmap (ppm, rppm), Portfolio
Graphics (pgf), Portfolio Graphics Compressed (pgc), Portrait (cvp), Poser Bump (bum), Postscript (ps,
ps1, ps2, ps3, eps, prn), PowerCard maker (crd), PowerPoint(images) (pps), PowerPoint
Presentation(images) (ppt), Print Master (pm), Print Shop (psa, psb), Printfox/?Pagefox (bs, pg, gb), Prism
(cpa), Prisms (pri), Psion Series 3 Bitmap (pic), Psion Series 5 Bitmap (mbm), Punk Productions Picture
(ppp), Puzzle (pzl), Q0 (q0, rgb), Qdv(Random Dot Software) (qdv), Qrt Ray-Tracer (qrt), Quake
Texture (wal), Quantel VPB (vpb), QuickTime Image Format (qtif, qti), RAW DVR (raw), RIPTerm
Image (icn), Radiance (rad, img, pic), Rainbow Painter (rp), Raw (raw, gry, grey), Rawzor (rwz),
Rayshade (pic), Red Storm File Format (rsb), Ricoh Digital Camera (j6i), Ricoh Fax (001, ric), Ricoh IS30
(pig), Rm2K XYZ (xyz), Rollei RAW (rdc, ia), RoverShot RAW (bay, raw), RunPaint(Multicolor) (rpm),
Saracen Paint (sar), SBIG CCD camera ST-4 (st4), SBIG CCD camera ST-X (stx, st4, st5, st6, st7, st8),
SciFax (sci), SciTex Continuous Tone (sct, ct, ch), Seattle Film Works (sfw), Seattle Film Works multi-
image (pwp, sfw), SecretPhotos puzzle (xp0), Sega SJ-1 DIGIO (sj1), Sharp GPB (img), Siemens Mobile
(bmx), SIF MICHEL-Soft (sif), Sigma RAW (x3f), Silicon Graphics RGB (rgb, rgba, bw, iris, sgi, int, inta),
Sinar RAW (cs1, sti), Skantek (skn), Slow Scan Television (hrz), SmartDraw 6 template (sdt), SmartFax
(1), SmoothMove Pan Viewer (pan), Softimage (pic, si), Solitaire Image Recorder (sir), Sony DSC-F1
Cyber-shot (pmp), Sony DSC-F828 RAW (srf), Sony PS2 TIM (tm2), Sony Playstation TIM (tim), Sony
RAW (sr2, arw), Spectrum 512 (spu), Spectrum 512(Compressed) (spc), Spectrum 512(Smooshed)
(sps), SPOT (dat), SriSun (ssi), Stad (pic, pac, seq), Star Office Gallery (sdg), Starbase (img), Stardent
AVS X (x, avs, mbfs, mbfavs), Starlight Xpress SX (RAW), Stereo Image (jps), ST Micro RAW (bay,
raw), Structured Fax Format (sff), Sun Icon/?Cursor (icon, cursor, ico, pr), Sun Rasterfile (ras, rast, sun, sr,
scr, rs), Sun TAAC file (iff, vff, suniff, taac), Syberia texture (syj), Synthetic Universe (syn, synu), SVG
(svg), TG4 (tg4), TI Bitmap (92i, 73i, 82i, 83i, 85i, 86i, 89i), TIFF Revision 6 (tif, tim, tiff), TMSat image
(imi), TRS 80 (hr), TealPaint (pdb), Teli Fax (mh), Thumbnail (tnl), TilePic (tjp), Tiny (tny, tn1, tn2, tn3),
TopDesign Thumbnail (b3d, b2d), Total Annihilation (gaf), Truevision Targa (tga, targa, pix, bpx, ivb),
Ulead Pattern (pst), Ulead PhotoImpact (upi), Ulead Texture(images) (pe4), Usenix FaceServer (fac, face),
Utah raster image (rle, urt), VIPS Image (v), VITec (vit), VRML2 (wrl), Venta Fax (vfx), Verity (vif),
Vicar (vic, vicar, img), Vidcom 64 (vid), Video Display Adapter (vda), Vista (vst), Vivid Ray-Tracer (img),
Vort (pix), Vue d'esprit (vob), WAD(Half life) (wad), WSQ (wsq), WaveL (iwc), Wavefront Raster file
(rla, rlb, rpf), WebShots(images) (wb1, wbc, wbp, wbz), Weekly Puzzle (jig), WebP (webp, wep),
Whypic (ypc), WinFAX (fxs, fxo, wfx, fxr, fxd, fxm), WinMIPS (pic), Windows & Aldus Metafile (wmf),
Windows Animated Cursor (ani), Windows Bitmap (bmp, rle, vga, rl4, rl8, sys), Windows Clipboard (clp),
Windows Comp. Enhanced Metafile (emz), Windows Compressed Metafile (wmz), Windows Cursor
(cur), Windows DIB (dib), Windows Enhanced Metafile (emf), Windows Icon (ico), Winzle Puzzle (wzl),
Wireless Bitmap(level 0) (wbmp, wbm, wap), Word Perfect Graphics(images) (wpg), Worldport Fax
(wfx), X Windows System dump (xwd, x11), X11 Bitmap (xbm, bm), X11 Pixmap (xpm, pm), XV Visual
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Schnauzer (p7), Xara(images) (xar), Xerox DIFF (xif), Ximage (xim), Xionics SMP (smp), YUV 16Bits
(yuv, qtl, uyvy), YUV 16Bits Interleaved (yuv, qtl, uyvy), YUV 4:1:1 (yuv, qtl), YUV 4:2:2 (yuv, qtl), YUV
4:4:4 (yuv, qtl), ZX Spectrum Hobetta ($s, $c, !s), ZX Spectrum Snapshot(sna), ZX Spectrum standard
(screen scr), ZZ Rough (rgh), Zeiss BIVAS (dta), Zeiss LSM (lsm), Zoner Callisto Metafile(zmf), Zoner
Zebra Metafile (zbr), Zsoft Multi-page Paintbrush (dcx), Zsoft Publisher's Paintbrush (pcx, pcc, dcx),
byLight (bif)

2.1.5 File Masks

R-Studio shows only those files/?folders that match the specified file mask. File mask affects files/?folders that are
processed by the Recover and Find commands. 

To specify a file mask,

1 Click the File Mask button

 Other ways to specify the file mask

· Right-click a folder and select File Mask on the shortcut menu
or
· Select the folder and select File Mask on the Tools menu

2 Specify the file mask on the File mask dialog box and click the OK button

Mask dialog box

 File mask options

You may specify options for All Files, File Extensions, Files, and Regular Expressions

Match case If this check box is selected, R-Studio makes a case-sensitive search.
Show empty folders If this check box is selected, R-Studio will show folders with no files in them.
Deleted files If this check box is selected, R-Studio makes a search among deleted files/folders.
Existing files If this check box is selected, R-Studio makes a search among existing files/folders.
Hide symbolic links If this check box is selected, R-Studio hides all symbolic links. It may be selected

by default if the Don't show symbolic links by default option is selected on the Settings
dialog box.

Use advanced
options

If this check box is selected, R-Studio will use the advanced options, even when
they are hidden. 

Advanced Options

Size from/up to Specifies file size limits. See the Data Formats and Multipliers topic for more
details on data formats.

https://www.r-studio.com/What-are-Hard-Soft-Links.html
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Bad sectors Specifies whether there are bad sectors in the files. Not known: it's unclear if there are
bad sectors in the files. 

Runtime image Specifies whether the files have already been included into the runtime image.
Date Specifies file date boundaries. Dates for Modified, Created, and Last Accessed

timestamps may be set separately. 

The Set for all button sets the specified data for all fields.

> R-Studio will show only those files that match the specified file masks

Click the Unmask button to remove the applied mask.

Mask presets

You may set various presets with different file masks. Just click on the Plus button to add the data from the dialog
box to the presets. You may also give presets names, delete them, and store them permanently.

2.1.6 Regular Expressions

Regular expression is a notation for patterns of text, as opposed to exact strings of characters. The notation uses
literal characters and metacharacters. Every character which does not have special meaning in the regular-
expression syntax is a literal character and matches an occurrence of that character. For example, letters and
numbers are literal characters. A metacharacter is a symbol with special meaning (an operator or delimiter) in the
regular-expression syntax.
. Wildcard: any character
* Repeat: zero or more occurrences of previous character or class
^ Line position: beginning of line
$ Line position: end of line
[class] Character class: any character in the set
[^class] Inverse class: any character not in the set
[x-y] Range: any characters within the specified range
\x Escape: literal use of metacharacter x
\<xyz Word position: beginning of the word
xyz\> Word position: end of the word

For example, the following regular expression .* matches any string of characters, ^a matches any string
beginning with character a.

2.1.7 Event Log

R-Studio logs and displays events in the Log panel. You may set a Log filter to display only needed information
and to write it to a log file. You may specify the log settings on the Settings dialog box.

You may clear or save the log 

To clear the log,

* Right-click the Log panel and select Clear Log on the shortcut menu.

To save the log to a file,

* Right-click the Log panel and select Save Log to File on the shortcut menu.

You may copy data from separate messages:

https://www.r-studio.com/What-are-Bad-Sectors.html
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Click Copy (Column Name): To copy the record's Type, Date, Time, Text, depending on which column is
selected

Click Copy Selected Text: To copy all the columns of the selected record.

2.2 Advanced Data Recovery

This chapter explains how to perform advanced data recovery operations.

· Drive Scan
· Fast-Search-for-Lost-Partition
· Customizing File Types
· Customizing File Types-I
· Customizing File Types-II

· Regions
· Exclusive Regions
· Images
· Wiping Objects

2.2.1 Drive Scan

In order to completely analyze data structure on an object, it must be scanned. Any object in the Drives panel can be

scanned. In addition, you may create a region to scan only a part of an object. The Regions topic explains how to create and

work with regions. Scan is also greatly improves estimations for chances of successful file recovery.

You may select scan area and some other scan parameters. Scan information may be saved to a file and later this
file may be opened. 

You may save scan information on the remote computer if necessary. 

Note: You may use Fast Search for Lost partitions if you want only to find partitions previously existed on the
drive. It's much faster.

Attention: Scanning large areas may be a very lengthy process!

NEVER TRY TO SAVE SCAN INFORMATION TO THE OBJECT BEING SCANNED!!!
Or you may obtain unpredictable results and lose all of your data. 

To scan an object

1 Select an object in the R-Studio's Drives panel

2 Click the Scan button

 Other ways to start scan

· Right-click the selected drive and select Scan on the shortcut menu, 
or
· Select Scan on the Drive menu

https://www.r-studio.com/What-is-Disk-Partition.html
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3 Specify the required parameters on the Scan dialog box and click the Scan button

Scan dialog box

 Scan options

Drive Size: Shows the size of the object to be scanned
Start: Sets the start point of the area to be scanned.
Size: Sets the size of the area to be scanned. 

Numbers in these fields can be in bytes or sectors. See the Data Formats and Multipliers topic for
more details on data formats.
File Systems: Specifies the file systems which objects are to be searched for.

Current version supports: FAT, NTFS, exFAT, ReFS, Ext2/3/4FS, XFS, HFS,
APFS, and UFS file systems. The Technician version supports also the ISO9660 file
system.
Please note that if you need to scan an HFS, HFS+, or HFSX disk, always enable the
Extra search for Known File Types option. This is very important because when files are
being deleted on the  HFS, HFS+, HFSX file systems, the computer completely
removes all system information on them, and there is no way to recover the deleted files
except by using the Extra Search for Known File Types option. See Data Recovery
on HFS/?HFS+ file system for details.

Extra search for
Known File Types

Enables search for Known File Types.

Save scan Info to
File:

If this checkbox is selected, R-Studio will save scan information to a specified file.
Later this file may be opened. Please note, that this option does not save actual drive
data, only information on drive data structure gathered during drive scan.
If 

Simple view If this option is selected, R-Studio will show only scan progress.
Detailed view If this option is selected, R-Studio will show graphic representation on objects found

during scan.
None If this option is selected, R-Studio will not show the Scan Information tab during

scan.
Buttons

Scan Starts scanning
Advanced Activates advanced scan options
Known File
Types...

Selects file types that R-Studio will recognize during the drive scan.

https://www.r-studio.com/What-is-Raw-File-Recovery.html
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Cancel Closes the dialog box

NEVER TRY TO SAVE SCAN INFORMATION TO THE OBJECT BEING SCANNED!!!
Or you may obtain unpredictable results and lose all of your data. 

If a remote computer is connected for Data Recovery over Network, the Scan dialog box will have a
different look 

and the Save Scan Information File dialog box will appear when you select a place to store scan info. You
may save it to the local or remote computer.

Known File Types (raw file search): While scanning, R-Studio can recognize the data’s particular file type.
Using such information, R-Studio can obtain more information about data/?file structure on the object being
scanned. By default, R-Studio tries to recognize the default list of supported file types specified on the
Known File Types tab of the Settings panel, greatly increasing time required for the scan. You may reduce it
by selecting only those file types that you need. Click the Known File Types... button and select the required
file types on the File Types dialog box. These selections will be applied to that scan session only.

R-Studio places such found files in the Raw Files section in the the Drives panel.

File Types dialog box

 Known File Types

Set as Default Click this button to set the current list of selected file types as default values.
Revert to Default Click this button to revert the default settings specified on the Known File Types

tab of the Settings panel.
Reset to
Recommended

Click this button to revert to factory-preset default settings.

Select All Click this button to select all file types in the list.
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Clear All Click this button to clear all file types in the list except some predefined ones.

 List of known file types

Document

AbiWord
Document: .abw

Adobe InDesign
File: .indd

Adobe PDF
document: .pdf

Apple iWork Keynote
document: .key

Apple iWork Pages
document: .pages

Apple iWork document Capella document: .cap Final Draft
Document: .fdr

FrameMaker
Document: .fm

GNU Info
Document: .info

Garmin MapSource
data: .mps

Lotus AMI Pro
Document: .sam

Lotus Organizer: .or5 Lotus Word Pro
Document: .lwp

Microsoft Office Open
XML Document

Microsoft OneNote
section file: .one

Microsoft Pocket Streets
Map File: .mps

Microsoft PowerPoint
2007 XML
Document: .pptx

Microsoft PowerPoint
Document: .ppt

Microsoft Visio
document: .vsd

Microsoft Word 2007
XML Document: .docx

Microsoft Word
Document: .doc

Word for Macintosh
Document: .mcw

Microsoft Word2
Document: .doc

Microsoft Works
document: .wps

OLE Storage OpenOffice Writer
document: .odt

OpenOffice
document: .ods

PageMaker
Document: .p65

PostScript
document:.ps

QuarkXPress file: .qxd QuarkXpress
project: .qxp

Rich Text
Document: .rtf

TEX document: .tex Text document: .txt Unicode
document: .txt

WordPerfect
Document: .doc

Document: E-book

Chaoxing SSReader
eBook: .pdg

EPUB eBook: .epub FB2 eBook: .fb2 MOBI eBook: .mobi
Microsoft Money
Data: .mny

Microsoft Reader
eBook: .lit

Microsoft Reader
eBook
annotations: .ebo

Document: Spreadsheet

Apple iWork Numbers
document: .numbers

Lotus 1-2-3 v1
worksheet: .wk3

Lotus 1-2-3 v2
workshee: .wk1, .fmt

Lotus 1-2-3 v3
worksheet: .wk3, .fm
3

Lotus 1-2-3 v4
worksheet: .wk4

Lotus 1-2-3
workbook: .123

Microsoft Excel 2/3/4
worksheet: .xls

Microsoft Excel 2007
XML
Document: .xlsx

Microsoft Excel 4
Spreadsheet: .xls

Microsoft Excel
Spreadsheet: .xls

Quattro Pro
Spreadsheet: .wq1
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Document: Database

Cathy database: .caf Data Interchange
Format file: .dif

GDSII database: .gds Microsoft Access 2007
XML
Document: .accdt

Microsoft Access 2007
Database: .accdb

Microsoft Access
Database: .mdb

Microsoft SQL
Log: .ldf

Microsoft SQL
Database: .mdf

MySQL Database
Dictionary: .frm

MySQL database: .myi Omnis Studio
Library: .lbs

Omnis Studio
Database: .df1

OpenOffice Base
document: .odb

dBase III
Database: .dbf

Document: Financial

Microsoft Money
Data: .mny

QuickBooks Backup
File: .qbb

QuickBooks Primary
Data File: .qbw

Quicken Data: .qdf

TurboTax return
file: .tax

Internet-related files

Compiled HTML
file: .chm

Internet shortcut: .url Microsoft OutLook
Personal Folder: .pst

Microsoft Outlook/?
Inbox offline
folder: .ost

Mozilla Firefox browser
extension: .xpi

Mozilla Mail Summary
file: .msf

Outlook Express
Messages: .dbx

The Bat! Address
book: .abd

The Bat! Message
Base: .tbb

The Bat! Message
Index: .tbi

Windows Address
Book: .wab

XML document
(Unicode): .xml

Email

E-Mail Message: .eml Microsoft OutLook
Personal Folder: .pst

Microsoft Outlook Inbox
offline folder: .ost

Mozilla Mail Summary
file: .msf

Outlook Express
Messages: .dbx

The Bat! Address
book: .abd

The Bat! Message
Base: .tbb

The Bat! Message
Index: .tbi

Windows Address
Book: .wab

Font

Adobe PostScript
Font: .pfb

Adobe Printer
Font: .pfm

BDF Unix font: .bdf BGI font: .chr

CPI DOS font: .cpi OpenType font: .otf TrueType Font: .ttf Windows System
Font: .fon

Graphics/?Picture

AVHRR Satellite
image: .sst

Adobe Lightroom
preview: .lrprev

Adobe Photoshop
image: .psd

Agfa/?Matrix Scodl
Image: .scd

Alias Wavefront Raster
Image: .rla

Amiga icon: .info ArcView Shape:.shp AutoCAD Binary
Image: .dxf
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AutoCAD
Drawing: .dwg

AutoCAD Image: .dxf Autodesc Animator Pro
color palette: .col

Autodesc Animator Pro
Image: .pic

Autodesc Animator
Image: .pic

Autologic Image: .gm BMF image: .bmf Bentley MicroStation
CAD Drawing: .dgn

Canon (CR2) RAW
graphics file: .cr2

Canon (CRW) RAW
graphics file: .crw

ColoRIX Image: .rix Computer Graphics
Metafile image: .cg

ComputerEyes Raw
Image: .ce1, .ce1

Continous Edge Graphic
Image: .ceg

Corel Texture
Image: .tex

CorelDraw CMX
Image: .cmx

CorelDraw Image: .cdr Cubicomp Picture
Maker Image
.r8, .g8, .b8

DICOM medical
image: .dcm

Digital Negative
image: .dbg

Dr. Halo palette: .pal Enhanced MetaFile
Image: .emf

Epson RAW
image: .erf

Epson Stylus
Image: .prn

Erdas LAN/GIS
Image: .lan, .gis

Fractal Image
Format: .fif

Freehand (MX)
Database: .fh10

Fuji RAW image: .raf

GEM Raster
Image: .img

GEM VDI Image: .gdi CompuServe GIF
Image: .gif

Garmin Mapsource
image: .img

Graphics Workshop for
Windows
Thumbnail: .thn

Gridded Binary
Image: .grb

HP Command Language
Image: .pcl

HP Raster Image: .rtl

HSI JPEG Image: .hsi Hemera Photo-Object
Image: .hpi

Hitachi Raster
Image: .hrf

Hotspot Image: .shg

IBM Picture Maker
Image: .pic

JPEG 2000: .jp2 JPEG Digital
Camera: .jpg

JPEG Image: .jpg

Jovian Logic Image: .vi Kodak PhotoCD
Image: .pcd

Kodak RAW
image: .dng

LBM/IFF Image: .lbm

Leica RAW image: .dng Lightwave Object: .lwo Lotus PIC Image: .pic Macintosh PICT
Image: .pct, .pic

Macintosh Paint
Image: .mac

Mamiya RAW
image: .mef

McIDAS Satellite
Image: .goe

Microsoft Paint
Image: .msp

Minolta RAW
image: .mrw

Nikon RAW
image: .nef

OS/2 Icon: .ico Olympus RAW
image: .orf

PBM Image: .pbm PGM Image: .pgm PIX Image: .pix PM Image: .pm

PNG Image: .png PPM Image: .ppm PaintShop Pro
Image: .psp

Panasonic RAW
image: .rw2

PaperPort Image: .max Pentax RAW
image: .pef

Pictor PC Paint
Image: .pic

Print Shop Image: .pds

Quick Link II fax
Image: .qfx

QuickDraw 3D
Metafile: .3dmf

RAW Digital Camera
image: .dng

RenderMan
Image: .rib

Ricoh RAW image: .dng SGI Image: .sgi STAD Image: .pac Samsung RAW
image: .dng
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Seattle FilmWorks/?
PhotoWorks
image: .pwm

Sigma RAW
image: .x3f

Sketch Image: .sk SmartDraw file: .sdr

Sony RAW image: .arw Sun Raster Image: .sun SymbianOS
Image: .mbm

TI Image: .92i

Tagged Image Format
File: .tif

TargetExpress
image: .mte

Utah Raster Toolkit
Image: .rle

VITec Image: .vit

Webshots Image: .wb1 Weresc CADE
drawing: .dtc

Windows Animated
cursor: .ani

Windows Bitmap
Image: .bmp

Windows Color
Palette: .pal

Windows Fax Cover
Image: .cpe

Windows MetaFile
Image: .wmf

Windows cursor: .cur

Windows icon: .ico WordPerfect Graphics
Image: .wpg

X PixMap Image: .xpm X Window Dump
Image: .xwd

Xara Drawing: .xar ZSoft PCX Image: .pcx iPhoto Image: .attr

Multimedia: Audio Files

AIFF Sound: .aif AVR Sound: .avr AY Chip music: .ay AdLib Tracker 2
module: .a2m

Advanced Streaming
Format file: .asf

Audacity audio: .au AudioCD file: .cda Battery 3 sample: .nov

CMF music: .cmf Common Loudspeaker
Binary: .cf1

Creative voice file: .voc DiamondWare
sound: .dwd

Digital Speech File: .dss Digital voice file: .dvf EA ASF/MUS audio
file: .asf

Extended M3U
playlist: .m3u

FLAC audio
file: .fla, .flac

KaraBox sound: .mkf La Lossless audio
file: .la

Liquid Audio File: .la1

MIDI Instrument
definition: .idf

MIDI music: .mid MIDI stream: .mds MPEG Layer I audio
file: .mpg

MPEG Layer II audio
file: .mp2

MPEG Layer III audio
file: .mp3

MUS music: .mus Monkeys audio
file: .ape

Musepack audio
file: .mpc

Next/Sun uLaw
sound: .au

Nitro Composer
sound: .minincs

Nord Modular G2
Patch: .pch2

Ogg Vorbis audio
file: .ogg

OptimFROG audio
file: .ofr

Portable Sound
Format: .psf

RIFF MIDI
music: .rmi

RK Audio sound: .rka Sierra AUD
sound: .aud

Sony OpenMG audio
file: .oma

Super NES audio
file: .spc

TTA audio file: .tta VQF sound: .vqf WavPack audio file: .wv Westwood AUD
sound: .aud

Windows Media Audio
File: .wma

Windows WAVE
sound: .wav

X-MIDI music: .xmi ZyXEL sound: .zyx

aPac audio file: .apc

Multimedia: Video Files
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3GPP multimedia audio/?
video: .3gp

3GPP2 multimedia
audio/?video: .3g2

4X Movie Video: .4xm Adobe Filmstrip
Animation: .fsf

AMV Video: .amv ARMovie video: .rpl Adobe Filmstrip
animation: .fsf

Autodesk
Animator: .fli

BINK Video: .bik BluffTitler video: .bt DVM video: .dvm DeluxePaint
animation: .anm

Director video: .dcr DriveCam video: .dce Eyemail video: .eye Flash Video: .flv

Intel DVI Video: .dvi Intel Indeo Video
File: .ivf

Interplay MVE
Video: .mve

LZA animation: .lza

LZA Animation: .lza Lotus ScreenCam
video: .scm

MPEG Transport
Stream video: .mts

MPEG video: .mpg

MPEG-2 Transport
Stream video: .m2ts

Matroska video: .mkv MythTV video: .nuv NEOchrome
animation: .ani

Nancy Codec
video: .noa

Nullsoft Video: .nsv QV-10 video: .cam QuickTime video: .mov

SGI movie format: .mv SMJPEG Video: .mjpg Sega FILM/?CPK
video: .cpk

Shockwave
video: .swf

Smacker video: .smk Sony Movie Player
video: .mqv

VOB video files: .vob VP6 encoded
Video: .vp6

VideoCD video: .vcd Vivo streaming
video: .viv

Windows AVI
Video: .avi

Windows Media
Video: .wmv

Multimedia Files

MP4 file: .mp4  Material Exchange
File: .mxf

RIFF Multimedia File Real Networks audio/?
video: .rm

Archive Files

7-Zip archive: .7z ACE archive: .ace AIN archive: .ain ARJ archive: .arj

ARX archive: .arx Android Package: .apk BAG archive: .bag BIX archive: .bix

BOA
archive: .b58, .boa

BZip2 archive: .bz2 BlackHole archive: .bh Blink archive: .bli

CPIO archive: .cpio ChArc archive: .chz Compress archive: .z Crush archive: .cru

DEB archive: .deb FOXSQZ
archive: .sqz

GZip archive: .gz HA archive: .ha

HAP archive: .hap HPack archive: .hpk Hyper archive: .hyp InstallShield CAB
archive: .cab

InstallShield Z archive: .z InstallShield compressed
file

JAR archive: .jar JRC archive: .jrc

LHA/?LZARK
archive: .lzh

LZA
archive: .lza, .lzz 

LZOParchive: .lzo, .
lzop

LZX archive: .lzx

LIMIT archive: .lim Microsoft Cabinet
archive: .cab

Microsoft Compress
compressed file

PAKLEO
archive: .pll
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QFC archive: .qfc Quantum
archive: .q, .pak

Quark archive: .ark RAR archive: .rar

RPM archive: .rpm ReSOF archive: .sof SAR archive: .sar SBC archive: .sbc

SQZ archive: .sqz SZip archive StuffIt archive: .sit TAR archive: .tar

UFA archive: .ufa UHArc archive: .uha UltraCompressor 2
archive: .uc2

WRAptor
archive: .wra

WinImp archive: .imp Windows Installer
Merge Module: .msm

Windows Installer
Package: .msi

indows Installer
Patch: .msp

Windows Installer Patch
Creation File: .pcp

Windows Installer
Validation
Module: .cub

YAC archive: .yc YBS archive: .ybs

ZIP archive: .zip ZOO archive: .zoo ZZip archive: .zz iOS Package: .ipa

xz archive: .xz

Executable/?Library/?DLL

DOS Style
Executable: .exe

ELF Executable (UNIX) ELF Library (UNIX) ELF Module (UNIX)

Java Bytecode: .class KolibriOS Executable NetWare Loadable
Module: .nlm

Shell Script

UEFI Executable
.efi

Windows DLL: .dll Windows
Executable: .exe

Windows 9x Device
Driver: .vxd

Windows Device
Driver: .sys

Windows OCX
File: .ocx

Development files

ACUCOBOL object Borland Delphi
Compiled Unit: .dcu

Borland Turbo Pascal
compiled Unit: .tpu

C/C++ Source
Code: .c

COM Type
Library: .tlb

GUI Design Studio
project: .gui

LUA Script: .lua Library: .lib

Microsoft .NET XML
Resource
template: .resx

Microsoft ClassWizard
file: .clw

Microsoft Linker
database .ilk

Microsoft Precompiled
header: .pch

Microsoft Program
database: .pdb

Microsoft Visual C++
project: .mdp

Microsoft Visual Studio
Solution: .sln

Microsoft Visual Studio
project: .dsp

Microsoft Visual Studio
workspace: .dsw

OMF Object
library: .lib

PolySpace results: .chk RDOFF Object
File: .rdf

Resource Compiler
Script File: .rc

Visual Studio Solution
User Options: .suo

Visual Studio Widget
File: .wid

Visual Studio
Workspace Options
file: .opt

VisualBasic
Project: .vbp

WinDev Window: .wdw Windows Compiled
resource (32bit) : .res

XPCOM Type
Library: .xpt

Xcode
Project: .pbxproj
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Disk images

Hyper-V virtual
disk: .vhdx

JAM compressed
disk: .jam

Norton Ghost disk
image: .ghs

QEMU virtual
disk: .qcow2

R-Drive Image disk
image: .rdr

VMware virtual
disk: .vmdk

Virtual PC virtual
disk: .vhd

VirtualBox virtual
disk: .vdi

Other file types

ABBYY Lingvo
dictionary: .lsd

AIX Backup File: .bff ArtMoney Table
file: .amt

CrystalMaker Data
File: .cmdf, .cmmf

Dwarf Fortress save
data: .dat

EasyCrypto
file: .encrypted

Fallout 3 save
game: .fos

Java Applet cache
index: .idx

Kaspersky Anti-Virus
data base: .avc

Kaspersky Anti-Virus
report: .rpt

Kaspersky Anti-Virus
signature bas: .kdc

Magic 3D Easy View
object: .x

Microsoft Security
Catalog: .cat

NHTSA UDS-1992
crash test result: .uds

NOD32 Antivirus
Update file: .nup

ORTIMZeit
project: .ozv

OziExplorer Map
data: .map

PRO100 project: .sto PlayStation 3
Theme: .p3t

RegEdit file: .reg

RegEdit file
(UNICODE): .reg

Source Game Engine
Compiled AI
Nodegraph: .ain

Unreal Package Valve Texture
File: .vtf

WinHelp: .hlp WinHelp
Contents: .cnt

WinXP Prefetch file: .pf Windows Backup
File: .bkf

Windows Clipboard
file: .clp

Windows Color
Profile: .icm

Windows
Minidump: .dmp, .mdm
p

Windows National
locale: .nls

Windows Password
file: .pwl

Windows Registry
hive: .dat, .hiv

Windows Thumbnail
cache: .db

Windows User
Interface Module: .wim

Windows shortcut: .lnk X-Plane Scenery: .dsf XNA Game Data: .xnb

Note: Using scan for Known File Types, R-Studio can successfully recover only un-fragmented files.
You may also specify your own file types for scanning. See Customizing File Types for details. User-
defined file types precede over built-in ones, if their definitions overlap.
You may set the defaults for known file types on the R-Studio Settings.
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R-Studio Technician/T80+

Scan (Post Actions) dialog box

Post Actions Options

Shutdown the computer on
task completion

If this check box is selected, R-Studio will shut down your computer when
scan has been completed. You should select the Save to file checkbox and
specify a place to save scan info to activate this option.

E-Mail notifications If this check box is selected, R-Studio will inform you about the outcome of
the operation via email. 

> R-Studio starts scanning the object, and its panel will show information about new found objects:

 R-Studio Main panel



Data Recovery Using R-Studio 54

© 2023 R-Tools Technology Inc.

Drives panel after scanning:

You can select an object by clicking it

The Log pane will show scan progress. Scan may be stopped by clicking the Stop button on the toolbar.
Later the scan process may be resumed with different scan parameters. Some scan parameters may also be
changed during the scan process. Click the Options button and change them on the Scanning dialog box.

You may change some options during the scan process
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Only in the Technician version

You may see which file object(s) is/are on a particular drive part. Click the corresponding rectangle in the
Scan Information pane and view the information on the Scan Information dialog box.

Scan Information dialog box

Double-click an object to view/?edit the file object in the Text/?hexadecimal editor.

When an object is scanned, a number of Recognized partitions will appear. R-Studio shows them in different
colors depending on which elements of the partition have been found.

An existing logical disk or partition

An existing logical disk or partition after drive scan

A recognized partition. Both boot records and file entries are found for this partition

A recognized partition. Only file entries are found for this partition

A recognized partition. Only boot records are found for this partition

A fast found partition
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Empty space on the object
A deleted partition
Files that have been found using scan for known file types (raw file search).

Although such recognized partitions are virtual objects, files can be searched for and recovered from
recognized partitions as from real logical disks using Basic File Recovery.

To see the information about a newly found object, simply click it in the Drives panel. Click this link to see
the information about the object Recognized13 on the logical disk H:.

When an object in the scanned drive is selected, R-Studio shows the scanned area of the object.

Object's scanned area

All scanned information may be deleted on the shortcut menu for a scanned object. 

Scan information may be saved in a file. Previously saved scan information may be loaded. This can be done on
the Drive or shortcut menu for a selected object.

Resuming incomplete scans or scanning the object with different parameters

You may resume the scan of an incompletely scanned object or rescan the already scanned object with different
parameters. The  Scan dialog will be a little bit different in this case.

https://www.r-studio.com/What-is-Logical-Disk.html
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Scan dialog box for incomplete scans

You may rescan the entire drive, scan unscanned areas, or scan an explicitly  specified area. 

Scan of multiple areas

You may simultaneously scan several successive or overlapping areas. Click the Advanced button, specify an
offset and size for a new area to scan on the Advanced Scan dialog box and click the Add button. You may
specify and add several scan areas. You may select which areas should be scanned. Selected scan areas can be
merged. Right-click a necessary area and select either Merge Down, Merge Down All, and Merge Selected.
You may also select/unselect unscanned areas.

Advanced Scan dialog box

R-Studio accumulates the information from successive scans and keeps track of changes in this information
obtained from different scans.

You may manage the areas 

Managing scan information

Scan information may be saved to a file. Previously saved scan information may be loaded. 

To save scan information

1 Select an object in the R-Studio Drives panel

2 Select Save Scan Information on the Drive or shortcut menu and save the scan information in a file

The default file extension is *.scn.
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If a remote computer is connected for Data Recovery over Network, the Save Scan Information File

dialog box will appear when you select a place to store scan info. You may save it to the local or remote
computer.

To load scan information

1 Select an object in the R-Studio Drives panel

2 Select Open Scan Information on the Drive or shortcut menu and select the required file with the scan
information

The default file extension is *.scn.

If a remote computer is connected for Data Recovery over Network, the Open Scan Information File

dialog box will appear when you select a place to load scan info from. You may load it from the local or
remote computer.

> The scan information will appear in the Drives panel

To remove scan information

1 Select an object in the R-Studio Drives panel

2 Select Remove Scan Information on the Drive or shortcut menu

> The scan information will disappear from the Drives panel

NEVER TRY TO SAVE SCAN INFORMATION ON THE OBJECT BEING SCANNED!!!
Or you may obtain unpredictable results and lose all your data. 

2.2.2 Fast Search for Lost Partitions

Drive scan gives very detailed and accurate results but takes long time. If you want to find only partitions
previously existed on the drive you may use fast search for lost partitions which is much faster.

To perform fast search for lost partitions, 

1 Select an object in the R-Studio's Drives panel

Fast search for lost partitions

https://www.r-studio.com/What-is-Disk-Partition.html
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2 Click the Partition Search button

R-Studio will start searching for lost partitions showing its progress.

Fast search for lost partitions

> R-Studio will show fast found partitions in blue. 

Fast search for lost partitions

You may right-click the partition and select Complete scan to scan the entire drive.
2.2.3 Customizing File Types

You may create your own known file types and add their file signatures for scanning in Known File Types. They
will appear in their respective folders on the File Types dialog box. 

You can do that either by using the R-Studio's graphic interface or by direct editing the known file description
file specified on the R-Studio Main settings dialog box.

Creating a Known File Types using a Graphic User's Interface

The easiest way to add your own is to use the R-Studio's graphic interface. 

https://www.r-studio.com/What-is-Raw-File-Recovery.html
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To create a Known File Type,

1 On the Known File Types settings dialog box, click the Edit User's File Types... button

> The Edit User's File Types dialog box will appear

Edit User's File Types dialog box

2 Click the Create File Types button and specify File type properties

Edit User's File Types dialog box

 File Types properties

id digit Required Digital file type identifier. Should be unique for each custom file type. 
group string Optional Specifies a file type group in which found files will appear. You may

specify either your own groups or select those predefined on the File

Types dialog box. 
descrip
tion

string Optional Brief file description

feature
s

NO_SCAN
TXT_ANS
I
TXT_UNI
CODE

Optional Additional properties of the file type. If you want to specify several
properties, they should be separated by a space. 
NO_SCAN: Not to be scanned for. If this flag is used, R-Studio will
not search for such file type. Such files will be shown when sorting
files by their extensions.
TXT_ANSI: The file can be viewed as ANSI text. If this flag is
specified, the file can be correctly represented as an ANSI text.
When previewing, this file will be immediately sent to Text/?

hexadecimal editor.
TXT_UNICODE: The file can be viewed as UNICODE text. If this flag
is specified, the file can be correctly represented as a UNICODE
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text. When previewing, this file will be immediately sent to Text/?

hexadecimal editor.
extensi
on

<string
>

Optional File extension.

3 Click the Add Signature button, specify the signature parameters, and click the Save button

Edit User's File Types dialog box

 File signature properties

Begin
End

Specifies from where the signature begins.
If End, the offset is from the end of file to the first byte of the signature. That is, if the
signature is two bytes long, the offset value should be 2.

AND
OR

Shows the order of the logical operation (union or intersection)

From A decimal number specifying the leftmost possible offset for the file signature.
To A decimal number specifying the rightmost possible offset for the file signature.

You may specify as many signatures as you need. Moreover, you may specify subgroups within a signature
using the Add Subgroup button. The structure of such possible subgroups is described on the Customizing
File Types-II help page.

> The newly specified file type will appear on the Edit User's File Types dialog box and the File Types
dialog box

Edit User's File Types dialog box

2.2.4 Customizing File Types-I

The syntax of signature description is similar to that of the XML language. They are stored in the file specified on
the R-Studio Main settings dialog box.

More advanced features are described in Customizing File Types-II.
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Signature file example
<?xml version="1.0" encoding="utf-8"?>
  <FileTypeList>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Signature offset="3" count="1">Abc\x5c\x00\x04</Signature>
      <Signature offset="9" count="2">\x23\x01\xf4</Signature>
    </FileType>
  </FileTypeList>

File structure

File header

The file starts with a standard XML header
<?xml version="1.0" encoding="utf-8"?>

Section FileTypeList
<FileTypeList>

It requires a closing element </FileTypeList>.

Section FileType

This is a description of each file signature. 

Attributes:
id <u32> Required Digital file type identifier.

Should be unique for each
file type.

group <string> Optional Specifies a file type group
in which found files will
appear. You may specify
either your own groups or
those predefined on the
File Types dialog box. 

Default: unknown

description <string> Optional Brief file description Default: null (no description)
features NO_SCAN

TXT_ANSI
TXT_UNICODE

Optional Additional properties of
the file type. If you want
to specify several
properties, they should be
separated by a space. 

Default: 0

extension <string> Optional File extension. Default: null (no extension)
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File type properties flags

NO_SCAN Not to be scanned for. If this flag is used, R-Studio will not search for such file type. Such
files will be shown when sorting files by their extensions.

TXT_ANSI The file can viewed as ANSI text. If this flag is specified, the file can be correctly
represented as an ANSI text. When previewing, this file will be immediately sent to Text/?
hexadecimal editor.

TXT_UNICOD
E

File can viewed as UNICODE text. If this flag is specified, the file can be correctly
represented as a UNICODE text. When previewing, this file will be immediately sent to
Text/?hexadecimal editor.

This section can contain an unlimited number of the Signature elements.If there are several Signature
elements, that means that all those signatures are simultaneously present in the file. Such signatures should have
different offset attributes and they should not overlap.

Element Signature

The element contains a string value of the file signature consisting of ASCII characters and hex bytes in the \xhh
format, where hh is a hexadecimal byte code. If there is not a hexadecimal number after \x , \x are treated as a
part of the string section of the signature

Attributes:
offset <u16> Optional Decimal offset for the signature Default: 0
count <u16> Optional Decimal number specifying the

number of signatures of the same
length. Used when several signatures
of the same length starting with the
same offset can be present in a file.
In this case they should be
sequentially written in the element,
and the size attribute specifies the
length of signature. count*size
should be equal to the number of
bytes in the element.
If only one signature can be on this
offset, count should be equal "1",
and size should be equal to the
length (the number of bytes) of the
signature.

Default: 1

size <u16> Optional Decimal number specifying the
number of bytes in the signature.

Default: the number
of bytes written in
the element.

from begin
end

Optional Specifies from where the offset is
calculated.
If end, the offset is from the end
of file to the first byte of the
signature. That is, if the signature is

Default: begin
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two bytes long, the offset value
should be 2.

Comments
<!-- Comment string -->

An XML standard string for a comment.

2.2.5 Customizing File Types-II

Currently R-Studio supports two versions of file type descriptions. Version 2 extends legacy Version 1 by
adding variable signature offsets and  AND/OR combination of several signatures in one file type. The version of
file type description is specified by the version attribute of the FileTypeList section . Version 1 is the default
option. 

File structure

Elements common to Versions 1 and 2 of file type description

File header

The file starts with a standard XML header
<?xml version="1.0" encoding="utf-8"?>

Section FileTypeList
<FileTypeList>

Attributes:

version 1.0
2.0

Optional Version of file type description Default: 1.0

It requires a closing element </FileTypeList>.

Comments
<!-- Comment string -->

An XML-standard string for a comment.

Version 1 of file type description

Signature file example

  <FileTypeList>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Signature offset="3" count="1">Abc\x5c\x00\x04</Signature>
      <Signature offset="9" count="2">\x23\x01\xf4</Signature>
    </FileType>
  </FileTypeList>

Section FileType

This is a description of each file signature. 

Attributes:

id <u32> Required Digital file type identifier.
Should be unique for each
file type.

group <string> Optional Specifies a file type group
in which found files will
appear. You may specify

Default: unknown



R-Studio Manual65

© 2023 R-Tools Technology Inc.

either your own groups or
those predefined on the
File Types dialog box. See
the table below.

description <string> Optional Brief file description Default: null (no description)
features NO_SCAN

TXT_ANSI
TXT_UNICODE

Optional Additional properties of
the file type. If you want to
specify several properties,
they should be separated
by a space. 

Default: 0

extension <string> Optional File extension. Default: null (no extension)

File type properties flags
NO_SCAN Not to be scanned for. If this flag is used, R-Studio will not search for such file type.

Such files will be shown when sorting files by their extensions.
TXT_ANSI The file can be viewed as ANSI text. If this flag is specified, the file can be correctly

represented as an ANSI text. When previewing, this file will be immediately sent to
Text/?hexadecimal editor.

TXT_UNICODE The file can be viewed as UNICODE text. If this flag is specified, the file can be
correctly represented as a UNICODE text. When previewing, this file will be
immediately sent to Text/?hexadecimal editor.

List of predefined file type groups

Group Name on the File Types dialog box.
archive Archive Files
graphics Graphics/?Picture
internet Internet-related files
multimedia Multimedia Files
audio Multimedia: Audio Files
video Multimedia: Video Files
font Font
document Document
doc_database Document: Database
doc_sheet Document: Spreadsheet
exe Executable/?Library/?DLL
unknown Other file types

This section can contain an unlimited number of the Signature elements.If there are several Signature
elements, that means that all those signatures are simultaneously present in the file. Such signatures should have
different offset attributes and they should not overlap.

Element Signature

The element contains a string value of the file signature consisting of ASCII characters and hex bytes in the \xhh
format, where hh is a hexadecimal byte code. If that is not a hexadecimal number after \x, \x are treated as a
part of the string section of the signature
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Attributes:

offset <u16> Optional Decimal offset for the signature Default: 0
count <u16> Optional Decimal number specifying the number of

signatures of the same length. Used when
several signatures of the same length starting
with the same offset can be present in a file. In
this case they should be sequentially written in
the element, and the size attribute specifies
the length of signature. count*size should be
equal to the number of bytes in the element.
If only one signature can be on this offset,
count should be equal to "1", and size should
be equal to the length (the number of bytes) of
the signature.

Default: 1

size <u16> Optional Decimal number specifying the number of
bytes in the signature.

Default: the
number of bytes
written in the
element.

from begin
end

Optional Specifies from where the offset is calculated.
If end, the offset is from the end of file to the
first byte of the signature. That is, if the
signature is two bytes long, the offset value
should be 2.

Default: begin

Version 2 of file type description

Signature file example

<?xml version="1.0" encoding="utf-8"?>
<FileTypeList version="2.0">
  <FileType id="5626" group="_Test" description="Test file" extension="tst">
    <Begin combine="and">
      <Signature from="0" to="20">ABC</Signature>
      <Signature offset="1">CDEFG</Signature>
      <AND>
        <Signature offset="0">DE</Signature>
        <Signature offset="0">RTD</Signature>
        <OR>
          <Signature offset="12">CP</Signature>
          <Signature offset="16">RTD</Signature>
        </OR>
      </AND>
    </Begin>
    <End combine="or">
      <Signature from="3" to="20">ABC</Signature>
      <Signature offset="5">CDEFG</Signature>
      <AND>
        <Signature offset="2">DE</Signature>
        <Signature offset="3">RTD</Signature>
        <OR>
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          <Signature offset="12">CP</Signature>
          <Signature offset="16">RTD</Signature>
        </OR>
      </AND>
    </End>
  </FileType>
</FileTypeList>

Section FileType

This is a description of each file signature. 

Attributes:

Similar to those in Version 1.

The section can contain one element Begin and one End. It should contain at least one of them. 

Example

 <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin [attributes]>
        ...
      </Begin>
      <End [attributes]>
        ...
      </End>
    </FileType>
  </FileTypeList>

Sections Begin and End

Specify the positions of  file type signatures in the file.

Attributes

combine and
or

Optional Shows the order of the logical
operation (union or intersection)

Default: and

These sections can contain one of several elements Signature. And one or several elements OR or AND. If there
are several elements inside the section they are combined according to the attribute combine.

Example:

  <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin combine="or">
        <Signature [attributes]> ... </Signature>
        ...
        <Signature [attributes]> ... </Signature>
        <AND>
          ...
        </AND>
        <OR>
          ...
        </OR>
      </Begin>
      <End>
        <OR>
          ...
        </OR>
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        <Signature [attributes]> ... </Signature>
        ...
        <Signature [attributes]> ... </Signature>
      </End>
    </FileType>
  </FileTypeList>

Sections AND and OR

These sections can contain one of several elements Signature. And one or several elements OR or AND. If there
are several elements inside the section they are combined according to the section type (logical AND or OR).

Example:

  <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin>
        <Signature [attributes]> ... </Signature>
        ...
        <Signature [attributes]> ... </Signature>
        <AND>
          <Signature [attributes]> ... </Signature>
          <OR>
            <Signature [attributes]> ... </Signature>
            <AND>
              <Signature [attributes]> ... </Signature>
              <Signature [attributes]> ... </Signature>
            </AND>
            <OR>
              <Signature [attributes]> ... </Signature>
              <Signature [attributes]> ... </Signature>
            </OR>
          </OR>
          <Signature [attributes]> ... </Signature>
        </AND>
      </Begin>
    </FileType>
  </FileTypeList>

Element Signature

The element contains a string value of the file signature consisting of ASCII characters and hex bytes in the \xhh
format, where hh is a hexadecimal byte code. If that is not a hexadecimal number after \x, \x are treated as a
part of the string section of the signature

Attributes:

offset <u16> Optional Decimal offset for the signature Default: 0
from <u16> Optional Decimal number specifying the

leftmost possible offset for the file
signature. 
Ignored if the offset attribute is
specified.

Default: undefined

to <u16> Optional Decimal number specifying the
rightmost possible offset for the file
signature. 

Default: undefined
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Ignored if the offset attribute is
specified.

size <u16> Optional Decimal number specifying the
number of bytes in the signature.

Default: the number
of bytes written in
the element.

Example:

  <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin>
        <Signature offset="3">Abc\x5c\x00\x04</Signature>
        <Signature from="9" to="15">\x23\x01\xf4</Signature>
      </Begin>
    </FileType>
  </FileTypeList>

2.2.6 Regions

Scanning large objects may take a long time. Sometimes, only a smaller area of a drive needs to be scanned or
searched for files. Such area is called a region. A region can be created on any object in the R-Studio's Drives

panel. 

Created regions can be scanned, and files on them can be recovered in the same way as from drives or logical
disks.

Created regions can be deleted or their size can be changed.

Note: R-Studio does not create anything real on the drive. Regions are virtual objects that do not affect actual
data on the drive.

To create a region

1 Select an object in the R-Studio's Drives panel and click the Create Region button

 Other ways to create the region

· Right-click the selected object and select Create Region on the shortcut menu
or
· Select the object and select Create Region on the Create menu
or
· Select the object and press the F4 key on the keyboard

2 Specify required parameters on the Create region dialog box and click the Create button

Create region dialog box

 Region options

Drive size: Shows size of the object where the region is to be created. The region cannot be larger
than this size.

Start: Start point of the region
Size: Size of the region. Cannot be larger than Drive size.

https://www.r-studio.com/What-is-Disk-Region.html
https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Logical-Disk.html
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Numbers in these fields can be in bytes or sectors. See the Data Formats and Multipliers topic for
more details on data formats.

> A Region object will appear in the Drives panel. 

To change the size of a region

* Right-click the Region in the R-Studio Drives panel, select Edit on the shortcut menu, and enter a new
size on the Edit Region dialog box.

To convert a region into an exclusive one

* Right-click the Region in the R-Studio Drives panel and select Exclude area on the shortcut menu

To remove a region

* Select a Region in the R-Studio Drives panel and click the Remove button, or

Right-click the selected region and select Remove Region on the shortcut menu.

2.2.7 Exclusive Regions

Exclusive regions are areas on any object visible in the R-Studio's Drives panel that are excluded from drive
operations. R-Studio never tries to read/?write data from/to such area. Exclusive regions are necessary when, for
example, there are areas with bad sectors on a drive, and it is necessary to avoid any drive operations with such
areas to not inflict further damage to such drive and to speed work with it. 

Note: R-Studio does not create anything real on the drive. Exclusive regions are virtual objects that do not
affect actual data on the drive.

To create an exclusive region

1 Right-click  an object in the R-Studio's Drives panel and select Create Exclusive Region on the

shortcut menu, or

Select the object and select Create Exclusive Region on the Create menu

https://www.r-studio.com/What-are-Bad-Sectors.html
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2 Specify required parameters on the Create Exclusive Region dialog box and click the Add  button

Create exclusive region dialog box

 Exclusive Region options

Start: Start point of the entire exclusive region
Size: Size of the entire exclusive region. Cannot be larger than Drive size.
Offset: Offset of the excluded area. 
Size: Size of the excluded area. 

Numbers in these fields can be in bytes or sectors. See the Data Formats and Multipliers topic for
more details on data formats.

> An Exclusive Region object will appear in the Drives panel. 

Its properties can be seen on the Excluded Areas tab.

To remove an exclusive region

* Select an Exclusive Region in the R-Studio Drives panel and click the Remove button, or

Right-click the selected region and select Remove Region on the shortcut menu.
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To change the size of an exclusive region

* Right-click an Exclusive Region in the R-Studio Drives panel, select Edit on the shortcut menu, and
add/?remove excluded areas on the Edite Exclusive Region dialog box.

You may remove an excluded area by right-clicking it and selecting Remove on the shortcut menu.

2.2.8 Images

An image is an exact, byte by byte, copy of any object in the Drives panel. When created, images can be
processed like their original objects. 

Images are very useful if there is a risk of total data loss due to hardware malfunction. If bad blocks are
constantly appearing on a drive, you must immediately create an image of this drive. All data search, scan and
restoring can be done from this image. 

While creating images, R-Studio can simultaneously perform drive scan and save scan information to lessen time
necessary to process the drive. 

The image can be saved on the remote computer if it is created via network. R-Studio can also load and process
images created with the DeepSpar Disk Imager™.

An imaging process can be stopped and then resumed later on.

R-Studio Corporate version and higher can create images directly on hard drives making in fact disk clones.

To create an image,

1 Select an object in the R-Studio's Drives panel and click the Create Image button

 Other ways to create the image

· Select the object and select Create Image on the Drive menu
or
· Right-click the selected object and select Create Image File on the shortcut menu

2 Specify image options, a file name, and destination for the image on the Create Image dialog box

Note: To store an image file, you need a free space equal to at least the object size.

Create Image (Main) dialog box
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Create Image (Bad sector processing) dialog box

Create Image (Scan Information) dialog box

 Image Options

Image filename Specifies the name and path for the image file
Image type: Compressed image (R-Drive Image compatible): If this option is selected, R-Studio

will create an image file which can be compressed, split into several parts, and
password-protected. This image file is fully compatible with the images created
by R-Drive Image, but incompatible with the previous versions of R-Studio.
Byte by byte image to a file: If this option is selected, R-Studio will create a
simple exact copy of the object. 
VMDK (ViMware Virtual Machine Disk) image: If this option is selected, R-Studio
will create an image of the VMware virtual disk type. Available in the Corporate,
Technician, and T80+ license.
Byte to byte image to a physical disk: R-Studio will create an exact copy of the
disk on another hard drive. Data on the target drive will be overwritten. Available
in the Corporate, Technician, and T80+ license.

Image compression
ratio

You may compress the data in the image to save space. Active only if the
Compressed image (R-Drive Image compatible) is selected.

Estimated size Shows the estimated size of the image file. An actual image size depends on how
much empty space is on the selected partition and what file types are there.

Active only if the Compressed image (R-Drive Image compatible) is selected.

http://en.wikipedia.org/wiki/VMDK
https://www.r-studio.com/What-is-Disk-Partition.html
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Image split size You may set this option to Automatic and let Windows decide how to split the
image file. This mostly depends on the file system on the destination drive. You
may also either explicitly specify the split size, or choose a preset for various
devices with removable storage. Select Fixed size for that. Active only if the
Compressed image (R-Drive Image compatible) is selected.

Password You may protect your image file with a password. Note: This feature provides a
relatively moderate protection against conventional unauthorized access. Active
only if the Compressed image (R-Drive Image compatible) is selected.

Create scan information
file

If this option is selected, R-Studio will perform drive scan simultaneously with
image creation. See the Drive Scan help page to learn scan options.

Read retries Specifies a value for I/O Tries, or how many times R-Studio will try to read a
bad sector. 
R-Studio treats bad sectors in the following way:
It reads a certain part of drive (predefined by Windows) and
· If Default read attempts is set to 0, the entire part with bad sectors will be filled

with the specified pattern. 
· If Default read attempts is set to a non-zero value, R-Studio reads again that

part sector by sector, repeating the attempts the specified number of times. If
R-Studio still cannot read a bad sector, it fills the sectors with the specified
pattern. In this case only the bad sectors will be filled with the pattern, but that
extremely slows the drive read process.

For example, if you set Default read retries to 1, a bad sector will be read 2 times.
Pattern to fill bad blocks Specifies a pattern R-Studio will use to fill bad sectors in this image. You may

specify the pattern either in the ANSI or Hex data format.
Note: R-Studio will never ever try to write anything on the drive from which
data is to recover or an image is to create. This pattern fills bad sectors only in
the image.

Drive sector map file
Enable multi-pass
image creation

These options are available only in the Technician/T80+ versions. Read more
about these options in the I/O Monitor and Sector Map files and Multi-pass
imaging help page.

If a remote computer is connected for Data Recovery over Network, the Create Image dialog box will
have a different look. You may save the image to the local or remote computer.

R-Studio Technician/T80+

These options are available only in the Technician/T80+ versions. 

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-a-Sector-Map-File.html
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Create Image (Additional output folders) dialog box

Additional output folders

Additional output folders Additional output folders where image files will be stored when R-Studio
runs out of space.

Create Image (Post Actions) dialog box

Post Actions Options

Shutdown the computer on
task completion

If this check box is selected, R-Studio will shut down your computer when
image creation has been completed. 

E-Mail notifications If this check box is selected, R-Studio will inform you about the outcome of
the operation via email. 

> R-Studio will start creating the image, the Progress message showing the progress.

You may change some options during the imaging process. Click the Options button and change them as
necessary/

You may stop the imaging process and then resume it later on. Click the Stop button and the Cancel drive

operation dialog box will appear. Select Stop if yo want to keep the partially created image or Discard if
you don't need this image file.
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To resume the creation of the image for the same object, select the same file name for the image. You'll be
able to create a new image file or continue to create the image for the object.

Resuming image creation

R-Studio will create a new file for every new start of imaging for the .rdi and .vmdk file types.

To process an already created Image, the image file should be opened.

To open an image

1 Click the Open Image button, or

Select Open Image File on the Drive menu

If a remote computer is connected for Data Recovery over Network, the Open Image File dialog box will
appear when you select a place to load the image file from. You may load it from the local or remote
computer.

2 Select the required image file 

If the image is a multi-volume one, and not all parts are at the same place, the dialog box will appear 

Multi-volume image dialog box

Specify paths to other image parts and click the OK button.



R-Studio Manual77

© 2023 R-Tools Technology Inc.

> An Image object will appear in the Drives panel

Depending whether this is a byte-by-byte, compressed (R-Drive Image compatible), multi-volume, or
VMDK image, its appearance in the Drives panels is different.

You may perform all data search, scan, and recovery from this image as it were a regular drive/?disk object.

A compressed (R-Drive Image compatible) image

A byte by byte  image

A multi-volume image

A VMDK image

To close an image

* Select the image and click the Close Image button,

· or right-click the image and select Close Image on the shortcut menu

· or select the image and press the F8 key.
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To close all image

* Select Close All Images on the Tools menu

A logical disk (or disks) containing in an image can be mounted in the operating system as a device which makes
its content accessible to any program including any other data recovery software.

To mount a logical disk in an image

1 Right-click the logical disk in the image in the Drives panel and select Mount on the shortcut menu

2 Select a disk letter to assign to the mounted logical disk and click OK

> A Virtual disk object will appear in the Drives panel 

and this virtual disk will be available to system in the read-only mode

To unmount a virtual disk from the system

1 Right-click the virtual disk in the image in the Drives panel and select Unmount on the shortcut menu

https://www.r-studio.com/What-is-Logical-Disk.html
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2.2.9 Wiping Objects

Disk objects can be wiped in order to completely destroy its data.

Supported Wipe Algorithms

File wiping is necessary only for files stored on conventional hard drives. Files stored on new SSD storage
devices cannot be effectively wiped out due to the principles of operation of these devices.

Currently R-Studio supports 6 wiping algorithms:

Zeroes The disk object or file is filled with zeroes through 1 pass. The fastest but the least
secure algorithm. Also it does not conceal the fact that the disk or file has been
wiped.

Pseudo-random
numbers

The disk object or file is filled with pseudo-random numbers through 1 pass. A
slower but little bit more secure algorithm than the Zeroes algorithm and it also
conceals to some degree the fact that the disk or file has been wiped.

DoD 5220.22-
M(3)

The disk object or file is wiped using Department of Defense standard 5220.22-
M(3). Provides high-grade data wiping filling the unused space or file with a special
digital pattern through 3 passes This algorithm is very secure, but slow.

DoD 5200.28-
STD(7)

The disk object or file is wiped using Department of Defense standard 5200.28-
STD(7). Provides high-grade data wiping filling the unused space or file with a
special digital pattern through 7 passes. This algorithm is very secure, but very
slow.

Bruce Schneier(7) The disk object or file is wiped using the Bruce Schneier(7) algorithm. The first
pass overwrites the drive with the bit pattern "00", the second with "11", and the
next five with a randomly generated bit pattern. This algorithm is very secure, but
very slow.

Peter Gutmann
(35)

The disk object or file is wiped using the Peter Gutmann's algorithm. Provides high-
grade data wiping filling the unused space or file with a special digital pattern
through 35 passes. This algorithm is military-level secure, but horribly slow.

What algorithm is to choose, depends on your specific needs. All of these wiping algorithms make recovery of
wiped data with any software-based data recover utility impossible. So if you want to protect your information
from a casual snooper, you may safely choose either the Zeroes or Pseudo-random numbers algorithm. The
latter also conceals the fact that you wiped the data.

If you want more security, you need to know the following: 

There are some techniques for recovery of wiped data. These techniques are based on the fact that magnetic
medium on the hard drive's platters "store" some information about previously written data. Such information
cannot be completely removed. Wiped data may be recovered even from mechanically damaged platters. So the
only safe way to completely remove data from a hard drive is to mechanically grind the magnetic medium off the
drive platters or dissolve them in special chemical solvents.  

But in order to recover the wiped data using one of these techniques, a hard drive must be disassembled, its
platters placed in a precise magnetic field measurement system, and the results of such measurement statistically
processed. All that is very expensive and requires a very qualified and experienced personnel and a specially
developed equipment. Only a very advanced organization such as a law enforcement or intelligence agency of a
developed nation, or a special high-tech firm can afford this. Moreover, each successive wiping pass makes such

https://www.r-studio.com/What-is-data-wiping.html
https://www.r-studio.com/What-is-Solid-State-Device-SSD.htm
https://www.r-studio.com/What-is-Solid-State-Device-SSD.htm
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data recovery much and much harder. So, the DoD 5220.22-M(3) clearing and sanitizing standard overwriting the
data with a special pattern through 3 passes is a rather reliable and safe choice for this case.

If you need the ultimate security, use the DoD 5220.22-M(7) clearing and sanitizing standard, the Bruce
Schneier(7), or even the Peter Gutmann (35) wiping algorithms. They render data almost unrecoverable, but they

are extremely slow.

Wiping Disk Objects:

To wipe a disk object,

1 Right-click the disk object in the Device view pane and select Wipe...

> The Wipe an object dialog box will appear.

Wiping Disk Objects

2 Select the desired wiping algorithms and click the OK button.

> R-Studio will start wiping the object.

2.3 Mass File Recovery

Recovery of multiple files

If you need to recover multiple files you may do it through the following steps:

1 Find and mark all the necessary files

Go to the Find and Mark Multiple Files topic for more information

2 Recover all marked files in a single file recovery step

Go to the Recover Multiple Files topic for more information

3 Create file recovery lists to manually edit the list of files to recovery (Technician/T80+ version)

Go to the File Recovery Lists topic for more information

Memory considerations

R-Studio stores information about found files in computer memory. If there are too many files, R-Studio may
run out of it. To avoid this, you have two options:
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Recover all files

If you want to recover data from an entire file system object (a logical disk, partition, partition image, etc.), you
may use the Recover All Files command from the Drive or shortcut menu. Right click the object in the Drives

panel to access the shortcut menu. A Recover dialog box will appear. Select required restore settings, including
file mask. This command restores unlimited number of files without memory restrictions.

View file information in steps

As soon as R-Studio nearly runs out of memory, a Too many files... message appears. You may temporally
stop file listing and browse through found files. Then you can resume file listing. You also may skip this file section
and continue file listing. 

In all cases, R-Studio keeps information about the entire file structure.

· Find and Mark Multiple Files 
· Recover Multiple Files
2.3.1 Find and Mark Multiple Files

If you need to find and mark many files at once, you may do that in the following ways:

By sorting them by their extensions or creation/?modification/?accessed time

To sort files by their extensions or creation/?modification/?accessed time,

* In the Folders panel select the tab

Extensions  to sort the files by their extensions
Creation
Time

to sort the files by their creation time

Modification
Time

to sort the files by their modification time

Accessed
Time

to sort the files by their accessed time

 Other ways to sort files by their extensions or creation/?modification/?accessed time

· Select the disk in Drives panel, select Open Drive Files Sorted By on the Drive menu, and select the
respective option, 

or
· In the Drives panel, right-click the disk and select Open Drive Files Sorted By on the shortcut menu and

select the respective option,

or
· In the Folders panel, right-click the disk letter and select Show Files Sorted By on the shortcut menu

and select the respective option,

> R-Studio will show the sorted files in the Folders and Content panels, showing the path to each file:

Folders panel for files sorted by their extensions

https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Disk-Partition.html
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Content panel with files/?folders sorted by their extensions

To return to the conventional view,

* In the Drives panel, right-click the logical disk, select Open Drive Files Sorted By on the shortcut menu,
and select Real File System Structure, 

or

In the Folders panel, select Show Files Sorted By on the Drive menu and select Real File System Structure

or

Click the Real tab

By finding and marking multiple files using the Find/?Mark dialog box

You may find and mark all the files on the entire disk by using Mark matched files in the Find/?Mark mode option.
You may specify all the necessary search options and mark all the found files. Please note that each find and
mark/?unmark operation is independent from previous ones. That is, if a file matches the search criteria, it will be
marked/?unmarked regardless of its previous marked/?unmarked state.

For example, if you first mark all doc files, and then all txt files, all doc files remain marked, too. If you then
decide to unmark all files smaller than 2 kB, all doc and txt files will stay marked except those that less than 2
kB.

2.3.2 Recover Multiple Files

If R-Studio while recovering files encounters either an already existing file or file with a broken name, normally it
will stop working and ask you what to do with the file. If you recover multiple files, that may require you answer
a lot of the same questions. You may use Mass File Recovery Options on the Recover dialog box to instruct
R-Studio what to do in those cases for all files.
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Recover (Advanced) dialog box

Advanced file recovery options

File Already Exists These options instruct R-Studio what to do if there already exists a file with the
same name. 

Extended options If this option is selected, more advanced options become accessible to process
multiple duplicates of the file.

Prompt If this option is selected, R-Studio asks the user what to do for each such file.
It stops file recovery until it receives the answer.

Rename If this option is selected, R-Studio adds a File ID to the file name. If a file
already exists with the same name and that file ID, a number will be added to th
file name and file ID.

Skip If this option is selected, R-Studio skips all new files with the same name.
Overwrite If this option is selected, R-Studio overwrites the existing file with the new one.
Overwrite Older If this option is selected, R-Studio overwrites the existing file with the new one

if the existing file is older than the new file. The time stamp used is Modified.
Overwrite Smaller If this option is selected, R-Studio overwrites the existing file with the new one

if the existing file is smaller than the new file. The time stamp used is Modified.
Overwrite Bigger If this option is selected, R-Studio overwrites the existing file with the new one

if the existing file is bigger than the new file. The time stamp used is Modified.
Broken File Name These options instruct R-Studio what to do if a file to be recovered appears to

have an invalid name.
Prompt If this option is selected, R-Studio shows the standard Broken File Name

dialog box for each file with a broken file name. It stops file recovery until it
receives the answer.

Rename and change all
invalid symbols to:

If this option is selected, R-Studio changes all invalid characters to the
character specified.

Skip If this option is selected, R-Studio skips all files with broken file names.
Hidden Attribute These options instruct R-Studio what to do if a file to be recovered appears to

have  the Hidden attribute.
Prompt If this option is selected, R-Studio asks the user what to do with the attribute.

It stops file recovery until it receives the answer.
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Remove If this option is selected, R-Studio removes the Hidden attribute from all files.
Keep If this option is selected, R-Studio keeps the Hidden attribute for all files.

Extended options

These options give you more flexible ways to process multiple files with the same name. You may compare
files by time (Modified) and size, and decide what R-Studio should do with those duplicates. If any of the
files has an invalid time, the comparison by time is skipped. In this case, if comparison by size is not  active,
R-Studio goes to the default action..

Extended advanced file recovery options

First compare
time
First compare
size 

These options instruct R-Studio which condition to use first, file time or size.

Compare
time
Compare size

These options instruct R-Studio to enable comparison by time and size..

Actions These selectable actions instruct R-Studio what to do if the condition is met.

Empty
field

If this option is selected, R-Studio skips the condition.

Prompt If this option is selected, R-Studio asks the user what to do for each such file. It stops file
recovery until it receives the answer.

Rename If this option is selected, R-Studio adds a File ID to the file name. If a file already exists with
the same name and that file ID, a number will be added to th file name and file ID.

Skip If this option is selected, R-Studio skips all new files with the same name.
Overwrite If this option is selected, R-Studio overwrites the existing file with the new one.

Time
conditions

If the Modified time stamp is invalid, R-Studio will skip the comparison.

Equal time Two time stamps are the same.
Older The existing file is older than the new one.i
Newer The existing file is newer than the new one.i

Size
conditions

Equal size Two files have the same size.
Smaller The existing file is smaller than the new one.i
Bigger The existing file is bigger than the new one.i

By default The action R-Studio takes when none of the comparison conditions have been met. That
may happen when the comparison by size is not enabled. 

2.3.3 Recovery Lists

You may create a file containing a list of files and folder found on a disk/partition. Then such file may be manually
edited to specify files to recover, and then loaded back into R-Studio. R-Studio will automatically mark the files
in this list for recovery. Such lists are very useful, for example, when it is necessary to have many files approved
for recovery by someone else who is far away from the computer where R-Studio is running.

https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Disk-Partition.html
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You may create recovery lists for the entire disk or for specific folders. Moreover, you may create a recovery list
for all files within the disk/folder, or for marked files/folders only.

All versions of R-Studio can create recovery lists in the plain text format with basic functionality. R-Studio
Technician/T80+ can create custom recovery lists in other formats with more advanced options 

Creating a simple recovery list

To create a recovery list

1 For an entire disk, select Export Recovery List on the File menu, or

Right-click the uppermost folder (higher than Root, usually the letter or the name of the disk) and select
Export Recovery List on the shortcut menu.

For a specific folder, right-click the folder and select Export Recovery List on the shortcut menu.

2 Specify the place to save the recovery list and other necessary options on the Export Recovery List
dialog box

Export Recovery List dialog box

Options dialog box

Export Recovery List options

Export the entire folder/file tree
Export marked file/folder names
Export file/folder names

Specifies which file and folder names will be exported. 

File format:

A file format for the recovery list.
Only text format is available for the standalone and corporate versions.
R-Studio Technician/T80+ can create custom recovery lists in other
formats with more advanced options 
The following formats are available for R-Studio Technician/T80+
version:
Plain Text
HTML
XML
JSON
CSV

File name: Specifies a file name of the recovery list. 

Editing the file recovery list

All files without any marks in the recovery list will be marked when the list is loaded into R-Studio. So, if you

have some files in the recovery list that don't need to be recovered, just delete them from the list. In addition, you
may use the following marks to specify some options 

:+ Mark the file, or the folder, all its files, and subfolders within the folder.



Data Recovery Using R-Studio 86

© 2023 R-Tools Technology Inc.

:* Mark the file, or the folder and its files, don't mark subfolders in the folder.
:- Unmark the file, or the folder, its files, and subfolders in the folder.
:= Unmark the file or the folder and its files, dont unmark subfolders in the folder.
:! Provide the information on the file. (R-Studio Technician/T80+ only)

 R-Studio processes records in the list consequently. That is, if there are the following lines in the file,
:+Files_to_Recover\
:-Files_to_Delete\File_2.jpg

the file File_2.jpg won't be marked for recovery, while for the lines
:-Files_to_Recover\File_2.jpg
:+Files_to_Recover\

file File_2.jpg will be.

Loading the edited recovery list

To load a recovery list into R-Studio,

* Select Import Recovery List from the File menu and select the file, or

Right-click the uppermost folder (higher than Root, usually the letter or the name of the disk) and select
Import Recovery List on the shortcut menu.

> R-Studio will load the file and mark the files accordingly.

An example of a simple recovery list

As an example, we'll create a simple recovery list, edit it to mark only those files that are to be recovered, and
load it back to mark those files. 

To create such recovery list

* Mark the necessary folders, right-click the Root folder, and select Export Recovery List on the shortcut
menu.

Right-click the uppermost folder (higher than Root, usually the letter or the name of the disk) and select
Export Recovery List on the shortcut menu.

Export Recovery List

Specify the necessary options and click the OK button.
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> R-Studio will save the file.

Structure of a simple recovery list file created by R-Studio
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"e:\"; label:"ntfs test";
fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one"; 
Diving/
Diving/Aquarium/
Diving/Aquarium/20190822_100644.jpg
Diving/Aquarium/20190822_101620.jpg
Diving/Aquarium/20190822_102526.jpg
Diving/Aquarium/20190822_103830.jpg
Diving/Aquarium/20190822_104333.jpg
Diving/MyPhoto1.jpg
Diving/MyPhoto2.jpg
Diving/MyPhoto3.jpg
Diving/MyPhoto4.JPG
Diving/MyPhoto5.jpg
SF/
SF/Sea-Lions/
SF/Sea-Lions/IMG_3493.JPG
SF/Sea-Lions/IMG_3535.JPG
SF/Sea-Lions/IMG_3542.JPG
SF/Sea-Lions/IMG_3579.JPG
SF/Sea-Lions/IMG_3580.JPG
SF/Sea-Lions/IMG_3581.JPG
SF/Sea-Lions/IMG_3589.JPG
SF/IMG_0869.JPG
SF/IMG_0873.JPG
SF/IMG_0890.JPG
SF/IMG_1739.JPG
SF/IMG_3460.JPG
SF/IMG_3461.JPG
SF/IMG_3476.JPG
SF/IMG_3478.JPG
SF/IMG_3479.JPG
SF/IMG_3480.JPG
SF/IMG_3481.JPG
SF/IMG_3493.JPG
SF/IMG_3535.JPG
SF/IMG_3542.JPG
SF/IMG_3579.JPG
SF/IMG_3580.JPG
SF/IMG_3581.JPG
SF/IMG_3589.JPG
SF/IMG_3590.JPG
SF/IMG_3591.JPG
SF/IMG_3592.JPG
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SF/IMG_3593.JPG
SF/IMG_3594.JPG
SF/IMG_3595.JPG
SF/IMG_3596.JPG
SF/IMG_3608.JPG
SF/IMG_3627.JPG
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

If such recovery list is created from an entire logical disk/partition, it will contain several virtual folders. For
example, they'll have the following structure for an NTFS partition.
///m/$Extend/
///m/$Extend/$Deleted/
///m/$Extend/$RmMetadata/
///m/$Extend/$RmMetadata/$Txf/
///m/$Extend/$RmMetadata/$TxfLog/
///m/$Extend/$RmMetadata/$TxfLog/$Tops
///m/$Extend/$RmMetadata/$TxfLog/$TxfLog.blf
///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000001
///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000002
///m/$Extend/$RmMetadata/$Repair
///m/$Extend/$ObjId
///m/$Extend/$Quota
///m/$Extend/$Reparse
///m/$AttrDef
///m/$BadClus
///m/$Bitmap
///m/$Boot
///m/$LogFile
///m/$MFT
///m/$MFTMirr
///m/$Secure
///m/$UpCase
///m/$Volume

Now we need to edit this file to mark for recovery the following folders/files:

1. All files in the root folder;

2. Two files MyPhoto1.jpg and MyPhoto3.jpg in the Diving subfolder;

3. All files in the Diving/Aquarium/ folder;

4. All files in the SF/ folder except the SF/Sea-Lions/ subfolder.

The edited simple recovery list

The final simple recovery list will be the following:
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
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:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"e:\"; label:"ntfs test";
fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one";
:= Diving/
:+ Diving/Aquarium/
:+ Diving/MyPhoto1.jpg
:+ Diving/MyPhoto3.jpg
:+ SF/
:- SF/Sea-Lions/
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

Loading the edited recovery list

When we load this recovery list into  R-Studio, will see the following results;

The root folder

The Diving folder

The SF folder

2.4 Volume Sets and RAIDs

R-Studio detects and processes valid hardware volume sets and RAIDs like regular drives/volumes.

R-Studio can analyze and recover data from software volume sets and RAIDs. If a software volume set or
RAID is present in your system, R-Studio detects it, and a Volume sets and RAIDs object appears in the
Drives panel. This object can be searched for files, scanned, and files found on it can be recovered the same way
as from normal drives/volumes.

If, due to hardware failure, a hardware volume set or RAID cannot be accessed, or due to data loss your system
does not recognize a software volume set or RAID, and you know what drives were in it, you may create a
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Virtual volume set or RAID and process it like a real software volume set or RAID or hardware volume set or
RAID. 

You may find more information on RAID types in our article What is Hardware RAID. 

You may turn numerical indexes for objects to distinguish them better while creating virtual RAIDs.

· Volume Sets, Stripe Sets, and Mirrors
· Basic RAID 4 and RAID 5 Operations
· Working with RAID 6 Presets 
· Working with RAID6 (Double Xor)

· Working with RAIDs with Parity Delays
· Working with Advanced RAID Layouts
· Nested and Non-Standard RAID Levels
· Finding RAID Parameters
· Checking RAID Consistency
· Syntax of a Description File for RAID Configurations
· Description Files for RAID Configurations
· Reverse RAIDs
· Various Disk and Volume Managers
· Mounting Virtual Objects in the System

Managing your own RAID layouts

To save your own RAID layout in the presets

1 Click the More... button on Parents tab and select Save on the shortcut menu.

2 Specify the name for the configuration on the Preset name dialog box.

Preset name dialog box

> The new RAID configuration will be saved in the presets

The configurations are stored in the user's RAID layout file. The path and name for this file is specified on the
R-Studio Settings dialog box. If no file is specified, R-Studio will ask you to enter the name.

Loading your RAID configuration 

If there're objects in the Parents tab, the preset will be applied to them. If the Parents tab is empty, R-Studio
will search the drives listed in the Drives tab for the parents in the user's RAID layout file. If the search fails,
R-Studio will show the Reference Parents not found message.

To load your RAID configuration 

1 Click the More... button on Parents tab and select the preset you want to load

> The new RAID configuration will be loaded

To edit your own RAID configuration

1 Click the More... button on Parents tab and select Edit... on the shortcut menu

https://www.r-studio.com/What-is-Hardware-RAID.html


R-Studio Manual91

© 2023 R-Tools Technology Inc.

2 Select the required configuration on the Edit Block RAID Layout Presets dialog box.

Edit Block RAID Layout Presets dialog box

3 Edit the parameters of the configuration and save it

> The new configuration parameters will be saved.

Turning Drivess On-Line and Off-Line on-the-fly

You may turn the objects in the virtual RAID or volume set on-line and off-line by selecting/?clearing the checkbox
on the Parents tab. It may be useful, for example, if you need to see which drive is non-actual in a RAID 5. 

Actually, when you turn an object off-line, R-Studio substitutes it with a Missing Drive or Empty Space
object.

Missing Drives and Empty Space

If one partition from a hardware volume set or RAID or software volume set or RAID is absent, due to
hardware failure, for example, you need to add a virtual missing drive or empty space in order to correctly re-
construct the hardware volume set or RAID or software volume set or RAID structure. The missing drive/?empty
space should be placed in the same place as the missing partition.

Note: R-Studio does not write anything real on the drive. Missing drives/empty space are virtual objects that do
not affect actual data on the drive.

To add a Missing drive/?Empty space object 

1 Select a Volume sets and RAIDs object in the R-Studio's Drives panel

2 Right-click in the Parents tab in the right pane and select Add Missing Drive or Add Empty Space on
the shortcut menu or select Add Missing Drive or Add Empty Space on the Create menu. Which object

type is necessary, R-Studio decides automatically.

For the Empty space object, Specify its size on the Add Empty Space dialog box.

Add Empty Space dialog box

> A Missing Drive or Empty Space object will appear in the Parents tab

2.4.1 Volume Sets, Stripe Sets, and Mirrors

To create a Volume set object

1 Click the Create Virtual RAID button and select Create Virtual Volume set

or select the Create Virtual Volume set on the Create menu

https://www.r-studio.com/What-is-Disk-Partition.html
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> A Virtual Volume set object will appear in the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.
Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order.

> The Virtual volume set or RAIDs object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel.

To create a Stripe set object (RAID 0)

1 Click the Create Virtual RAID button and select Create Virtual Block RAID & Autodetect

or select the Create Virtual Block RAID & Autodetect on the Create menu

https://www.r-studio.com/What-is-Disk-Partition.html
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> A Virtual Block RAID object will appear in the Drives panel

2 Select RAID 0 (Stripe set) on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.
You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The Block size and Offset (in sectors) parameters must be set the same as for the original volume set. 

You also need to specify Block order. You may select it on the Blocks order drop-down or shortcut menu.

If the those parameters are not correct, data on the parents will not be damaged, but they cannot be
recovered.
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> The Virtual Block RAID object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

To create a Mirror set object (RAID 1)

1 Click the Create Virtual RAID button and select Create Virtual Mirror

or select the Create Virtual Mirror on the Create menu

> A Virtual Mirror object will appear in the Drives panel
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2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.

> The Virtual Mirror object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel.

2.4.2 Basic RAID 4 and RAID 5 Operations

RAID 4 and RAID 5 are much similar. You may create and edit a RAID 4 object the same way as a RAID 5
one. 

To create a RAID 5 object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID & Autodetect

or select the Create Virtual Block RAID & Autodetect on the Create menu

> A Virtual Block RAID object will appear in the Drives panel

2 Select RAID 5 on the RAID type
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3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.
You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 5. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 5. 

You also need to specify Block order for virtual RAID 5. You may select it on the Block order drop-down or
shortcut menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 5
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 5. Find a file and preview it.
If the file appears correct, you have created a correct RAID 5 layout. 

If your RAID 5 has an unusual configuration, you may create them manually. See Working with Advanced
RAID Layouts for details.
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Parents tab

> The RAID 5 object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

Creating and saving your own RAID 5 configuration

You may create and save your own RAID configurations for non-standard RAIDs. You may specify Offset,
Block order/?size and Row count. See Working with Advanced RAID 5 Layouts for details.

2.4.3 Working with RAID6 (Double Xor) Presets

R-Studio allows you to create and process RAID 6 Double Xor layouts with the following presets:

EVENODD RAID DP X-Code(2) Adaptec 3805

In addition you may create your own RAID 6 configurations.

https://www.r-studio.com/What-is-Disk-Partition.html
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Creating a RAID 6 (Double Xor) object from a preset:

We will use the EVENODD preset as an example.

To create a RAID 6 (Double Xor) object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID & Autodetect

or select the Create Virtual Block RAID & Autodetect on the Create menu

> A Virtual Block RAID object will appear in the Drives panel

2 Select RAID 6/?Double Xor on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.
You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Parents tab
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Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order.

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original volume set. 

You also need to specify Blocks order (EVENODD for our case) for virtual RAID 6 (Double Xor). You may
select it on the Blocks order drop-down or shortcut menu.

If the those parameters are not correct, data on the parents will not be damaged, but they cannot be
recovered.

Note: You may check how correctly you have reconstructed the original volume set or RAID. Find a file
and preview it. If the file appears correct, you have created a correct RAID layout. 

> The Virtual Block RAID object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel. The Description Files for RAID Configurations topic shows the RAID description file
for this RAID configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.4 Working with RAID 6 Presets

R-Studio allows you to create and process RAID 6 layouts. You may use either presets for several RAID 6
layouts, or use your own custom ones.

R-Studio provides presets for the following RAID 6 layouts:

https://www.r-studio.com/What-is-Disk-Partition.html
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Reed-Solomon

Left Synchronous
(standard),

Left Asynchronous
(continuous),

Right Synchronous Right Asynchronous

Creating a RAID 6 object from a preset:

We will use the Reed-Solomon (Left Synchronous (standard)) preset as an example.

To create a RAID 6 object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID & Autodetect

or select the Create Virtual Block RAID & Autodetect on the Create menu

> A Virtual Block RAID object will appear in the Drives panel

2 Select RAID 6/?Reed-Solomon on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.
You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 
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Parents tab

Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order.

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original volume set. 

You also need to specify Blocks order (Left Synchronous (standard) for our case) for virtual RAID 6. You may
select it on the Blocks order drop-down or shortcut menu.

If the those parameters are not correct, data on the parents will not be damaged, but they cannot be
recovered.

Note: You may check how correctly you have reconstructed the original volume set or RAID. Find a file
and preview it. If the file appears correct, you have created a correct RAID layout. 

> The Virtual Block RAID object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel. The Description Files for RAID Configurations topic shows the RAID description file
for this RAID configuration.

https://www.r-studio.com/What-is-Disk-Partition.html
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You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.5 Working with RAIDs with Parity Delays

R-Studio allows you to create RAIDs with parity delays (any level that allows that). For example, let us create a
RAID 5 the parity delays with the following layout:

· Three drives, 
· Delay=16
· Block size: 16 KB
· Offset: 1088 sectors (544 KB)
· Block order: Left Asynchronous (Continuous)

 Block order table:

A B C

Delay=16

1 1 2 PD
2 3 4 PD
3 5 6 PD
4 7 8 PD
5 9 10 PD
6 11 12 PD
7 13 14 PD
8 15 16 PD
9 17 18 PD

10 19 20 PD
11 21 22 PD
12 23 24 PD
13 25 26 PD
14 27 28 PD
15 29 30 PD
16 31 32 PD
17 33 PD 34

Delay=16
18 35 PD 36
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19 37 PD 38
20 39 PD 40
21 41 PD 42
22 43 PD 44
23 45 PD 46
24 47 PD 48
25 49 PD 50
26 51 PD 52
27 53 PD 54
28 55 PD 56
29 57 PD 58
30 59 PD 60
31 61 PD 62
32 63 PD 64
33 PD 65 66

Delay=16

34 PD 67 68
35 PD 69 70
36 PD 71 72
37 PD 73 74
38 PD 75 76
39 PD 77 78
40 PD 79 80
41 PD 81 82
42 PD 83 84
43 PD 85 86
44 PD 87 88
45 PD 89 90
46 PD 91 92
47 PD 93 94
48 PD 95 96

To create such RAID 5,

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID & Autodetect

or select Create Virtual Block RAID & Autodetect on the Create menu

Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select RAID 5 on the RAID type

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
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· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the
RAID object you want to add the partition to.

These objects may be drives, logical drives, or images. Check that the objects are correctly placed.

Note: Objects should be placed in the same order as they were in the original RAID 5. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order field.

4 Specify the parity delay number in the Parity delay control on the Parents tab. 

The number of rows will change to 48. 

If necessary, adjust the First parity parameter

By default, this parameter is set equal to Parity delay. By changing it, you may "shift" the block order table.
For example, when the First parity parameter is set as 1 for the RAID 5 of 3 drives with Parity delay of 3.,
the block order table will be the following:First parity parameter
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5 Select Left Asynchronous (Continuous) on the Block Order Field and click the Apply button on the
Parents tab

> The created Virtual Block RAID 1 object can now be processed like regular drives/??volumes

If R-Studio detects a valid file system on this RAID object, a partition object will appear in the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.6 Working with Advanced RAID Layouts

R-Studio allows you to create and process very complex custom RAID layouts. 
Advanced RAID 5

For example, let us create a RAID 5 with the following layout:

· Three drives, 
· Block size: 4 KB
· Offset: 32768 sectors (64 KB)
· Block order:

A B C

1 PD 1 2
2 PD 3 4

https://www.r-studio.com/What-is-Disk-Partition.html
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3 PD 5 6
4 7 PD 8
5 9 PD 10
6 11 PD 12
7 13 14 PD
8 15 16 PD
9 17 18 PD

To create such RAID 5,

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID & Autodetect

or select Create Virtual Block RAID & Autodetect on the Create menu

Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select Custom on the RAID type

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.
These objects may be drives, logical disks, or images. Check that the objects are correctly placed.

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

https://www.r-studio.com/What-is-Logical-Disk.html
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3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order for field.

4 Manually enter 9 to Number of rows on the Parents tab

The Block order table will expand.

5 Enter the block order in the table on the Parents tab

Use the RAID Sequence window to move from one row to another. 

Sequences window

Using the keyboard: arrow keys to navigate, digit and p keys to enter the block order.

Using the mouse: right-click the cell and select the number or parity from the shortcut menu. If the block
table is too large, you better use the keyboard to enter the digits. 

Corrections: R-Studio will tell you if some digits are not correct. Navigate to the required cell and enter the
correct value. Use the Delete key to clear a cell. 



Data Recovery Using R-Studio 108

© 2023 R-Tools Technology Inc.

Clear the table: Right-click the table and select Clear all on the shortcut menu.

6 When you finishes entering the information, click the Apply button on the Parents tab

> The created Virtual Block RAID 1 object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on this RAID object, a partition object will appear in the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

https://www.r-studio.com/What-is-Disk-Partition.html
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You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

Advanced RAID 5

Another example is a RAID with the following layout, similar to that used in Mac Pro internal RAID cards with 4
drives.

· Four drives, 
· Block size: 512 KB (1024 sectors)
· Offset: 32768 sectors (64 KB)
· Block order:

Sequence 1 Sequence 2 Sequence 3 Sequence 4

A B C D A B C D A B C D

PD 1 2 PD 3 4 PD 5 6 PD 7 8

As you see, this layout cannot be fit directly into a standard 2D block order table. Still, it's possible to create
such RAID layout using the RAID Sequence window.

To create such RAID,

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID & Autodetect

or select Create Virtual Block RAID & Autodetect on the Create menu

Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select Custom on the RAID type

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.
These objects may be drives, logical disks, or images. Check that the objects are correctly placed.

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)
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3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order field.

4 Manually enter 3 to Number of rows on the Parents tab and change Block order to Custom

5 Right-click the RAID Sequence window and select Remove All. Manually enter 3 to Number of rows on
the Parents tab

6 Right-click Cell 1 in the block order table and select Create New Sequence. 

7 Right-click Cell 2 in the block order table and select Add to Sequence, do that for Cell 3, too. 

8 Right-click Cell 4 in the block order table and select Create New Sequence. 

9 Right-click Cell 5 in the block order table and select Add to Sequence, do that for Cell 6, too. 

Continue those steps for the rest of the table until the RAID Sequence window will have 4 sequences of 3
drives:

Sequences window

10 Select the first line in the RAID Sequence window, right-click Cell 1 in the block order table, and select
Parity of Data. 

If any unnecessary sequences appear, right-click them in the RAID Sequence window, and select Remove.

11 Right-click Cell 2 in the block order table and select 1, do that for Cell 3 selecting 2. 

If any unnecessary sequences appear, right-click them in the RAID Sequence window, and select Remove.

12 Move to the next sequence in the  RAID Sequence window and repeat the procedure for cells 4, 5, and
6. 

Do that for the rest of the sequences until you fill all cells in the block order table in the Parents tab. 
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> The created Virtual Block RAID 1 object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on this RAID object, a partition object will appear in the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

Advanced RAID 6 Layout

For example, let us create a RAID 6 with the following layout:

· Five drives, 

· Block size: 64 KB
· Offset: 0
· Block order:

A B C D E

1 RS 1 2 3 PD
2 4 5 6 PD RS
3 8 9 PD RS 7
4 12 PD RS 10 11
5 PD RS 13 14 15
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6 PA PA PA PA PA

where 

PD is parity of data;
PA is parity of all;
RS is Reed-Solomon;

Rows from 1 to 5 use two types of error correction: parity of data (xor) and Reed-Solomon. That is, row 1 uses
blocks A1 and E1, row 2 uses blocks D2 and E2, and so on. 

Row 6 is used for error correction for columns. That is, column A uses block A6, column B uses B6, and so on.
Parity of all is used for error correction.

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID & Autodetect

or select Create Virtual Block RAID & Autodetect on the Create menu

Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select Custom on the RAID type

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.
These objects may be drives, logical disks, or images. Check that the objects are correctly placed.

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)
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3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order parameter.

4 Manually enter 6 to Number of rows on the Parents tab

5 Enter the block order in the table on the Parents tab

You may enter either a block number, or an error correction block of the following types:

PD Parity of data
PA Parity of all
RS Reed-Solomon
SP  Spare Part
I Ignore

Note: You should specify an error correction block only when the correct sequence is selected on the RAID

Sequences window.

Sequences window

Using the keyboard: arrow keys to navigate, digit, and rs, pd, pa, u, i keys to enter the block order.

Using the mouse: right-click the cell and select the number or parity from the shortcut menu. If the block
table is too large, you better use the keyboard to enter the digits.
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For the rows:

Select the required row sequence on the RAID Sequences window, select the cell on the RAID table, and
enter the required value. R-Studio automatically generates those sequences when you add RAID parents.

For the columns and arbitrary sequences:

You need to create those sequences and add the respective blocks to it manually. 

To create a sequence: Click Add empty on the RAID Sequences window or select Create New

Sequence on the shortcut menu on the Parents tab.

To add a block to a sequence: Right-click the respective cell and select Add To Sequence on the shortcut
menu on the Parents tab.

To remove a block to a sequence: Right-click the respective cell and select Remove From Sequence on
the shortcut menu on the Parents tab.

6 When you finishes entering the information, click the Apply button on the Parents tab

> The created Virtual Block RAID 1 object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on this RAID object, a partition object will appear in the Drives

panel. 
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The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7 Nested and Non-Standard RAID Levels

R-Studio can work with various nested and non-standard RAID levels. Currently, the following RAID levels are
supported:

· RAID10 (1+0)

· RAID1E

· RAID5E

· RAID5EE

· RAID6E
2.4.7.1 RAID10 (1+0)

A RAID 10 (or 1+0) is a stripe of mirrors. Its block order can be represented as:
A B C D

1 1 1 2 2

To create a RAID 10 object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID & Autodetect

or select the Create Virtual Block RAID & Autodetect on the Create menu

> A Virtual Block RAID object will appear in the Drives panel

https://www.r-studio.com/What-are-Nested-Non-Standard-RAIDs.html
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2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.

3 Select RAID 10 on the RAID type

You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 10. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 10. 

You also need to specify Block order for virtual RAID 10. You may select it on the Block order drop-down or
shortcut menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 10
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 10. Find a file and preview
it. If the file appears correct, you have created a correct RAID 10 layout. 
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Parents tab

> The RAID 10 object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.2 RAID1E

RAID 1E is utilizes both the mirroring and striping: data is striped across all drives, as in RAID 0. Additionally, a
copy of each stripe is stored on a different drive, as in RAID 1. Its block order can be represented as:

A B C

1 1 1 2
2 2 3 3

To create a RAID 1E object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID & Autodetect

or select the Create Virtual Block RAID & Autodetect on the Create menu

https://www.r-studio.com/What-is-Disk-Partition.html
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> A Virtual Block RAID object will appear in the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.

3 Select RAID 1E on the RAID type

You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 1E. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 1E. 

You also need to specify Block order for virtual RAID 1E You may select it on the Block order drop-down or
shortcut menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 1E
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 1E. Find a file and preview
it. If the file appears correct, you have created a correct RAID 1E layout. 
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Parents tab

> The RAID 1E object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.3 RAID5E

RAID 5E (where E stands for Enhanced) is a RAID 5 layout with an integrated hot-spare drive, where the spare
drive is an active part of the block rotation scheme. An example of such RAID layout is in the table below:

A B C D

1 1 2 3 PD
2 5 6 PD 4
3 9 PD 7 8
4 PD 10 11 12
5 SP SP SP SP

where PD and SP stand for Parity of Data and Spare Part.

https://www.r-studio.com/What-is-Disk-Partition.html
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To create a RAID 5E object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID & Autodetect

or select the Create Virtual Block RAID & Autodetect on the Create menu

> A Virtual Block RAID object will appear in the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.

3 Select RAID 5E on the RAID type

You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 5E. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 5E. 

You also need to specify Block order for virtual RAID 5E You may select it on the Block order drop-down or
shortcut menu.
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If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 5E
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 5E. Find a file and preview
it. If the file appears correct, you have created a correct RAID 5E layout. 

Parents tab

> The RAID 5E object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.4 RAID5EE

RAID 5EE (where E stands for Enhanced) is a RAID 5 layout with an integrated hot-spare drive, where the
spare drive is an active part of the block rotation scheme. An example of such RAID layout is in the table below:

A B C D

1 1 2 SP PD
2 4 SP PD 3

https://www.r-studio.com/What-is-Disk-Partition.html
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3 SP PD 5 6
4 PD 7 8 SP

where PD and SP stand for Parity of Data and Spare Part.

To create a RAID 5EE object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID & Autodetect

or select the Create Virtual Block RAID & Autodetect on the Create menu

> A Virtual Block RAID object will appear in the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.

3 Select RAID 5EE on the RAID type

You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 5EE. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)
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The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 5EE. 

You also need to specify Block order for virtual RAID 5EE You may select it on the Block order drop-down
or shortcut menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID
5EE cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 5EE. Find a file and preview
it. If the file appears correct, you have created a correct RAID 5EE layout. 

Parents tab

> The RAID 5EE object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.5 RAID6E

RAID 6E (where E stands for Enhanced) is a RAID 6 layout with an integrated hot-spare drive, where the spare
drive is an active part of the block rotation scheme. An example of such RAID layout is in the table below:

https://www.r-studio.com/What-is-Disk-Partition.html
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A B C D E F

1 RS 1 2 3 4 PD
2 5 6 7 8 PD RS
3 10 11 12 PD RS 9
4 15 16 PD RS 13 14
5 20 PD RS 17 18 19
6 PD RS 21 22 23 24
7 SP SP SP SP SP SP

where RS, PD and SP stand for Reed-Solomon, Parity of Data, and Spare Part, respectively.

To create a RAID 6E object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID & Autodetect

or select the Create Virtual Block RAID & Autodetect on the Create menu

> A Virtual Block RAID object will appear in the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Right-click the Parents tab and select the required partition from the shortcut menu, 
or
· Right-click the partition in the  Drives panel, select Add to RAID on the shortcut menu, and select the

RAID object you want to add the partition to.

3 Select RAID 6E on the RAID type

You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 6E. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

 Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.
Add Empty Space/?Add Missing Drive Click this button to add an empty space or missing drive object

to the RAID
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Remove Click this button to remove the selected object from the RAID
Move Up Click this button to move up the selected object in the RAID
Move Down Click this button to move down the selected object in the RAID
Synchronize Offsets Click this button to make the offsets the same for all objects in

the RAID
Reset changes Click this button to return the configuration to the initial state

(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 6E. 

You also need to specify Block order for virtual RAID 6E You may select it on the Block order drop-down or
shortcut menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 6E
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 6E. Find a file and preview
it. If the file appears correct, you have created a correct RAID 6E layout. 

Parents tab
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> The RAID 6E object can now be processed like regular drives/?volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear in
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.8 Finding RAID Parameters

R-Studio can find parameters for RAID 5 and 6. RAID parameters can be found automatically or manually. 

The number of drives in the RAID should be between 3 and 32. RAID parameters can be found only when all
original drives (or their images) are present. Even one substitute object in a RAID (like a missing drive) makes
finding RAID parameters impossible.

To find RAID parameters automatically, 

1 Click the Auto Detect button on the Parents tab

> R-Studio will start searching for the RAID parameters and show the most probable one on the RAID
Parameter Detection dialog box

 RAID Parameter Detection dialog box

2 Click the Apply button and R-Studio will change the RAID layout to the selected one on the Parents

tab.

3 Click the Apply button on the Parents tab

>  R-Studio will use the found parameters for the RAID.

If necessary, you may return to the RAID Parameter Detection dialog box by clicking the Choose Variants

button, and select another RAID layout. 

To find RAID parameters manually, 

1 Click the drop-down Auto Detect list on the Parents tab and select Advanced Detection.

https://www.r-studio.com/What-is-Disk-Partition.html
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2 Specify the necessary detection parameters on the RAID Parameter Detection dialog box and click the
Start detection button

Raid Parameters Detection dialog box

You may change the drive order, offset for drive(s), and enable/?disable drives.
Advanced Parameters

Max offset: The area on the drive to find RAID parameters in. 
Offset search
performance
RAID layouts search
performance

Cumulative parameters that estimates the probability of certain found RAID
parameters. Moving it to the right increases accuracy but slows the process.
Moving it to the left reduces the accuracy but makes the process faster. 

You may add your own RAID offsets. Right-click empty space in the Found offsets pane and select Add
Custom offset on the shortcut menu and specify the offset individually for every drive.

3 Select an offset and click the Click here to find RAID Layouts button on the Raid Parameters Detection
dialog box

RAID Parameters Detection dialog box

4 Select a RAID variant in the Found RAID layouts pane and click the Apply button

5 Click the Apply button on the Parents tab
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>  R-Studio will use the found parameters for the RAID.

If necessary, you may return to the RAID Parameter Detection dialog box by clicking the Choose Variants

button, and select another RAID layout. 

2.4.9 Checking RAID Consistency

You may check RAID consistency (whether the data parity values are valid) for RAID layouts with parity
blocks.

To check RAID consistency,

* Right-click the RAID and select Check RAID consistency... on the shortcut menu

> The RAID consistency check window will appear showing the progress. 

RAID consistency check window

When the check is finished, you may inspect the results.

Block
color
Green Data parity values are valid.
Red Data parity values are not valid.
White 0's

When a mouse pointer hovers over a block, a tooltip will show the sector range within the block and number
of consistent and inconsistent sectors. Double-clicking the block moves it to the upper-leftmost corner and
zooms in the data by 2.

 RAID consistency check controls

Sectors The number of the first sector in the row.
Offset Offset in the data. Enter the address you want to jump to and press the Enter key.
Sectors/?Bytes/?KB... Specifies the dimension of the data in the Offset field.
Previous/?Next Moves to the previous/?next part of the data.
+/?- Zooms into/?out of, the data.

2.4.10 Syntax of a Description File for RAID Configurations

You may create and store your own RAID configurations The syntax of those files is similar to that of the XML
language. They are stored in an .xml file specified on the R-Studio Settings.

A number of file examples are shown on the Description Files for RAID Configurations topic.

There are two types of such description files: for RAID presets and custom-created RAID layouts.
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RAID preset configuration file

<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5" rows="3" type="5" order="2"
parityDelay="1">
        <Parents>
            <Parent comp="RAID5Disk1.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="1"/>
            <Parent comp="RAID5Disk2.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="2"/>
            <Parent comp="RAID5Disk3.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="3"/>
        </Parents>
    </RAID>
</RAIDList>

Custom-created RAID configuration file example

<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6Complex" rows="6" type="256">
        <Parents>
            <Parent name="img1.bin" size="941359104" order="1"/>
            <Parent name="img2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="img3.bin" size="941359104" order="3"/>
            <Parent name="img4.bin" size="941359104" order="4"/>
            <Parent name="img5.bin" size="941359104" order="5"/>
        </Parents>
        <Table>
            <Block id="A1">ReedSolomon</Block>
            <Block id="B1">1</Block>
            <Block id="C1">2</Block>
            <Block id="D1">3</Block>
            <Block id="E1">XorOfData</Block>
            <Block id="A2">4</Block>
            <Block id="B2">5</Block>
            <Block id="C2">6</Block>
            <Block id="D2">XorOfData</Block>
            <Block id="E2">ReedSolomon</Block>
            <Block id="A3">8</Block>
            <Block id="B3">9</Block>
            <Block id="C3">XorOfData</Block>
            <Block id="D3">ReedSolomon</Block>
            <Block id="E3">7</Block>
            <Block id="A4">12</Block>
            <Block id="B4">XorOfData</Block>
            <Block id="C4">ReedSolomon</Block>
            <Block id="D4">10</Block>
            <Block id="E4">11</Block>
            <Block id="A5">XorOfData</Block>
            <Block id="B5">ReedSolomon</Block>
            <Block id="C5">13</Block>
            <Block id="D5">14</Block>
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            <Block id="E5">15</Block>
            <Block id="A6" sequence="1">XorOfAll</Block>
            <Block id="B6" sequence="2">XorOfAll</Block>
            <Block id="C6" sequence="3">XorOfAll</Block>
            <Block id="D6" sequence="4">XorOfAll</Block>
            <Block id="E6" sequence="5">XorOfAll</Block>
        </Table>
        <Sequences>
            <Sequence id="1">A1 A2 A3 A4 A5 A6</Sequence>
            <Sequence id="2">B1 B2 B3 B4 B5 B6</Sequence>
            <Sequence id="3">C1 C2 C3 C4 C5 C6</Sequence>
            <Sequence id="4">D1 D2 D3 D4 D5 D6</Sequence>
            <Sequence id="5">E1 E2 E3 E4 E5 E6</Sequence>
        </Sequences>
    </RAID>
</RAIDList>

File structure

File header

The file starts with a standard  XML header:
<?xml version="1.0" encoding="utf-8"?>

Section RAIDList
<RAIDList>

It can contain any number of the <RAID> sections and requires a closing element </FileTypeList>.

Section structure example: 
  <RAIDList>
    <RAID [attributes]>
      ...
    </RAID>
    ...
    <RAID [attributes]>
      ...
    </RAID>

Section RAID

This section describes each RAID layout.

It must contain at least one <Table> and <Parents> sections and can contain one block <Sequences>..
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5" rows="3" type="5" order="2"
parityDelay="1">
        <Parents>
            
        </Parents>
        <Table>

        </Table>
        <Sequences>

        </Sequences>
    </RAID>
</RAIDList>
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Attributes:
blocksize <u32> Required The block size of the RAID in bytes
name <string> Optional The name of the RAID layout
rows <u16> Required The number of rows in the RAID layout table.
type <u16> Required The type of the RAID preset. The following types are

supported:
1: RAID0 (Stripe set)
2: RAID10
3: RAID1E
4: RAID4
5: RAID5
6: RAID5E
7: RAID5EE
8: RAID6 / Reed-Solomon Encoding
9: RAID6E / Reed-Solomon Encoding
10: RAID6 / Vertical Xor Encoding
256: Custom Raid Table
If the RAID type parameter contradicts to the RAID table,
the RAID table always prevails.

order <u16> Required/Optio
nal

The RAID sub-type. For example, order="2" means Left
Asynchronous for RAID5 layouts. Any value for the custom
RAID layouts will be ignored. 

parityDela
y

<u16> Required The Parity delay parameter.

Section structure example:
<RAID blockSize="65536" rows="6" type="256">
        <Parents>

        </Parents>

        <Table>

        </Table>
        <Sequences>

        </Sequences>
    </RAID>

Section Parents

This section describes the RAID parents. It contains the <Parent> elements of the RAID.

Section structure example:
        <Parents>
            <Parent comp="RAID5Disk1.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="1"/>
            <Parent comp="RAID5Disk2.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="2"/>
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            <Parent comp="RAID5Disk3.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="3"/>
        </Parents>

Element Parent

The element specifies the parent of the RAID.

Attributes:
comp <string> Required/O

ptional
The file-container with the parent object.

name <string> Required The object name of the RAID parent.
offset <u16> Required is

not 0
The offset value in bytes

size= <u16> Required The object size in bytes
order <u16> Required The order of the RAID object

Section Table

This section describes the RAID layout table. It contains the <Block> elements which number is a product of
two attributes in the <RAID> section: <parents> x <rows>.

Section structure example:
  <RAIDList>
    <RAID name="example" parents="2" rows="2" blocksize="16777216">
      <Table>
        <Block [attributes]> ... </Block>
        <Block [attributes]> ... </Block>
        <Block [attributes]> ... </Block>
        <Block [attributes]> ... </Block>
      </Table>
    </RAID>
  </RAIDList>

Element Block

The element specifies the block number in the RAID layout table (a positive integer number) or an error
correction block of the following types:

· PD or ParityOfData

· PA or ParityOfAll

· RS or ReedSolomon

· U or Unknown

· I or Ignore

Any other value is treated as Unknown.

Attributes:
id <string> Required The alpha-numerical identifier of the block in the RAID layout

table. The element in the 3-rd column of the 2-nd line is
designated as C2. AA is used after letter Z, and so on.

sequence <string> Optional The numerical identifier for non-default sequences.
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Section Sequences

This section describes the non-default data checksum sequences used to preserve data integrity. It is not
necessary to explicitly list default sequences (the table rows). Sequences can contain any number of the
<Sequence> elements. 

Section structure example:
  <RAIDList>
    <RAID name="example" parents="4" rows="4" blocksize="16777216">
     <Parents>
     
     </Parents>
      <Table>
        ...
      </Table>
      <Sequences>
        <Sequence [attributes]> ... </Sequence>
        ...
        <Sequence [attributes]> ... </Sequence>
      </Sequences>
    </RAID>
  </RAIDList>

Element Sequence

The element contains the list of the RAID blocks belonging to that sequence. The elements are separated by a
space .

Attributes:
id <u16> Required The sequence identifier.

Element example:

See the RAID configuration file example.

Comments
<!-- Comment string -->

An XML standard string for a comment.

2.4.11 Description Files for RAID Configurations

Below are description files for RAID examples described in the Volume Sets and RAIDs chapter. The syntax
of them is described in the Syntax of a Description File for RAID Configurations topic.

StripeSet

The stripe set layout is described in the Volume Sets, Stripe Sets, and Mirrors topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="StripeSet" rows="2" type="1" order="7"
parityDelay="1">
        <Parents>
            <Parent comp="RAID0Disk1.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="1"/>
            <Parent comp="RAID0Disk2.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="2"/>
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        </Parents>
    </RAID>
</RAIDList>

Basic RAID 5

The RAID layout is described in the Working with Basic RAID 4 and RAID 5 Operations topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5" rows="3" type="5" order="2"
parityDelay="1">
        <Parents>
            <Parent comp="RAID5Disk1.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="1"/>
            <Parent comp="RAID5Disk2.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="2"/>
            <Parent comp="RAID5Disk3.dsk" name="Promise1+0 JBOD1.10"
size="40060321792" order="3"/>
        </Parents>
    </RAID>
</RAIDList>

RAID 5 with parity delays

The RAID layout is described in the RAID5 with Parity Delays Operations topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="16384" name="RAID5HP" rows="48" type="5" order="2"
parityDelay="16" firstParity="16">
        <Parents>
            <Parent name="RAID5HPDisk1.bin" offset="557056" size="941359104"
order="1"/>
            <Parent name="RAID5HPDisk2.bin" offset="557056" size="941359104"
order="2"/>
            <Parent name="RAID5HPDisk3.bin" offset="557056" size="941359104"
order="3"/>
        </Parents>
    </RAID>
</RAIDList>

Advanced RAID 5

The RAID layout is described in the Working with Advanced RAID Layouts topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="4096" name="RAID5Complex" rows="9" type="256">
        <Parents>
            <Parent name="RAID5CDisk1.bin" offset="16777216" size="941359104"
order="1"/>
            <Parent name="RAID5CDisk2.bin" offset="16777216" size="941359104"
order="2"/>
            <Parent name="RAID5CDisk3.bin" offset="16777216" size="941359104"
order="3"/>
        </Parents>
        <Table>
            <Block id="A1">XorOfData</Block>
            <Block id="B1">1</Block>
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            <Block id="C1">2</Block>
            <Block id="A2">XorOfData</Block>
            <Block id="B2">3</Block>
            <Block id="C2">4</Block>
            <Block id="A3">XorOfData</Block>
            <Block id="B3">5</Block>
            <Block id="C3">6</Block>
            <Block id="A4">7</Block>
            <Block id="B4">XorOfData</Block>
            <Block id="C4">8</Block>
            <Block id="A5">9</Block>
            <Block id="B5">XorOfData</Block>
            <Block id="C5">10</Block>
            <Block id="A6">11</Block>
            <Block id="B6">XorOfData</Block>
            <Block id="C6">12</Block>
            <Block id="A7">13</Block>
            <Block id="B7">14</Block>
            <Block id="C7">XorOfData</Block>
            <Block id="A8">15</Block>
            <Block id="B8">16</Block>
            <Block id="C8">XorOfData</Block>
            <Block id="A9">17</Block>
            <Block id="B9">18</Block>
            <Block id="C9">XorOfData</Block>
        </Table>
    </RAID>
</RAIDList>

Advanced RAID 5

The RAID layout is described in the Working with Advanced RAID Layouts topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="524288" name="RAID_MacPro" rows="3" type="256">
        <Parents>
            <Parent name="RAID_MAC_ProDisk1.bin" fs="NTFS" offset="16777216"
size="941359104" order="1"/>
            <Parent name="RAID_MAC_ProDisk2.bin" offset="16777216" size="941359104"
order="2"/>
            <Parent name="RAID_MAC_ProDisk3.bin" offset="16777216" size="941359104"
order="3"/>
            <Parent name="RAID_MAC_ProDisk4.bin" offset="16777216" size="941359104"
order="4"/>
        </Parents>
        <Table>
            <Block id="A1" sequence="1">XorOfData</Block>
            <Block id="B1">1</Block>
            <Block id="C1">2</Block>
            <Block id="D1" sequence="2">XorOfData</Block>
            <Block id="A2">3</Block>
            <Block id="B2">4</Block>
            <Block id="C2" sequence="3">XorOfData</Block>
            <Block id="D2">5</Block>
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            <Block id="A3">6</Block>
            <Block id="B3" sequence="4">XorOfData</Block>
            <Block id="C3">7</Block>
            <Block id="D3">8</Block>
        </Table>
        <Sequences>
            <Sequence id="1">A1 B1 C1</Sequence>
            <Sequence id="2">D1 A2 B2</Sequence>
            <Sequence id="3">C2 D2 A3</Sequence>
            <Sequence id="4">B3 C3 D3</Sequence>
        </Sequences>
    </RAID>
</RAIDList>

RAID 6 Reed-Solomon (Left Synchronous (Standard)) Preset

The RAID layout is described in the Working with RAID 6 Presets topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6RS" rows="5" type="8" order="1"
parityDelay="1">
        <Parents>
            <Parent name="img1.bin" size="941359104" order="1"/>
            <Parent name="img2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="img3.bin" size="941359104" order="3"/>
            <Parent name="img4.bin" size="941359104" order="4"/>
            <Parent name="img5.bin" size="941359104" order="5"/>
        </Parents>
    </RAID>
</RAIDList>

RAID6 (Double Xor) Preset

The RAID layout is described in the Working with RAID 6 Presets topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID62X" rows="4" type="10" order="1"
parityDelay="1">
        <Parents>
            <Parent name="RAID62X1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID62X2.bin" size="941359104" order="2"/>
            <Parent name="RAID62X3.bin" size="941359104" order="3"/>
            <Parent name="RAID62X4.bin" size="941359104" order="4"/>
            <Parent name="RAID62X5.bin" size="941359104" order="5"/>
            <Parent name="RAID62X6.bin" size="941359104" order="6"/>
        </Parents>
    </RAID>
</RAIDList>

Advanced RAID 6

The RAID layout is described in the Working with Advanced RAID Layouts topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6Complex" rows="6" type="256">
        <Parents>
            <Parent name="img1.bin" size="941359104" order="1"/>
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            <Parent name="img2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="img3.bin" size="941359104" order="3"/>
            <Parent name="img4.bin" size="941359104" order="4"/>
            <Parent name="img5.bin" size="941359104" order="5"/>
        </Parents>
        <Table>
            <Block id="A1">ReedSolomon</Block>
            <Block id="B1">1</Block>
            <Block id="C1">2</Block>
            <Block id="D1">3</Block>
            <Block id="E1">XorOfData</Block>
            <Block id="A2">4</Block>
            <Block id="B2">5</Block>
            <Block id="C2">6</Block>
            <Block id="D2">XorOfData</Block>
            <Block id="E2">ReedSolomon</Block>
            <Block id="A3">8</Block>
            <Block id="B3">9</Block>
            <Block id="C3">XorOfData</Block>
            <Block id="D3">ReedSolomon</Block>
            <Block id="E3">7</Block>
            <Block id="A4">12</Block>
            <Block id="B4">XorOfData</Block>
            <Block id="C4">ReedSolomon</Block>
            <Block id="D4">10</Block>
            <Block id="E4">11</Block>
            <Block id="A5">XorOfData</Block>
            <Block id="B5">ReedSolomon</Block>
            <Block id="C5">13</Block>
            <Block id="D5">14</Block>
            <Block id="E5">15</Block>
            <Block id="A6" sequence="1">XorOfAll</Block>
            <Block id="B6" sequence="2">XorOfAll</Block>
            <Block id="C6" sequence="3">XorOfAll</Block>
            <Block id="D6" sequence="4">XorOfAll</Block>
            <Block id="E6" sequence="5">XorOfAll</Block>
        </Table>
        <Sequences>
            <Sequence id="1">A1 A2 A3 A4 A5 A6</Sequence>
            <Sequence id="2">B1 B2 B3 B4 B5 B6</Sequence>
            <Sequence id="3">C1 C2 C3 C4 C5 C6</Sequence>
            <Sequence id="4">D1 D2 D3 D4 D5 D6</Sequence>
            <Sequence id="5">E1 E2 E3 E4 E5 E6</Sequence>
        </Sequences>
    </RAID>
</RAIDList>

RAID10 (1+0)

The RAID layout is described in the RAID10 (1+0) topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID10" rows="1" type="2" order="7"
parityDelay="1">
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        <Parents>
            <Parent name="RAID10-1.bin" size="941359104" order="1"/>
            <Parent name="RAID10-2.bin" size="941359104" order="2"/>
            <Parent name="RAID10-3.bin" size="941359104" order="3"/>
            <Parent name="RAID10-4.bin" size="941359104" order="4"/>
        </Parents>
    </RAID>
</RAIDList>

RAID1E

The RAID layout is described in the RAID1E topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID1E" rows="2" type="3" order="1"
parityDelay="1">
        <Parents>
            <Parent name="RAID1EDisk1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID1EDisk2.bin" size="941359104" order="2"/>
            <Parent name="RAID1EDisk3.bin" size="941359104" order="3"/>
        </Parents>
    </RAID>
</RAIDList>

RAID5E

The RAID layout is described in the RAID5E topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5E" rows="5" type="6" order="1"
parityDelay="1">
        <Parents>
            <Parent name="RAID5EDisk1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID5EDisk2.bin" size="941359104" order="2"/>
            <Parent name="RAID5EDisk3.bin" size="941359104" order="3"/>
            <Parent name="RAID5EDisk4.bin" size="941359104" order="4"/>
        </Parents>
    </RAID>
</RAIDList>

RAID5EE

The RAID layout is described in the RAID5EE topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5EE" rows="4" type="7" order="1"
parityDelay="1">
        <Parents>
            <Parent name="RAID5EEDisk1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID5EEDisk2.bin" size="941359104" order="2"/>
            <Parent name="RAID5EEDisk3.bin" size="941359104" order="3"/>
            <Parent name="RAID5EEDisk4.bin" fs="NTFS" size="941359104" order="4"/>
        </Parents>
    </RAID>
</RAIDList>
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RAID6E

The RAID layout is described in the RAID6E topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6E" rows="7" type="9" order="1"
parityDelay="1">
        <Parents>
            <Parent name="RAID6E1.bin" size="941359104" order="1"/>
            <Parent name="RAID6E2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="RAID6E3.bin" size="941359104" order="3"/>
            <Parent name="RAID6E4.bin" size="941359104" order="4"/>
            <Parent name="RAID6E5.bin" size="941359104" order="5"/>
            <Parent name="RAID6E6.bin" size="941359104" order="6"/>
        </Parents>
    </RAID>
</RAIDList>

2.4.12 Various Disk and Volume Managers

R-Studio can work with objects created by various disk and volume managers. Currently, the following
managers are supported:

· Windows Dynamic Disks

· Windows Storage Spaces

· Apple RAIDs

· Apple CoreStorage/?FileVault/?Fusion Drive Volumes

· Linux mdadm RAIDs

· Linux Logical Volume Manager (LVM and LVM2)

R-Studio can automatically recognize and add their physical components, component images, or the user can
manually add the components when their data is damaged so severely that R-Studio cannot recognize them. 
2.4.12.1 Windows Dynamic Disks

R-Studio supports dynamic disks, including Windows software RAIDs, mirrors, and spanned volumes. When
R-Studio detects components from such dynamic disks, it assembles them accordingly. 

https://www.r-studio.com/What-is-Windows-Dynamic-Disks.html
https://www.r-studio.com/What-is-Software-RAID.html
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Windows dynamic disks (RAID5)

R-Studio detects components form dynamic disks and creates those dynamic disks automatically. At the same
time, R-Studio gives access to the parents of the dynamic disks (drives and images).

Windows dynamic disks (RAID5) in R-Studio

If recognized parents of a dynamic disk, including drive images, are added to R-Studio later, it automatically
adds them to their respective dynamic disk.

When an automatically created dynamic disk is selected, R-Studio highlights its components. 

Also, R-Studio automatically detects inconsistent components of dynamic disks and marks them accordingly.
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Windows dynamic disks (RAID5) with unsynced parent

R-Studio shows the components of the selected dynamic disk on its LDM Components tab. 

LDM Components tab

R-Studio shows broken dynamic disks in pink. 

Broken dynamic disks in R-Studio

The LDM Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio cannot recognize them as parts of a broken dynamic disk. Select the
object from the drop-down box and click the Connect button. R-Studio displays the objects it recognizes as the
components of the dynamic disk in blue. 
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Adding a component manually

You may immediately switch to the dynamic disk configuration that R-Studio believes most probable by clicking
the Reassemble button.

R-Studio shows dynamic disks with manually added components in blue:

Dynamic disks with added components in R-Studio

2.4.12.2 Windows Storage Spaces

Storage pools and spaces is a new storage technology, first introduced in Windows 8 and Windows Server
2012, that allows the user to combine various (not always similar) drives into a kind of a RAID or compound
volume. First, the drives are combined into a storage pool, then several storage spaces with striping (similar to
RAID0), mirroring (similar to RAID1), and parity (similar to RAID5) can be created in that storage pool. You
may read more about storage pools and spaces in the Microsoft's Storage Spaces: FAQ.

R-Studio supports Windows Storage Spaces created by Windows 8/8.1 and Windows 10/?Threshold 2/?
Anniversary/?Fall Creators updates.

When drives from a storage pool are connected to a Windows computer, it automatically detects them and
assembles storage spaces accordingly. 

https://www.r-studio.com/What-is-Windows-Storage-Spaces.html
http://windows.microsoft.com/en-us/windows-8/storage-spaces-pools#
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Storage spaces

Storage pools and spaces can be managed using the Storage Spaces item in the Control Panel.

Storage spaces

R-Studio detects drives (or their images) from storage pools and creates storage pools and spaces
automatically. At the same time, R-Studio gives access to the parents of the storage spaces (drives and images).
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Storage spaces in R-Studio

If recognized parents of a storage space, including drive images, are added to R-Studio later, it automatically
adds them to their respective storage space.

When an automatically created storage space is selected, R-Studio highlights its components. It also highlights
the storage space that Windows may itself create from the same components. 

R-Studio shows the components of the selected storage space on its WSS Components tab. 

WSS Components tab

R-Studio shows broken storage spaces in pink. 
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Broken storage spaces in R-Studio

The WSS Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio cannot recognize them as parts of a broken storage space. Select the
object from the drop-down box and click the Connect button. R-Studio displays the objects it recognizes as the
components of the storage space in blue. 

Adding a component manually

You may immediately switch to the storage space configuration that  R-Studio believes most probable by
clicking the Reassemble button.

R-Studio shows storage spaces with manually added components in blue:

Storage spaces with added parents in R-Studio

2.4.12.3 Apple RAIDs

OS X can create several software RAIDs from drives connected to a Mac computer: RAID1 (Mirror set),
RAID0 (Stripe set), and Concatenated disk set. 
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Apple RAID0 example

R-Studio detects components of Apple RAID sets and creates their virtual RAIDs automatically. At the same
time, R-Studio gives access to the individual components of the Apple RAID sets (drives and images).

Apple RAIDs in R-Studio

If recognized components of an Apple RAID, including drive images, are added to R-Studio later, it
automatically adds them to their respective Apple RAID.

When an automatically created Apple RAID is selected, R-Studio highlights its components. 

R-Studio shows the components of the Apple RAID on its MacOS Components tab. 



R-Studio Manual147

© 2023 R-Tools Technology Inc.

MacOS Components tab

R-Studio shows broken Apple RAIDs in pink. 

Broken Apple RAIDs in R-Studio

The MacOS Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio cannot recognize them as parts of a broken Apple RAID. Select the
object from the drop-down box and click the Connect button. R-Studio displays the objects it recognizes as the
components of the Apple RAID in blue. 

Adding a component manually

You may immediately switch to the Apple RAID configuration that  R-Studio believes most probable by clicking
the Reassemble button.

R-Studio shows Apple RAIDs with manually added components in blue:
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Apple RAIDs with added components in R-Studio

2.4.12.4 Apple CoreStorage/FileVault/Fusion Drive Volumes

The macOS operating system has the following disk management systems:

FileVault, is a disk encrypted utility;

Fusion Drive is an Apple's hybrid drive technology;

CoreStorage is a logical volume management system. 

R-Studio supports all these technologies and can unlock their encrypted volumes (drives and images) using either
their passwords or recovery keys.

CoreStorage/FileVault

Locked CoreStorage Volume in R-Studio

https://www.r-studio.com/What-is-Apple-FileVault.html
https://www.r-studio.com/What-is-Apple-Fusion-Drive.html
http://en.wikipedia.org/wiki/Core_Storage


R-Studio Manual149

© 2023 R-Tools Technology Inc.

To unlock the volume

1. Right-click the encrypted volume and select Unlock encrypted drive on the shortcut menu.

2. Enter the password/recovery key on the Unlock encrypted drive dialog box

> R-Studio will unlock the volume

Unlocked CoreStorage Volume in R-Studio

If the volume is partially encrypted, R-Studio can recognize which part is encrypted and which isn't. It will 
provide a correct access to the unencrypted and encrypted parts of the volume, provided that the correct
password is entered.

Partially encrypted volume

Apple Fusion Drive

R-Studio detects components of Apple Fusion Drive and creates virtual Fusion Drives automatically. At the
same time, R-Studio gives access to the individual components of the Fusion Drives (drives and images).

Fusion Drive in R-Studio

When an automatically created Fusion Drive  is selected, R-Studio highlights its components.

R-Studio shows the components of the Fusion Drive on its APFS Fusion Components tab. 
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Fusion Drive Components tab

R-Studio shows broken Fusion Drive s in pink. 

Broken Fusion Drive in R-Studio

The Fusion Drive Components tab also allows you to manually disconnect or connect the components, for
example, if they are such damaged that R-Studio cannot recognize them as parts of a broken Fusion Drive.
Select the object from the drop-down box and click the Connect button. R-Studio displays the objects it
recognizes as the components of the Fusion Drive in blue. 

Adding a component manually

You may immediately switch to the Fusion Drive configuration that  R-Studio believes most probable by clicking
the Reassemble button.

R-Studio shows Fusion Drive with manually added components in blue:
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Fusion Drive with added members in R-Studio

2.4.12.5 Linux mdadm RAIDs

mdadm is a Linux utility used to manage and monitor software RAID devices.

R-Studio supports such devices and when drives from a mdadm RAID are connected to a Windows computer,
it automatically detects them and assembles mdadm RAIDs accordingly. 

Linux mdadm RAIDs

R-Studio detects components from mdadm RAIDs and creates those RAIDs automatically. At the same time,
R-Studio gives access to the components of those RAIDs (drives and images).

mdadm RAIDs in R-Studio

If recognized components of a mdadm RAID, including drive images, are added to R-Studio later, it
automatically adds them to their respective mdadm RAID.

When an automatically created mdadm RAID is selected, R-Studio highlights its components. 

R-Studio shows the components of the mdadm RAIDs on its mdadm Components tab.

https://www.r-studio.com/What-is-mdadm-RAIDs.html
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mdadm Components tab

R-Studio shows broken mdadm RAIDs in pink. 

Broken mdamd RAIDs in R-Studio

The mdadm Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio cannot recognize them as parts of a broken mdadm RAID. Select the
object from the drop-down box and click the Connect button. R-Studio displays the objects it recognizes as the
components of the mdadm RAID in blue. 

Adding a component manually

You may immediately switch to the mdadm RAID configuration that  R-Studio believes most probable by
clicking the Reassemble button. 

R-Studio shows mdadm RAIDs with manually added components in blue:
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mdadm RAIDs with added components in R-Studio

2.4.12.6 Linux LVM/LVM2

Linux LVM is a logical volume manager for the Linux OS that manages drives and other data storage devices.
Using it, It is possible to create single logical volumes on several physical drives, add and replace them in a
running system, resize logical volumes, create various RAID configuration, and so on. You may read more about
Linux LVM in our article: What is Logical Volume Manager (LVM).

LVM volume example

R-Studio detects drives from LVMs and creates their virtual volumes automatically. At the same time, R-Studio
gives access to the components of the virtual LVM volumes (drives and images).

LVM Volumes in R-Studio

If recognized components of an LVM volume, including drive images, are added to R-Studio later, it
automatically adds them to their respective LVM volume.

When an automatically created LVM volume is selected, R-Studio highlights its components. 

https://www.r-studio.com/What-is-Logical-Volume-Manager-LVM.html
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R-Studio shows the components of the LVM volume on its LVM Components tab. 

LVM Components tab

R-Studio shows broken virtual LVM volumes in pink. 
Broken LVM volumes in R-Studio

The LVM Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio cannot recognize them as parts of a broken LVM volume. Select the
object from the drop-down box and click the Connect button. R-Studio displays the objects it recognizes as the
components of the LVM volume in blue. 

Adding a component manually

You may immediately switch to the LVM volume configuration that  R-Studio believes most probable by
clicking the Reassemble button. 

R-Studio shows virtual LVM volumes with manually added components in blue:
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LVM volumes with added components in R-Studio

2.4.13 Mounting Virtual Objects in the System as Virtual Drives

Technician/T80+ version only.

Virtual objects created in the Device view pane of R-Studio can be mounted in the system as read-only virtual
drives. Such virtual drives become accessible to the system and to other programs. Moreover, such virtual drives
remain mounted after R-Studio has been closed.

To mount a virtual object as a read-only virtual drive in the system

1 Right-click the virtual object and select Mount on the shortcut menu

2 Select the mount type on the Mount as a virtual drive dialog box and click the OK button.

Mount options

Mount as: Physical drive: The virtual drive will be mounted as a read-only virtual physical
drive. Windows will search for partitions on it, and if it finds any with supported 
file systems, it will assign disk letters to them. Recommended if the drive should be
accessible to the host Windows and other programs in the system.  If the data on

https://www.r-studio.com/What-is-Disk-Partition.html
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the drive is severely damaged, it may slow down, lock, or even crash the host
Windows.
Partition: The virtual drive will be mounted as a read-only partition with a virtual
partition table created by R-Studio. Recommended if the drive should be
accessible only to another data recovery program.

Drive letter Select the disk letter for the virtual drive if the virtual drive is mounted as a partition.
The letter may be assigned automatically by the system, specified manually, or the
virtual drive may have no letter at all. The latter is recommended if you don't want
Windows to analyze the data on the drive.

> A read-only virtual drive will appear in the Drives panel

And in the system  (Windows Disk Management) as a physical drive

or 

as a partition (Windows Disk Management) as a physical drive
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And this virtual disk becomes accessible to the system and other programs.

To unmount a virtual drive

1 Right-click the virtual drive in the Drives panel and select Unmount on the shortcut menu

2.5 Data Recovery over Network

Available in the Corporate and Technician/Y80+ versions. The Standalone version works with networks only
in the Demo mode.

This chapter explains how to perform data recovery operations over network.

R-Studio has network capabilities that allow the system administrator, using its computer, to recover files on any
computers accessible over network. 

R-Studio supports the TCP/IP protocol and any protocol supported in Microsoft Network.

R-Studio Agent must be installed on computers where files are to be recovered. This program gives R-Studio
access to local drives on remote computers over network. 

If, due to file system crash, the network computer where you are going to recover your data cannot start, you
may use R-Studio Agent Emergency to start the computer.

Files can be recovered without R-Studio Agent if the computer where the files are to be recovered runs
Windows is accessible from a computer also running Windows. In this case, the administrator must have
administrator privileges on the remote computer. 

You should always disable a firewall and/or antivirus software on the both computers. As an alternative,
advanced users may tune them to allow R-Studio and R-Studio Agent to communicate via network.

All data transmitted over network are encrypted with a strong algorithm for data security. Restoring data over
network is very much the same as that on a local computer.

In addition, R-Studio can load/?save any files like drive images, scan info files, RAID configuration files, from/to
the computers to which it has access using R-Studio Agent.

· R-Studio Agent
· Data Recovery over Network
· Connecting over the Internet

2.5.1 R-Studio Agent

R-Studio Agent is a program that provides R-Studio with an access to the drives of a network computer. It
should be installed and properly registered on the computer which drives are to be accessed. R-Studio Agent
has versions for the following PC operating systems:

· Windows
· Mac OS
· Linux

and there is R-Studio Agent Emergency that can be used to start a computer from which you are going to
recover data that cannot start other way due to a file system crash, for example. Please, note that you need to
use R-Studio Emergency as an emergency agent if you want to start a Mac computer. 

R-Studio can work equally with all versions of R-Studio Agent and access computers run under Windows,
Mac OS, and Linux.
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You must have enough rights on the remote computer to install and run R-Studio Agent.
2.5.1.1 R-Studio Agent for Windows

R-Studio Agent should be installed under an administrator account. 

When installed, R-Studio Agent starts automatically and runs as a service. To configure it, R-Studio Agent
should be started again manually. 

 The following switches are available:
-? evokes a help screen;
-install installs R-Studio Agent as a service
-remove removes R-Studio Agent services
-console starts R-Studio Agent as a console application

Started without a switch, R-Studio Agent runs as a GUI application and its icon appears on the taskbar tray. In
this mode, it can be configured and its log may be viewed. 

Simply connect to the remote computer providing a desired password for R-Studio Agent in the Connect to

Remote Computer dialog box. R-Studio checks if there is R-Studio Agent running on this computer. If not, a
Can't connect... message will appear. 

Click the Yes button, and R-Studio will remotely install R-Studio Agent.

Attention Windows users: R-Studio Agent may be remotely installed over a network from a computer
running Windows to another computer running Windows. To do so, you must have administrator
accounts on both computers.

To access the R-Studio Agent main panel, 

1 Click its tray icon

> The main panel will appear. You may view its log

R-Studio Agent main panel

To configure R-Studio Agent, 

1 Right-click its tray icon and select Configure 
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2 Specify required parameters on the Please configure R-Studio Agent dialog box and click the OK
button

Please configure R-Studio Agent dialog box

 R-Studio Agent Options

Password: Enter a password to obtain access to this computer from a network.
Re-Enter: Re-enter the password. 
Accepted Protocols

Pipes supported by Windows. To improve security, this option should be disabled.
TCP/IP supported by any network OS.
Port port for incoming connections
Accepted IP Addresses

IP Address specifies addresses from which this computer can be accessed.
Subnet Mask specifies a subnet mask of the network from which this computer can be accessed.

> R-Studio Agent will now run with the specified parameters
2.5.1.2 R-Studio Agent for Mac

You need to have an administrative account on the Mac computer to start R-Studio Agent for Mac.
To start the R-Studio Agent for Mac and access its main panel, 

1 Go to the Application folder, double-click R-Studio Agent for Mac, and enter the account password

> The main panel will appear. You may view its log

R-Studio Agent for Mac main panel

To configure R-Studio Agent for Mac, 

1 Go to the R-Studio Agent for Mac menu and select Preferences 
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2 Specify required parameters on the Please configure R-Studio Agent dialog box and click the OK
button

Please configure R-Studio Agent Mac dialog box

 R-Studio Agent for Mac Options

Password: Enter a password to obtain access to this computer from a network.
Re-Enter: Re-enter the password. 
Incoming connection preferences

Enable incoming
connections

Select this checkbox if you want to allow incoming connections.

TCP/IP Port A TCP/IP port for incoming connections
Accepted IP Addresses

IP Address specifies addresses from which this computer can be accessed.
Subnet Mask specifies a subnet mask of the network from which this computer can be accessed.

> R-Studio Agent for Mac will now run with the specified parameters

Connecting from R-Studio Agent for Mac to R-Studio.

To establish a connection from R-Studio Agent for Mac to R-Studio, 

1 Run the R-Studio Agent for Mac and select Connect from the Tools menu

2 Enter the necessary information on the Connect to R-Studio dialog box and click the Connect button.

Connect to R-Studio dialog box

Connect to R-Studio settings

Server Specify the DNS name or IP address of the host where R-Studio is
running.

Port Specify the port set on the R-Studio Connect to Remote Computer

dialog box.
Password Specify the password set on the R-Studio Connect to Remote

Computer dialog box.

> R-Studio Agent for Mac will connect to the computer where R-Studio is running and it will show the

drive and logical disk structure of the remote computer.
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It can be processed the same way as that on a local computer.
2.5.1.3 R-Studio Agent for Linux

You need to have the root privileges to run R-Studio Agent for Linux.

Unlike R-Studio Agent for Windows and R-Studio Agent for Mac, R-Studio Agent for Linux is a console application and
should be run in the Terminal. You also need to mark it as an executable before start.

When it is started for the first time, R-Studio Agent for Linux asks for its configuration.

R-Studio Agent for Linux Configuration dialog box

 R-Studio Agent for Linux Options

Specify password
for incoming
connection

Enter a password to obtain access to this computer from a network.

Confirm password
for incoming
connection

Re-enter the password for confirmation. 

Specify IP
address... 

Specifies addresses and a subnet mask from which this computer can be accessed.
Enter 0 to allow connections from any address.

Specify TCP/IP Port
for listening

A TCP/IP port for incoming connections. Press Enter for the default one [3174].

Don't pay much attention to the warning about "unregistered demo version". If necessary, you'll be able to
register R-Studio Agent for Linux through R-Studio.

You may see the current configuration by starting  R-Studio Agent for Linux with the command rsagent --
show_config .
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R-Studio Agent for Linux Configuration dialog box

You may change the current configuration by starting  R-Studio Agent for Linux with the command rsagent --
configure .

Connecting from R-Studio Agent for Linux to R-Studio.

To establish a connection from R-Studio Agent for Linux to R-Studio, 

1 Run the R-Studio Agent for Linux and press Enter

2 Enter the necessary information

Connect to R-Studio dialog box

> R-Studio Agent for Linux will connect to the computer where R-Studio is running and it will show the

drive and logical disk structure of the remote computer.

It can be processed the same way as that on a local computer.

2.5.2 Data Recovery over Network

Generally, data restoring over network is very much the same as that on a local computer. 

R-Studio Agent should be running on the network computer where data are to be recovered. 

Read the Connecting over the Internet topic to learn how to establish connection between R-Studio and
R-Studio Agent over the Internet.

To connect to a remote computer

1 Click the Connect to Remote button or select Connect To Remote on the Drive menu and select
Connect to the remote computer

A list of nearby computers will appear in the Computer List on the Connect to Remote Computer dialog
box.
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Connect to Remote Computer dialog box

2 Select a computer from the list on the Connect to Remote Computer dialog box and enter the
password 

Otherwise, you need to specify in the Computer: field the name or IP address of the remote computer where
data are to be recovered. The Port should coincide with the port specified for the R-Studio Agent.

The Password: field is for the password of R-Studio Agent running on the remote computer. If you want to
see the entered password, right-click the field and select Show password on the shortcut menu.

Note: If the remote computer is started with R-Studio Agent Emergency, leave this field blank.

> R-Studio will connect to the remote computer and show its drive and logical disk structure of the

remote computer below the device/?disk structure of your local computer

It can be processed the same way as that on a local computer.

Recover dialog box

When the Recover dialog box appears, you may select whether you want to save recovered files on the local
or remote computer. Saving recovered files on a remote computer may be useful when the remote computer
has a healthy drive because you do not have to transfer files over network. It may be an external USB drive,
for example.
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When R-Studio connects to the remote computer, it check if R-Studio Agent is present and its password.
If there is no R-Studio Agent installed, R-Studio may try to remotely install it. See the R-Studio Agent
topic for details.

2.5.3 Connecting over the Internet

Available in the Technician/T80+ only.

R-Studio and R-Studio Agent can be connected over the Internet. The connection can be made either using IP
addresses or DNS names. 

If hosts where R-Studio and R-Studio Agent are running have public IP addresses the connection can be made the
same way as for the local network, except that the IP address or DNS name should be explicitly specified in the
Computer filed the Connect to Remote Computer dialog box

If either (or both) of the hosts are on private networks behind NATs and firewalls and do not have public IP
addresses, the corresponding ports should be opened or forwarded. In addition, connection should be made
either only from R-Studio or from R-Studio Agent.

Connection directions

* Both R-Studio and R-Studio Agent have public IP addresses (no NAT/?firewall) or the ports on the NAT/?

firewall are forwarded/?opened.

A connection can be made either from R-Studio or from R-Studio Agent.

https://www.r-studio.com/What-is-NAT.html
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* R-Studio is behind a NAT and R-Studio Agent has a public IP address or the ports on its NAT/?firewall are

forwarded/?opened.

A connection should be made from R-Studio.

* R-Studio has a public IP address or the ports on its NAT/?firewall are forwarded/?opened and R-Studio Agent

is behind a NAT.

A connection should be made from R-Studio Agent.
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* Both R-Studio and R-Studio Agent are behind NATs/?firewalls.

No connections are possible.

Connection from R-Studio Agent to R-Studio

R-Studio settings

If a connection is to be made from R-Studio Agent to R-Studio, R-Studio should be set to accept connection
on the Connect to Remote Computer dialog box. 

Connect to Remote Computer dialog box

Select Wait connection from remote computer, and specify options for incoming connections.

 R-Studio Incoming Connection Options

Password: Enter a password to obtain access to this computer from a network.
Allow connection
from any address

Select this option if you want to allow connections to R-Studio from any IP address

Allow connection
from the host

Select this option if you want to allow connections to R-Studio from a specific IP
address or a network

IP Address specifies addresses from which this computer can be accessed.
Subnet Mask specifies subnet mask of the network from which this computer can be accessed.
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Port port for incoming connections.

R-Studio will wait for an incoming connection.

Waiting for remote connection dialog box

Connecting from R-Studio Agent to R-Studio.

To establish a connection from R-Studio Agent to R-Studio, 

(See the R-Studio Agent for Mac or R-Studio Agent for Linux help page to learn how to establish
connections from those R-Studio Agent versions).

1 Right-click the R-Studio Agent tray icon and select Connect

2 Enter the necessary information on the Connect to R-Studio dialog box and click the Connect button.

Connect to R-Studio dialog box

Connect to R-Studio settings

Server Specify the DNS name or IP address of the host where R-Studio is
running.

Port Specify the port set on the R-Studio Connect to Remote Computer

dialog box.
Password Specify the password set on the R-Studio Connect to Remote

Computer dialog box.

> R-Studio Agent will connect to the computer where R-Studio is running and it will show the drive and

logical disk structure of the remote computer.

It can be processed the same way as that on a local computer.

III R-Studio Technician/T80+

R-Studio Technician/T80+ Demo can perform all data recovery actions except saving recovered files greater
than 256 KB and multi-pass imaging.



R-Studio Technician/T80+ 168

© 2023 R-Tools Technology Inc.

The R-Studio T80+ version requires an active internet connection to run and register. You may read more about
R-Studio T80+ in our article R-Studio T80+ - A Professional Data Recovery and Forensic Solution for Small
Business and Individuals Just for US$1/day.

This chapter covers features that available only in the R-Studio Technician/T80+ versions.

· File Information
· Custom Recovery Lists
· Drive Copy Wizard
· File Maps
· I/O Monitor and Sector Map files
· Runtime Imaging
· Multi-pass Imaging
· Reverse RAIDs
· Working with the Third-Party Hardware
· Forensic Mode

3.1 File Information

R-Studio Technician/T80+ shows much more information about files than R-Studio does. 

Info about a file with good chances
for recovery

Info for a file with below average
recovery chances

More information

Click this button to pin the file information. This panel will show the information
about the "pinned" file regardless of the current selected file.

Click this button to copy all this information

http://www.r-studio.com/affordable-professional-data-recovery-forensic-solution.html
http://www.r-studio.com/affordable-professional-data-recovery-forensic-solution.html
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Click this button to select the file you want to go to. 

Click this button to close all the information. 

Overlapping files Shows the list or files that may occupy the same drive sectors. You may click the file
id to see information about this file.

Regions Shows the list of sectors occupied by the file and corresponding overlapping files.
You may click a sector number open the sector in the built-in Hexadecimal editor.

Examples of file information on other file systems

File info on an ext4fs file system Info for a file on an HFS+ file system
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File info on an APFS file system Info for a file on an XFS file system

3.2 Custom Recovery Lists

The R-Studio Technician/T80+ versions can create more advanced recovery lists.

Export Recovery List options

Export the entire folder/file tree
Export marked file/folder names
Export file/folder names

Specifies which file and folder names will be exported. 

File format:

A file format for the recovery list.
Only text format is available for the standalone and corporate versions.
R-Studio Technician/T80+ can create custom recovery lists in other
formats with more advanced options 
The following formats are available for R-Studio Technician/T80+
version:
Plain Text
HTML
XML
JSON
CSV

File name: Specifies a file name of the recovery list. 

Editing the file recovery list

All files without any marks in the recovery list will be marked when the list is loaded into R-Studio. So, if you

have some files in the recovery list that don't need to be recovered, just delete them from the list. In addition, you
may use the following marks to specify some options 

:+ Mark the file, or the folder, all its files, and subfolders within the folder.
:* Mark the file, or the folder and its files, don't mark subfolders in the folder.
:- Unmark the file, or the folder, its files, and subfolders in the folder.
:= Unmark the file or the folder and its files, dont unmark subfolders in the folder.
:! Provide the information on the file. (R-Studio Technician/T80+ only)

 R-Studio processes records in the list consequently. That is, if there are the following lines in the file,
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:+Files_to_Recover\
:-Files_to_Delete\File_2.jpg

the file File_2.jpg won't be marked for recovery, while for the lines
:-Files_to_Recover\File_2.jpg
:+Files_to_Recover\

file File_2.jpg will be.

A simple recovery list for reference

Structure of a simple recovery list file created by R-Studio
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"e:\"; label:"ntfs test";
fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one"; 
Diving/
Diving/Aquarium/
Diving/Aquarium/20190822_100644.jpg
Diving/Aquarium/20190822_101620.jpg
Diving/Aquarium/20190822_102526.jpg
Diving/Aquarium/20190822_103830.jpg
Diving/Aquarium/20190822_104333.jpg
Diving/MyPhoto1.jpg
Diving/MyPhoto2.jpg
Diving/MyPhoto3.jpg
Diving/MyPhoto4.JPG
Diving/MyPhoto5.jpg
SF/
SF/Sea-Lions/
SF/Sea-Lions/IMG_3493.JPG
SF/Sea-Lions/IMG_3535.JPG
SF/Sea-Lions/IMG_3542.JPG
SF/Sea-Lions/IMG_3579.JPG
SF/Sea-Lions/IMG_3580.JPG
SF/Sea-Lions/IMG_3581.JPG
SF/Sea-Lions/IMG_3589.JPG
SF/IMG_0869.JPG
SF/IMG_0873.JPG
SF/IMG_0890.JPG
SF/IMG_1739.JPG
SF/IMG_3460.JPG
SF/IMG_3461.JPG
SF/IMG_3476.JPG
SF/IMG_3478.JPG
SF/IMG_3479.JPG
SF/IMG_3480.JPG
SF/IMG_3481.JPG
SF/IMG_3493.JPG
SF/IMG_3535.JPG
SF/IMG_3542.JPG
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SF/IMG_3579.JPG
SF/IMG_3580.JPG
SF/IMG_3581.JPG
SF/IMG_3589.JPG
SF/IMG_3590.JPG
SF/IMG_3591.JPG
SF/IMG_3592.JPG
SF/IMG_3593.JPG
SF/IMG_3594.JPG
SF/IMG_3595.JPG
SF/IMG_3596.JPG
SF/IMG_3608.JPG
SF/IMG_3627.JPG
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

If such recovery list is created from an entire logical disk/partition, it will contain several virtual folders. For
example, they'll have the following structure for an NTFS partition.
///m/$Extend/
///m/$Extend/$Deleted/
///m/$Extend/$RmMetadata/
///m/$Extend/$RmMetadata/$Txf/
///m/$Extend/$RmMetadata/$TxfLog/
///m/$Extend/$RmMetadata/$TxfLog/$Tops
///m/$Extend/$RmMetadata/$TxfLog/$TxfLog.blf
///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000001
///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000002
///m/$Extend/$RmMetadata/$Repair
///m/$Extend/$ObjId
///m/$Extend/$Quota
///m/$Extend/$Reparse
///m/$AttrDef
///m/$BadClus
///m/$Bitmap
///m/$Boot
///m/$LogFile
///m/$MFT
///m/$MFTMirr
///m/$Secure
///m/$UpCase
///m/$Volume

HTML format

This is a default format of recovery lists for the R-Studio Technician/T80+ version. It allows its users to supply
their customers with the recovery lists with the easiest way to edit. 
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Export Recovery List dialog box for the HTML format

HTML Options dialog box

You may export the default HTML template and edit it to adapt it for your own purposes. 

When the customer loads an HTML recovery list in their browser, they can mark files they want to recover, and
export their names into the final recovery list in the plain text format.

HTML Recovery list in a browser

You may compare this list with the edited simple recovery list.

  An exported recovery list 

:# Version = 1
:# Sort = by real 
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"e:\"; label:"ntfs test";
fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one"; 
Diving/Aquarium/20190822_100644.jpg
:! Id=630001
Diving/Aquarium/20190822_101620.jpg
:! Id=640001
Diving/Aquarium/20190822_102526.jpg
:! Id=650001
Diving/Aquarium/20190822_103830.jpg
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:! Id=660001
Diving/Aquarium/20190822_104333.jpg
:! Id=670001
Diving/MyPhoto1.jpg
:! Id=270001
Diving/MyPhoto2.jpg
:! Id=280001
Diving/MyPhoto3.jpg
:! Id=290001
Diving/MyPhoto4.JPG
:! Id=2a0001
Diving/MyPhoto5.jpg
:! Id=2b0001
SF/IMG_0869.JPG
:! Id=370001
SF/IMG_0873.JPG
:! Id=380001
SF/IMG_0890.JPG
:! Id=390001
SF/IMG_1739.JPG
:! Id=3a0001
SF/IMG_3460.JPG
:! Id=3b0001
SF/IMG_3461.JPG
:! Id=3c0001
SF/IMG_3476.JPG
:! Id=3d0001
SF/IMG_3478.JPG
:! Id=3e0001
SF/IMG_3479.JPG
:! Id=3f0001
SF/IMG_3480.JPG
:! Id=400001
SF/IMG_3481.JPG
:! Id=410001
SF/IMG_3493.JPG
:! Id=1000000
SF/IMG_3535.JPG
:! Id=1000001
SF/IMG_3542.JPG
:! Id=1000002
SF/IMG_3579.JPG
:! Id=1000003
SF/IMG_3580.JPG
:! Id=1000004
SF/IMG_3581.JPG
:! Id=1000005
SF/IMG_3589.JPG
:! Id=1000006
SF/IMG_3590.JPG
:! Id=1000007
SF/IMG_3591.JPG
:! Id=4a0001
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SF/IMG_3592.JPG
:! Id=4b0001
SF/IMG_3593.JPG
:! Id=4c0001
SF/IMG_3594.JPG
:! Id=4d0001
SF/IMG_3595.JPG
:! Id=4e0001
SF/IMG_3596.JPG
:! Id=4f0001
SF/IMG_3608.JPG
:! Id=500001
SF/IMG_3627.JPG
:! Id=510001
MyPhoto6.JPG
:! Id=5e0001
MyPhoto7.JPG
:! Id=5f0001
MyPhoto8.JPG
:! Id=600001
MyPhoto9.JPG
:! Id=610001

A manually edited plain text recovery list

The edited simple recovery list

The final simple recovery list will be the following:
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"e:\"; label:"ntfs test";
fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one";
:= Diving/
:+ Diving/Aquarium/
:+ Diving/MyPhoto1.jpg
:+ Diving/MyPhoto3.jpg
:+ SF/
:- SF/Sea-Lions/
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

Plain text format

Custom recovery lists in the text format contains more information about files than simple recovery lists.
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Export Recovery List dialog box for the plain text format

You may compare two versions of the same plain text recovery list:

An advanced text recovery list

This is an advanced version of the recovery list described on the Recovery List page.
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; mountpoint:"e:\"; label:"ntfs
test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89";
firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one"; 
Diving/
:! Id=4000000260001
:! Flags=directory
:! Created=11/22/2022 12:35:18 PM
:! Modified=11/22/2022 01:09:07 PM
:! Accessed=11/22/2022 01:22:18 PM
:! MFT number=38
:! Parent MFT number=5

Diving/Aquarium/
:! Id=4000000620001
:! Flags=directory
:! Created=11/22/2022 01:09:07 PM
:! Modified=11/22/2022 01:09:58 PM
:! Accessed=11/22/2022 01:22:17 PM
:! MFT number=98
:! Parent MFT number=38

Diving/Aquarium/20190822_100644.jpg
:! Id=630001
:! Size=3.63 MB (3,808,537 Bytes)
:! Created=11/22/2022 01:09:56 PM
:! Modified=8/21/2019 11:06:44 PM
:! Accessed=11/22/2022 01:09:56 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 449232 size: 3.63 MB (3,808,537 Bytes) / first data
    :! other files:  [480000000530001] IMG_0510.JPG
:! sector 682862 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000540001] IMG_0516.JPG
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:! sector 682862 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [480000000540001] IMG_0516.JPG
:! MFT number=99
:! Parent MFT number=98

Diving/Aquarium/20190822_101620.jpg
:! Id=640001
:! Size=3.23 MB (3,389,662 Bytes)
:! Created=11/22/2022 01:09:56 PM
:! Modified=8/21/2019 11:16:20 PM
:! Accessed=11/22/2022 01:09:57 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 456672 size: 3.23 MB (3,389,662 Bytes) / first data
    :! other files:  [480000000550001] IMG_0525.JPG
:! sector 682864 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000550001] IMG_0525.JPG
:! sector 682864 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [480000000560001] IMG_0539.JPG
:! MFT number=100
:! Parent MFT number=98

Diving/Aquarium/20190822_102526.jpg
:! Id=650001
:! Size=3.06 MB (3,208,377 Bytes)
:! Created=11/22/2022 01:09:57 PM
:! Modified=8/21/2019 11:25:26 PM
:! Accessed=11/22/2022 01:09:57 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 463296 size: 3.06 MB (3,208,377 Bytes) / first data
    :! other files:  [480000000560001] IMG_0539.JPG
:! sector 682866 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000570001] IMG_0541.JPG
:! sector 682866 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [480000000570001] IMG_0541.JPG
:! MFT number=101
:! Parent MFT number=98

Diving/Aquarium/20190822_103830.jpg
:! Id=660001
:! Size=3.22 MB (3,381,308 Bytes)
:! Created=11/22/2022 01:09:57 PM
:! Modified=8/21/2019 11:38:30 PM
:! Accessed=11/22/2022 01:09:58 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 469568 size: 3.22 MB (3,381,308 Bytes) / first data
    :! other files:  [480000000580001] IMG_0542.JPG
:! sector 682868 (offset: 80 ) size: 72 Bytes / resident
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    :! other files:  [480000000580001] IMG_0542.JPG
:! sector 682868 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [480000000590001] IMG_0543.JPG
:! MFT number=102
:! Parent MFT number=98

Diving/Aquarium/20190822_104333.jpg
:! Id=670001
:! Size=3.19 MB (3,344,532 Bytes)
:! Created=11/22/2022 01:09:58 PM
:! Modified=8/21/2019 11:43:33 PM
:! Accessed=11/22/2022 01:09:58 PM
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 476176 size: 3.19 MB (3,344,532 Bytes) / first data
    :! other files:  [480000000590001] IMG_0543.JPG
:! sector 682870 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000005a0001] IMG_0545.JPG
:! sector 682870 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [4800000005a0001] IMG_0545.JPG
:! MFT number=103
:! Parent MFT number=98

Diving/MyPhoto1.jpg
:! Id=270001
:! Size=2.56 MB (2,682,000 Bytes)
:! Created=11/22/2022 12:35:18 PM
:! Modified=4/29/2009 02:52:42 AM
:! Accessed=11/22/2022 12:35:19 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 11336 size: 2.56 MB (2,682,000 Bytes) / first data
    :! other files:  [480000000460002] IMG_3579.JPG, [480000001000003]
IMG_3579.JPG
:! sector 682742 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000470002] IMG_3580.JPG, [480000001000004]
IMG_3580.JPG
:! sector 682742 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000470002] IMG_3580.JPG, [480000001000004]
IMG_3580.JPG
:! MFT number=39
:! Parent MFT number=38

Diving/MyPhoto2.jpg
:! Id=280001
:! Size=1.75 MB (1,830,252 Bytes)
:! Created=11/22/2022 12:35:19 PM
:! Modified=4/29/2009 02:53:22 AM
:! Accessed=11/22/2022 12:35:19 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
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:! sector 16576 size: 1.75 MB (1,830,252 Bytes) / first data
    :! other files:  [480000000480002] IMG_3581.JPG, [480000001000005]
IMG_3581.JPG
:! sector 682744 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000480002] IMG_3581.JPG, [480000001000005]
IMG_3581.JPG
:! sector 682744 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000490002] IMG_3589.JPG, [480000001000006]
IMG_3589.JPG
:! MFT number=40
:! Parent MFT number=38

Diving/MyPhoto3.jpg
:! Id=290001
:! Size=1.73 MB (1,816,964 Bytes)
:! Created=11/22/2022 12:35:19 PM
:! Modified=4/29/2009 02:53:58 AM
:! Accessed=11/22/2022 12:35:19 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 20152 size: 1.73 MB (1,816,964 Bytes) / first data
    :! other files:  [480000000490002] IMG_3589.JPG, [480000001000006]
IMG_3589.JPG
:! sector 682746 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000001000007] IMG_3590.JPG
:! sector 682746 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000004a0001] IMG_3591.JPG
:! MFT number=41
:! Parent MFT number=38

Diving/MyPhoto4.JPG
:! Id=2a0001
:! Size=880.15 KB (901,269 Bytes)
:! Created=11/22/2022 12:35:19 PM
:! Modified=4/29/2009 02:54:20 AM
:! Accessed=11/22/2022 12:35:20 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 23704 size: 880.15 KB (901,269 Bytes) / first data
    :! other files:  [4800000004b0001] IMG_3592.JPG
:! sector 682748 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000004c0001] IMG_3593.JPG
:! sector 682748 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000004d0001] IMG_3594.JPG
:! MFT number=42
:! Parent MFT number=38

Diving/MyPhoto5.jpg
:! Id=2b0001
:! Size=3.13 MB (3,286,883 Bytes)
:! Created=11/22/2022 12:35:20 PM
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:! Modified=4/29/2009 03:13:38 AM
:! Accessed=11/22/2022 12:35:20 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 25472 size: 3.13 MB (3,286,883 Bytes) / first data
    :! other files:  [4800000004e0001] IMG_3595.JPG
:! sector 682750 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000004f0001] IMG_3596.JPG
:! sector 682750 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000500001] IMG_3608.JPG
:! MFT number=43
:! Parent MFT number=38

SF/
:! Id=4000000360001
:! Flags=directory
:! Created=11/22/2022 12:35:27 PM
:! Modified=11/22/2022 01:24:57 PM
:! Accessed=11/22/2022 01:25:09 PM
:! MFT number=54
:! Parent MFT number=5

SF/Sea-Lions/
:! Id=4000000420002
:! Flags=directory
:! Created=11/22/2022 01:24:57 PM
:! Modified=11/22/2022 01:25:09 PM
:! Accessed=11/22/2022 01:27:46 PM
:! MFT number=66
:! Parent MFT number=54

SF/Sea-Lions/IMG_3493.JPG
:! Id=430002
:! Size=4.75 MB (4,985,023 Bytes)
:! Created=11/22/2022 01:25:05 PM
:! Modified=6/5/2009 06:50:22 PM
:! Accessed=11/22/2022 01:25:05 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 208544 size: 4.75 MB (4,985,023 Bytes) / first data
    :! other files:  [4800000002a0001] MyPhoto4.JPG
:! sector 682798 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000002b0001] MyPhoto5.jpg
:! sector 682798 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000002b0001] MyPhoto5.jpg
:! Overlapping files=[480000001000000] IMG_3493.JPG
:! MFT number=67
:! Parent MFT number=66

SF/Sea-Lions/IMG_3535.JPG
:! Id=440002
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:! Size=3.55 MB (3,718,479 Bytes)
:! Created=11/22/2022 01:25:06 PM
:! Modified=6/5/2009 06:55:56 PM
:! Accessed=11/22/2022 01:25:06 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 218288 size: 3.55 MB (3,718,479 Bytes) / first data
    :! other files:  [4800000002d0001] IMG_0201.JPG
:! sector 682800 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000002d0001] IMG_0201.JPG
:! sector 682800 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000002e0001] IMG_0211.JPG
:! Overlapping files=[480000001000001] IMG_3535.JPG
:! MFT number=68
:! Parent MFT number=66

SF/Sea-Lions/IMG_3542.JPG
:! Id=450002
:! Size=3.92 MB (4,110,749 Bytes)
:! Created=11/22/2022 01:25:06 PM
:! Modified=6/5/2009 06:57:38 PM
:! Accessed=11/22/2022 01:25:07 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 225552 size: 3.92 MB (4,110,749 Bytes) / first data
    :! other files:  [4800000002e0001] IMG_0211.JPG
:! sector 682802 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000002f0001] IMG_0250.JPG
:! sector 682802 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000002f0001] IMG_0250.JPG
:! Overlapping files=[480000001000002] IMG_3542.JPG
:! MFT number=69
:! Parent MFT number=66

SF/Sea-Lions/IMG_3579.JPG
:! Id=460002
:! Size=3.92 MB (4,109,345 Bytes)
:! Created=11/22/2022 01:25:07 PM
:! Modified=6/5/2009 06:59:32 PM
:! Accessed=11/22/2022 01:25:07 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 233584 size: 3.92 MB (4,109,345 Bytes) / first data
    :! other files:  [480000000300001] IMG_0283.JPG
:! sector 682804 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000300001] IMG_0283.JPG
:! sector 682804 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000310001] IMG_0389.JPG
:! Overlapping files=[480000001000003] IMG_3579.JPG
:! MFT number=70
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:! Parent MFT number=66

SF/Sea-Lions/IMG_3580.JPG
:! Id=470002
:! Size=3.35 MB (3,510,477 Bytes)
:! Created=11/22/2022 01:25:08 PM
:! Modified=6/5/2009 06:59:40 PM
:! Accessed=11/22/2022 01:25:08 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 241616 size: 3.35 MB (3,510,477 Bytes) / first data
    :! other files:  [480000000310001] IMG_0389.JPG
:! sector 682806 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000320001] IMG_0390.JPG
:! sector 682806 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000320001] IMG_0390.JPG
:! Overlapping files=[480000001000004] IMG_3580.JPG
:! MFT number=71
:! Parent MFT number=66

SF/Sea-Lions/IMG_3581.JPG
:! Id=480002
:! Size=4.09 MB (4,285,353 Bytes)
:! Created=11/22/2022 01:25:08 PM
:! Modified=6/5/2009 06:59:48 PM
:! Accessed=11/22/2022 01:25:09 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 248480 size: 4.09 MB (4,285,353 Bytes) / first data
    :! other files:  [480000000330001] IMG_0391.JPG
:! sector 682808 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000330001] IMG_0391.JPG
:! sector 682808 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000340001] IMG_3694.JPG
:! Overlapping files=[480000001000005] IMG_3581.JPG
:! MFT number=72
:! Parent MFT number=66

SF/Sea-Lions/IMG_3589.JPG
:! Id=490002
:! Size=4.44 MB (4,651,043 Bytes)
:! Created=11/22/2022 01:25:09 PM
:! Modified=6/5/2009 07:00:18 PM
:! Accessed=11/22/2022 01:25:10 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 256856 size: 4.44 MB (4,651,043 Bytes) / first data
    :! other files:  [480000000340001] IMG_3694.JPG
:! sector 682810 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000350001] IMG_3699.JPG
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:! sector 682810 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000350001] IMG_3699.JPG
:! Overlapping files=[480000001000006] IMG_3589.JPG
:! MFT number=73
:! Parent MFT number=66

SF/IMG_0869.JPG
:! Id=370001
:! Size=3.53 MB (3,698,659 Bytes)
:! Created=11/22/2022 12:35:27 PM
:! Modified=5/30/2009 10:13:46 AM
:! Accessed=11/22/2022 01:22:26 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 111224 size: 3.53 MB (3,698,659 Bytes) / first data
    :! other files:  [480000000010000] $MFTMirr
:! sector 682774 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000010000] $MFTMirr
:! sector 682774 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000020000] $LogFile
:! MFT number=55
:! Parent MFT number=54

SF/IMG_0873.JPG
:! Id=380001
:! Size=5.61 MB (5,881,104 Bytes)
:! Created=11/22/2022 12:35:28 PM
:! Modified=5/30/2009 10:15:56 AM
:! Accessed=11/22/2022 01:22:28 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 118448 size: 5.61 MB (5,881,104 Bytes) / first data
    :! other files:  [480000000020000] $LogFile
:! sector 682776 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000040000] $AttrDef
:! sector 682776 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000040000] $AttrDef
:! MFT number=56
:! Parent MFT number=54

SF/IMG_0890.JPG
:! Id=390001
:! Size=5.40 MB (5,663,358 Bytes)
:! Created=11/22/2022 12:35:29 PM
:! Modified=5/30/2009 10:47:26 AM
:! Accessed=11/22/2022 01:22:29 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 129936 size: 5.40 MB (5,663,358 Bytes) / first data
    :! other files:  [480000000060000] $Bitmap
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:! sector 682778 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000060000] $Bitmap
:! sector 682778 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000070000] $Boot
:! MFT number=57
:! Parent MFT number=54

SF/IMG_1739.JPG
:! Id=3a0001
:! Size=4.07 MB (4,266,181 Bytes)
:! Created=11/22/2022 12:35:30 PM
:! Modified=6/3/2009 09:59:04 AM
:! Accessed=11/22/2022 01:22:30 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 141000 size: 4.07 MB (4,266,181 Bytes) / first data
    :! other files:  [480000000070000] $Boot
:! sector 682780 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000070000] $Boot
:! sector 682780 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000000a0000] $UpCase
:! MFT number=58
:! Parent MFT number=54

SF/IMG_3460.JPG
:! Id=3b0001
:! Size=4.38 MB (4,593,453 Bytes)
:! Created=11/22/2022 12:35:31 PM
:! Modified=6/5/2009 04:58:08 PM
:! Accessed=11/22/2022 01:22:30 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 149336 size: 4.38 MB (4,593,453 Bytes) / first data
    :! other files:  [4800000000a0000] $UpCase
:! sector 682782 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000000a0000] $UpCase
:! sector 682782 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000200001] $Tops
:! MFT number=59
:! Parent MFT number=54

SF/IMG_3461.JPG
:! Id=3c0001
:! Size=3.91 MB (4,102,032 Bytes)
:! Created=11/22/2022 12:35:31 PM
:! Modified=6/5/2009 04:58:26 PM
:! Accessed=11/22/2022 01:22:31 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 158312 size: 3.91 MB (4,102,032 Bytes) / first data
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    :! other files:  [480000000200001] $Tops
:! sector 682784 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000200001] $Tops
:! sector 682784 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000210001] $TxfLog.blf
:! MFT number=60
:! Parent MFT number=54

SF/IMG_3476.JPG
:! Id=3d0001
:! Size=3.92 MB (4,114,595 Bytes)
:! Created=11/22/2022 12:35:32 PM
:! Modified=6/5/2009 05:02:50 PM
:! Accessed=11/22/2022 01:22:32 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 166328 size: 3.92 MB (4,114,595 Bytes) / first data
    :! other files:  [480000000210001] $TxfLog.blf
:! sector 682786 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000220001] $TxfLogContainer00000000000000000001
:! sector 682786 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000220001] $TxfLogContainer00000000000000000001
:! MFT number=61
:! Parent MFT number=54

SF/IMG_3478.JPG
:! Id=3e0001
:! Size=4.74 MB (4,968,784 Bytes)
:! Created=11/22/2022 12:35:33 PM
:! Modified=6/5/2009 05:03:22 PM
:! Accessed=11/22/2022 01:22:33 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 174376 size: 4.74 MB (4,968,784 Bytes) / first data
    :! other files:  [480000000230001] $TxfLogContainer00000000000000000002
:! sector 682788 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000230001] $TxfLogContainer00000000000000000002
:! sector 682788 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000250001] WPSettings.dat
:! MFT number=62
:! Parent MFT number=54

SF/IMG_3479.JPG
:! Id=3f0001
:! Size=4.28 MB (4,484,110 Bytes)
:! Created=11/22/2022 12:35:34 PM
:! Modified=6/5/2009 05:03:42 PM
:! Accessed=11/22/2022 01:22:34 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
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:! sector 184088 size: 4.28 MB (4,484,110 Bytes) / first data
    :! other files:  [480000000250001] WPSettings.dat
:! sector 682790 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000250001] WPSettings.dat
:! sector 682790 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000270001] MyPhoto1.jpg
:! MFT number=63
:! Parent MFT number=54

SF/IMG_3480.JPG
:! Id=400001
:! Size=4.28 MB (4,491,209 Bytes)
:! Created=11/22/2022 12:35:34 PM
:! Modified=6/5/2009 05:03:48 PM
:! Accessed=11/22/2022 01:24:01 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 192848 size: 4.28 MB (4,491,209 Bytes) / first data
    :! other files:  [480000000270001] MyPhoto1.jpg
:! sector 682792 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000280001] MyPhoto2.jpg
:! sector 682792 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000280001] MyPhoto2.jpg
:! MFT number=64
:! Parent MFT number=54

SF/IMG_3481.JPG
:! Id=410001
:! Size=3.38 MB (3,541,845 Bytes)
:! Created=11/22/2022 12:35:35 PM
:! Modified=6/20/2009 11:00:56 AM
:! Accessed=11/22/2022 01:23:57 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 201624 size: 3.38 MB (3,541,845 Bytes) / first data
    :! other files:  [480000000290001] MyPhoto3.jpg
:! sector 682794 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000290001] MyPhoto3.jpg
:! sector 682794 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000002a0001] MyPhoto4.JPG
:! MFT number=65
:! Parent MFT number=54

SF/IMG_3493.JPG
:! Id=1000000
:! Size=4.75 MB (4,985,023 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:36 PM
:! Modified=6/5/2009 06:50:22 PM
:! Accessed=11/22/2022 12:35:37 PM
:! File type=JPEG Digital Camera
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:! Recovery chances=Below Average (Integrity OK, Beginning overwritten by
existing file [480000000430002])
:! Regions (sector size=512B):
:! sector 208544 size: 4.75 MB (4,985,023 Bytes) / first data
    :! other files:  [4800000005b0001] IMG_0547.JPG
:! sector 682796 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000005b0001] IMG_0547.JPG
:! sector 682796 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000005c0001] IMG_0550.JPG
:! Overlapping files=[480000000430002] IMG_3493.JPG
:! MFT number=66
:! Parent MFT number=54

SF/IMG_3535.JPG
:! Id=1000001
:! Size=3.55 MB (3,718,479 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:37 PM
:! Modified=6/5/2009 06:55:56 PM
:! Accessed=11/22/2022 12:35:37 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Below Average (Integrity OK, Beginning overwritten by
existing file [480000000440002])
:! Regions (sector size=512B):
:! sector 218288 size: 3.55 MB (3,718,479 Bytes) / first data
    :! other files:  [4800000005c0001] IMG_0550.JPG
:! sector 682798 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000005d0001] IMG_0551.JPG
:! sector 682798 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000005d0001] IMG_0551.JPG
:! Overlapping files=[480000000440002] IMG_3535.JPG
:! MFT number=67
:! Parent MFT number=54

SF/IMG_3542.JPG
:! Id=1000002
:! Size=3.92 MB (4,110,749 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:37 PM
:! Modified=6/5/2009 06:57:38 PM
:! Accessed=11/22/2022 12:35:38 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Below Average (Integrity OK, Beginning overwritten by
existing file [480000000450002])
:! Regions (sector size=512B):
:! sector 225552 size: 3.92 MB (4,110,749 Bytes) / first data
    :! other files:  [4800000005e0001] MyPhoto6.JPG
:! sector 682800 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000005e0001] MyPhoto6.JPG
:! sector 682800 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000005f0001] MyPhoto7.JPG
:! Overlapping files=[480000000450002] IMG_3542.JPG
:! MFT number=68
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:! Parent MFT number=54

SF/IMG_3579.JPG
:! Id=1000003
:! Size=3.92 MB (4,109,345 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:38 PM
:! Modified=6/5/2009 06:59:32 PM
:! Accessed=11/22/2022 12:35:39 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Below Average (Integrity OK, Beginning overwritten by
existing file [480000000460002])
:! Regions (sector size=512B):
:! sector 233584 size: 3.92 MB (4,109,345 Bytes) / first data
    :! other files:  [4800000005f0001] MyPhoto7.JPG
:! sector 682802 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000600001] MyPhoto8.JPG
:! sector 682802 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000600001] MyPhoto8.JPG
:! Overlapping files=[480000000460002] IMG_3579.JPG
:! MFT number=69
:! Parent MFT number=54

SF/IMG_3580.JPG
:! Id=1000004
:! Size=3.35 MB (3,510,477 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:39 PM
:! Modified=6/5/2009 06:59:40 PM
:! Accessed=11/22/2022 12:35:39 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Below Average (Integrity OK, Beginning overwritten by
existing file [480000000470002])
:! Regions (sector size=512B):
:! sector 241616 size: 3.35 MB (3,510,477 Bytes) / first data
    :! other files:  [480000000610001] MyPhoto9.JPG
:! sector 682804 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000610001] MyPhoto9.JPG
:! sector 682804 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000630001] 20190822_100644.jpg
:! Overlapping files=[480000000470002] IMG_3580.JPG
:! MFT number=70
:! Parent MFT number=54

SF/IMG_3581.JPG
:! Id=1000005
:! Size=4.09 MB (4,285,353 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:39 PM
:! Modified=6/5/2009 06:59:48 PM
:! Accessed=11/22/2022 12:35:40 PM
:! File type=JPEG Digital Camera
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:! Recovery chances=Below Average (Integrity OK, Beginning overwritten by
existing file [480000000480002])
:! Regions (sector size=512B):
:! sector 248480 size: 4.09 MB (4,285,353 Bytes) / first data
    :! other files:  [480000000630001] 20190822_100644.jpg
:! sector 682806 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000640001] 20190822_101620.jpg
:! sector 682806 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000640001] 20190822_101620.jpg
:! Overlapping files=[480000000480002] IMG_3581.JPG
:! MFT number=71
:! Parent MFT number=54

SF/IMG_3589.JPG
:! Id=1000006
:! Size=4.44 MB (4,651,043 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:40 PM
:! Modified=6/5/2009 07:00:18 PM
:! Accessed=11/22/2022 12:35:41 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Below Average (Integrity OK, Beginning overwritten by
existing file [480000000490002])
:! Regions (sector size=512B):
:! sector 256856 size: 4.44 MB (4,651,043 Bytes) / first data
    :! other files:  [480000000650001] 20190822_102526.jpg
:! sector 682808 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000650001] 20190822_102526.jpg
:! sector 682808 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000660001] 20190822_103830.jpg
:! Overlapping files=[480000000490002] IMG_3589.JPG
:! MFT number=72
:! Parent MFT number=54

SF/IMG_3590.JPG
:! Id=1000007
:! Size=4.67 MB (4,899,941 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:41 PM
:! Modified=6/5/2009 07:00:22 PM
:! Accessed=11/22/2022 12:35:42 PM
:! File type=NTFS Directory Entries
:! Recovery chances=Average (Signature, Unfragmented)
:! Regions (sector size=512B):
:! sector 265944 size: 4.67 MB (4,899,941 Bytes) / first data
    :! other files:  [480000000660001] 20190822_103830.jpg
:! sector 682810 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000670001] 20190822_104333.jpg
:! sector 682810 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000670001] 20190822_104333.jpg
:! MFT number=73
:! Parent MFT number=54
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SF/IMG_3591.JPG
:! Id=4a0001
:! Size=4.08 MB (4,280,042 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:42 PM
:! Modified=6/5/2009 07:00:22 PM
:! Accessed=11/22/2022 12:35:42 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 275520 size: 4.08 MB (4,280,042 Bytes) / first data
    :! other files:  [480000000370001] IMG_0869.JPG
:! sector 682812 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000370001] IMG_0869.JPG
:! sector 682812 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000380001] IMG_0873.JPG
:! MFT number=74
:! Parent MFT number=54

SF/IMG_3592.JPG
:! Id=4b0001
:! Size=5.04 MB (5,285,211 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:42 PM
:! Modified=6/5/2009 07:00:22 PM
:! Accessed=11/22/2022 12:35:43 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 283880 size: 5.04 MB (5,285,211 Bytes) / first data
    :! other files:  [480000000380001] IMG_0873.JPG
:! sector 682814 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000390001] IMG_0890.JPG
:! sector 682814 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000390001] IMG_0890.JPG
:! MFT number=75
:! Parent MFT number=54

SF/IMG_3593.JPG
:! Id=4c0001
:! Size=4.74 MB (4,969,442 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:43 PM
:! Modified=6/5/2009 07:00:26 PM
:! Accessed=11/22/2022 12:35:44 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Average (Signature, Unfragmented)
:! Regions (sector size=512B):
:! sector 294208 size: 4.74 MB (4,969,442 Bytes) / first data
    :! other files:  [4800000003a0001] IMG_1739.JPG
:! sector 682816 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000003a0001] IMG_1739.JPG
:! sector 682816 (offset: 176 ) size: 90 Bytes / resident
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    :! other files:  [4800000003b0001] IMG_3460.JPG
:! MFT number=76
:! Parent MFT number=54

SF/IMG_3594.JPG
:! Id=4d0001
:! Size=4.69 MB (4,917,237 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:44 PM
:! Modified=6/5/2009 07:00:30 PM
:! Accessed=11/22/2022 12:35:45 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Average (Signature, Unfragmented)
:! Regions (sector size=512B):
:! sector 303920 size: 4.69 MB (4,917,237 Bytes) / first data
    :! other files:  [4800000003b0001] IMG_3460.JPG
:! sector 682818 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000003c0001] IMG_3461.JPG
:! sector 682818 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000003c0001] IMG_3461.JPG
:! MFT number=77
:! Parent MFT number=54

SF/IMG_3595.JPG
:! Id=4e0001
:! Size=5.09 MB (5,338,697 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:45 PM
:! Modified=6/5/2009 07:00:32 PM
:! Accessed=11/22/2022 12:35:46 PM
:! Recovery chances=Average (Unrecognized, Unfragmented)
:! Regions (sector size=512B):
:! sector 313528 size: 5.09 MB (5,338,697 Bytes) / first data
    :! other files:  [4800000003d0001] IMG_3476.JPG
:! sector 682820 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000003d0001] IMG_3476.JPG
:! sector 682820 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000003e0001] IMG_3478.JPG
:! MFT number=78
:! Parent MFT number=54

SF/IMG_3596.JPG
:! Id=4f0001
:! Size=4.93 MB (5,174,072 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:46 PM
:! Modified=6/5/2009 07:00:34 PM
:! Accessed=11/22/2022 12:35:47 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Average (Signature, Unfragmented)
:! Regions (sector size=512B):
:! sector 323960 size: 4.93 MB (5,174,072 Bytes) / first data
    :! other files:  [4800000003e0001] IMG_3478.JPG
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:! sector 682822 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000003f0001] IMG_3479.JPG
:! sector 682822 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000003f0001] IMG_3479.JPG
:! MFT number=79
:! Parent MFT number=54

SF/IMG_3608.JPG
:! Id=500001
:! Size=5.01 MB (5,257,021 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:47 PM
:! Modified=6/5/2009 07:01:28 PM
:! Accessed=11/22/2022 12:35:48 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Average (Signature, Unfragmented)
:! Regions (sector size=512B):
:! sector 334072 size: 5.01 MB (5,257,021 Bytes) / first data
    :! other files:  [480000000400001] IMG_3480.JPG
:! sector 682824 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000400001] IMG_3480.JPG
:! sector 682824 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000410001] IMG_3481.JPG
:! MFT number=80
:! Parent MFT number=54

SF/IMG_3627.JPG
:! Id=510001
:! Size=3.48 MB (3,651,691 Bytes)
:! Flags=deleted
:! Created=11/22/2022 12:35:48 PM
:! Modified=6/5/2009 07:02:36 PM
:! Accessed=11/22/2022 12:35:48 PM
:! Recovery chances=Average (Unrecognized, Unfragmented)
:! Regions (sector size=512B):
:! sector 344344 size: 3.48 MB (3,651,691 Bytes) / first data
    :! other files:  [480000000410001] IMG_3481.JPG
:! sector 682826 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000001000000] IMG_3493.JPG
:! sector 682826 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000001000000] IMG_3493.JPG
:! MFT number=81
:! Parent MFT number=54

MyPhoto6.JPG
:! Id=5e0001
:! Size=1.07 MB (1,123,560 Bytes)
:! Created=11/22/2022 12:35:56 PM
:! Modified=4/29/2009 02:54:46 AM
:! Accessed=11/22/2022 12:35:56 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
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:! sector 436440 size: 1.07 MB (1,123,560 Bytes) / first data
    :! other files:  [4800000004c0001] IMG_3593.JPG
:! sector 682852 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000004d0001] IMG_3594.JPG
:! sector 682852 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000004d0001] IMG_3594.JPG
:! MFT number=94
:! Parent MFT number=5

MyPhoto7.JPG
:! Id=5f0001
:! Size=842.76 KB (862,983 Bytes)
:! Created=11/22/2022 12:35:56 PM
:! Modified=4/29/2009 02:55:06 AM
:! Accessed=11/22/2022 12:35:56 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 438640 size: 842.76 KB (862,983 Bytes) / first data
    :! other files:  [4800000004e0001] IMG_3595.JPG
:! sector 682854 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [4800000004e0001] IMG_3595.JPG
:! sector 682854 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [4800000004f0001] IMG_3596.JPG
:! MFT number=95
:! Parent MFT number=5

MyPhoto8.JPG
:! Id=600001
:! Size=997.99 KB (1,021,937 Bytes)
:! Created=11/22/2022 12:35:56 PM
:! Modified=4/29/2009 02:55:30 AM
:! Accessed=11/22/2022 12:35:57 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 440328 size: 997.99 KB (1,021,937 Bytes) / first data
    :! other files:  [4800000004f0001] IMG_3596.JPG
:! sector 682856 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000500001] IMG_3608.JPG
:! sector 682856 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000500001] IMG_3608.JPG
:! MFT number=96
:! Parent MFT number=5

MyPhoto9.JPG
:! Id=610001
:! Size=3.37 MB (3,533,017 Bytes)
:! Created=11/22/2022 12:35:57 PM
:! Modified=4/29/2009 02:56:50 AM
:! Accessed=11/22/2022 12:35:57 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
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:! Regions (sector size=512B):
:! sector 442328 size: 3.37 MB (3,533,017 Bytes) / first data
    :! other files:  [480000000510001] IMG_3627.JPG
:! sector 682858 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [480000000510001] IMG_3627.JPG
:! sector 682858 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [480000000530001] IMG_0510.JPG
:! MFT number=97
:! Parent MFT number=5

Other recovery list formats

You may export recovery lists in the following formats:

XML format

Export Recovery List dialog box for the XML format

JSON format

Custom recovery lists in the text format contains more information about files than simple recovery lists.

Export Recovery List dialog box for the JSON format

CSV format

Custom recovery lists in the text format contains more information about files than simple recovery lists.

Export Recovery List dialog box for the CSV format
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CSV Options dialog box

3.3 Drive Copy Wizard

You may copy any object in the Drives panel to any other object, if there is enough space on the target one.

Before Copy object to... becomes enabled on the Create menu, you need to enable writing.

To enable writing,

1 In the R-Studio main panel, select the Tools menu, then Settings, and select Enable Write on the

Settings dialog box.

> The Copy object to... will be enabled on the Create menu.

Now objects can be copied.

While the objects are being copied, you may change some parameters and view the I/O monitor on the Object
Copy Progress dialog box.

You may change some options during the copy process
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Depending on the objects to copy and your tasks, you may do:

Binary (byte to byte copy)

An exact copy of the source object (or a part thereof) to the destination device (from its beginning or a specified
offset). Any object may be copied to any object this way.

To perform a binary copy of an object,

1 Select Copy object to... on the Create menu

2 Select a source and destination objects in the Drives Copy Wizard panel and click the Next button

Drives Copy Wizard

3 Select Binary (byte to byte) copy on the Copy Options dialog box, specify copy options, and click the
Next button

Copy options dialog box

 Copy options

Source

Copy whole object Select this option if you want to copy the entire source object to the destination one
Copy range Select this option if you want to copy a part of the source object
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Offset Specify the offset from which the source object data will be copied to the destination
object

Size Specify the size of the source object data which will be copied to the destination
object

Destination

Offset Specify the offset on the destination object to which the source object data will be
copied

3 View the copy task settings on the Drives Copy Wizard and click the Finish button

Drives Copy Wizard

or click the <- Drive Copy Wizard button to edit the copy parameters

> R-Studio will start copying data from the source object to the destination one.

Smart partition copy

Only partitions can be copied with this option to other partitions or empty spaces. You may change some
parameters of the the copied partition(s) on the destination drive.

To perform a smart partition copy of a partition,

1 Select Copy object to... on the Create menu

https://www.r-studio.com/What-is-Disk-Partition.html
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2 Select source and destination partitions in the Drives Copy Wizard  panel and click the Next button

Drives Copy Wizard

3 Select Smart partition copy in the Copy Options panel, specify copy options, and click the Next button

Copy options dialog box

 Copy options

Destination

Copy without
stretching 

Select this option if you want to copy the partition exactly to the destination place

Copy to: Select this option if you want to change some parameters of the copied partition on
the destination place

Free space before Specify how much space will be left empty before the start of the copied partition
Partition size Select this option and specify the new size of the copied partition
Partition type
Primary (Active)/?
Primary/?Logical

Specify the type of the partition to be copied. Do not change this setting unless you
have serious reasons to do so.
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3 View the copy task settings on the Drives Copy Wizard and click the Finish button

Drives Copy Wizard

or click the Drive Copy Wizard button to edit the copy parameters

> R-Studio will start copying data from the source partition to the destination place.

Smart drive copy

Only  whole drives  can be copied with this option to other drives. You may change some parameters of the
copied drives.

To perform a smart drive copy of a drive,

1 Select Copy object to... on the Create menu

2 Select a source and destination drives in the Drives Copy Wizard panel and click the Next button

Drives Copy Wizard
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3 Select Smart drive copy in the Copy Options panel, specify copy options, and click the Next button

Copy options dialog box

 Copy options

Copying mode

Copy all partitions
onto original places

Select this option if you want to copy all partitions to their original places.

One partition after
another

Select this option if you want to copy the partitions one after another preserving their
space. If there is empty space between the partitions, it will be omitted. Otherwise it
is similar to Copy all partitions onto original places.
If Fixed active partition is selected, the original offset/?size of the active partition will be
preserved (in case the loader has links to it).

Expand/?Shrink
partition to whole
drive

Specify this option if you want to proportionally expand/?shrink the selected partitions
to occupy the entire target drive. 
If Fixed active partition is selected, the original offset/?size of the active partition will be
preserved (in case the loader has links to it).
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3 View the copy task settings on the Drives Copy Wizard and click the Finish button

Drives Copy Wizard

or click the Cancel button to cancel this process.

> R-Studio will start copying data from the source drive to the destination one.

3.4 File Maps

R-Studio can show file maps. Right-click  the file and select Map of file in their shortcut menu.

File Map
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3.5 I/O Monitor and Sector Map Files

These features greatly improves working with failing drives for R-Studio.

I/O Monitor

I/O Monitor allows you to inspect the process of drive input/output operations in real time. When R-Studio
performs a disk operation the I/O Monitor button becomes active.

Click this button, and the I/O Monitor will appear.

I/O Monitor

You may also start I/O Monitor from the shortcut menu and progress dialog boxes during various drive
operations.

Sector Map Files

Sector map files are files that contain information about conditions of drive sectors, which may be good, bad,
slow, and unstable. R-Studio estimates chances for successful file recovery basing on these files and avoiding
unnecessary attempts to read bad sectors. Sector map files are crucial for multi-pass imaging.

R-Studio creates its own sector map files or can import such files created from other disk imaging programs.
Currently R-Studio supports sector map files from HDDSuperClone and DDRescue. 

To open, save or clean a sector map file for an object,

* Right-click the object and select Open Sector Map, Save Sector Map, or Clean Sector Map,
respectively, on the shortcut menu.

You may look at the graphical representation of the loaded sector map by starting I/O Monitor.

Sector Map 

https://www.r-studio.com/What-is-a-Sector-Map-File.html
https://www.r-studio.com/What-are-Bad-Sectors.html
http://www.hddsuperclone.com/sitev1/
http://www.gnu.org/software/ddrescue/
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3.6 Runtime Imaging

Runtime imaging is image creation for a drive object performed simultaneously with other data read operations
from this drive. When R-Studio reads data from a certain area of the source (a drive, partition, or region), it
writes the data to the target which can be either a dedicated drive or an image file. When the data from this area
is needed again, R-Studio reads it from the target rather than the source thus reducing access to the source. This
is very important for faulty or unstable drives which health may be constantly deteriorating during data recovery
operations. 

R-Studio also creates a sector map file during runtime imaging.

To start runtime imaging of an object,

using a plain image file

1 Select a drive object in the R-Studio's Drives panel and click the Start Runtime Image button, 

or right-click the object and select Set Runtime Image on the shortcut menu.

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-a-Sector-Map-File.html
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Runtime imaging

Select Plain or VMDK image file in the Image type field, specify the file name and path for the image and
sector map files, and click the OK button. Don't select the VMDK image file unless you can disable writing to
the drive. Cloning to a physical drive is not recommended because Windows can write some data to the
drive corrupting the imaged data when the image has been completed and runtime imaging is over.

Plain image file requires immediate allocation of disk space equal to the object size, whereas VMDK image

file is growing gradually upon imaging progress.

> R-Studio will turn on runtime imaging.

Runtime imaging

Select the object and click the Stop Runtime Imaging button or item in the shortcut o menu turn runtime
imaging off.

using a physical drive

1 Select a drive object in the R-Studio's Drives panel and click the Start Runtime Image button, 

or right-click the object and select Set Runtime Image on the shortcut menu.1



R-Studio Manual205

© 2023 R-Tools Technology Inc.

Runtime imaging

Select Physical drive in the Image type field, specify the name and path for the sector map file, and click the
OK button.

Note: all data on the drive will be destroyed. 

> R-Studio will turn on runtime imaging.

Runtime imaging

Select the object and click the Stop Runtime Imaging button or select this item in the shortcut menu to turn
runtime imaging off.

R-Studio stores the information about runtime configurations and asks the users whether they want to keep

runtime imaging or discard it during its startup.

Runtime imaging
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This configuration will appear in R-Studio.

Runtime imaging

Completing Runtime Image

You may complete the runtime image without browsing through the entire file system on the disk.

1 Select the object being imaged and click the Complete Runtime Image button, 

or right-click the object and select Complete Runtime Image on the shortcut menu.

Runtime imaging

> The Complete Runtime Imaging dialog box will appear.

Runtime imaging

Select the necessary parameters of multi-pass imaging and select the OK button.
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> R-Studio will complete the creation of the runtime image.

If the runtime image has not been completed, you may resume it next time you start runtime imaging.

Runtime imaging

Creating runtime image for individual files

You may create a runtime image containing only individual files rather than all data on the disk.

1 Open the disk with the files, mark the files, and click the Save marked to runtime image button.

or right-click on the right pane, and select Complete Runtime Image on the shortcut menu.

Runtime imaging
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> The Complete Runtime Imaging dialog box will appear.

Runtime imaging

Select the necessary parameters of multi-pass imaging and select the OK button. You may Skip files with bad

sectors if necessary.

> R-Studio will complete the creation of the runtime image.

You may open such images as regular ones. 

Runtime imaging

Such image contains information about the entire file system, but if a non-imaged file is opened, it'll contain
only zeros.

3.7 Multi-pass Imaging

Multi-pass imaging is a process of image creation through several passes (phases). Each phase reads data from
different areas of a hard drive, starting from areas with good sectors then going to slow sector areas and finishes
with bad sector areas. This approach maximizes the amount of data that can be recovered from a failing drive
and reduces it chances to fail during this process. 

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-are-Bad-Sectors.html
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Phase 1. Copying most good data from the drive

In this phase, R-Studio reads data from drive by sector blocks, or groups of consecutive drive sectors read in
one go. The phase is performed in several steps.

Step 1. R-Studio reads data from the drive until it runs into a block with bad or slow sector(s). Then it drops
that block and jumps to another area until it finds a block with no bad or slow sectors. Then it continues reading
data until it runs into another bad or slow block, and the process repeats. When this step is finished, most good
data from the hard drive has been read, and R-Studio has detected the front blocks (edges) of bad and slow
sector areas.

Step 2. R-Studio finds the rear edges of bad sector areas. It reads the skipped area from its rear end backwards
until it runs into a block with a bad sector. Then R-Studio jumps to another bad sector area and the process is
going on until all bad sector areas have been processed. When this step is finished, some good data from the
hard drive has been read, and R-Studio has detected the rear edges of bad sector areas.

Step 3. R-Studio reads data from slow sector areas. It does that much the same way as for bad sector areas. 
When this step is finished, good data from slow sectors on the hard drive has been read, and R-Studio has
detected the rear edges of slow sector areas.

Step 4. R-Studio finds the rear edges of bad sector areas in slow sector areas. When this step is finished, some
new good data from slow sectors on the hard drive has been read, and R-Studio has detected the rear edges of
all bad sectors within slow sector areas.

Step 5. R-Studio tries to read all skipped sector blocks. This is done without skipping bad sector blocks and
checking read speed against minimum I/O rate.

When Phase 1 is completed, R-Studio has read most of readable data and detected front and rear edges of all
bad sector areas.

R-Studio tries to read the rest of data in the next phases, and does that sector by sector (rather than blocks).

Phase 2. Trimming

R-Studio detects the front and rear sectors of bad sector areas. When this step is finished, some new good data
from bad sector areas has been read, and R-Studio has detected the front and rear sectors of all bad sector
areas.

Phase 3. Scraping

R-Studio tries to read data from bad sector areas sector by sector.

Phase 4. Retrying (mostly optional)

R-Studio tries to read data from bad sectors through several attempts. 

You may read more about this process in our article Multi-pass imaging in R-Studio

To create an image through multi-pass imaging,

1 Select an object in the R-Studio's Drives panel and click the Create Image button

 Other ways to create the image

· Select the object and select Create Image on the Drive menu

http://www.r-studio.com/Multipass-imaging-damaged-drives.html
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or
· Right-click the selected object and select Create Image File on the shortcut menu

2 Specify image options, a file name, and destination for the image on the Create Image dialog box and
click the OK button

Create Image (Bad sector processing) dialog box

Bad sectors processing options
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Image filename Specifies the name and path for the image file
Image type: Compressed image (R-Drive Image compatible): If this option is selected, R-Studio

will create an image file which can be compressed, split into several parts, and
password-protected. This image file is fully compatible with the images created
by R-Drive Image, but incompatible with the previous versions of R-Studio.
Byte by byte image: If this option is selected, R-Studio will create a simple exact
copy of the object.
VMDK (ViMware Virtual Machine Disk) image: If this option is selected, R-Studio
will create an image of the VMware virtual disk type. Available in the Corporate,
Technician, and T80+ license.

Drive sector map file A file with the sector map of the object to image. Optional for the RDI image
type, mandatory for the byte-by-byte and VMDK image types.

Enable multi-pass
image creation

Turns multi-pass imaging on and off.

Data to process All data: All data on the disk will be imaged.
Existing files only (FS bitmap): Only the disk's area where existing files reside will
be imaged.
Unused clusters only: Only the disk's free space will be imaged.
You may image the existing files first and then unused clusters. 

Perform reading in
reverse order if possible

Switches the direction of all phases/steps to reverse.

Minimum skip size Minimum size of drive area to skip when a bad sector is encountered.
Maximum skip size Maximum size of drive area to skip when a bad sector is encountered.
Number of retries
(Retrying phase)

The number of read attempts in the Retrying phase.

Disable imaging phases Multi-imaging phases that can be skipped.

> R-Studio will start creating the image, the Progress message showing the progress.

Multi-pass imaging progress dialog box

3.8 Reverse RAIDs

Reverse RAIDs is a technique that is reverse to creating virtual RAIDs. When creating a reverse RAID, the data
from a real object is decomposed into virtual parents.Then data on those virtual parents can be processed like on
real objects. They can be viewed, edited, imaged, copied to physical drives, etc.

· Reverse RAID of an Object
This technique can be used to decompose data on a single volume into virtual parents. Then such virtual parents
can be processed like on real objects. They can be viewed, edited, imaged, copied to physical drives, etc.

http://en.wikipedia.org/wiki/VMDK
https://www.r-studio.com/What-is-a-Sector-Map-File.html
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· Reverse RAID of a RAID
This technique can be used to re-construct data on individual RAID drives when data on physical drives is
corrupted, but can be recovered using RAID redundancy. A missing drive is an example of this case. Or if
there are bad sectors scattered over the physical drives but the overall RAID integrity remains. Then the data
can be copied to physical drives to create a healthy RAID.

Note: Many controllers write their own metadata to drives to recognize that the drives belong to certains RAIDs.
Without that metadata they won't see those RAIDs. You have to write that metadata manually.

3.8.1 Reverse RAID of an Object

This technique can be used to decompose data on a single object into virtual parents. Then such virtual parents
can be processed like on real objects. They can be viewed, edited, imaged, copied to physical drives, etc.

Suppose you have an image of a former RAID 6 (Reed-Solomon) and you wand to re-create data on individual
drives from that RAID 6. You can do that by creating a reverse RAID of an  image. 

Note: Many controllers write their own metadata to drives to recognize that the drives belong to certains RAIDs.
Without that metadata they won't see those RAIDs. You have to write that metadata manually.

To create a reverse RAID of a drive image (or other drive object),

1 Right-click the drive object in the Drives panel and select Create Reverse RAID on the shortcut menu.

> The Reverse parents will appear in the Drives panel

Initially, the reverse RAID is set to its default values as RAID 5 on the Parents tab.

https://www.r-studio.com/What-are-Bad-Sectors.html
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2 Adjust RAID parameters on the Parents tab, as necessary. 

You need to add one reverse parent, change RAID type, and adjust RAID offset .

> Process the appeared reverse parents in the Drives panel as real objects.

These parents can be imaged, viewed/?edited, etc.

3.8.2 Reverse RAID of a RAID

This technique can be used to re-construct data on individual RAID drives when data on physical drives is
corrupted, but can be recovered using RAID redundancy.



R-Studio Technician/T80+ 214

© 2023 R-Tools Technology Inc.

Suppose you have a RAID 5 with one missing drive and you need to reconstruct data on that drive. You can do
that by creating a reverse RAID for it and then copy data from that missing drive to a real one, or to an image. 

Note: Many controllers write their own metadata to drives to recognize that the drives belong to certains RAIDs.
Without that metadata they won't see those RAIDs. You have to write that metadata manually.

To create a reverse RAID of a RAID with a missing drive,

1 Create a virtual RAID 5 of the existing drives or their images

Add a missing drive to the Parents tab.

If necessary, read the Basic RAID 4 and RAID 5 Operations and Volumes Sets and RAIDs help pages for
details. 

2 Right-click the Virtual Block Raid in the Drives panel and select Create Reverse RAID on the shortcut
menu.

> The Reverse parents will appear in the Drives panel

These parents may be processed as real objects, they can be imaged, viewed/?edited. For your case the
missing drive can be copied to a drive in the Drive Copy Wizard.
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Note: The reverse parents contain the data that should be on the RAID parents, according to its layout,
while RAID parents contain actual data, that may be corrupted. 

3.9 Working with the Third-Party Hardware

The Technician/T80+ version of R-Studio can work together with third-party hardware developed for in-depth
data recovery. Currently, the following devices are supported:

· DeepSpar Disk Imager™
· DeepSpar USB Stabilizer
· DeepSpar RapidSpar
· PC-3000 UDMA hardware

3.9.1 DeepSpar Disk Imager™

DeepSpar Disk Imager™ (DDI) is an HDD imaging device specifically built for data recovery from drives
with hardware issues. It greatly increases imaging speed, accuracy, and integrity of data retrieved from such
drives. 

The main features that DDI provides when working with drives are the following: 

· Direct low-level access to a drive bypassing the computers BIOS.
· Disabling specific drive read/?write heads.
· Disable SMART subsystem, Bad Sector Reallocation, and Read Look-Ahead
· Read sector timeout controlled by Software/?Hardware/?PHY drive reset commands
· Bit level analysis of corrupted data to filter out the read-write channel noise
· Fully customizable multi-pass imaging

And many more others an advanced drive imager must have. You may learn more about DDI on its vendor site:
DeepSpar Disk Imager™.

DeepSpar Disk Imager™ basics

The main idea of data recovery with DDI is to clone data from the source drive with a certain level of hardware
malfunction to a clone drive and perform data recovery operations either from the clone drive or while data is
being cloned. Such approach greatly reduces tear and wear of the source drive and reduces further deterioration
of its state.

https://www.r-studio.com/What-is-Data-Recovery-Hardware.html
http://ww.deepspar.com/products-ds-disk-imager.html
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There are two modes in which DDI processes drives: 

· DDI clones the entire source drive to the source one consequently, sector by sector. Any further data
recovery will be made from the clone HDD. 

· DDI clones those sectors of the source HDD which have been read during data recovery. Such readings
are optimized to minimize the movement of the drive's head unit. All following reads from those sectors will
be done from the clone drive. For example, if files are to be recovered from a partition on the drive, DDI
will clone the boot record of the drive, the file table of the partition, and the sectors of the files. If the
partition is scanned, the scanned sectors will be cloned, too. All consecutive operations, such as file
preview, and so on, will be done from the clone drive. This greatly reduces the time necessary to perform
the recovery operations and furthermore drive wear. 

DeepSpar Disk Imager™ board

Read the DDI documentation on how to install DDI  connect the drives to DDI and start working with it. 

The DDI board should be installed into a separate network computer (the DDI computer), and the source and
clone drives should be connected to it. The DDI computer should be started using the boot USB stick supplied
with the board. R-Studio running on another computer (the R-Studio computer) accesses the drive via the
network. All data recovery operations will be done through this setup:

https://www.r-studio.com/What-is-Disk-Partition.html
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There may be several DDI computers on the network, R-Studio will connect to all of them. Such configuration
may be useful for RAID recovery when several drives on the RAID have hardware problems.

Working with DDI

To start working with DDI, its computer should be connected to R-Studio.

To connect  R-Studio to the DDI computer,

* Select Connect to DDI on the Drive menu

> The drives connected to DDI will appear in the Drive pane.

Now it is possible to work with drives connected to DDI like all other drive objects in the Drive panel. For
example, such drives may be included into virtual RAIDs and other compound objects.
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Viewing the drive map

A drive map shows the conditions for individual drive sectors. You may see which sectors are OK, bad, or
unstable. 

To view the drive map, 

* Right-click the required drive/?partition and select I/O Monitor on the shortcut menu,

or

select the object and select I/O Monitor on the Drive menu

> The drive map will appear in the I/O Monitor window.

DDI I/O Monitor window

You may also image individual files and view file maps.

R-Studio can also load and process images created with the DeepSpar Disk Imager™.

Connecting to DeepSpar Disk Imager™ manually

If R-Studio cannot find DeepSpar Disk Imager™, the Select Interface dialog box will appear. Try to find the
DDI interface manually. 
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3.9.2 DeepSpar USB Stabilizer

This hardware works under Windows 10/11-64 bits
USB Stabilizer is a device that allows any Windows software to reliably work with unstable/degraded USB
storage devices providing a connection between the computer and source device. The storage devices can be
hard drives, SSD devices, USB memory sticks, memory cards connected through a special adapter, etc.
Windows shows such device as if it was connected directly to the system providing access to it for R-Studio.

If any drive issue occurs, USB Stabilizer handles this issue drive issues preventing the system from freezes,
crashes, or disconnecting the drive. Such handling may include various drive resets or even drive repower without
system loosing the device.

You may learn more about USB Stabilizer on its vendor's USB Stabilizer or our sites.

Installing USB Stabilizer:

USB Stabilizer Tech/Pro

1 Connect the USB Stabilizer to your computer and power it on 

There should be no device connected.

The USB STABILIZER object should appear in the Safely Remove Hardware menu when USB Stabilizer
is connected..

2 Run R-Studio, locate the DEEPSPAR NO DEVICE object in the Device/Disk panel, and click the Install

driver button on the Properties tab.

There should be no device connected.

The USB STABILIZER object should appear in the Safely Remove Hardware menu 

https://www.r-studio.com/What-is-Solid-State-Device-SSD.htm
http://www.deepspar.com/usb-stabilizer.html
http://www.r-studio.com/USB-Stabilizer-for-unstable-drives.html
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DeepSpar USB Stabilizer

R-Studio will start installing the drivers. You need to restart your system to complete installation.

> The DEEPSPAR: POWER OFF object will appear in the the Device/Disk panel.

DeepSpar USB Stabilizer

R-Studio is now ready for work with USB Stabilizer.

USB Stabilizer Pro

1 Connect the USB Stabilizer to your computer and power it on 

There should be no device connected.

The USB STABILIZER object should appear in the Safely Remove Hardware menu when USB Stabilizer
is connected..

2 Run USB Stabilizer Control Panel that comes with USB Stabilizer Pro and click the Install
button.

There should be no device connected.
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DeepSpar USB Stabilizer Pro

Control Panel will start installing the drivers. You need to restart your system to complete installation.

> The DEEPSPAR: POWER OFF object will appear in the the Device/Disk panel.

DeepSpar USB Tech Stabilizer

R-Studio is now ready for work with USB Stabilizer.
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Working with USB Stabilizer:

1 Connect the device for recovery to USB Stabilizer and click the Power button

DeepSpar USB Stabilizer

> R-Studio will show the USB Stabilizer's drive.

DeepSpar USB Stabilizer

It may take quite a long time to turn the drive on depending on the drive conditions. R-Studio will show the
DEEPSPAR: DEVICE IS BUSY line if there's not enough power for the hard drive to work. That may happen
when computer's USB port cannot deliver enough power and the external power supply is disconnected.
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R-Studio can now process the USB Stabilizer drive as it's a common drive connected to a USB port. 

You may read about USB Stabilizer parameters in its  manual.

You may change other parameters for USB Stabilizer Pro through its Control Panel.

USB Control PanelStabilizer

Read the USB Stabilizer Pro documentation for more details.

You may change these parameter during drive operations with USB Stabilizer.

DeepSpar USB Stabilizer

You may also watch drive read operations in real time at the I/O monitor.

.DeepSpar USB Stabilizer
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You may specify the algorithm to process faulty drives. Click the Edit algorithm button and specify algorithm's
parameters.

.DeepSpar USB Stabilizer

3.9.3 DeepSpar RapidSpar™

RapidSpar is a specialized data recovery device from DeepSpar intended to extract data from problematic
drives. Failing (source) and target drives are connected to the device, and it autonomously copies data from the
source to the target in a way that maximizes the amount of successfully extracted data and minimizes possible
damage to the source drive. The copy parameters can be quickly changed during this process directly on the
device. Then the recovery software can read data from the target drive. 

When connected to a PC, the specialized software (including R-Studio) can read (and clone) only those drive
areas that contain the necessary files and folders to decrease time required for data recovery.

In addition, it's possible to perform some repair works with hard drives.

You may read more about RapidSpar on its web site.

https://www.deepspar.com/
https://www.rapidspar.com/
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RapidSpar doesn't require any installed drivers.

Working with RapidSpar:

1 Connect the source and target hard drives to RapidSpar and start the device.

Refer to the RapidSpar manual for detailed instructions.

DeepSpar RapidSpar
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> R-Studio will show the RapidSpar drive.

DeepSpar RapidSpar

Read the RapidSpar documentation for the information about its parameters.

R-Studio can now process the RapidSpar drive as it's a common drive connected to a USB port. 

You may change these parameter during drive operations with RapidSpar.

DeepSpar RapidSpar

You may also watch drive read operations in real time at the I/O monitor.

.DeepSpar RapidSpar
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3.9.4 PC-3000 UDMA hardware

PC-3000 UDMA form ACELab® is a hardware-software solution for hard drive repair and data recovery. Its
hardware part is a PCI-Express card that can work with both IDE and SATA hard drives providing access to
hard drives with severe physical failures. Its software part is Data Extractor UDMA that performs actual data
recovery. The PC-3000 UDMA card can be used alone for raw data extraction and drive repair. 

R-Studio can work directly with the PC-3000 UDMA card as an alternative to data recovery software. Our
article Joint work of R-Studio and PC-3000 UDMA hardware explains this in more detail. 

3.10 Forensic Mode

Note: This feature is available for the Technician/T80+ version of R-Studio only!

When this mode is enabled, R-Studio will generate a forensic data collection audit log that can be presented at
court hearings. This log includes information about a hardware configuration on which the forensic data collection
takes place and MD5 for recovered files.

Note: A new log will be generated each time the hardware configuration is changed (a drive is connected/?
disconnected, an external USB device is connected/?disconnected, etc)

http://www.acelaboratory.com/
http://www.r-studio.com/improve-pc3000-data-analysis.html
https://www.r-studio.com/What-is-a-Computer-Forensic-Analysis.html
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To enable this feature,

* Select Enable Forensic Mode on the Main tab of the Settings dialog box.

The Forensic Log tab will appear on the Recover dialog box.

Forensic Log tab

Enter the required information on this tab and then go to the other tabs of the  Recovery dialog box.

While file recovery, R-Studio will create forensic data collection audit log in the specified folder. Below is an
example of such log.
******************************** Forensic Data Collection Audit Log
********************************

R-Studio Technician

**************************************** Drives Information
****************************************

- Drive Number 0 ---------------------------------
* Drive Type [256 bytes]: Computer,Local Computer
* Name [30 bytes]: Local Computer
* OS [46 bytes]: Windows 10 Build 19044
* System [136 bytes]: 4 x Intel(R) Core(TM) i5-4570 CPU @ 3.20GHz, 3200 MHz, 16294
MB RAM

- Drive Number 4 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Disk
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* Name [62 bytes]: KINGSTON SA400S37120G 03090005
* OS Object [38 bytes]: \\.\PhysicalDrive0
* R-Studio Driver [44 bytes]: WinNT\Handle\Physical
* Size [8 bytes]: 111.7GB (234441648 sec)
* Sector Size [4 bytes]: 512B
* Partition Size [8 bytes]: 111.7GB (234441648 sec)
* GPT Disk GUID [74 bytes]: 69e6114c-6751-5e84-ed6d-8ece5d5616b4
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 14593
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
# Partition Layout Sector Size [4 bytes]: 512B
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: KINGSTON
  * Product [64 bytes]: SA400S37120G
  * Firmware [16 bytes]: 03090005
  * Serial Number [32 bytes]: 50026B77843A5618
+ IDE Properties [8 bytes]: 
  * Size [48 bytes]: 111.7GB (234441648 LBA)
  * Sector Size [8 bytes]: 512
  * Device Type [8 bytes]: SSD
  * Interface [38 bytes]: SATA 3.2, 6.0 Gb/s
  * Interface Speed [18 bytes]: 6.0 Gb/s
  * Standard [12 bytes]: ACS-3
  * Features [70 bytes]: S.M.A.R.T., APM-, LBA48, NCQ, TRIM
+ SCSI Address [8 bytes]: 
  * Port Number [1 bytes]: 2
  * Path Id [1 bytes]: 0
  * Target Id [1 bytes]: 0
  * Lun [1 bytes]: 0
* Bus Type [4 bytes]: SerialATA-II

- Drive Number 5 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Disk
* Name [56 bytes]: TOSHIBA DT01ACA100 MS2OA750
* OS Object [38 bytes]: \\.\PhysicalDrive1
* R-Studio Driver [44 bytes]: WinNT\Handle\Physical
* Size [8 bytes]: 931.5GB (1953525168 sec)
* Sector Size [4 bytes]: 512B
* Partition Size [8 bytes]: 931.5GB (1953525168 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 121601
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  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
# Partition Layout Sector Size [4 bytes]: 512B
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: TOSHIBA
  * Product [64 bytes]: DT01ACA100
  * Firmware [16 bytes]: MS2OA750
  * Serial Number [32 bytes]: 44H5ATLKS
+ IDE Properties [8 bytes]: 
  * Size [50 bytes]: 931.5GB (1953525168 LBA)
  * Logical Sector Size [8 bytes]: 512
  * Physical Sector Size [10 bytes]: 4096
  * Device Type [36 bytes]: HDD 3.5" 7200 RPM
  * Interface [38 bytes]: SATA 3.0, 6.0 Gb/s
  * Interface Speed [18 bytes]: 6.0 Gb/s
  * Standard [18 bytes]: ATA8-ACS
  * Features [58 bytes]: S.M.A.R.T., APM-, LBA48, NCQ
+ SCSI Address [8 bytes]: 
  * Port Number [1 bytes]: 2
  * Path Id [1 bytes]: 1
  * Target Id [1 bytes]: 0
  * Lun [1 bytes]: 0
* Bus Type [4 bytes]: SerialATA-II

- Drive Number 6 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Disk
* Name [62 bytes]: WDC WD1200BEVT-22ZCT0 11.01A11
* OS Object [38 bytes]: \\.\PhysicalDrive2
* R-Studio Driver [44 bytes]: WinNT\Handle\Physical
* Size [8 bytes]: 111.7GB (234441648 sec)
* Sector Size [4 bytes]: 512B
* Partition Size [8 bytes]: 111.7GB (234441648 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 14593
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
# Partition Layout Sector Size [4 bytes]: 512B
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: WDC
  * Product [64 bytes]: WD1200BEVT-22ZCT0
  * Firmware [16 bytes]: 11.01A11
  * Serial Number [32 bytes]: WD-WXE808HN3826
+ IDE Properties [8 bytes]: 
  * Size [48 bytes]: 111.7GB (234441648 LBA)
  * Sector Size [8 bytes]: 512
  * Interface [38 bytes]: SATA 2.5, 3.0 Gb/s
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  * Standard [18 bytes]: ATA8-ACS
  * Features [66 bytes]: S.M.A.R.T., APM, AAM, LBA48, NCQ
+ SCSI Address [8 bytes]: 
  * Port Number [1 bytes]: 2
  * Path Id [1 bytes]: 4
  * Target Id [1 bytes]: 0
  * Lun [1 bytes]: 0
* Bus Type [4 bytes]: SerialATA-II

- Drive Number 7 ---------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [6 bytes]: C:
* Mount Points [8 bytes]: C:\
* OS Object [98 bytes]: \\?\Volume{daf04b8f-aece-4176-9e12-25271c9682d5}
* R-Studio Driver [42 bytes]: WinNT\Handle\Logical
* Size [8 bytes]: 111.1GB (233156718 sec)
* Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 117MB (239616 sec)
* Partition Size [8 bytes]: 111.1GB (233156718 sec)
* Partition Number [4 bytes]: 3
* GPT Partition GUID [74 bytes]: daf04b8f-aece-4176-9e12-25271c9682d5
* GPT Type GUID [256 bytes]: Data Partition, ebd0a0a2-b9e5-4433-87c0-68b6b72699c7
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 3GB (6291456 sec)
  * MFT Mirror Position [8 bytes]: 8KB (16 sec)
  * Index Block Size [4 bytes]: 4KB
  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 111.1GB (233156717 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 14593
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
+ SCSI Address [8 bytes]: 
  * Port Number [1 bytes]: 2
  * Path Id [1 bytes]: 0
  * Target Id [1 bytes]: 0
  * Lun [1 bytes]: 0
* Bus Type [4 bytes]: SerialATA

- Drive Number 8 ---------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [90 bytes]: Volume{06a81b86-6c2b-4a3c-9170-fff1161fb034}
* OS Object [98 bytes]: \\?\Volume{06a81b86-6c2b-4a3c-9170-fff1161fb034}
* R-Studio Driver [42 bytes]: WinNT\Handle\Logical
* Size [8 bytes]: 508MB (1040384 sec)
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* Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 111.2GB (233398272 sec)
* Partition Size [8 bytes]: 508MB (1040384 sec)
* Partition Number [4 bytes]: 4
* GPT Partition GUID [74 bytes]: 06a81b86-6c2b-4a3c-9170-fff1161fb034
* GPT Type GUID [256 bytes]: Windows Recovery Partition, de94bba4-06d1-4d40-a16a-
bfd50179d6ac
* GPT Partition Attributes [256 bytes]: System, No automount (0x8000000000000001)
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 169.3MB (346792 sec)
  * MFT Mirror Position [8 bytes]: 8KB (16 sec)
  * Index Block Size [4 bytes]: 4KB
  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 507.9MB (1040383 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 14593
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
+ SCSI Address [8 bytes]: 
  * Port Number [1 bytes]: 2
  * Path Id [1 bytes]: 0
  * Target Id [1 bytes]: 0
  * Lun [1 bytes]: 0
* Bus Type [4 bytes]: SerialATA

- Drive Number 9 ---------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [6 bytes]: D:
* Mount Points [8 bytes]: D:\
* OS Object [98 bytes]: \\?\Volume{78addf5b-0000-0000-0000-100000000000}
* R-Studio Driver [42 bytes]: WinNT\Handle\Logical
* Size [8 bytes]: 931.5GB (1953519616 sec)
* Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 1MB (2048 sec)
* Partition Size [8 bytes]: 931.5GB (1953519616 sec)
* Partition Number [4 bytes]: 1
* Partition Type [256 bytes]: NTFS/HPFS/exFAT (0x7)
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 3GB (6291456 sec)
  * MFT Mirror Position [8 bytes]: 8KB (16 sec)
  * Index Block Size [4 bytes]: 4KB
  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 931.5GB (1953519615 sec)
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# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 121601
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
+ SCSI Address [8 bytes]: 
  * Port Number [1 bytes]: 2
  * Path Id [1 bytes]: 1
  * Target Id [1 bytes]: 0
  * Lun [1 bytes]: 0
* Bus Type [4 bytes]: SerialATA

- Drive Number 10 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [90 bytes]: Volume{f6b7cc94-0000-0000-0000-100000000000}
* OS Object [98 bytes]: \\?\Volume{f6b7cc94-0000-0000-0000-100000000000}
* R-Studio Driver [42 bytes]: WinNT\Handle\Logical
* Size [8 bytes]: 39GB (81972923 sec)
* Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 1MB (2048 sec)
* Partition Size [8 bytes]: 39GB (81972923 sec)
* Partition Number [4 bytes]: 1
* Partition Type [256 bytes]: NTFS/HPFS/exFAT (0x7)
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 3GB (6291456 sec)
  * MFT Mirror Position [8 bytes]: 8KB (16 sec)
  * Index Block Size [4 bytes]: 4KB
  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 39GB (81972920 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 14593
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
+ SCSI Address [8 bytes]: 
  * Port Number [1 bytes]: 2
  * Path Id [1 bytes]: 4
  * Target Id [1 bytes]: 0
  * Lun [1 bytes]: 0
* Bus Type [4 bytes]: SerialATA
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- Drive Number 11 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [90 bytes]: Volume{f6b7cc94-0000-0000-0000-b0c509000000}
* OS Object [98 bytes]: \\?\Volume{f6b7cc94-0000-0000-0000-b0c509000000}
* R-Studio Driver [42 bytes]: WinNT\Handle\Logical
* Size [8 bytes]: 72.6GB (152461312 sec)
* Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 39GB (81975296 sec)
* Partition Size [8 bytes]: 72.6GB (152461312 sec)
* Partition Number [4 bytes]: 2
* Partition Type [256 bytes]: NTFS/HPFS/exFAT (0x7)
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 3GB (6291456 sec)
  * MFT Mirror Position [8 bytes]: 8KB (16 sec)
  * Index Block Size [4 bytes]: 4KB
  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 72.6GB (152461311 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 14593
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
+ SCSI Address [8 bytes]: 
  * Port Number [1 bytes]: 2
  * Path Id [1 bytes]: 4
  * Target Id [1 bytes]: 0
  * Lun [1 bytes]: 0
* Bus Type [4 bytes]: SerialATA

- Drive Number 12 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [90 bytes]: Volume{e7571fdc-fbbd-42cf-86fe-03807522d76d}
* OS Object [98 bytes]: \\?\Volume{e7571fdc-fbbd-42cf-86fe-03807522d76d}
* R-Studio Driver [42 bytes]: WinNT\Handle\Logical
* Size [8 bytes]: 100MB (204800 sec)
* Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 1MB (2048 sec)
* Partition Size [8 bytes]: 100MB (204800 sec)
* Partition Number [4 bytes]: 1
* GPT Partition GUID [74 bytes]: e7571fdc-fbbd-42cf-86fe-03807522d76d
* GPT Type GUID [256 bytes]: UEFI System Partition, c12a7328-f81f-11d2-ba4b-
00a0c93ec93b
* GPT Partition Attributes [256 bytes]: No automount (0x8000000000000000)
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 32
  * Cluster Size [4 bytes]: 1KB (2 sec)
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  * First Cluster Offset [8 bytes]: 3.99MB (8188 sec)
  * Root Directory Cluster [4 bytes]: 2
  * First FAT Offset [8 bytes]: 3.24MB (6654 sec)
  * Size of One FAT Table [8 bytes]: 384.5KB (769 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 100MB (204800 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 14593
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
+ SCSI Address [8 bytes]: 
  * Port Number [1 bytes]: 2
  * Path Id [1 bytes]: 0
  * Target Id [1 bytes]: 0
  * Lun [1 bytes]: 0
* Bus Type [4 bytes]: SerialATA

- Drive Number 13 --------------------------------
* Drive Type [256 bytes]: Volume
* Name [58 bytes]: Microsoft reserved partition
* OS Object [48 bytes]: \Device\HarddiskVolume2
* R-Studio Driver [42 bytes]: WinNT\Native\Logical
* Size [8 bytes]: 16MB (32768 sec)
* Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 101MB (206848 sec)
* Partition Size [8 bytes]: 16MB (32768 sec)
* Partition Number [4 bytes]: 2
* GPT Partition GUID [74 bytes]: ad153538-3269-4fe5-a229-0aa8afc25a2d
* GPT Type GUID [256 bytes]: System Reserved Partition, e3c9e316-0b5c-4db8-817d-
f92df00215ae
* GPT Partition Attributes [256 bytes]: No automount (0x8000000000000000)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4
+ Physical Drive Geometry [8 bytes]: 
  * Cylinders [8 bytes]: 14593
  * Tracks Per Cylinder [4 bytes]: 255
  * Sectors Per Track [4 bytes]: 63
  * Sector Size [4 bytes]: 512B
+ SCSI Address [8 bytes]: 
  * Port Number [1 bytes]: 2
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  * Path Id [1 bytes]: 0
  * Target Id [1 bytes]: 0
  * Lun [1 bytes]: 0
* Bus Type [4 bytes]: SerialATA

- Drive Number 14 --------------------------------
* Drive Type [256 bytes]: Partition
* Name [42 bytes]: EFI system partition
* Size [8 bytes]: 100MB (204800 sec)
* Partition Offset [8 bytes]: 1MB (2048 sec)
* Partition Size [8 bytes]: 100MB (204800 sec)
* Partition Number [4 bytes]: 1
* GPT Partition GUID [74 bytes]: e7571fdc-fbbd-42cf-86fe-03807522d76d
* GPT Type GUID [256 bytes]: UEFI System Partition, c12a7328-f81f-11d2-ba4b-
00a0c93ec93b
* GPT Partition Attributes [256 bytes]: No automount (0x8000000000000000)
* GPT Partition Name [42 bytes]: EFI system partition
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 32
  * Cluster Size [4 bytes]: 1KB (2 sec)
  * First Cluster Offset [8 bytes]: 3.99MB (8188 sec)
  * Root Directory Cluster [4 bytes]: 2
  * First FAT Offset [8 bytes]: 3.24MB (6654 sec)
  * Size of One FAT Table [8 bytes]: 384.5KB (769 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 100MB (204800 sec)

- Drive Number 15 --------------------------------
* Drive Type [256 bytes]: Partition
* Name [58 bytes]: Microsoft reserved partition
* Size [8 bytes]: 16MB (32768 sec)
* Partition Offset [8 bytes]: 101MB (206848 sec)
* Partition Size [8 bytes]: 16MB (32768 sec)
* Partition Number [4 bytes]: 2
* GPT Partition GUID [74 bytes]: ad153538-3269-4fe5-a229-0aa8afc25a2d
* GPT Type GUID [256 bytes]: System Reserved Partition, e3c9e316-0b5c-4db8-817d-
f92df00215ae
* GPT Partition Attributes [256 bytes]: No automount (0x8000000000000000)
* GPT Partition Name [58 bytes]: Microsoft reserved partition

- Drive Number 16 --------------------------------
* Drive Type [256 bytes]: Partition
* Name [42 bytes]: Basic data partition
* Mount Points [8 bytes]: C:\
* Size [8 bytes]: 111.1GB (233156718 sec)
* Partition Offset [8 bytes]: 117MB (239616 sec)
* Partition Size [8 bytes]: 111.1GB (233156718 sec)
* Partition Number [4 bytes]: 3
* GPT Partition GUID [74 bytes]: daf04b8f-aece-4176-9e12-25271c9682d5
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* GPT Type GUID [256 bytes]: Data Partition, ebd0a0a2-b9e5-4433-87c0-68b6b72699c7
* GPT Partition Name [42 bytes]: Basic data partition
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 3GB (6291456 sec)
  * MFT Mirror Position [8 bytes]: 8KB (16 sec)
  * Index Block Size [4 bytes]: 4KB
  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 111.1GB (233156717 sec)

- Drive Number 17 --------------------------------
* Drive Type [256 bytes]: Partition
* Name [54 bytes]: Windows Recovery Partition
* Size [8 bytes]: 508MB (1040384 sec)
* Partition Offset [8 bytes]: 111.2GB (233398272 sec)
* Partition Size [8 bytes]: 508MB (1040384 sec)
* Partition Number [4 bytes]: 4
* GPT Partition GUID [74 bytes]: 06a81b86-6c2b-4a3c-9170-fff1161fb034
* GPT Type GUID [256 bytes]: Windows Recovery Partition, de94bba4-06d1-4d40-a16a-
bfd50179d6ac
* GPT Partition Attributes [256 bytes]: System, No automount (0x8000000000000001)
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 169.3MB (346792 sec)
  * MFT Mirror Position [8 bytes]: 8KB (16 sec)
  * Index Block Size [4 bytes]: 4KB
  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 507.9MB (1040383 sec)

- Drive Number 18 --------------------------------
* Drive Type [256 bytes]: Empty Space
* Name [28 bytes]: Empty Space18
* Size [8 bytes]: 1.44MB (2959 sec)
* Partition Offset [8 bytes]: 111.7GB (234438656 sec)
* Partition Size [8 bytes]: 1.44MB (2959 sec)

- Drive Number 19 --------------------------------
* Drive Type [256 bytes]: Partition,Primary
* Name [22 bytes]: Partition1
* Mount Points [8 bytes]: D:\
* Size [8 bytes]: 931.5GB (1953519616 sec)
* Partition Offset [8 bytes]: 1MB (2048 sec)
* Partition Size [8 bytes]: 931.5GB (1953519616 sec)
* Partition Number [4 bytes]: 1
* Partition Type [256 bytes]: NTFS/HPFS/exFAT (0x7)
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 3GB (6291456 sec)
  * MFT Mirror Position [8 bytes]: 8KB (16 sec)
  * Index Block Size [4 bytes]: 4KB
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  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 931.5GB (1953519615 sec)

- Drive Number 20 --------------------------------
* Drive Type [256 bytes]: Partition,Primary
* Name [22 bytes]: Partition1
* Size [8 bytes]: 39GB (81972923 sec)
* Partition Offset [8 bytes]: 1MB (2048 sec)
* Partition Size [8 bytes]: 39GB (81972923 sec)
* Partition Number [4 bytes]: 1
* Partition Type [256 bytes]: NTFS/HPFS/exFAT (0x7)
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 3GB (6291456 sec)
  * MFT Mirror Position [8 bytes]: 8KB (16 sec)
  * Index Block Size [4 bytes]: 4KB
  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 39GB (81972920 sec)

- Drive Number 21 --------------------------------
* Drive Type [256 bytes]: Partition,Primary
* Name [22 bytes]: Partition2
* Size [8 bytes]: 72.6GB (152461312 sec)
* Partition Offset [8 bytes]: 39GB (81975296 sec)
* Partition Size [8 bytes]: 72.6GB (152461312 sec)
* Partition Number [4 bytes]: 2
* Partition Type [256 bytes]: NTFS/HPFS/exFAT (0x7)
+ NTFS Information [8 bytes]: 
  * Cluster Size [4 bytes]: 4KB (8 sec)
  * MFT Record Size [4 bytes]: 1KB
  * MFT Position [8 bytes]: 3GB (6291456 sec)
  * MFT Mirror Position [8 bytes]: 8KB (16 sec)
  * Index Block Size [4 bytes]: 4KB
  * Sector Size [4 bytes]: 512B
  * Volume Size [8 bytes]: 72.6GB (152461311 sec)

************************************************************************************
****************

-------------------------------------------- Session 1
---------------------------------------------
START Date / Time of Collection: 2022-07-05 03:56:48

Case Name: Stiven v. Christofer
Case Number: 28-S-0205-CR85763
Operator / Investigator Name: J.F. Lewson

Source drive:Sector Modification Date    MD5                                
SHA-1                                   SHA-256                            

                            File Name
 20                 2021-11-15 11:18:41  Partition1/Root
    $I30: INDEX_ALLOC (Non-Resident)
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         288-295
 20                 2022-04-14 10:07:42  Partition1/Root/$RECYCLE.BIN
 20                 2022-04-14 10:07:42  Partition1/Root/$RECYCLE.BIN/S-1-5-
21-1491398347-2858144638-2526585153-1002
 20                 2022-04-14 10:07:42  a526b9e7c716b3489d8cc062fbce4005   

2df502a944ff721241be20a9e449d2acd07e0312
e1b9ce9b57957b1a0607a72a057d6b7a9b34ea60f3f8aa8f38a3af979bd23066
Partition1/Root/$RECYCLE.BIN/S-1-5-21-1491398347-2858144638-2526585153-
1002/desktop.ini
 20                 2021-11-15 11:18:41  Partition1/Root/$RECYCLE.BIN/S-1-5-
21-3229151806-1869599629-3662833694-1001
 20                 2021-11-15 11:18:41  a526b9e7c716b3489d8cc062fbce4005   

2df502a944ff721241be20a9e449d2acd07e0312
e1b9ce9b57957b1a0607a72a057d6b7a9b34ea60f3f8aa8f38a3af979bd23066
Partition1/Root/$RECYCLE.BIN/S-1-5-21-3229151806-1869599629-3662833694-
1001/desktop.ini
 20                 2021-11-15 10:47:20  Partition1/Root/Documents
    $I30: INDEX_ALLOC (Non-Resident)
         99920-99927
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files
 20                 2021-11-15 10:47:18  
Partition1/Root/Documents/OpenOffice-files/Calc-files
 20                 2021-11-15 10:47:18  
Partition1/Root/Documents/OpenOffice-files/Calc-files/ods-files
 20                 2020-04-06 16:21:52  b1eb4cc9101bcb86c0042231f898f0ae   

8e5da7978ebe26604b5f556ec2d20a4ce1176ff1
4d226d7f3c0e1c874f0aaf772f9a5cf9bed2c7d982906a4a0314c206cbc4bb35
Partition1/Root/Documents/OpenOffice-files/Calc-files/ods-files/.DS_Store
    DATA: DATA (Non-Resident)
         99960-99975
 20                 2020-04-06 16:18:30  eab006354c7cf4e1fd3772afd0643672   

bfc7b3368a46a640c3145646b0dfad10bb89f096
4709af13b6dbaf11feab0750bc2a3734eab9a94e184bd7f736805adcb02ac368
Partition1/Root/Documents/OpenOffice-files/Calc-files/ods-
files/file_example_ods_10.ods
    DATA: DATA (Non-Resident)
         99976-100007
 20                 2020-04-06 16:20:50  94790aeb545e806ea9cf161f6ae2697f   

152a13f940c2dfa4530b1b022897cb3dbd0cb45b
edb79e7965f6b61722f1c6427200e4ba44692e573b2f2f8cd210f356aed7f3c9
Partition1/Root/Documents/OpenOffice-files/Calc-files/ods-
files/file_example_ods_1000.ods
    DATA: DATA (Non-Resident)
         100008-100111
 20                 2020-04-06 16:19:47  000389561d71032e79411613d73f01f5   

3e9fdd1b26eed17f40e98a0f8d13af11decdf951
b668e04c130d51d023531482c8067b5232284decdf54760c6ae431e3718388c3
Partition1/Root/Documents/OpenOffice-files/Calc-files/ods-
files/file_example_ods_50.ods
    DATA: DATA (Non-Resident)
         100112-100143
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 20                 2020-04-06 16:21:44  28aa35b07f4a28f4f001e28f277dd1be   
f9dfcafc3e9b6c1c15a949ab9150b8e7d599f1d6

069ad480df6dba6de101188dc126f688127206932d98f02149eb390b6e8f2928
Partition1/Root/Documents/OpenOffice-files/Calc-files/ods-
files/file_example_ods_5000.ods
    DATA: DATA (Non-Resident)
         100144-100519
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Calc-files/oxlsx-files
 20                 2020-04-06 16:31:06  c763a032a1999d42934abebc25fc6a83   

07c1d02aa03ae7768dfb88445bff68e9c32c2264
208fef9240237b668cbb927255a8f204e6ab808a68701ffe72bf3ca85e4d13e1
Partition1/Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/.DS_Store
    DATA: DATA (Non-Resident)
         100520-100535
 20                 2020-04-06 16:25:50  f893b7290b96905f0776e0e1cb4b91c4   

d80a4175a6a2767b61fe8e2b33774bd211b6a934
ab82e943104f1edfa17b58595b4221c02ddf93aa4056fa630473de192f85d1fe
Partition1/Root/Documents/OpenOffice-files/Calc-files/oxlsx-
files/file_example_OXLSX_10.xlsx
    DATA: DATA (Non-Resident)
         100536-100551
 20                 2020-04-06 16:30:27  be99eeaa2e2aa77ecb4d7b9eeff44cb4   

1aad45945f99a02383e168e339a20d38999491b6
cd6583c0aa16dde7342c4dc5483987edf173d7378ce946ded7383bbf4b5990ba
Partition1/Root/Documents/OpenOffice-files/Calc-files/oxlsx-
files/file_example_OXLSX_100.xlsx
    DATA: DATA (Non-Resident)
         100552-100575
 20                 2020-04-06 16:30:10  2280cba8bea0ded6bf9c428939f9cb32   

4aee4fe0add47392f508fef28af3f5c02a9eb4a2
59da4d0e97a54c462fcf34268b14a4214ef324da368712a0a32678c976e89484
Partition1/Root/Documents/OpenOffice-files/Calc-files/oxlsx-
files/file_example_OXLSX_50.xlsx
    DATA: DATA (Non-Resident)
         100576-100591
 20                 2020-04-06 16:30:42  980e7a175ea67333379753a788d331e5   

c90c1841006b8da26e69636596c7a8e5fcc26ec6
0d66f10f1b76f620d69e4054eeab6669f2e64b0b2fa5e3365101027aa5b657e7
Partition1/Root/Documents/OpenOffice-files/Calc-files/oxlsx-
files/file_example_OXLSX_5000.xlsx
    DATA: DATA (Non-Resident)
         54912-55287
 20                 2020-04-06 16:23:13  db42bc048678d194bda93124fcc1e359   

9f7137c6703b51cd78a797b56b5f2a2e7c8b83ea
433476459c23ba979ab467ce4c310e29a40e3b9a8d68dd63467b503ddc4cdf23
Partition1/Root/Documents/OpenOffice-files/Calc-files/.DS_Store
    DATA: DATA (Non-Resident)
         99944-99959
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Microsoft-files
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files
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 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-files
    $I30: INDEX_ALLOC (Non-Resident)
         101296-101303
 20                 2020-04-06 16:13:48  7901a6038143aa293bff65c1dcc564a9   

13c30d142999708f8b0f3b71bce35c1c91304032
ad75eff3191cbb4e3215b25ce1733f062f474ff6aa242db82de391eada0f114e
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-files/
.DS_Store
    DATA: DATA (Non-Resident)
         101008-101023
 20                 2018-10-19 11:12:18  01a42d82b4e2e143876cc0afea4883ed   

3cc9264c3a5569c08abfb9ee343dba1bf96f1b3d
be198ae04df0476e6a8153e4b396da05c9badef729f87f1abbb626f8bfae8491
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-
files/file_example_XLS_10.xls
    DATA: DATA (Non-Resident)
         100928-100967
 20                 2018-10-19 11:14:00  efcb6e746de385a6ba15f9e697503f4c   

96451e09d24aacaab7c00292316020ecd8090dbf
8562df19f14cb945b769a0812fb1afd5acd9e349f0cdd71150282202d71319ee
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-
files/file_example_XLS_100.xls
    DATA: DATA (Non-Resident)
         6944-7015
 20                 2018-10-19 11:14:56  f9773bf0bd611c8a9107140956b3881f   

7a538e2ca18bb7cb0c2fb0130767012f7acd9019
d3107cae4af0231540887be840135ec03763d83926c2900fb76aead0226787ca
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-
files/file_example_XLS_1000.xls
    DATA: DATA (Non-Resident)
         4992-5295
 20                 2018-10-19 11:13:23  b3df6dd6764416491f51415c4ccf1aaf   

eea1bebb11f6beab8f38bc2b1705dbf598bcbfa6
a7beba6217ffa60c9e79f0310d024a74cbaf363d7b884d214178e413e758b68e
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-
files/file_example_XLS_50.xls
    DATA: DATA (Non-Resident)
         100872-100927
 20                 2018-10-19 11:15:24  ecb548b885ec5cf6f6e38ece80fa5f2e   

5ddffe520563c9b9c26a7c297c99b2e896e891d0
bc8d33d7033eb858dd63ae4882d4381fb9fe85c0740fd41efb9a309fca9e366f
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-
files/file_example_XLS_5000.xls
    DATA: DATA (Non-Resident)
         101496-102863
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-files
    $I30: INDEX_ALLOC (Non-Resident)
         55288-55295
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 20                 2020-04-06 16:16:33  8f9765363a3610383bbafb7ed7e8928c   
075e8f3a721f3d733c20e897c3e9db0c907322b7

9320252c62acfa865ebd315c1597d767f9ebc16ea410bff7e3d2e479bdcde088
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-files/
.DS_Store
    DATA: DATA (Non-Resident)
         101280-101295
 20                 2018-10-19 11:16:15  bd5ec17de931c601b3231fdb4eac6db6   

2a647da6430913fa47cfd7874721f0832bb91f52
584bd2879378c518796f4422f8ed41c971798e76c5ee58c307fc3d40adb03eaa
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-
files/file_example_XLSX_10.xlsx
    DATA: DATA (Non-Resident)
         101112-101135
 20                 2018-10-19 11:17:58  43cb8b1c3ede97eaeb779d0bc7d03710   

41360a2a5d2f8a2aaacd2ae503ea754fc33d93f4
97e004974d26f04bf7bf960d5b4e33f2f59a81d79e95526804f5b570f819eacb
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-
files/file_example_XLSX_100.xlsx
    DATA: DATA (Non-Resident)
         100840-100871
 20                 2018-10-19 11:18:45  513e4fac7ff88720001864d1a350ed1c   

87e9c39ea24c1949cca6f68ff42cdb8208c32a13
14fed5fcf63206d7f5bd275058b7d79184ce187b062fcdab5d9ff77b4ea19502
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-
files/file_example_XLSX_1000.xlsx
    DATA: DATA (Non-Resident)
         9720-9831
 20                 2018-10-19 11:16:44  775654d96ef34c95ce1a60e9606977e9   

1954ba25e67edc407955203d21aeb8c3a99d272f
e40aeadfebe57e3be87ac46260ad09ec1c4c030b95eef2af767382d0fe79198a
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-
files/file_example_XLSX_50.xlsx
    DATA: DATA (Non-Resident)
         101088-101111
 20                 2018-10-19 11:19:09  ea38c0c454aa508b5909161bd8260918   

e566e8c34a723ad44431cc3f0fdbf3bce18410e5
acbd5c728f2738a70f59c245c961eb8122d59aa07b7debdc7d348efe472b650b
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-
files/file_example_XLSX_5000.xlsx
    DATA: DATA (Non-Resident)
         103080-103551
 20                 2020-04-06 16:31:14  52d71be9d0971685678823c546b72eff   

1930f5ed939a35965802a508afb3865810e7e0af
8ffc5293b616b558264fdb2277fb6a8d032ebecaf6b678b491ddcfdef1a3f9f2
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/.DS_Store
    DATA: DATA (Non-Resident)
         100984-101007
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files
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 20                 2020-04-06 16:12:41  34b20ad44b5d33cc3401b0ca1c9c55ad   
236a6271d535ea5149eca9fe73e939900968c019

9cc166b17367418d3af128bd74ae79c7b0a20c0a1fd19c4d458c1834897905db
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files/
.DS_Store
    DATA: DATA (Non-Resident)
         101056-101071
 20                 2018-10-19 11:10:23  759cbcd3d7c574ec4de97222bc407665   

1308c158c06c9050ffa3f0f5898a5ccf4a94c8c7
3fbfda0b36c4edc4b4d48ec5c0425ced04ed15c6e3891495201a7289533a2ce2
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-
files/DOCFile_500kb.doc
    DATA: DATA (Non-Resident)
         103592-104599
 20                 2018-10-19 11:20:26  35176f9b7f521954445100e5df74dee9   

5aee31c3f490b421e75548ea713a6755818980db
f907aadb6b9b38c8e19eaf44aa11796051eeac35d0d2115246449da98f1137f7
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-
files/file-sample-doc_100kB.doc
    DATA: DATA (Non-Resident)
         102864-103071
 20                 2018-10-19 11:19:59  bb8c0ad499fc64837a45154a27e07734   

1e09acf84e23e9eddb152f812354785e2f7cd159
2bcd9c011678a8aa7045a6485bef7872c4295fbb6c2467cc29135ffcc769457b
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-
files/file-sample-doc_1MB.doc
    DATA: DATA (Non-Resident)
         104808-106823
 20                 2018-10-19 11:21:18  e16fb51cef336edf2c19d065ef49a662   

15bfff84aea3602cd0ec81bd7ac9789a969c3528
41f65cf10d9b0b42d12307a46b66ae632e6d883e067db5959969822780823d7a
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-
files/file-sample-doc_500kB.doc
    DATA: DATA (Non-Resident)
         106824-107807
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files
 20                 2020-04-06 16:12:41  0717f9af8c983c9af7d5fb9d311ab163   

0ce1f83b661658d58caee54b75ede278a30e0927
359246310af6c9ff8c7192b637ae949a8c388f1c9b684d46c1ea013d4fcafffb
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files/
.DS_Store
    DATA: DATA (Non-Resident)
         101040-101055
 20                 2018-10-19 11:11:20  96d043aabc6bdad1046db4c47aa7a3a8   

7705c94a188ecebd1be2f68f70687b1ef7360d21
9383ce8098236174683cefab77cbddfe8cc17d8656b4e87281e783ce55b76d52
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-
files/DOCXFile_500kb.docx
    DATA: DATA (Non-Resident)
         107824-108511
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 20                 2018-10-19 11:22:33  0815c2eb26ab3ad59fab1ccba9d18fd0   
20898f28011ae05f5062e09690b292ed13fbbf20

acd7fe4a7ee20c77b48489be5b9dbad8a850a2b29af721c912f6993e238b5471
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-
files/file-sample-docx_100kB.docx
    DATA: DATA (Non-Resident)
         108512-108759
 20                 2018-10-19 11:21:55  9a1485d3bca8dd88cb67f248c0144d0b   

0dcff5af4a39b3d57e964ead8a004636c3a276f4
98983b17e3562d015ac1c1a6f9d9971090303c04d0d70d6729416d376385eb2b
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-
files/file-sample-docx_1MB.docx
    DATA: DATA (Non-Resident)
         108760-110847
 20                 2018-10-19 11:23:09  183a5dc1a099e3c8c0b54c6aa52d64b7   

1266501c54bdea72f239925138a61a62a9f8b2ba
ff010e8d024e80c14901ea9ac618f253862667e7a69f69b070002cbc74df9f58
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-
files/file-sample-docx_500kB.docx
    DATA: DATA (Non-Resident)
         110848-111983
 20                 2020-04-06 16:44:01  8b1836fc208a9ab78cb95bc0d00b6256   

c6f205d3920442756681d4bc1c3091dae0b69466
5dba5fad9c2bf25ea40190fb34594641a66e44d4fd40a7cabf9ea11862e6246a
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/Word-files/.DS_Store
    DATA: DATA (Non-Resident)
         101072-101087
 20                 2020-04-06 16:44:31  b6e071bf10615607b95d544a2022d187   

199662a8e3916924b81b13ac8ae705f3c581cec9
c988d303b52f36214ce9464a07df2dbf114b6820971eddd987668e89bb0167a6
Partition1/Root/Documents/OpenOffice-files/Microsoft-files/.DS_Store
    DATA: DATA (Non-Resident)
         100968-100983
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Writer-files
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Writer-files/odocx-files
 20                 2020-04-06 16:33:22  70b4b7f69342042902032114b234fa03   

79bfe4ccde5838e150a0f236b9c7478104b9cd09
2dd6ea9aef467ef368f7024e22ae3ea03d3e4f73949c0e1ee7cb055779c596a7
Partition1/Root/Documents/OpenOffice-files/Writer-files/odocx-files/file-sample-
odocx_100kB.docx
    DATA: DATA (Non-Resident)
         101136-101279
 20                 2020-04-06 16:36:02  e579cd58b1ac23749e4251835bc0f610   

e8d59c3b4ea9f4c08c4e59031736a578d728dff6
1c0f9edf45a390e0d279a1d10da038e374b515cef3e5c077c8bae99e3dd4a5cc
Partition1/Root/Documents/OpenOffice-files/Writer-files/odocx-files/file-sample-
odocx_1MB.docx
    DATA: DATA (Non-Resident)
         112144-114047
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 20                 2020-04-06 16:36:58  0a64c077c83153e159aa45906220ff3e   
ca27738f86b01900b3b94e19bd99003fb47a5c80

05100d4633bff3a8809b8b075ecbb7e9dd22f94148307faabad972ee8c8307d7
Partition1/Root/Documents/OpenOffice-files/Writer-files/odocx-files/file-sample-
odocx_500kB.docx
    DATA: DATA (Non-Resident)
         114048-114951
 20                 2020-04-06 16:34:45  f1dbf4f7ad95d39ccc0f877d9b887afa   

c6b1149ecbd1303d75868e19643e61c60a822808
fb723512f7f3f166cb0013f3160d98b648719f08bc6dcde7db5043277cb1ca85
Partition1/Root/Documents/OpenOffice-files/Writer-files/odocx-
files/ODOCXFile_500kb.docx
    DATA: DATA (Non-Resident)
         114952-115823
 20                 2021-11-15 10:47:19  
Partition1/Root/Documents/OpenOffice-files/Writer-files/odt-files
 20                 2020-04-06 16:43:34  d4c494a030d81983196866482a5597fe   

46aa85342a8d01ae27ea91965ce088813a4410ed
8fcb878c093e2f4652b632bb347b3f69db28ece431801b9651b3809b47ff16e4
Partition1/Root/Documents/OpenOffice-files/Writer-files/odt-files/.DS_Store
    DATA: DATA (Non-Resident)
         9832-9847
 20                 2020-04-06 16:40:21  c3e2b9d976977ec25d6347ed02673120   

c913470ca428305f83c37c34a17cdf79903a3248
455b56ea7a3bd759f917b8e3a3d16b567f10ada93c8202ddee8945db150bf810
Partition1/Root/Documents/OpenOffice-files/Writer-files/odt-files/file-sample-
odt_100kB.odt
    DATA: DATA (Non-Resident)
         100592-100839
 20                 2020-04-06 16:42:33  5f1e8dfdac3fc3133511a75f26001854   

7a26c32e318fa96d08c4515122c197e7bf7397ba
23a5d871d288d0b5bd3a65747e2dc6bba4689a9c67ccf8e609e8d8ce9af74336
Partition1/Root/Documents/OpenOffice-files/Writer-files/odt-files/file-sample-
odt_1MB.odt
    DATA: DATA (Non-Resident)
         116088-118183
 20                 2020-04-06 16:41:23  324dd4fe1e621090a5dfe7e0c7680050   

c070a68cce81d1058838a5438a91c3a6bff11fa5
de09f89e254cc5ecc388ba278cf2f224067e9fbc9c64ae3009adf565fcc798c6
Partition1/Root/Documents/OpenOffice-files/Writer-files/odt-files/file-sample-
odt_500kB.odt
    DATA: DATA (Non-Resident)
         118184-119319
 20                 2020-04-06 16:43:29  b45be240cb18dda2cd78caee72891837   

06bb21bd6ffd5eae59034e4cf9533076ccb68bb5
ed39112cdf37ddc805e39b9edb033fd97dcce179831c1392a2a59e46f85a0796
Partition1/Root/Documents/OpenOffice-files/Writer-files/odt-files/ODTFile_500kb.odt
    DATA: DATA (Non-Resident)
         54392-54911
 20                 2020-04-06 16:37:14  14a0ca21163393f57c739e278f95dfde   

cc80e712df7b497601fb5ab86c23f4d6ebd8db0c
b4c09d792b41a04e369df0ccdd202eba89a11c9f1530a62be60183379cd85335
Partition1/Root/Documents/OpenOffice-files/Writer-files/.DS_Store
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    DATA: DATA (Non-Resident)
         101024-101039
 20                 2020-04-06 16:34:59  229601a0b29ad34773e4891161a14e2b   

e0a791be31e35348bac1d6840e27e8e47c730f98
2c6a0a942b9466457708117adfecb2408b24b214cd595fd00a850a8cca2a8d26
Partition1/Root/Documents/OpenOffice-files/.DS_Store
    DATA: DATA (Non-Resident)
         99928-99943
 20                 2021-11-15 10:47:20  Partition1/Root/Documents/pdf
 20                 2018-10-19 11:31:09  cafaa4fe6206c58f5dec13c3ea9d0371   

7ed087345df3071191fbb455470a4ae8e4b423e7
2a42cd96488ebc2e8fd807008726dee7ab1709c007fa9abe8affbc5843591bb0
Partition1/Root/Documents/pdf/file-sample-pdf_100kB.pdf
    DATA: DATA (Non-Resident)
         6424-6943
 20                 2018-10-19 11:28:32  f75c9215162661abdd9cd1aa11d792e6   

06dcbad6d7184b39925fb0a19f55b4a9ce3f297b
0da983da280865ec4ef11497f7ae9a3322d36b88a12b419e90109774ae50d40f
Partition1/Root/Documents/pdf/file-sample-pdf_1MB.pdf
    DATA: DATA (Non-Resident)
         120360-122727
 20                 2018-10-19 11:30:08  23d2d7627d3edbc66586726cbd4225b1   

34d580da967fbc3ba1bc54e59da11b7183afffb6
0dce6c42b677f621d5f8ac8abbfad0ed7d69e7e18e1f328c9276453e2b57680b
Partition1/Root/Documents/pdf/file-sample-pdf_500kB.pdf
    DATA: DATA (Non-Resident)
         122728-124143
 20                 2018-10-19 12:05:41  2cea8c95dc5f5db6065f704068292867   

6628857689d03f6e0b52cdaef20c9be4f17d0f79
5e147079d557fe26de3dbdf0c5c7aab4ac18ec13d4e31bea320d1167475dae0c
Partition1/Root/Documents/pdf/large_pdf.pdf
    DATA: DATA (Non-Resident)
         124144-154039
 20                 2018-10-19 11:49:27  4bfa34445fe5e92cee0d4be1c4b6afbd   

4c166dd5ad455053664bb095fbed5238f5a17a68
1284a8bd83fa65802aa0ee0d7ca77a008c6db18cbd288f1b1f1319aae703fa4a
Partition1/Root/Documents/pdf/PDFFile_500kb.pdf
    DATA: DATA (Non-Resident)
         154040-156631
 20                 2018-06-22 11:08:57  b05a97e064cc54b99daba53bde958d58   

31249aec7b1e9dd55828b296f3626c5654071860
b0e8e10fc34b366dfa1709719cd737745581fb277a82509a60518cb5e6c8ddfc
Partition1/Root/Documents/easychair.docx
    DATA: DATA (Non-Resident)
         55296-59767
 20                 2013-06-26 08:00:33  0a4ffa384ae31d33a801acc0e1746e65   

f09aedad237560fe3fc2d255d39520923cab91f2
6387b9576f369e587e7c810df976b29ededf8c4f7e3f1d6662b7ccd78dc4a521
Partition1/Root/Documents/Mac_mini_Early2009_UG.pdf
    DATA: DATA (Non-Resident)
         59768-66015
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 20                 2013-06-26 07:58:08  12ab314eb73a4a938bed3d6550da0ff2   
22b0141246f4f5c7cf20171645c0f8de596cb35a

eada5fecc16cb98c28c54b080319ff79eb20b62a313ed4b6ba5c254a4a3ede7e
Partition1/Root/Documents/Mac_mini_Intel-based_Mid2007_UserGuide.pdf
    DATA: DATA (Non-Resident)
         66016-67767
 20                 2013-06-26 07:56:33  bcb1278d0441dd482bc9aafb57abe8a6   

790de86e64018a72d48b97ed9281d9bbe036d728
b9aa929d68b88288d49fa4850143e18120c67d55c81c8733e605a639637cdb7c
Partition1/Root/Documents/Mac_mini_Intel_User_Guide.pdf
    DATA: DATA (Non-Resident)
         67768-72199
 20                 2018-10-19 12:04:44  9bc47b9f8c3ddc76f98b888d29d58dc8   

ca2d122f689a98ca752fdbe0414e6296dcff8c68
18ca6866a60efd06455338739bed02ed3a60bbe8e9cd5e8688b7877aa2a11ef6
Partition1/Root/Documents/MyDoc1.docx
    DATA: DATA (Non-Resident)
         72200-99919
 20                 2016-08-09 06:43:29  cbe35c8518717402622e37fe748e08b3   

028f8ea45432e9b87e45693847d0b6c068b3096d
4868c01d946e0ab00fb2af3bb186ead65ff41d82817f8cc210e254cb115f494a
Partition1/Root/Documents/Test_Arch.zip
    DATA: DATA (Non-Resident)
         156632-163591
 20                 2021-11-15 10:47:28  Partition1/Root/Music
    $I30: INDEX_ALLOC (Non-Resident)
         296-303
 20                 2021-11-15 10:47:25  Partition1/Root/Music/Andre_Rieu
    $I30: INDEX_ALLOC (Non-Resident)
         4968-4991
 20                 2016-06-05 06:40:09  a44be999d6682d18644da916cc3a5569   

545dca6e41229c13c8ea51930b809c1155ba1ae8
1ca04432f8cc56e7e11d13f9a4a930dda67d2756c68040bd280bbc6307854b2a
Partition1/Root/Music/Andre_Rieu/Andr_Rieu-
Air_On_A_G_String_Johann_Sebastian_Bach_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         508840-521647
 20                 2016-06-05 06:39:14  babfb3a12071e9207803c707f0ea4da9   

19c0fc620469b9f709a9e5f41358cc9f77935133
9a61b7a900bce729eab4c964ebfdac730e656e0b4206741d09f8b1ea9ce0d34a
Partition1/Root/Music/Andre_Rieu/Andr_Rieu-Ballade_Pour_Elise_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         521648-529695
 20                 2016-06-05 06:39:10  d4d8f39e2b3c8df8c62b363284524e7c   

3eea72aa9277fee3f8af60fbcb7b47929339190c
aa0def648856d03145be5428ef6e00461ceab3b93c56c33d4559e98c46a4971f
Partition1/Root/Music/Andre_Rieu/Andr_Rieu-Barbero_de_Sevilla_F_garo_-
_Largo_Al_Fact_tum_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         529696-544487
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 20                 2016-06-05 06:39:14  0f83a6b9df6c1c8768ff7a5466789eb2   
77dd488fc42dce156f172e9e5557c2f4ed51cc83

88ff016fb6208004ad2b77d58c0b58ca54fcaa1d76a0c58c9030bc554977496a
Partition1/Root/Music/Andre_Rieu/Andr_Rieu-Clavelitos_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         544488-551535
 20                 2016-06-05 06:40:02  e76773c030362550b84955ddb47bc7db   

bfd4ac01e34c51d4bd852ff38b63c2001e8fd151
3e7e0a37558c0578d8333b6f4e10f09d0518065a12065f22d11a91ef388b9abf
Partition1/Root/Music/Andre_Rieu/Andr_Rieu-
Funiculi_Funicula_isp._Mario_Lanza_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         551536-558855
 20                 2016-06-05 06:39:51  36f69d719447f30f50290692ae1ba58a   

cf6c96a7051dbc35fd6c67239e94db3f657082db
2d5f4b5ab667f46ceda5d6ecde00da34928f393b601d23d43dd661437db76a23
Partition1/Root/Music/Andre_Rieu/Andr_Rieu-Greensleeves_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         558864-573031
 20                 2016-06-05 06:39:14  f33002bfcfdff30eca4937b2fa02e7b4   

2913a18636137a730ee80459472f1890342bfac1
2fdbac3252e9b287a4db3441b4f0cd6ec55dcf26f1488c37bc17c69cbd0a417d
Partition1/Root/Music/Andre_Rieu/Andr_Rieu-
Romantic_Paradise_Live_in_Italy_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         573032-574559
 20                 2016-06-05 06:40:24  afdf9b6627e3ee2a87027fe4037b684a   

9c63c3b09f44b182b4cc95980b2e4c06429a0a33
d7d259fb9aea96c6016bd0a2cce50a63a84344d5ca87ea98df496b4d697fbc60
Partition1/Root/Music/Andre_Rieu/Andr_Rieu-
Suite_for_Jazz_Orchestra_No._2_Vals_No._2_Dmitry_Shostakovich_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         574560-583311
 20                 2016-06-05 06:39:45  95412d5402c21407a4f1fedf4976a019   

a5e5dac46a0e6669836e8f74fb36f19e7dab4167
6d0a3e7cef78acd51b5fd4402aa8d2f9e691e1666e154a58fda31050874f9a38
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-
All_Men_Shall_Be_Brothers_From_Beethoven_s_9th_Symphony_Live_In_Dublin_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         167896-177111
 20                 2016-06-05 06:40:08  a0c6ca644336e199bdd47941f90273cb   

76d44494e624dd4740115081c055bf9e471b6aa4
f68153eaec5a9d70b3902d84d7ade66266a3495b125a8805d4ef4f0ec44fdf61
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Andante_-_Piano_Concerto_No._21_-
_Elvira_Madigan_Mozart_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         177112-204839
 20                 2016-06-05 06:39:23  1349bee844c598e63840776a8672c7b9   

45c0ec96e6a7ea035e011a76e6efcd9b749c43f5
e8ec4dac74ef09da945f22715ad4de103374e725961d0ad36f4f5db42d6f6444
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-
Bella_Tarantella_Love_inVenice_2014_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
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         204840-217055
 20                 2016-06-05 06:39:12  7d8c170fdef0f9be95ebb3eb8ff5c351   

872e0e6c8c382dda836901f58d666e2e07895a15
27649a6813d82823912829120b9225f81cae99c3152fa545b074f53fb76aad33
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-
C.Orff._Fortuna_imperatrix_mundi_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         217064-227039
 20                 2016-06-05 06:40:13  b2d52b23a778f12d5ecd3dd17cefac21   

f03a5694e19238f4a6d361b700f958ff62e69f64
e631522504fa6d6f73809bfbe7a6218a55b7ccec7bb17676785a1b8d17b09583
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Carnival_of_Venice_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         227040-248655
 20                 2016-06-05 06:39:28  6ed3f80daa58010724c6522a1c8599b8   

6f81fa64c5902341f43c2937f0df73f5fc436d56
2d5575b49ef97e53966ebd96bccbb3373cb397d6a25faa306b0a294cfc830ef8
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-
Cielito_Lindo_Meksikanskaya_narodnaya_pesnya_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         248656-253143
 20                 2016-06-05 06:39:33  5df7c88018a4a90877e37f5146b64ba4   

bf1e81b6e750a7e0209fd50b8b63df0d118e8c1f
0c86737d7209b8b3591b18ce125f04eed7e2ad356909a9eab72e6c79b951d5c5
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Concierto_De_Aranjuez_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         253144-264287
 20                 2016-06-05 06:39:10  e1469291b0a0383d587c8783a206679b   

606a92c5f170a172c0bdeac2bdb07170e3a680d7
abebd5f9a4c397e6ea404e8b2a2bb002a6f89b45403e6af7d456d275b1c59f28
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-
Einzug_der_Gladiatoren_nemeckij_marsh_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         275504-285607
 20                 2016-06-05 06:39:25  24edae723208ebb53fa9a70c6235d174   

7cae4dc4e4c21b5ccc9feacf63ce1e50007abe55
6b957574e65f2f23369e4c57affcc6bc8afbc0bef486c9cbfcb4ae82d0f3c78d
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Einzugsmarsch_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         264288-275503
 20                 2016-06-05 06:39:16  4214e0582e22356faa3006f593c31521   

648429f6f343f3b6fa1c5befd1fa17e1dbd359e6
0ca50844f96980e2ebc420da7319dba1b399a562a57b19436c40ea64906f5fcc
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Francuzskij_kankan_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         285608-291711
 20                 2016-06-05 06:39:30  6f867a4b657fcb11eb1590b93f6121af   

2a44513002d45228f4b477c0a6fd8b7011d14006
2407979c0e2c55845565cfce09b5141e0c00df7e7355e7ae29b063d7df9064cd
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Heigh-Ho_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         291712-294151
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 20                 2016-06-05 06:39:12  9da23d67db029b0a2aba65a902977ee7   
f4427b8ce2d37fe2d94726a760b55565e0060beb

b955ebeff0f774c7cab342a71e978b20767797fffbcb8fb6ebc9a223eee81e6e
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-I_Hear_The_Sound_Of_Cymbals_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         294152-306983
 20                 2016-06-05 06:40:19  04f2d1fdff801d2ebe6df0f29a18e619   

ae5ef67f8fdee64c69cdfbcb53367450e2525201
234ef05b32baaed3d91a60f77b5c3728eed21fff34c5c8110c5d07a57f38247a
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-
Jackety_Sax_Benny_Hill_Theme_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         306984-313959
 20                 2016-06-05 06:40:19  3a8b983d9b22d2cf58714f94272085a2   

d8888d6e7698e19dd06f88ae0c52132e808322c9
7eae251302dfbec1381e645c1feb6fb81a3bfb40dd378c835fd7082be83b227e
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Kalinka_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         313960-325439
 20                 2016-06-05 06:40:05  ed26972ec518840247f114119e032cb9   

954750d662eec3f4f7469c7dc86dfb6caac47852
43ce97c1e7f4358484b18cbfcf5046e4a9fff92378f63603a4d4d1251a3c8c25
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Main_Title_The_Godfather_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         325440-334727
 20                 2016-06-05 06:39:44  90d6ced1e8a5012ba917d1049cb86d83   

c8563a0a974c53b5a410522f68392c92230997fc
9fe1e61c05e2c3815df1a7b4f2933b8fd3d8fac85f21cee97bb890259c2268cb
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Marche_De_Radetzky_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         334728-343527
 20                 2016-06-05 06:40:22  16c30e0592019ff78261b8ace757d93c   

26c8510995f161358ca9a623cc6830ec0f3bb7f0
0926727b89c24ec0837ec080a9fcd6dca7977568a0c4cdae2f0bdfdde21588ce
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-
Moonriver_from_Breakfast_At_Tiffany_s_Henry_Mancini_violin_cover_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         352904-362279
 20                 2016-06-05 06:40:21  16c30e0592019ff78261b8ace757d93c   

26c8510995f161358ca9a623cc6830ec0f3bb7f0
0926727b89c24ec0837ec080a9fcd6dca7977568a0c4cdae2f0bdfdde21588ce
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-
Moonriver_from_Breakfast_At_Tiffany_s_Henry_Mancini_violin_cover_(mp3.cc) (1).mp3
    DATA: DATA (Non-Resident)
         343528-352903
 20                 2016-06-05 06:39:22  9f2fa86941e53af861f58a20fe4ca3a0   

048dae683de9566f2444750ce4e18a59b2f14b39
3adba60be7fc3f52ff992361feb663af28ab74f5ff475616368b6d69ba4605b4
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-O_Sole_Mio_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         362280-377447
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 20                 2016-06-05 06:39:08  7a4d0e64b2e59713d8372bc8c33a413f   
6eb557504149913d0642d0a355fb57c2a168af78

650857fb1cbacbe2984478823d857c4c49055302e375039a389112f314ce28bf
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Sabre_Dance_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         377448-384543
 20                 2016-06-05 06:40:26  85af6129badd4d015270a811c686b5ed   

fa8560286a78c9fb2476223d241dabfc080ac585
72454419c59109188499bf8f20f94988ab0f6feec1ef0b083cf0b3d481919e0f
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Second_Waltz_Shostakovich_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         384544-394927
 20                 2016-06-05 06:39:37  d8f4430b58e89bfbca7e04d9c8c1ae85   

ed606770fb935d2c7da8cec4634ae25cf6251bc0
258c0d8334a22f8cfe48cfa4f407faa4911a86e6dc0159eed3943989efc5aeb2
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-The_Blue_Danube_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         394936-417087
 20                 2016-06-05 06:39:33  526ac06ad6e99e345c605e8ee5308765   

a26404f1a20c22fb35c1f2e1a789689e16503f05
3f19694235113ab6393a3e3b9e7a7c0bff2c34de5f5a23b1946f19dbc44b2522
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-The_Gypsy_Baron_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         417088-437583
 20                 2016-06-05 06:39:41  5e069942912410b0a2b9a07393c5bca8   

1d9a975521d5841a4096be46b52cea589a3b996a
d3ed442842ec32249c32fd65368878a1d3ffb0b6796c5a7fe23ba072c9b13792
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-
The_Stars_And_Stripes_Forever_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         437584-448295
 20                 2016-06-05 06:39:30  620bf7a865780b1d6f5357af14d91ad5   

7634bcf96204d17693e4616ae29abad6499624b6
6a06815b8af9bfb97b6f6363c4f818439b69b22dd25dfd77fee199125fe00c79
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Thunder_And_Lightning_Polka_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         448296-460503
 20                 2016-06-05 06:39:16  c9cf9053c04806485687e3cc0c26fef2   

56258d0bc0e87ebea17ec4f918166e2387711f1e
350efbb5f6dd944682942dd6e88bfbd4cf1c60104bcd95a172067ac32e9538c6
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-
Tiritomba_Love_inVenice_2014_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         460504-470655
 20                 2016-06-05 06:39:18  e9f2e7b7ec1b375bf8409bbb63c0c1d3   

516710c7d6977e5654ba350b12e3619d2272ad3b
61b1e1ed2daec5f1244624145ccd81aba6efa16a5f38bcf150ddba1c78deff21
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Valse_Neige_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         470656-481119
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 20                 2016-06-05 06:40:01  5f5e765df138f0d8695d567bd6ba7ebf   
4a7d04e3579fcd2a5a95d890264fa507b1de62cb

9940e93f8931702e4f68baea39708e3b3a7f2fa3e7fef0060d60ca2158616b8c
Partition1/Root/Music/Andre_Rieu/Andre_Rieu-Viennese_Waltz_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         481120-508839
 20                 2021-11-15 10:47:26  Partition1/Root/Music/Barry_Sisters
    $I30: INDEX_ALLOC (Non-Resident)
         7016-7023
 20                 2013-10-18 13:58:26  ca8ecbaf0d6dc35e2633236cdd4fd3a3   

7bd6f803814c58ef522cd3ff8a894ed0ca154bfa
0ff94b864e65320d8059654c503843df15f2edc91768e6d5821c557c845215e5
Partition1/Root/Music/Barry_Sisters/Barry_Sisters-Ketsele_Baroyges.mp3
    DATA: DATA (Non-Resident)
         583312-588871
 20                 2013-10-18 13:25:14  2cac595c471dbc63b18f64d7402e5a47   

48db9c5251b72973949dcf6cc0696bb3e42bc916
b1518592e55d37fd09cb91b3d1a9e66b49dc0b72cc673f189b5ad18ee75f664a
Partition1/Root/Music/Barry_Sisters/Barry_Sisters-L'Chaim.mp3
    DATA: DATA (Non-Resident)
         588872-595495
 20                 2013-10-18 13:14:20  ab3e597a143beb7cca18afabe6b2cf05   

0bea492a98c11c131dcae40348a47e2fb68d33d3
b81c2fbc0e859c621194bcf7a25cffb4726452e5d0c8ca864e03f00188e71c96
Partition1/Root/Music/Barry_Sisters/Barry_Sisters-Tum_Balalaika.mp3
    DATA: DATA (Non-Resident)
         595496-602071
 20                 2013-10-18 14:14:54  93faf50fbbb3852820fd0af9304d981e   

dc99e2890538319da9a264eb59a0400b7e4faa6b
4bb557581d0a2209c20e156357e008fad23b9c22307941c4d2304cb481a28c66
Partition1/Root/Music/Barry_Sisters/Barry_Sisters-Vaybele_a_Tsnie.mp3
    DATA: DATA (Non-Resident)
         602072-608455
 20                 2013-10-18 13:51:52  665e256b848c6932d601ba9c7a69d71a   

b7d4ce6579d8ecd957ff0c14651de2bdf2292796
e98e2fe701aadbb80ac154396492411124619eae88ded655d8d1f77bfb575116
Partition1/Root/Music/Barry_Sisters/Barry_Sisters-Yidl_Mitn_Fidl.mp3
    DATA: DATA (Non-Resident)
         608456-625383
 20                 2013-10-18 13:06:18  ebc7efe7222437cea77bbb756ae20b66   

09241e9a275c0c2d05ea04fb984fe05af985d8ec
920841b083ac3a3783c057428cf447576d9b2eda5bf0a20efee56e70c30d2e4f
Partition1/Root/Music/Barry_Sisters/Barry_Sisters_Chiribim_Chiribom.mp3
    DATA: DATA (Non-Resident)
         625392-631599
 20                 2013-10-18 14:20:22  d835c7abf97c3739e3ad3a2943e3bbe5   

011f89ba643ce150000bf5db3d5f1d25d93f0293
f9eda23a76b4fe6ad41117ae5fbb18e914fc400fa01533c39b1eee1e7ff2409b
Partition1/Root/Music/Barry_Sisters/Bublitshki_Barry_Sisters.mp3
    DATA: DATA (Non-Resident)
         631600-641023
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 20                 2013-10-18 13:28:36  d8cdf8cfd4419fbb70c7f5df347f6890   
1fe23a26be467f59c14703cbeeb580ed5de3a5c9

bc0052be54f9175bb0e590aac8ecf1dcf4ba7587c263cf9fca6bc8ccc0feb3dc
Partition1/Root/Music/Barry_Sisters/Hava_Nagila-Barry_Sisters.mp3
    DATA: DATA (Non-Resident)
         641024-648903
 20                 2013-10-18 13:41:54  675c2e035c953df83bc6dd245966ff8e   

30d3a38b8b4f55bd67a82035c42d0a304c1db394
f16175bc9c26f9fe3fc8d8b8a497eef3d29f6642372a9472cf33e805cf4c8882
Partition1/Root/Music/Barry_Sisters/Hevenu_Shalom_Aleihem-Barry_Sisters.mp3
    DATA: DATA (Non-Resident)
         648904-656031
 20                 2013-10-19 02:03:04  8cff6cb8a834d5a0e00366853c2ed8bd   

494933f834d9c170f0a3aff602c2093a8e62ae13
bd0271ca25d8f9c6c58bb13c6bb8b7dd478bc1255da5cb427e3a1d836dc11db4
Partition1/Root/Music/Barry_Sisters/Papirosn_Barry_Sisters.mp3
    DATA: DATA (Non-Resident)
         656032-665879
 20                 2013-10-18 13:37:44  c928185e9da6fd4bb10b64b5b578552f   

32fcebb494330a3fff73fdc9675c4c8057f3cd00
3e8a99fa1a7f6e3eabf64d155b1e57f3006a9f7847f21e798642b3a445339a93
Partition1/Root/Music/Barry_Sisters/Vi_iz_dus_geseleh-Barry_Sisters.mp3
    DATA: DATA (Non-Resident)
         665880-682359
 20                 2021-11-15 10:47:26  
Partition1/Root/Music/Electric_Lgcht_Orchestra
 20                 2021-11-15 10:47:27  
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981
    $I30: INDEX_ALLOC (Non-Resident)
         54296-54303
 20                 2005-04-07 03:11:40  e56b81d6e95ba198ba13f55a6c94d9d6   

1f7b7dd059fe88dd1373c218ca3fdcd549f32758
348646f1fa7fd3f99d595b68a33c90f2ec43d0a439d1bbb2768c06f47ffae21a
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/01. PROLOGUE .mp3
    DATA: DATA (Non-Resident)
         50824-54295
 20                 2005-04-07 03:11:40  e183a3f026acbfaf8e4c8c9997c03721   

8bb96b64b57214247bc90c129cf363ac14f29a3b
f7d0d08f9116c4279f07c753763b89aa4415afd102b3235ab4e8f3caaadc55e7
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/02. TWILIGHT .mp3
    DATA: DATA (Non-Resident)
         700776-708375
 20                 2005-04-07 03:11:40  e71574ae3bdb6a6d39a777b63f98c261   

ea5a27d3abbe6dad451b8d5fcab8e2ed20916918
6f1ae25b46b334a0814a39f0176879857d32beca920d546573e80f60a89d3b1d
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/03. YOURS TRULY, 2095.mp3
    DATA: DATA (Non-Resident)
         708376-720199
 20                 2005-04-07 03:11:40  1a5112f377cacd6d35e093d47c52fcc0   

7b5b697381584a2cb6e6c32199d563c7807019ef
9be8d830897a6e8ed2bfd9f4f3196e8a5c32862667cfc049cce196aa7fcb0561
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/04. TICKET TO THE MOON .mp3
    DATA: DATA (Non-Resident)
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         720200-731799
 20                 2005-04-07 03:11:40  f9d68c6e0468aed135415687d65e41a6   

bd2292b32c41c9d04b8c64e80162c37a14377986
32f769043c203cd172d4595c79e043e650b48b218e0c7187c7c53576272d98e9
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/05. THE WAY LIFE'S MEANT TO
BE .mp3
    DATA: DATA (Non-Resident)
         731800-744895
 20                 2005-04-07 03:11:40  75d6f8ea67e56aff2c37a7355c311c81   

55a5fea075d9c791b07109450e3f80f3c36ad700
dec7a546e447a06e821bfae76d56842886a66e524a49e27126593b9c0fb806dc
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/06. ANOTHER HEART BREAKS
.mp3
    DATA: DATA (Non-Resident)
         744896-755583
 20                 2005-04-07 03:11:40  f20ca468c271d565a9cf8a2b5dc00064   

ff4c2759b70f49cbe7926aacccf1da736f3dc5c6
644040723a1cd11e09a7bf8e4d8cd88cd30716b9679ae9884af9583dd6744e44
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/07. RAIN IS FALLING.mp3
    DATA: DATA (Non-Resident)
         755584-766583
 20                 2005-04-07 03:11:40  9f71d12c63e3c3df2a343ad6f7949e1e   

7517b6d91b71bf3e4a52ac33ca78ea99951f1d76
2ce95099a194b20d8e64d8ed79ab4e61ecbc784b6695e3af431a7e9dcd92bad7
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/08. FROM THE END OF THE
WORLD .mp3
    DATA: DATA (Non-Resident)
         766584-775807
 20                 2005-04-07 03:11:40  13521f054f7d59ba7cab3df7da45257e   

ca176095f3b9164be65daba5f2a97f695f40dd07
0a943aaa8f0318db5db96170499523f8890de0a788885943adba75efd7db8af6
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/09. THE LIGHTS GO DOWN .mp3
    DATA: DATA (Non-Resident)
         775808-785815
 20                 2005-04-07 03:11:40  c05d2969d001899b4a175a4e68c2fecb   

9294e29e1f30e28f23922416b5a908a3109bb9d5
1790a250729eb139b25d588de3f53834b8f2f7cd2928125784b0df8aeb3a892b
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/10. HERE IS THE NEWS .mp3
    DATA: DATA (Non-Resident)
         785816-796343
 20                 2005-04-07 03:11:40  4a6ac89638420964737bcd597e12f667   

ca4fbdc19d85bb999c0bc1299f57f25a690ae3a4
4a47e924470a26a57ebb89b947cfdc9eb96477838050fea459aaa01544a8aa8d
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/11. 21ST CENTURY MAN .mp3
    DATA: DATA (Non-Resident)
         796344-808063
 20                 2005-04-07 03:11:40  1b3bb20062656046700d2356c66978e6   

e985fc4780e2f3ce001ba44e6cadaff8df4b4bab
0089088cb3062cbfa50f8d414ecb68c5c94f9d9aec77966fae55a154553f7f5c
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/12. HOLD ON TIGHT.mp3
    DATA: DATA (Non-Resident)
         808064-816815
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 20                 2005-04-07 03:11:40  6553cefc73c2eb9c974d65d9e100ce63   
a63cf43e4e070796a1e0f5636585ef855e647226

5b78807b8012ed28af78845c00244a3ae6575e8afaf280d0c3184de600d55541
Partition1/Root/Music/Electric_Lgcht_Orchestra/Time_1981/13. EPILOGUE.mp3
    DATA: DATA (Non-Resident)
         816816-821127
 20                 2021-11-15 10:47:28  Partition1/Root/Music/Ennio
Morricone
    $I30: INDEX_ALLOC (Non-Resident)
         54304-54311
 20                 2001-08-16 14:00:00  e9d6556f18f45fcc506d99d17ca3010d   

885dbda70b153885ad660dd3f87f0ecbcc7d21d4
554c109bf97dcfca8d5bbc27d255dc2e963ca7430056105fc3538529ccdaed38
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-A Gun for Ringo.mp3
    DATA: DATA (Non-Resident)
         821128-825511
 20                 2001-08-16 14:00:00  4b2bcfafa655751e0be9aad58d32df98   

a8183fbb98ddca996fd50fdc7437c5bdfef48540
f54573a8c38b12641a9a9db40ba85ddfa0ec67103e3967d5f45e7f97fe9971f7
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-C'Era Una Volta Il Trenino.mp3
    DATA: DATA (Non-Resident)
         825512-832503
 20                 2001-08-16 14:00:00  cc03b5901e0950ed7f6fce239c53f387   

97a6202ed8a5a7613a5d92b8670654fef60c802f
d77bd85c9a96cc1ba4a3f091499a725910552ad4a2b7df1ee78412d09f5d0934
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-Chi Mai.mp3
    DATA: DATA (Non-Resident)
         832504-840895
 20                 2001-08-16 14:00:00  8242372bc075979a755f5ebc64b1c0f0   

bd4b071c45c321ae859e6fa1bc29a8c6408982a2
d92f7501ae994e95527fdd1e6e3d721c206466f1271e6a27a1b0a0196b23b14c
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-Cockey'S Song.mp3
    DATA: DATA (Non-Resident)
         840896-848991
 20                 2001-08-16 14:00:00  167926ceb7f39e1707f1514fb44ac9b8   

bb942a68678bf29a9e0d847e5e644bfe43471a96
7cc3f790f6f420158a51bfc20c7b23e468259b9b09d664f6effa116b242112ca
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-Farewell to Cheyenne.mp3
    DATA: DATA (Non-Resident)
         848992-853927
 20                 2001-08-16 14:00:00  9ce646a5049fdd19bee62c84eabebd5a   

95d1260f50f41efb91474471f0111428979bbf41
ec42a38484cc6fd4fc83eee6471d01115db77bf174c586d8b4edca7b06b8a387
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-For A Few Dollar.mp3
    DATA: DATA (Non-Resident)
         853928-858559
 20                 2001-08-16 14:00:00  6704adff61e44c1f7daa9ce2baabbab0   

051a4ae5d60171a60c6074a2fb36621fcaeaf211
d4b43c1f5371386e9f1b7dae44f7de1dbe8d9ad78da0b2a9ad6a85da6a8c02f7
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-Goodbye Colone.mp3
    DATA: DATA (Non-Resident)
         858560-861895
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 20                 2001-08-16 14:00:00  df47b2ebadac3343ef63ba820f567d55   
21c4de7b3fb30bd0093cab0c8f19d7aeea3cf10a

c24c1a09c7dda361b870b14634ae7d73ee8d8032ed9edf9dc11335ecce8ef580
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-Le Vent, Le Cri.mp3
    DATA: DATA (Non-Resident)
         861896-876823
 20                 2001-08-16 14:00:00  dd654b0d7aadbd4ed5aa2f07f601d54d   

db453dc07334b16e5cd0dec60a1c2fc89ffa30df
54bde5e91c19478763fd4a20947a573ffda7a217832e596849967eeb7bfddeb8
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-March of the macgregors.mp3
    DATA: DATA (Non-Resident)
         876824-881551
 20                 2001-08-16 14:00:00  f2857800c13a4eb3d2c196093921f56b   

bfcc6fbcef98f95d5ec1c0774157de3b20335f0c
9c2c7fa2afebd245606977bfb5b47dcf966099fee8edada864245eba72655468
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-Once Upon A Time In
America.mp3
    DATA: DATA (Non-Resident)
         881552-888727
 20                 2001-08-16 14:00:00  66ead755183f910d14aeb071b1b0a906   

250c0430cad1a773f2bc950312ce2447109827e6
5f6e0777093692d2c79dd756154fccd87de7216cdfa745376cee1dfad28cb49d
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-Once Upon A Time In The
West.mp3
    DATA: DATA (Non-Resident)
         888728-895631
 20                 2001-08-16 14:00:00  f8c04ca99abc731f691dac5d1258c623   

50a4f21dc3daa70a9d5474bca6cbd1b2fcc5069e
cd81f63dba683d5a7be2a10a67a5c953a67ceb62f4f5c60972103fae64924410
Partition1/Root/Music/Ennio Morricone/Ennio Morricone-Overture a fistful of
dollars.mp3
    DATA: DATA (Non-Resident)
         895632-901135
 20                 2016-04-28 14:51:04  678be5fa10fd689690b47a63b8091549   

8a196fde7b67298c6f65f44b17a74a318218c748
c0fba9eb8cd60edf592efde7a94c273083a20f55fa5e7349781bbae8605025d3
Partition1/Root/Music/ CONFEDERATE_SONG_TO_ARMS_IN_DIXIE.mp3
    DATA: DATA (Non-Resident)
         163592-167895
 20                 2016-04-28 15:12:33  cb2a01e7a4de030627a8bd11330853a4   

55d40b7ca48373cc59e03b2614a0005731d5de62
605c872d2891b98875f39782521e108538dc511464535a89a76b786b48348c81
Partition1/Root/Music/derek-warfield-the-southern-wagon.mp3
    DATA: DATA (Non-Resident)
         682360-690663
 20                 2016-04-28 15:14:01  d09612ad1b02eb2f89ce0f7cb54687b0   

72d986512c390254a289a02ea36c1a6b10ff7cd8
9c783ba314837f59174f2a3713327f92fdc0cb4de41643bd23ab8717a3887989
Partition1/Root/Music/derek-warfield-the-wearing-of-the-grey.mp3
    DATA: DATA (Non-Resident)
         690664-700767
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 20                 2016-04-28 14:46:58  31cce7cada7d6e1250024562038f851f   
d7bbd1e78ad71bb930cc00b809ea08ae7d3f8c06

48ef762818c7e36088ed5ca27c8d0f725ee0ea16860cae92cc810b5161495de0
Partition1/Root/Music/Im_a_good_old_rebel.mp3
    DATA: DATA (Non-Resident)
         901136-915415
 20                 2016-04-28 14:36:43  698ab247141b7ee08376ca4bdc107614   

324362db1940e541cb85932aabba5335b6d39051
2c23952b20f4187c39d0fd1a78ff32d49c6d217d49eb3f60d45d2643a24121a7
Partition1/Root/Music/johnny-cash-cry-cry-cry.mp3
    DATA: DATA (Non-Resident)
         915416-922327
 20                 2016-04-28 14:32:14  24d2f32b70c8720297b4683e45526d53   

e0dd254f7b546f3e11ce1e9a09f58570c361dd19
7adc7fe757bc7cdef0fe354b0bb8d78a22c192f8c4a52c177d9a025297e213a5
Partition1/Root/Music/johnny-cash-san-quentin.mp3
    DATA: DATA (Non-Resident)
         922328-929727
 20                 2016-04-28 14:38:27  ea34e906ad80d8c007b228d64f43325d   

61c9e3055c945058176152d9e3173f90a9f4c37b
fd4d14e4c536ced737fddd3c9503c4d6fe2fa2b15a797bffce2a822b6edbdb01
Partition1/Root/Music/Johnny_Cash-I_Got_Stripes.mp3
    DATA: DATA (Non-Resident)
         929728-935607
 20                 2016-04-28 14:29:20  012ff60673c13ee257122f7c89ccc8a1   

3bc32eb8195628611ebb11ecfe891b5ec974d3e5
63c6eb80644401b50f6056ccfa6bba2b28acd50354de27ab94ec7b2bb3838a35
Partition1/Root/Music/Johnny_Cash-Man_in_Black.mp3
    DATA: DATA (Non-Resident)
         935608-949151
 20                 2016-04-28 14:22:18  59d71c51254e6a34ec2b56bd24215f0e   

ae45fd4e2ae3f49d99703e42ab4098eb971d2454
1c48623249bf89e918b06169d6e6ff08f5d9902ec744762dd99d040f690348c1
Partition1/Root/Music/Johnny_Cash-THE_GENERAL_LEE.mp3
    DATA: DATA (Non-Resident)
         949152-956031
 20                 2016-04-28 14:35:10  59f3006e9f2f718ab75f7373e92bbd12   

bffb06aa970738517061f1358e318e5cc78273c6
5f7d1a6b32d4f316ac05b41e91b6a2752a860338cb7c09850c5d92a3ce897472
Partition1/Root/Music/johnny_cash_ghost_riders_in_the_sky.mp3
    DATA: DATA (Non-Resident)
         956032-963071
 20                 2016-04-28 14:44:03  5286083472934c6997889b1384dd750a   

f3eb5f4e78bfca1a1e4718c83a1e3b7a8efa946f
e02aa2f29274a73d1d4580cb00f5bc6f4166ca87427e0d8a4558ffea3e7fc1bf
Partition1/Root/Music/Stonewall_Jacksons_Way.mp3
    DATA: DATA (Non-Resident)
         963072-967495
 20                 2016-04-28 14:58:37  aec6b3e9c714bdb1472d21aad613006a   

e0c8ab1280482e428a65286e156a3287274fdb3e
d3b8e261c2afb6b0989e6a2d83205ea06603345ad3b336447d68ace48e697af7
Partition1/Root/Music/The_Bonnie_Blue_Flag.mp3
    DATA: DATA (Non-Resident)
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         978264-988463
 20                 2016-04-28 14:16:20  85c29de2ac785e0f2453e0b86334ef54   

d5b2bc5822e324b4e943e076e6075aab8314cb56
a9070f9bc811a4174461542046a71870a99a84c5d05dee4452bcb1ce24f72a91
Partition1/Root/Music/THE_BONNIE_BLUE_FLAG-1861.mp3
    DATA: DATA (Non-Resident)
         967496-978263
 20                 2016-04-28 14:17:10  6cb3521e4ab602c95a09a61348545cfe   

3bdeb449dc5dbf5508e097b41a91d85c8a02df3f
c56dbe344b96a59932a0049378a6c591d19d189948ea0fd1e3b33dfd2ff6e7d4
Partition1/Root/Music/Yankee_Doodle.mp3
    DATA: DATA (Non-Resident)
         988464-993359
 20                 2021-11-15 10:47:35  Partition1/Root/Photos
    $I30: INDEX_ALLOC (Non-Resident)
         54320-54327
 20                 2021-11-15 10:47:29  Partition1/Root/Photos/Diving
 20                 2009-04-29 02:52:42  1be9257a5f5816119a1ee7932f277709   

b164610273e1684806c4cfdfb087dd6bb9c45ae4
de7eee26d1a8ef8b8f7098ca323d635bc2f2e2ec3260a8e7cdb9afee41d679aa
Partition1/Root/Photos/Diving/MyPhoto1.jpg
    DATA: DATA (Non-Resident)
         993360-998599
 20                 2009-04-29 02:53:22  96d4bd523d897cb9b71d81b9703e7361   

d4688bb699075afc0892b2a044eb42367c934c3e
7c0cb8fc34246a7711cf0e0ea56589fafdc204a911d20fe60ec23f516ca6a859
Partition1/Root/Photos/Diving/MyPhoto2.jpg
    DATA: DATA (Non-Resident)
         998600-1002175
 20                 2009-04-29 02:53:58  bb6bbeaad2b8ef9c9abe4648de3a5999   

cdfcfb3779a3a208af1f7643914dce53632588c4
6030e056aa02221686bf6e6a32cfa7abff8a1401c28b43d57eab23a2aa1fc5f2
Partition1/Root/Photos/Diving/MyPhoto3.jpg
    DATA: DATA (Non-Resident)
         1002176-1005727
 20                 2009-04-29 02:54:20  beb944c66d0c83a708fe1c69011a5d42   

4a9ebcece6a0c3a780f6e9852e065f2ce7d625a0
2b6598767763c096a1ec8161fd98ad00c878a514e91224e74598774e1285d00e
Partition1/Root/Photos/Diving/MyPhoto4.JPG
    DATA: DATA (Non-Resident)
         1005728-1007495
 20                 2009-04-29 03:13:38  55bef019410f8bcd10731a46fa250909   

35fa0050b34ec540b6f9facd24d01d31094f8bc4
c343fee6083774eeabe36c0e4496de4af942ec99ac3f454c675cef28cf6f9552
Partition1/Root/Photos/Diving/MyPhoto5.jpg
    DATA: DATA (Non-Resident)
         1007496-1013919
 20                 2021-11-15 10:47:30  Partition1/Root/Photos/Helsinki
    $I30: INDEX_ALLOC (Non-Resident)
         54312-54319
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 20                 2007-07-25 00:14:30  28b5e80d00c5c1e44547e944319f2fc4   
6cffe5d309990d77989a119859d4f353f0e0169a

2622f7b32f509b200ac78787efd194133f8d36000fc739d22f0dad47a606e7b4
Partition1/Root/Photos/Helsinki/Helsinki 005.jpg
    DATA: DATA (Non-Resident)
         1013920-1016151
 20                 2007-07-25 00:14:35  0985e9acf3eed9f6efdc54f6444a890c   

8409c041c31a8eb3023994ed1b8f49781abf32cd
477aa2e3af10f4bc3715b20d37e89e52692450827b65563ff2223cc54d763287
Partition1/Root/Photos/Helsinki/Helsinki 007.jpg
    DATA: DATA (Non-Resident)
         1016152-1018815
 20                 2007-07-25 00:14:37  6c0f93298d0e48ba408f661bfc2236e6   

6fa4cc63ea595337398e2edb7f070860cd510b03
8cfc04cb423aa7bfdaac2580107e4dc2a5d05544848ea3de7c8c2fd22519390f
Partition1/Root/Photos/Helsinki/Helsinki 008.jpg
    DATA: DATA (Non-Resident)
         1018816-1021879
 20                 2007-07-25 00:14:39  eb17a6b5efad44800ce7d7d83c69eff6   

ea0ca44a349338d6c4776c6a96fb7829316d9041
b83b385bf8de8d8457ffa0b8ae5e6adb625fc9153ffab29bae8afda438cb516c
Partition1/Root/Photos/Helsinki/Helsinki 009.jpg
    DATA: DATA (Non-Resident)
         1021880-1024591
 20                 2007-07-25 00:14:54  52a5aadcbfcaf383d1a0297bac0fb533   

7faad9d693e98fad561813e6d4257fc34ef214fb
77cfcae9196c54e0a33116bfc6659e33835bae5ade4aa19a71f3a64fdd943b04
Partition1/Root/Photos/Helsinki/Helsinki 014.jpg
    DATA: DATA (Non-Resident)
         1024592-1027959
 20                 2007-07-25 00:14:56  ff01a8fcc0828e06a441d6da9d971b25   

ae1fd253e25c59f3825809fc18055c7a84dde7ff
78dd23b664150bbfcedb1a8146c8b6db6e00b6839ba9f3e7b5c064d61740fe77
Partition1/Root/Photos/Helsinki/Helsinki 015.jpg
    DATA: DATA (Non-Resident)
         1027960-1031215
 20                 2007-07-25 00:14:59  b7fd46830da4a1c74c0dca5be70fcdfd   

b550ecd95a731e7fe45cf52b43676883409773c9
08447b4529b38472248673ee2ebb2e9f24958cbd662bf53680fe5bb43f647846
Partition1/Root/Photos/Helsinki/Helsinki 016.jpg
    DATA: DATA (Non-Resident)
         1031216-1034159
 20                 2007-07-25 00:15:14  42cd2c12e0f30c16eaa5e32791ea2865   

e6d0da7d265e116f8a7988070b2a8296798f2d91
df4725a0326e39af256d3a49cc83e4d4d435f121ac79a1a26eb1177060031040
Partition1/Root/Photos/Helsinki/Helsinki 020.jpg
    DATA: DATA (Non-Resident)
         1034160-1039799
 20                 2007-07-25 00:15:55  8364499c7c8615c153efece95eb08384   

2465309940f8a58182b4ed088bef7665d6b35159
84c973bf92e484c4f56575d929df42fb4ffffa275d9d1558a57d5618eec4a3be
Partition1/Root/Photos/Helsinki/Helsinki 036.jpg
    DATA: DATA (Non-Resident)
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         1039800-1042735
 20                 2007-07-25 00:15:57  21f868c3943b06282bb955cd9acf182b   

7957e9ea9347cb656f160cb053034817a52d803a
5716a3e5ee831b4df017e0eccd9df6a4b082c330d23ed134ca8859cbff65e00c
Partition1/Root/Photos/Helsinki/Helsinki 037.jpg
    DATA: DATA (Non-Resident)
         1042736-1045207
 20                 2007-07-25 00:16:04  5e0825fd4b9ea941bc183b07ee53b30b   

10f84ba2a8812560d8b9f840046c1228cc47482a
34c4ad4320904766be78eb8a5c6041ad0dd63a8c6796730ac99f6e6d7ff375c1
Partition1/Root/Photos/Helsinki/Helsinki 039.jpg
    DATA: DATA (Non-Resident)
         1045208-1048895
 20                 2007-07-25 00:16:26  f60112a20189a34ded555d744fc995cd   

2031d955a59fb5bbeaac6c5d02f34e55134791be
9fde08acebe4cb7e8dc5708a7d088791a25530418c9a35c9117da43c03a3013e
Partition1/Root/Photos/Helsinki/Helsinki 046.jpg
    DATA: DATA (Non-Resident)
         1048896-1052791
 20                 2007-07-25 00:16:53  6bdc1d3560757979d5a8c74499703fca   

d3734dd78b1dc1d7aa80e7a37c052a64e90b7161
86abc31897dd528e0d2bfbe7adbe0cf13c750f0a335cff560bd9809ee30200ec
Partition1/Root/Photos/Helsinki/Helsinki 055.jpg
    DATA: DATA (Non-Resident)
         1052792-1056847
 20                 2007-07-25 00:16:57  eab027d27180b03de7e2545824918f50   

a7840875a34c7b006c79a13f2cf4c97a8db83f84
587323db9e818f483b1f6dff3720e3c94db08a508d93473ac6c82f43dd2448d9
Partition1/Root/Photos/Helsinki/Helsinki 056.jpg
    DATA: DATA (Non-Resident)
         1056848-1062087
 20                 2007-07-25 00:17:39  fe959fdcae31e90b0fdb0a3982e59b79   

74a2b387cd3326b645d66c1219ab2104d4f10d25
7d23a5b29e990e1f4310f53f432e73dd89001a511fa0a8672214e7ab2ab86bb8
Partition1/Root/Photos/Helsinki/Helsinki 068.jpg
    DATA: DATA (Non-Resident)
         1062088-1066479
 20                 2007-07-25 00:17:51  048ac817b294fcbd35226d924dd6403e   

136b336c3532deca6c127d208732db730c3632d4
7b835006d4c1d9f5785f1a784cb86d2be8f47cef5e697df057dd918070c417db
Partition1/Root/Photos/Helsinki/Helsinki 072.jpg
    DATA: DATA (Non-Resident)
         1066480-1069903
 20                 2007-07-25 00:17:53  2b62227eb196f862d1cf457a5ddac5cc   

347e84f14e2e129a591d2d522e81297d4d4c7522
779fc6198aab07b47c7164961b9fe7fd337e52d4ef113689abaa1f31c264a1bb
Partition1/Root/Photos/Helsinki/Helsinki 073.jpg
    DATA: DATA (Non-Resident)
         1069904-1072775
 20                 2007-07-25 00:17:56  890e90a5a7abb2d1a27392229808b4c2   

5acbac453876602bcb7faaba6914248a0d872608
36274f507db46efa766e15f0a461fe5a28ed10826a281b4b96e9df0711564baf
Partition1/Root/Photos/Helsinki/Helsinki 074.jpg
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    DATA: DATA (Non-Resident)
         1072776-1075887
 20                 2007-07-25 00:18:01  d39d9a42c01b2108540103ce2f788520   

21dfc2b20479ee49c336da51cf587e72012b5bcf
495dd2dc8a6d2604529975e79572ae86d42014b3e05ce342606fcfb234afa2f6
Partition1/Root/Photos/Helsinki/Helsinki 076.jpg
    DATA: DATA (Non-Resident)
         1075888-1079175
 20                 2007-07-25 00:18:04  8e8492d1199d9009f051056b7e87f6d0   

7a03c9c26fac9c90861e698647b473f0a2a1b0dc
68029f074e36d150bec089850c56c82d5e372763c6cebedf3f471d637a92aa68
Partition1/Root/Photos/Helsinki/Helsinki 077.jpg
    DATA: DATA (Non-Resident)
         1079176-1082087
 20                 2007-07-25 00:18:06  883494b431679f7f9d39ea7d1ceb157c   

50bc8c009c7c51b4616d27a1617facb6fe328fd1
5928276ed054d2e97359345c2ba204ce53fe1cae4357100ef71dfe1aa3a023ca
Partition1/Root/Photos/Helsinki/Helsinki 078.jpg
    DATA: DATA (Non-Resident)
         1082088-1084655
 20                 2007-07-25 00:18:08  f47cd4b931c58d5c6afd085467ceed91   

b08393e2e176e342a02d3faa0ddd920cad62c021
d4169e76e48b21e828783e426a4fe722ee4be7070ee164802fe941b43819e2bf
Partition1/Root/Photos/Helsinki/Helsinki 079.jpg
    DATA: DATA (Non-Resident)
         1084656-1087415
 20                 2007-07-25 00:18:11  6d75cc9c722568437c5e8794412248b6   

13fa2483785d35170cc086691f4394650f91a418
ca5a0e3e2d3e675605bf3eaf97c2bfaa7aa543f26b21f168275aa41eb6411580
Partition1/Root/Photos/Helsinki/Helsinki 080.jpg
    DATA: DATA (Non-Resident)
         1087416-1090207
 20                 2007-07-25 00:18:13  9796e28ed4fa1a498fb0d4a88d54271a   

597df2450fcb9a316a6ff38d73019d7d3a61fefc
e368ca4f127fadca31ca967bbc4e0c053b545155864d65fdb12172ccdbc041d1
Partition1/Root/Photos/Helsinki/Helsinki 081.jpg
    DATA: DATA (Non-Resident)
         1090208-1092983
 20                 2007-07-25 00:18:31  4c313faa0ef5e45095fbbfb9df12ba3b   

701e94358467ab51eeb285128eab7b14c5a991e4
a113063e2a5139328035dfb08a1e90e1e28a547ce3d4596e1d1d2ade4a8018a3
Partition1/Root/Photos/Helsinki/Helsinki 087.jpg
    DATA: DATA (Non-Resident)
         1092984-1095375
 20                 2007-07-25 00:18:33  2b19644cde41ead9a90607ddefbd9baf   

bdd733f02ffa868959fd0211032d6743924ca0a0
f2e739d955a2257d9b5cee24b3748e28ab6303ae314c5ebd5007426f3cdef87f
Partition1/Root/Photos/Helsinki/Helsinki 088.jpg
    DATA: DATA (Non-Resident)
         1095376-1097783



R-Studio Technician/T80+ 262

© 2023 R-Tools Technology Inc.

 20                 2007-07-25 00:18:35  726690c9daec4197326eefa1c43aeea9   
029b8a8f3e152b12ad93fc24d007dbd0c4e4795b

9ba48d14266e1e0b3e0ef70e5784a948729ead0873ea22487a97a4d4107c24df
Partition1/Root/Photos/Helsinki/Helsinki 089.jpg
    DATA: DATA (Non-Resident)
         1097784-1100831
 20                 2007-07-25 00:18:37  0c72be139e24115e6c158746f68cc331   

10b55785fbb2dd271d493be3602a5f5547b252f4
a4e27da775a445947ae3609332aa8685a67de31c62d8057cc9499e26bd70d1d2
Partition1/Root/Photos/Helsinki/Helsinki 090.jpg
    DATA: DATA (Non-Resident)
         1100832-1103079
 20                 2007-07-25 00:18:39  f85c8796fa3172ddb8bdaa6cccb10a53   

1567805661f1d053fa4d53957d6d9893e1efd7ab
246697b1731a42e45c1526217fd9aac2ba85cc0d29970c6179e94a87f7ed03ae
Partition1/Root/Photos/Helsinki/Helsinki 091.jpg
    DATA: DATA (Non-Resident)
         1103080-1105343
 20                 2021-11-15 10:47:30  Partition1/Root/Photos/NY
    $I30: INDEX_ALLOC (Non-Resident)
         54328-54335
 20                 2009-05-24 07:43:16  77b5b122cd1b05c2af50cd0836f9b985   

31a3271a5d1b054dc69992580d32f26a8adb9383
47fa5a2e0ef322ddc7018a13324c80ea39dfda762d844de8de680b358b088044
Partition1/Root/Photos/NY/IMG_0201.JPG
    DATA: DATA (Non-Resident)
         1118136-1124855
 20                 2009-05-24 08:25:48  a09054f3aceefb09a45ca4478b43640e   

05311785bee82da2d04a7b83d8fa4108d48a7f84
401d1499cd59ec7ffc8e215baeaffea2c1d752a60df93783a6c328dc3373b1a4
Partition1/Root/Photos/NY/IMG_0211.JPG
    DATA: DATA (Non-Resident)
         1124856-1133791
 20                 2009-05-24 09:58:56  a343458fad6b045f9d77c6fb646f71ce   

dd2bbbb4381c49130a9ad450252f0b8c849cfaa2
860249189d3d69279458b6b3f41b2839fde01df255c81ceaf3c2ce13a4104a2c
Partition1/Root/Photos/NY/IMG_0250.JPG
    DATA: DATA (Non-Resident)
         1133792-1142863
 20                 2009-05-24 14:21:14  c29ac1f58994cb46c53a56f46fdde5b5   

a8f5e6e7eafc146e3e868eaadf38cc9f0c28ebfe
d97b2373efdab0df6877c8637749310b0c11310081e1830eac7e630232a21b8c
Partition1/Root/Photos/NY/IMG_0283.JPG
    DATA: DATA (Non-Resident)
         1142864-1151551
 20                 2009-05-25 11:07:46  f8d65215fe542da63bdee82868e0fe9a   

f9eabae61c6d18c1ad3c5dc2d45b1a0a01e6d09a
fc31eadca0b68f19c6ba0be9c8ec51ec87e2fb0e718dc2ace60e257883a6162b
Partition1/Root/Photos/NY/IMG_0389.JPG
    DATA: DATA (Non-Resident)
         1151552-1159343
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 20                 2009-05-25 11:15:24  f145c400d3ed9e69557851c522320a56   
3f56ea39f77f1fd9b18dc2041f51baa61504103f

7b4c77c6dad37857ec7fd82e960db64e4c842d05cfc72115b7d439942f8d051f
Partition1/Root/Photos/NY/IMG_0390.JPG
    DATA: DATA (Non-Resident)
         1159344-1167087
 20                 2009-05-25 11:15:32  b603d9b3aff85c5f62a9e8091f2dc916   

b496ea7f8aa7ed6e5b4c893225ae3912fc8a0970
1028b54e45ac0d610863a8e8a3448c7a428518e96b517ba9170aa5eea7cfd0eb
Partition1/Root/Photos/NY/IMG_0391.JPG
    DATA: DATA (Non-Resident)
         1167088-1175415
 20                 2009-06-06 12:01:08  94ca44fd6bcad151e18159393fc0e71c   

0b9a0d4d357d9236ac8dbc2d09b3e4792c934a14
c8a4056f1e11d6d4041bf97db5cb37c102f9117e36009a723881f809cb84c881
Partition1/Root/Photos/NY/IMG_3694.JPG
    DATA: DATA (Non-Resident)
         1175416-1187271
 20                 2009-06-06 12:11:32  35df6163f8b1154b535bb185aced2d56   

01f1be100762c5d175ec75eb8333079551f29c00
fc71d8ebcc188ba26d3e07a28da5ddf89078606d20d84f4922412ef8a5aac283
Partition1/Root/Photos/NY/IMG_3699.JPG
    DATA: DATA (Non-Resident)
         1187272-1197455
 20                 2021-11-15 10:47:34  Partition1/Root/Photos/PNG
    $I30: INDEX_ALLOC (Non-Resident)
         54336-54351
 20                 2016-08-09 06:29:55  0e20c4014a80419756af6b3618d894d4   

dfeb1486ddb64d89b56426847dc945d40a7413fe
7392ae31589eeb672798620f5fa6f5776a67c7aa7494c455e509df324e915a09
Partition1/Root/Photos/PNG/DSC00398.png
    DATA: DATA (Non-Resident)
         1197456-1204095
 20                 2016-08-09 06:29:55  50a39ae6bdde09570419e04899e861ca   

7d9a673c484ae32fa631bc03bdf3f3c5c670524f
957f4fa27af2dbbc6b4d5156a8151a6222093e8dad15a7c53559c118fe8443ef
Partition1/Root/Photos/PNG/DSC00400.png
    DATA: DATA (Non-Resident)
         1204096-1208903
 20                 2016-08-09 06:29:56  07a975f0d121d5710e9e0678c9f08a5d   

d15beaa4483bda7879642f452a76a5f9d0e5a2ec
aabc57174e53dd3af315c336720dfef22fdaee6ece52bfc59a8e36ed09cd31a6
Partition1/Root/Photos/PNG/DSC00401.png
    DATA: DATA (Non-Resident)
         1208904-1214455
 20                 2016-08-09 06:29:56  1cfea16f1e3b86b9d85ec43a1c146405   

c78d1c40f4579c7c8a98d9cd6629083a48c42a03
51415fb98f758a51ec6fd914cf6b57b9d34fd3564f61b05a57df7376f038b536
Partition1/Root/Photos/PNG/DSC00402.png
    DATA: DATA (Non-Resident)
         1214456-1219775
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 20                 2016-08-09 06:29:57  f39301a4119a7e8b83f8bb9573675cb7   
1bd0dc7373246658aa02cd49846f51b9cb4baa85

f5cc938586b14de903d81f20d3948c41ceb47ccbb4bc8062899f750371d5ff85
Partition1/Root/Photos/PNG/DSC00403.png
    DATA: DATA (Non-Resident)
         1219776-1230831
 20                 2016-08-09 06:29:57  2b6dd7410024c29335480e4b01ecf6bf   

8b76cfdfc2c4bc8ccfef9bfa859e0a7d798bdc25
e1ef35ccca901231062b8d831a77e703819a931a5e63e0c23761754798e3e44b
Partition1/Root/Photos/PNG/DSC00409.png
    DATA: DATA (Non-Resident)
         1230832-1236839
 20                 2016-08-09 06:29:57  831472853caf70e4279eb9b10fb95502   

946d4e88d33b732e7ebf9e4a76ba8eac5d5efbab
3f124d3163afa23b01b70667de6c4eb8ae56763bca0def60a74f24f7c9eb434c
Partition1/Root/Photos/PNG/DSC00410.png
    DATA: DATA (Non-Resident)
         1236840-1243119
 20                 2016-08-09 06:29:58  554ec19309cce9e77234673957d843a6   

4487afbe76ff4de2a255a2cf1b3c428c46ac0fe1
1ada79bc031064a27353aea69860a3edd9bcfc6eadbcc9af2c115cad419cc275
Partition1/Root/Photos/PNG/DSC00411.png
    DATA: DATA (Non-Resident)
         1243120-1249863
 20                 2016-08-09 06:29:58  bbbfa1afbe6caf6d20727636eca423c6   

11b5983ecb84b0fd177be00e6319d2598d0e577e
9374fb21b2c7126dfc5f7101471baffff849998d9eb42796a280c448ba95ba68
Partition1/Root/Photos/PNG/DSC00412.png
    DATA: DATA (Non-Resident)
         1249864-1256839
 20                 2016-08-09 06:29:58  d6596d9f439081baed836fa0c8a28a8e   

15c0b00e68f538c8d5ef69b2bc27e9362a8dd439
4cdcf050e903d1daa38d87b04855c7419e44409165d2ea41381c7cb122d3b257
Partition1/Root/Photos/PNG/DSC00413.png
    DATA: DATA (Non-Resident)
         1256840-1264383
 20                 2016-08-09 06:29:59  3980b368079e048f6f8eed6d218f1456   

97d2ce7c74dfd4a07f6b162b69b822945e50413d
073a2f3e47a5092e8877a46b441a3f95eaa73d1e7558c746ca833b87dadc1013
Partition1/Root/Photos/PNG/DSCN0108.png
    DATA: DATA (Non-Resident)
         1264384-1278247
 20                 2016-08-09 06:29:59  3af85c982fdaee46f578fcec569f037e   

36a556ffd3c56988dcec87a15b61c0a916132be3
c412553bcb7e21e6cf15e377873ee80738a6b6f9990b4e84fd7fa9b1db44a95f
Partition1/Root/Photos/PNG/DSCN0109.png
    DATA: DATA (Non-Resident)
         1278248-1288871
 20                 2016-08-09 06:30:00  c1ac17a6c98f27fbeac401359f14b515   

e6b6186c29e38ea7dbda9ba4b8c242732d4b2241
3bb72a8e56f4f4f36760fd9256a366690650f54f8202d789bde31af8535fad46
Partition1/Root/Photos/PNG/DSCN0113.png
    DATA: DATA (Non-Resident)
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         1288872-1299927
 20                 2016-08-09 06:30:01  03d72084aa58d9ce060595bcfe0257a7   

973a861c8388d4caac711f847005e944edb50d13
b2ce7f5ec69b5418bc723a160f4cc8780a9d3184efb2d3de220d0cb848cb6c33
Partition1/Root/Photos/PNG/DSCN0116.png
    DATA: DATA (Non-Resident)
         1299928-1311911
 20                 2016-08-09 06:30:01  a066c510d6c6ae3227d4f675abe5b0f1   

b2ae56bbcbd1962ba46802878e67b96dcf384673
1344199eda7438278493240159d4547186da9e9f485480bf7b435f4184a12835
Partition1/Root/Photos/PNG/DSCN0117.png
    DATA: DATA (Non-Resident)
         1311912-1323551
 20                 2016-08-09 06:30:02  d5dfe820657d381ad10740edc4536a67   

6b7e5f77db5bbacb5a5516ab6bbe20e19b928d48
3bd8b74067d514bd306318489cbbfd056aaa25a7cdf19e888198e35e56259e37
Partition1/Root/Photos/PNG/DSCN0121.png
    DATA: DATA (Non-Resident)
         1323552-1343399
 20                 2016-08-09 06:30:02  9a667f59d860a11fb4a0bda9f6fdf0d6   

9a6cc2c151aae01c03fe955fa44b5e1e482d5ce7
7759c44a7b384eb1c5bd0e351bfd91a7a839f1ac4bfa7ab813ae5c48514a2bc3
Partition1/Root/Photos/PNG/DSCN0124.png
    DATA: DATA (Non-Resident)
         1343400-1347279
 20                 2016-08-09 06:30:03  2c08bc733d7461eeac2b1a9af2b9f360   

dc4fe2772c7392aa184a9f83fd9a34114024f5ef
af0c4ab532fca75fa8f84b80a0d7fd6b3d9593f531ea989ba84b8b7f94d6a3b7
Partition1/Root/Photos/PNG/DSCN0125.png
    DATA: DATA (Non-Resident)
         1347280-1357855
 20                 2016-08-09 06:30:03  0a5e03889a84d667baabdd3094e61025   

ec6077f5b83a2f683c82a7279511a6478fe98f91
f85747e4ca8289fd1ef0c96fddd7aaddf70b3733c2a91054f762968ce8ee6942
Partition1/Root/Photos/PNG/DSCN0129.png
    DATA: DATA (Non-Resident)
         1357856-1367767
 20                 2016-08-09 06:30:04  5ee9282489f0903303703bb5d77d439a   

d5da1618ec1281d2e48e8f74fdce2e1eab40576e
b5be34d6680d6ea87ae54801dbb57cb720b2bd872dcfc527a8550c895c03727b
Partition1/Root/Photos/PNG/DSCN0131.png
    DATA: DATA (Non-Resident)
         1367768-1379495
 20                 2016-08-09 06:30:05  9e953995ca786148098b427656a60e35   

090f7c89de46092ea19b3b0a0f8b93300bbf0dc6
46d66ae03cdb2566c5893391e2c8cdd3f8402914bdd635cc9def0d46c7bfb23d
Partition1/Root/Photos/PNG/DSCN0132.png
    DATA: DATA (Non-Resident)
         1379496-1384247
 20                 2016-08-09 06:30:05  cfe7fe275b90861aa58433e1aaada445   

84afbdceb6f06bc5fd4ef5ae58a7417357d2b5fb
5edfd80300f07e45c8484d52c005afe83c00b56df1e56f3387ae2047120c4729
Partition1/Root/Photos/PNG/DSCN0133.png
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    DATA: DATA (Non-Resident)
         1384248-1402263
 20                 2016-08-09 06:30:06  ca234fe6fa2fc56916c1450e9fcc891a   

f62c36132b14d9afa36d1a2927cb4c5f2bba9705
7462ead43cbfbee4df6e1673ccc2d08800641de9b32f905f0f85dd7196a916f6
Partition1/Root/Photos/PNG/DSCN0135.png
    DATA: DATA (Non-Resident)
         1402264-1413071
 20                 2016-08-09 06:30:06  2c386dda664658d66050e7cfd9d869fd   

7ca02cbaab88968b2b30e34b2d1e81cd9fe0b8a4
d219ab0e123d60887b31202dae8c68045518346d90511b86d3c908c763b58b2a
Partition1/Root/Photos/PNG/DSCN0136.png
    DATA: DATA (Non-Resident)
         1413072-1425783
 20                 2016-08-09 06:30:07  b2b1be511998f2e630475d164efa0c3d   

1482b7550f5f958eb62e5c3a77a13b594d33695f
7d580fccd6dfb31cca059dfd4032ec4793de0acba9c3ba89ac63fc3724f5b4fc
Partition1/Root/Photos/PNG/DSCN0138.png
    DATA: DATA (Non-Resident)
         1425784-1432047
 20                 2016-08-09 06:30:09  28c3d52822bcd0eb7123a20f9d0f71a0   

0add9ad208f1878ee29f26f74746591c81377934
ae8696cbc2e7427fa257d6760471a8aa8255f6c17e5ade05c8c83874e8c765da
Partition1/Root/Photos/PNG/IMG_0301.png
    DATA: DATA (Non-Resident)
         1432048-1460183
 20                 2016-08-09 06:30:10  f5e5a8ad113cf60301cc3038738018df   

db903a727602dca3f285d4c837bb7b04591dd260
229324830ef256de4a568105244876dc6cb38c7fcbc883b23d1ceb599c10d529
Partition1/Root/Photos/PNG/P1000075.png
    DATA: DATA (Non-Resident)
         1460184-1482863
 20                 2016-08-09 06:30:11  dbc0c95df4c2b4a16fd5d653a03e3a03   

3fde4c2902804033cfc33f70292b5e840b649917
f257c37d5437b8f38c33d97f2df239fb07990af33080676d5721a798c3fcd268
Partition1/Root/Photos/PNG/P1000076.png
    DATA: DATA (Non-Resident)
         1482864-1500847
 20                 2016-08-09 06:30:12  a3df8bed38651d33eac4b21dd6a001e5   

20c969a51774ada67c4488028b73fe5db1883ef7
9475b205dded40cc9b42d5c9a5ac75021fba4c068f4e1aa5f984e4b42930a1b5
Partition1/Root/Photos/PNG/P1000077.png
    DATA: DATA (Non-Resident)
         1500848-1522703
 20                 2016-08-09 06:30:13  7262d86f98a816ac5aa19d5000fdaa38   

ca5a2244d3bdea722af50db79459d4f56ac29aea
19265744bc50cc6ebdb7dd30c358d350d589827ce088da6b12a73d7bcc6b8415
Partition1/Root/Photos/PNG/P1000078.png
    DATA: DATA (Non-Resident)
         1522704-1544367
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 20                 2016-08-09 06:30:14  20f2266bc91a926c0af8fb8890b39cdd   
a3d919d08dfae21239593898960b415f4fcad938

c8fa689c01b91841af197ff442ba4aefb5673021bdcc4e9cfd9e40504ac381df
Partition1/Root/Photos/PNG/P1000079.png
    DATA: DATA (Non-Resident)
         1544368-1566127
 20                 2016-08-09 06:30:15  b3943271dec5e1d6f8f98ce41195a573   

9fa3da99f4a4ca7c1370f8c91d4789e3d6de658d
60bacec13cd11f0b094df945f9024bff7b916d8491cb3219085c7d1e22322bfc
Partition1/Root/Photos/PNG/P1000080.png
    DATA: DATA (Non-Resident)
         1566128-1587527
 20                 2016-08-09 06:30:16  399f7ca061e54f792c0842ddb75abe08   

f70bd20e4ae6d08da136889d32d066f6fdf17089
fe0f4d8b2cb268cd92235375fcb5df2445c27498c663ee64f3e84a5d97931246
Partition1/Root/Photos/PNG/P1000081.png
    DATA: DATA (Non-Resident)
         1587528-1609207
 20                 2016-08-09 06:30:17  badbc4166c959a41bc77820f2c1aa5ac   

24d11bd0f46e9598a4a5a09e7c2c250f4c0190f1
fb9a16f920b54863194096ebdc384445f0fb82d3cdbf1224607fa46b6f72a6f2
Partition1/Root/Photos/PNG/P1010289.png
    DATA: DATA (Non-Resident)
         1609208-1631775
 20                 2016-08-09 06:30:18  3699a09b4d90e3e0466d2e025ac71f38   

db77c0005f5554eeb928a28e642c20b1c1c19459
424a8ae233c30ce4931ef37b5d76c6c335261af36b76af9bcb2e82e2e67a4c7a
Partition1/Root/Photos/PNG/P1010292.png
    DATA: DATA (Non-Resident)
         1631776-1645127
 20                 2016-08-09 06:30:19  9c8dfa6629ca4056b66ba70df36b6155   

3014b48f9d129411703968c62347a6741bde31da
397078f5d412f0dadf993efbbc6fc986e107bbef03a8e88a59f26d62ee629833
Partition1/Root/Photos/PNG/P1010296.png
    DATA: DATA (Non-Resident)
         1645128-1663407
 20                 2016-08-09 06:30:20  449a39e60fb73cd06792eb33702e3fd2   

7aa3459012435f09a2abfe5d2aaee35beea20e8b
70c8b6f17dfe2770bd089fc1c837863743d638b991eaf382713adb536cd14338
Partition1/Root/Photos/PNG/P1010299.png
    DATA: DATA (Non-Resident)
         1663408-1680375
 20                 2016-08-09 06:30:21  ee784f441db80e795a4f50a5ed06bc31   

f544a576568271f1a70995fe83bdc6926351b954
9d17e3ea583d57ca7d2b2abaa7b0f676a098d0e2e8508085eee3dd0df639f32e
Partition1/Root/Photos/PNG/P1010302.png
    DATA: DATA (Non-Resident)
         1680376-1692727
 20                 2016-08-09 06:30:22  9b2ee5928e602ec7610cad42538a2ea7   

c8a6797e0898840a416b40a71facdc991badd151
b3520b16941b9a6a82db76978bad29faed5bd1af715f9f8d0a9511e830e51c39
Partition1/Root/Photos/PNG/P1010304.png
    DATA: DATA (Non-Resident)
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         1692728-1704823
 20                 2016-08-09 06:30:23  1bfbd10558bb2dd12cadfd3032b78572   

fec0d4502b9ff0d5b892e00edb5f8a7a391f79f2
af314883ec48e419f8dfdf653c212be1dd9664af4f1fce7dd6bd56becf925b1e
Partition1/Root/Photos/PNG/P1010316.png
    DATA: DATA (Non-Resident)
         1704824-1726783
 20                 2021-11-15 10:47:35  Partition1/Root/Photos/SF
    $I30: INDEX_ALLOC (Non-Resident)
         54352-54359
 20                 2009-05-30 10:13:46  be7dba7a3fff3748f1f438b728b279a4   

3cc2043ed0f732f71cf92f505fafb9e8282925e2
9249d50a8d9054d2bc182f1504f085621c8db30e7fd3081b5dfd83f5d9890c3a
Partition1/Root/Photos/SF/IMG_0869.JPG
    DATA: DATA (Non-Resident)
         1726784-1734007
 20                 2009-05-30 10:15:56  999611c3e27def28c94708e9b6203db8   

34b2fda8e0db1bdee804c403574e0e067e07cb13
71f3335d6e50b888d6f80b57c2408921466623ef90d1a6f33b6c5e8a775573d1
Partition1/Root/Photos/SF/IMG_0873.JPG
    DATA: DATA (Non-Resident)
         1734008-1745495
 20                 2009-05-30 10:47:26  ca72b6c55f22a45908b24cbd8bf29a56   

4a6f4ab37a9caa41ba1b8f5b97d81b4c157d9d20
84b973d5bafd5fa96a9c62130536c457d0f67e77db155e41f819a83d13867d52
Partition1/Root/Photos/SF/IMG_0890.JPG
    DATA: DATA (Non-Resident)
         1745496-1756559
 20                 2009-06-03 09:59:04  bfa7e431bf44e036bd8c6f77179e7543   

c501d565c9570983c7be391ad6c4175c23d8e077
e77e31291d871816c80055edee4ad8c650617c58f4dcd55b9492b8e5a07742ca
Partition1/Root/Photos/SF/IMG_1739.JPG
    DATA: DATA (Non-Resident)
         1756560-1764895
 20                 2009-06-05 16:58:08  1854c9f44cc66810600f955e7e57bdb1   

4f878ac70788a0b2942afe7449bb2b13adac23f5
e4503c9868e27b7a333e69624fe3b7d62e2ca932e1990fd96d0fc22102111c4d
Partition1/Root/Photos/SF/IMG_3460.JPG
    DATA: DATA (Non-Resident)
         1764896-1773871
 20                 2009-06-05 16:58:26  6f2ac54948b5b30ce16e477c66e111ce   

6fc0971621d0185a8364b15518eceb79d39b4d9e
acafd581b254a3c004a962a13f4cf37197819770b7b8b45d12315d7f74f8f243
Partition1/Root/Photos/SF/IMG_3461.JPG
    DATA: DATA (Non-Resident)
         1773872-1781887
 20                 2009-06-05 17:02:50  2a052e493fbcd7cdd55a850a611cc445   

442be0bacc541cfd913bfd9322b6fd453359f39d
da4c8a85efc46392dba681825a0a4eecd9a6a3d1d0f33b233638d89ea5ff981a
Partition1/Root/Photos/SF/IMG_3476.JPG
    DATA: DATA (Non-Resident)
         1781888-1789927
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 20                 2009-06-05 17:03:22  44652638deef4f478e07706566550c61   
b4393152bedf73c7c5df083b42ff7843d4602f67

b5e555ca283d8ed1b765f12312f87c3c311ef157dd8bfbbe6f1392dabbb770f1
Partition1/Root/Photos/SF/IMG_3478.JPG
    DATA: DATA (Non-Resident)
         1789928-1799639
 20                 2009-06-05 17:03:42  3872c8067f88768007a636d612c3650e   

d32f3acf3b3deeb86916106fa7d9c4537979d9eb
e9af47c22716e1d660cf85cb51b096a331f74f6f630fda53e941e3fb61000e96
Partition1/Root/Photos/SF/IMG_3479.JPG
    DATA: DATA (Non-Resident)
         1799640-1808399
 20                 2009-06-05 17:03:48  035c6628e8d5bbed6287bb85cf6022b2   

aa888343c7b2cc0b633cec47a12ac1b984f7ea99
17475eae12901a87325a745dd90adae4565f5de89f122c72a6bb64bf6de96304
Partition1/Root/Photos/SF/IMG_3480.JPG
    DATA: DATA (Non-Resident)
         1808400-1817175
 20                 2009-06-20 11:00:56  e41f63dcb998da55a02dd60fa505bcdc   

a0abbb34ddd702d6497978d1f48c92aff7f7cf31
02f936f3ba9a24f0fce9c3fa840780d36bf7eb6b01671312c085aa4c54b43ddb
Partition1/Root/Photos/SF/IMG_3481.JPG
    DATA: DATA (Non-Resident)
         1817176-1824095
 20                 2009-06-05 18:50:22  22e77e0803b18803256074b4c252bd88   

6f562ec7317481dff469c03a3e6390f9c370f00d
036c2c5dd5e4b22b3894b3a45dd6bec0da5ca5330b3d0031c40a4e32af2634de
Partition1/Root/Photos/SF/IMG_3493.JPG
    DATA: DATA (Non-Resident)
         1824096-1833839
 20                 2009-06-05 18:55:56  1300d583c82fe612dd57d3ad910a9486   

0e57692faeabc7845441bd30ac282f2cb83f29f1
6f6f10a14c50635a84a63fefcc97845831f0dbd5f78d54e6b16589462f825926
Partition1/Root/Photos/SF/IMG_3535.JPG
    DATA: DATA (Non-Resident)
         1833840-1841103
 20                 2009-06-05 18:57:38  8b1353ff9495552a19b0bfeec5394247   

1f4fe5885358892353a875c06b616c9cfe14d81b
69b90255a3a0f893a3e7565c69f0cec869ed2bce143fda09e4c1ffc99a6c00f6
Partition1/Root/Photos/SF/IMG_3542.JPG
    DATA: DATA (Non-Resident)
         1841104-1849135
 20                 2009-06-05 18:59:32  cefa4e580592809baf1c00cefacd93f0   

7c871f52b0f04cd6ceb2e6bce43164157eef6234
965587104c3492b03b42fca3c7f84ddadcf789462f1b0d46bb972b3d6466bba0
Partition1/Root/Photos/SF/IMG_3579.JPG
    DATA: DATA (Non-Resident)
         1849136-1857167
 20                 2009-06-05 18:59:40  9143872d4928619a667153c4ed3a303c   

11cdcf422af6bfda3857dfa92b38eb9095c9d242
4e8e53a15940b4c9aa50be4bb088aabfe42734e5b31259f750d0fa1db4f0b1e7
Partition1/Root/Photos/SF/IMG_3580.JPG
    DATA: DATA (Non-Resident)
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         1857168-1864031
 20                 2009-06-05 18:59:48  a545a740177ead5214943f35115e2d84   

1897045c018a11183ab3acf9e4ba123e666508f1
6fed1d2964c18f82e7d5ea8f5d3077c09a56d8536359cdd81147299abce60b47
Partition1/Root/Photos/SF/IMG_3581.JPG
    DATA: DATA (Non-Resident)
         1864032-1872407
 20                 2009-06-05 19:00:18  74896797a5afc74f9d257c087a2d7637   

407583fd0347dfa12f33662d334d230facd3b02d
4a825f744198f83421b6a61bb96e5bce642f3256bfc16178e674e3ddb5a42eed
Partition1/Root/Photos/SF/IMG_3589.JPG
    DATA: DATA (Non-Resident)
         1872408-1881495
 20                 2009-06-05 19:00:22  191bf4eac6e4bec6779e857609448a0c   

1f9531e936ae6efdf1328c4b55e22640860e2f98
e872c99ba38c4110b6175cd3cf1e5e7fd7efbb7ce3062d96ab6c5eaa140323ab
Partition1/Root/Photos/SF/IMG_3590.JPG
    DATA: DATA (Non-Resident)
         1881496-1891071
 20                 2009-06-05 19:00:22  d8b25a6d107fa25e67c01fd1691a840a   

ea92863dc37bf6d1c9d2c8f29f16424c4f768bf6
18a4871a2a3fbadb0d29653d8588b4fb32e41b9a3c6637279279384675f12dd7
Partition1/Root/Photos/SF/IMG_3591.JPG
    DATA: DATA (Non-Resident)
         1891072-1899431
 20                 2009-06-05 19:00:22  be2a41a0f6c956b0a9105cbc81366a86   

6f62e8ea9a06e82a63f796eb532be7ecdeebfd49
b68f3bad91756a3e13652c6195c2884b7867f2a13cab485ce2cb779ac36f7754
Partition1/Root/Photos/SF/IMG_3592.JPG
    DATA: DATA (Non-Resident)
         1899432-1909759
 20                 2009-06-05 19:00:26  482bfbc2665903526f3bb328d70bcc68   

61deca50b2413161e868a249afd24fa696f4cb33
fafd55132f1cc69b75470ea0c745d694240e7184b46af5c4896a0bd741f28c60
Partition1/Root/Photos/SF/IMG_3593.JPG
    DATA: DATA (Non-Resident)
         1909760-1919471
 20                 2009-06-05 19:00:30  157a7a625ea640ff216ef35c01b20740   

69d556d9d0b24e42803719f268abacb8a9b13312
428284f5eb2a1955514beaff192dc352276b4ff2630f8c45418a361be6194c9d
Partition1/Root/Photos/SF/IMG_3594.JPG
    DATA: DATA (Non-Resident)
         1919472-1929079
 20                 2009-06-05 19:00:32  b36d08d7fddeae5a02bf023c82f6ce6a   

9e42ca16ed3796bf4e5999a2984a0b02b16e0c11
3f26880ee0c4a655f47b60537967f1c4343884a8641c21ccb6f217a51298b4e9
Partition1/Root/Photos/SF/IMG_3595.JPG
    DATA: DATA (Non-Resident)
         1929080-1939511
 20                 2009-06-05 19:00:34  298393890a37472a688a82e7bbc13ec7   

03c15b242f3f0b7c82bae05898db3ad4bcd912cb
84a890dd1d913c5daccd41689890c1156ab5d45f36e34563f0c018bd145579b1
Partition1/Root/Photos/SF/IMG_3596.JPG
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    DATA: DATA (Non-Resident)
         1939512-1949623
 20                 2009-06-05 19:01:28  af118fa168b1e768805bab011ed79ec3   

9b25a5144660578d6cc32f6ea8c363460cf3f683
f0f404ce95f1b8b1e78a1d396f3bcaebb675663ea1f1456de1fd929580a5f4a1
Partition1/Root/Photos/SF/IMG_3608.JPG
    DATA: DATA (Non-Resident)
         1949624-1959895
 20                 2009-06-05 19:02:36  84013837a9cd3be6cd35dd5afb77099b   

946ed167cd548dcf48f35ee0990010941789cece
dd15a8d44aae3e54207f8cb5f0f4f214f0676b882f596d41009a03f2f6a72546
Partition1/Root/Photos/SF/IMG_3627.JPG
    DATA: DATA (Non-Resident)
         1959896-1967031
 20                 2021-11-15 10:47:36  Partition1/Root/Photos/Vegas
    $I30: INDEX_ALLOC (Non-Resident)
         54360-54367
 20                 2009-05-27 20:46:20  0f5cb6b4dc609659f4ce7e5a1c4c01aa   

fca842cc27792be149e0186d246d9d9c40c28ecf
5b38b41aaa5e3ecf533862027673b0d4179cbcc3fdfd44e99aa2d701b4025a6e
Partition1/Root/Photos/Vegas/IMG_0510.JPG
    DATA: DATA (Non-Resident)
         1967032-1975471
 20                 2009-06-20 02:42:41  c5497d040ee9ca74aacb1a627584620b   

5b0a9e275afe04aee280915acb838038dbc72eab
1cfb5f3818b7930f31a8e63762a5652badd4a1e58977f5954e2bac8507d1d71b
Partition1/Root/Photos/Vegas/IMG_0516.JPG
    DATA: DATA (Non-Resident)
         1975472-1983991
 20                 2009-05-27 20:55:54  be3c022f27e9b50f54fde9ed2926716d   

e9b1ad5e0e40903ed58448dbf90701db4ff4f4bc
0ee032b760e54100eb1fc9db986ef972a23094fb7b94edd1907f94d52a0ca3b5
Partition1/Root/Photos/Vegas/IMG_0525.JPG
    DATA: DATA (Non-Resident)
         1983992-1991639
 20                 2009-05-27 20:59:50  0d30cbcb374dc62be046953738a90523   

df8f55969022328fb652f8141b41321bf855deb3
c57233f22715b0a50cbd90e2b48acda7aaab245a8c31bc9a45aaff16373d9675
Partition1/Root/Photos/Vegas/IMG_0539.JPG
    DATA: DATA (Non-Resident)
         1991640-2000143
 20                 2009-05-27 21:00:44  277f3865011837bc68612c72eb9a2691   

b6e63a75c77639cdade2a42ca29d8eebb1e5023f
613c9c7ee324ae96857260ba9e56a1d3145de5ab368331035854a555c7cefa5e
Partition1/Root/Photos/Vegas/IMG_0541.JPG
    DATA: DATA (Non-Resident)
         2000144-2007823
 20                 2009-05-27 21:04:54  77acf0f1d75d65cbb59329f3253e4030   

6a4fd9123679ffcfdf3e0aa00a8ab81946bcba8f
6fa349225b5fd265133ff2bd8b5d780154bfe47bd1ee00c754181fe10dbd90fa
Partition1/Root/Photos/Vegas/IMG_0542.JPG
    DATA: DATA (Non-Resident)
         2007824-2015527
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 20                 2009-05-27 21:05:02  960983bce3dfa5e34935b215f0e018ce   
31a3b17c2f0b01d6924ca2c0bb82c25f1aa76de3

b52a36769aa422b741ef739e8f8bc5fe7b820e31bbc0954f5a07f028c4c8973b
Partition1/Root/Photos/Vegas/IMG_0543.JPG
    DATA: DATA (Non-Resident)
         2015528-2022495
 20                 2009-06-20 02:42:23  06ce765c697ea92ab4782b4696174512   

f3dcfcfc2e2ddd9a76ac0d172c1ee07c62beec8a
b2b195f7a62c89e5b1f9b45c3016a5e53b90b3cb8e4d6ad517d1c05b5750d0fe
Partition1/Root/Photos/Vegas/IMG_0545.JPG
    DATA: DATA (Non-Resident)
         2022496-2030367
 20                 2009-06-20 02:42:17  b2f292f1694c9d12f2b100abec8e252d   

039efc71f61ac6816f7d53f0cecabf6a64b8122d
c10eecef25e4a6d7650e4c239df01192e5c700b24b8bf275768bb8de3d881cae
Partition1/Root/Photos/Vegas/IMG_0547.JPG
    DATA: DATA (Non-Resident)
         2030368-2036887
 20                 2009-05-27 21:09:00  f7960866200a1f52ee74a46ebcd9761e   

f09b4b253fdaa5bdcf8b425111492d1ece716488
3184ac48cc4db4822d2df1ef5539e413473705fa478aa1d467eb0fcd21ee182c
Partition1/Root/Photos/Vegas/IMG_0550.JPG
    DATA: DATA (Non-Resident)
         2036888-2044927
 20                 2009-05-27 21:09:10  4ac853b049966e9cee7e7cdf9894eb9c   

30e71ec78c93e590083c26222afecfcb377766d6
5043a207a823a52d556a2532bd92e3c104941793efb1e7cbc417baa2451b72ab
Partition1/Root/Photos/Vegas/IMG_0551.JPG
    DATA: DATA (Non-Resident)
         2044928-2051983
 20                 2009-04-29 02:54:46  3feacbf5dd9afc05143f12a55f0536f0   

acf18fc7824c46e2107113e28438a1a7f3d5364c
501d7f5876228466260bcf200bed3e71fbf362f9f7f5601cf45ff8b7e3dd792e
Partition1/Root/Photos/MyPhoto6.JPG
    DATA: DATA (Non-Resident)
         1105344-1107543
 20                 2009-04-29 02:55:06  22bf64446fcd3a630ab17bf839de6e7d   

6e023a946c407fb59b2b96216f46b6d0e7f4081d
d317be69a99418cd6c1aa628837db02537b04cd2c0549099e2f5edc7f4361c40
Partition1/Root/Photos/MyPhoto7.JPG
    DATA: DATA (Non-Resident)
         1107544-1109231
 20                 2009-04-29 02:55:30  cb4bed7e6405a90b65cd80ccbec04928   

6581e5cc10659704ea5d98b81a7a326ab9640a26
94f3d3b0877947b05a4e4a6be15f9caa590ff9a9dbc3984b65bf5ea9760758d8
Partition1/Root/Photos/MyPhoto8.JPG
    DATA: DATA (Non-Resident)
         1109232-1111231
 20                 2009-04-29 02:56:50  2abc60a295d7e3eaa91cb7ad92efc788   

52de9551e8710d6978e525194b8e9cd3a44ea992
20141717c1bfbf42901603843fdd360a56ed64af6865fdc61197ec48fc89807b
Partition1/Root/Photos/MyPhoto9.JPG
    DATA: DATA (Non-Resident)
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         1111232-1118135
 20                 2021-11-16 09:38:58  Partition1/Root/System Volume
Information
 20                 2021-11-16 09:38:58  9a9e2941af363372e78db223793602c9   

172678454aa1776e9a7e71ecacb3b5a57f388c75
2ac9b80907e81185d3479e340ed6123a4063cf0fd1305cd6b66227cf30a74647
Partition1/Root/System Volume Information/IndexerVolumeGuid
 20                 2021-11-16 09:39:01  1e7a6c21c279de2ce269b029a0e2c472   

c5d14bce2dc6fd037e4ecf41a0b8ff864c0d1baf
ad4f52a33fa3d312a93a946a3c8dd4bc5826046f2e570f1c93b3c97246c6e5ec
Partition1/Root/System Volume Information/tracking.log
    DATA: DATA (Non-Resident)
         4912-4951
 20                 2021-11-15 10:46:45  69921f526526f76d9f2ecce1e61a4408   

72f60bff40c69e35d3c3ce6e00d72a2b132c28b0
5a88103911c673be8f0b86345b0c0c7a275b6312a7b666f75de78409b3cb2f48
Partition1/Root/System Volume Information/WPSettings.dat
 20                 2021-11-15 10:50:33  Partition1/Root/Video
    $I30: INDEX_ALLOC (Non-Resident)
         54384-54391
 20                 2021-11-15 10:47:43  Partition1/Root/Video/Avi
    $I30: INDEX_ALLOC (Non-Resident)
         54368-54375
 20                 2021-11-15 10:48:51  
Partition1/Root/Video/Avi/Cops_Season_24_HDTV
    $I30: INDEX_ALLOC (Non-Resident)
         54376-54383
 20                 2016-06-05 22:18:26  7f0357f25d88e1369c8dc1acd0aed663   

317dd884a8bc77e96e7fd1656e4aed35d077b0da
a48313a5f5756abd792ba5fa1da6e92f9caf0a7511435e2f5dcfce5250bea41a
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E01.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         3870016-4228031
 20                 2016-06-05 22:19:24  8dd47bbfb3420f7ff4b0b101e8cad36b   

1fd74b806f952314abfecea3fbd56b0560ebb315
72a952dc62b83d078327a25c5e0d81e6027e684238c7b1bcf02c1c29e8f097ef
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E02.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         4228032-4585423
 20                 2016-06-05 22:19:41  e389377f24ca35cc802aa90d821a246d   

3f4c33408ad18287d5f1dca0b474c208748c7002
8622c265f0c0533bd756b0b45fdbf661c23370c093c8a708b14a503238a2ad9f
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E03.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         4585424-4943447
 20                 2016-06-05 22:12:38  5e828eea4a7d198d5d029eb6a5fd8a97   

5f696a6568215a658415bbf736098166253c7bd2
ce10df567443f9c8211655bf9c62071d636dd5106f334efbbf22d57b62e0a256
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E04.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         4943448-5301583
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 20                 2016-06-05 22:17:43  409e0f6332db4c12da861cd3cab5ae14   
6d21926f26bd26e3730274b37ad69731219c29f5

e8b357b3f488e04276a2f1dfd9147e8f1b73e4a5a4ad7854abebb1e6a83fc379
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E05.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         5301584-5659415
 20                 2016-06-05 22:18:57  b55ee3db70b62f883db5573a5746e4d1   

08c309ee65b69c1a937f447b9b45e95055ad422e
e39d39283cd4fbee2a5e4e59dba6751c4b2be36eedfaf0ad4d2b3e904867dd9d
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E06.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         5659416-6017039
 20                 2016-06-05 22:17:05  1febb45222f9f114e88c533c36f8f29b   

b1656a3eb4766af43e31b46defb3827be551bfde
42513d7f9738dd06077f8e2636cdb6852aa852bc67316cbbc45b6bec5cff69c9
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E07.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         6701312-7058527
 20                 2016-06-05 22:16:17  0ecf424d46e619cd1d09bce2dae5b570   

a15b481e4083022254c0ff9aa85f369782a7c87b
7240d9aed4d0129139f9d817bd1beb140f2c46b226e77570f083387e54a04ebd
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E08.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         7058528-7416287
 20                 2016-06-05 22:17:14  88b3f03a9e20f9b2310dde6cd0296fca   

b839c39d53c22c5e8a46cda745f0c90ac86ac38d
2b61dad5b94d79f8b0e202db5dc30f5a581f1093b588a16354701419aaeb6ebb
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E09.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         7416288-7774255
 20                 2016-06-05 22:19:17  de1cf8808dff26c1b4398220a8913dd1   

139ad01952126d3294c49e4f2258168462f4b61d
3a70dfd2993d0ae572855aa7a20847d58a0e8823fba77e0e136a9a2a92b0bb6e
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E10.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         7774256-8132167
 20                 2016-06-05 22:16:49  216bdd9f74a00a7a9b4383e2e655ef58   

47bdb9493dc69f0aff6c38536f3100cca3c6c3f3
ed4d42a3c4162a16da28f21d85a2dfb53b0f07fe005b9012e573717fef70af59
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E11.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         8132168-8489975
 20                 2016-06-05 22:17:34  51bf22c8ed46f23cd1efde24952d305e   

a090ee7373d093cf91ee3afa42decbbdf5f43d6a
72d917ebda33cc238fa1bcada877f7949ff460105e7467d2c314a63fd1224740
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E12.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         8489976-8847887
 20                 2016-06-05 22:19:31  ac81e8b5472ca54054c8e57b6e69b1b0   

bdb5963313cf1cdcbd9d7ae2e66daf8b669000d6
eae261da6d61b544dc42c8843ab4752496fb4869fcbff869baa9f62ea47b9ee7
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E13.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
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         8847888-9206559
 20                 2016-06-05 22:16:28  8d99cfc73a09a48825a276375bfad763   

735aa03db094173277fb702ef0c7d96bdc8e11c2
052e121628b631a3154d04a2b30774340fdaf0e4593b9b751187f867b2c433e3
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E14.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         9206560-9565823
 20                 2016-06-05 22:18:51  6c498108cd539cb1b05c813b8e91893d   

843e634c0def9751870c8bbe5087be478211d62b
42d916b97a81a2147ef5e03a9e07dab0e6db4d6b148693492644f539ebbf1cdc
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E15.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         9565824-9923519
 20                 2016-06-05 22:18:10  0e418b50264b2bb748f031e1250de762   

b6a7edd6909b1ff6e5d6e85b6cd3734a8ddff4ef
9286b40a34a4fae19a24117c179cca4f4493f54341dc66fa2255e49eb209c1ab
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E16.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         9923520-10281511
 20                 2016-06-05 22:19:07  65fe333f28d8c5f27d21a2445d95fa91   

f6ed23e660b1f8559e5f7151ee16cd583e3fc353
344d36ce2ecefe1d3676197f247dca485e37be2282a469aa2fb2a219907d737e
Partition1/Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E17.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         10281512-10639959
 20                 2016-06-05 22:18:17  514b0659f98a3c45202f1cc8a125fe61   

1ba85643445ac825a4d4a5281020d6f82b5bc69a
b99c92603b97699ed7aa10a4e7f21fbd92a4cd8688a4083e33e8a4c54049aaba
Partition1/Root/Video/Avi/Cops.S24E18.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         2051984-2410095
 20                 2016-06-05 22:18:12  0e6f2a5dea0e8a1e4dd33ad2c99395cb   

9a0b653b3820ba4dd0d78ae94d0da524ff62567a
133cccd202e162aa8f52cbf289351dcb3414d78cfb82945ae49233b4d245d907
Partition1/Root/Video/Avi/Cops.S24E19.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         2410096-2765911
 20                 2016-06-05 22:18:38  f3704970997f2eb8af3fb9dd2691f7d0   

580ca470463e58d4b29eba6471081910b7b4ebfc
3544a68251c3b273675eae72431be23a3971057c6c18292bf69f71cd5b42590f
Partition1/Root/Video/Avi/Cops.S24E20.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         2765912-3124295
 20                 2016-06-05 22:18:47  ba81e0c6597f2e3898535fb78ffa0ccb   

7f537260ad18099950dcc69964de66ceb45fe176
3797d035d4b503fa1c8b05153790ed1371394b7d549589219955d75c77abedbd
Partition1/Root/Video/Avi/Cops.S24E21.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         3124296-3481199
 20                 2016-06-05 22:19:37  f61d04146b1f1e8404b1a16e9adfab5e   

306ebaddaa2d57688f4e5888cf5363da207e3f28
ad0d94c09fb496f2f2177c0d6de71ac3d8f2188c1631676ed713acd251b3f406
Partition1/Root/Video/Avi/Cops.S24E22.HDTV.x264.mp4
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    DATA: DATA (Non-Resident)
         3481200-3870015
 20                 2021-11-15 10:48:56  Partition1/Root/Video/Flv
 20                 2010-01-05 14:11:42  d2ef7350396693de9389e8b39774b4d7   

31920aa00dc386e8d2e1889f80c7b170560d349c
38a0753248b06cfca4ceeb4bc67198214216bdd2313e0d8cc3ee641471054766
Partition1/Root/Video/Flv/Better_than_me_flv.flv
    DATA: DATA (Non-Resident)
         6017040-6033135
 20                 2021-11-15 10:48:56  Partition1/Root/Video/M4V
 20                 2012-08-22 07:36:44  968139c8f965b32be629b5eddac23382   

3d4ab462a46e985f61e55d3d293598ae658179e9
d84d38f3792764ab30e3d735da22c5977920c92a0339d46055d5710b40e008bc
Partition1/Root/Video/M4V/general_hospital_fall_2008_promo_(hq)_m4v.m4v
    DATA: DATA (Non-Resident)
         6033136-6035127
 20                 2021-11-15 10:49:34  Partition1/Root/Video/Mov
 20                 2015-10-11 07:33:14  53bd8bd63f73df2e647b20ac336b5184   

3847624df92163b5857177e06fccfc01f09655c6
4b5af7cae10bd584f7ffcfd7c6a690a8df6f12bf4a5d54e83fdcec6d44d6ae8d
Partition1/Root/Video/Mov/FILE0031.MOV
    DATA: DATA (Non-Resident)
         10639960-13303647
 20                 2015-10-11 07:48:14  4d0737f26d565e7ade41c1eeff0e7cae   

9a11b89381fc546c638eb8cbdfb1a1f4b892348e
0afc907c0ae3aa8f6ee9a35ec2f863650872a30f9dcc3cb72391f856b7124370
Partition1/Root/Video/Mov/FILE0032.MOV
    DATA: DATA (Non-Resident)
         13303648-15967559
 20                 2021-11-15 10:50:25  Partition1/Root/Video/MP4
 20                 2010-11-30 10:58:19  3e3661d0dc6f16a5d416791614623e9e   

3d41e5063b1c5b1a4f659c669a2016873578c3c2
553fcee0ff4df6eefc45024c334ff2ddda887031c2d2ce75d64f8a0cc28365f1
Partition1/Root/Video/MP4/mp4
Haiti_can_succeed,_but_not_without_your_help_(Former_US_president_Bill_Clinton).mp4
    DATA: DATA (Non-Resident)
         15967560-16143863
 20                 2015-09-18 17:52:23  f9d18db99b4d4f3d5d8f7ecda07a283a   

3f30923a876e075e0c5735d095fafc71798a5a8f
d055ab546e6c24517aeaadc8217b3a56443baf902230c7a41235f6402770e4c0
Partition1/Root/Video/MP4/VID_20150918_215223.mp4
    DATA: DATA (Non-Resident)
         16143864-16348887
 20                 2015-09-18 18:00:20  b970ad6b6fc339a639a747d43279fc24   

226dd51746a2765ebfeb7e58a61d5f43ee8cfcf3
0e2d63dc86db96e93cb84e61724699bce08aa1f68ca17216e98355800ead5038
Partition1/Root/Video/MP4/VID_20150918_220020.mp4
    DATA: DATA (Non-Resident)
         16348888-16685327
 20                 2015-09-20 08:31:20  050863ea63873886856c1850f89b2872   

15e1a4f4ed00ae657cc4892959e2d161d011b84f
64e86ce37f11c639c102721be53d58f6f42302056fc183a701c7cbd6696a0f38
Partition1/Root/Video/MP4/VID_20150920_123120.mp4



R-Studio Manual277

© 2023 R-Tools Technology Inc.

    DATA: DATA (Non-Resident)
         16685328-16938367
 20                 2021-11-15 10:50:29  Partition1/Root/Video/MPEG
 20                 2016-08-06 11:50:22  8661e7edc04aa49accced6da2520decc   

0b7c023cd7f19445e78f11a5d3d4c2058196e307
63a8045b7ee6345adec7079e0e18fe89656e0cb188eb34712614e9b539f89740
Partition1/Root/Video/MPEG/Mpeg_Video.mpeg
    DATA: DATA (Non-Resident)
         6035128-6119063
 20                 2021-11-15 10:50:33  Partition1/Root/Video/MTS
 20                 2015-08-05 03:44:42  28264a21f4babe4c26fd9422ecce8066   

ddd8c7b7717e0c0374d50af851a499b9ec11e428
fdaf9826c0bb27005d60b611857f6ac4d81191cfcdd63519343f7d4192208491
Partition1/Root/Video/MTS/00026.MTS
    DATA: DATA (Non-Resident)
         16938368-17128831
 20                 2013-03-20 07:16:48  c8813d64f8e33e4e41c773d188ce6f62   

cd6dae3c9a31db7f02d18bfa8fa493d85b64e64b
1cfbb5d3d93c7725f06a388d93490e112427c640db705dfe90036c98c6db4820
Partition1/Root/Video/MTS/00140.MTS
    DATA: DATA (Non-Resident)
         6119064-6132695
 20                 2013-03-20 07:16:20  40566a6585ba0440175eed119a32a32a   

95776ef4d52ea51062c472ce744de1ef075bdf2f
34cf55b950cbce275ddc1ecad2e9fc0821e4b664d23eeb3270059b3e6e8d0c4e
Partition1/Root/Video/MTS/00168.MTS
    DATA: DATA (Non-Resident)
         6132696-6148823
 20                 2013-03-20 07:15:22  90b17b9d8b04d14b2a72aa1a7ea2c6c8   

19ddc6147e3f8d9c628c83cf33525cc859423c00
fbf55ea6c3b86c666c79caaf5c1386eebede4f02b8b70c7c91610effaf874ddc
Partition1/Root/Video/MTS/00346.MTS
    DATA: DATA (Non-Resident)
         17128832-17145343
 20                 2016-06-05 09:36:07  d6b0ce497e569371b94e19fea48355cd   

37fbacb48c80859f47024f2382d9880be633477b
b08522bb8e9d63c86c290a8c7032f3097fc78db704ea1d54eaaa75934c29de46
Partition1/Root/Video/The.Lincoln.Lawyer.2011.1080p.BluRay.x264.DTS-FGT.mkv
    DATA: DATA (Non-Resident)
         17145344-33576271
 20                 2012-11-03 10:10:07  9565cf6684e2858bda872890a32cc671   

da8c56c8b989ed9c2b42057ac657257520cfe661
beedd667813a9279426cfa769cb39f53156080fe78e73803dcb3206978985b04
Partition1/Root/Blue Skies (1946) 104 min.Fred Astaire.Bing Crosby.Irving
Berlin.Musical.avi
    DATA: DATA (Non-Resident)
         33576272-36340295
 20                 2013-06-26 07:58:08  12ab314eb73a4a938bed3d6550da0ff2   

22b0141246f4f5c7cf20171645c0f8de596cb35a
eada5fecc16cb98c28c54b080319ff79eb20b62a313ed4b6ba5c254a4a3ede7e
Partition1/Root/Mac_mini_Intel-based_Mid2007_UserGuide.pdf
    DATA: DATA (Non-Resident)
         6148824-6150575
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 20                 2005-08-06 06:04:54  59262f761288b9fd5f1306a80aa25ddb   
95f732edc568a3563de4f2fa4410b4b488a9778e

d1205b011a0139b8a9c8fcc15ca227a72c7ef575828ff99d747021ebbab04fca
Partition1/Root/P1000075.JPG
    DATA: DATA (Non-Resident)
         36340296-36344487
 20                 2005-08-06 06:06:04  33e7439162b60fc39c701fe1d40cdde7   

fef0d28922959512f5766b22867100583a83ea27
7645c7b66336c420372c6f4e4b8f3c1d9cf14cff36d6599b54587b8f8a8827e8
Partition1/Root/P1000076.JPG
    DATA: DATA (Non-Resident)
         36344488-36348455
 20                 2013-12-12 08:31:39  bf2a0fb0328c20ab65a1d9485d9748c4   

e3c3e84fc05f16d09edce676ff52a24812f15a1f
1fb743fa827fe7569bb93232555389aa596398997b7e4946fba2f9141f78b26c
Partition1/Root/TestVHDGPT.vhd
    DATA: DATA (Non-Resident)
         36348456-38445615

END Date / Time of Collection: 2022-07-05 04:02:59
------------------------------------------------------------------------------------
----------------

IV Text/hexadecimal Editor

Any object visible to R-Studio can be viewed and edited in the Text/?hexadecimal editor. It is also able to
parse the data and represent data according to various data patterns. You may also create your own patterns to
parse data.

Note: Data alteration is available on the Technician/T80+ and Corporate versions only.

You may turn numerical indexes for objects to distinguish them better.

· Viewing and Editing Objects 

· Navigating through an Object

· Data Copy

· Files and Sectors

· Creating Custom Patterns

· Pattern Example I

· Pattern Example II

R-Studio Features
Contact Information and Technical Support
Data Recovery Using R-Studio
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs
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Data Recovery over Network
Technical Information and Troubleshooting
R-Studio Emergency
R-Studio Agent Emergency

4.1 Viewing and Editing Objects

YOU MUST BE ABSOLUTELY SURE OF WHAT AND WHERE YOU ARE WRITING!

Or you may completely lose all your data.

Before you can physically write anything on a drive, you need to enable writing. 

To enable writing,

1 In the R-Studio main panel, select the Tools menu, then Settings, and select Enable Write on the

Settings dialog box.

> The Editable: status will change to Yes from Read Only.

Now the object can be edited.

Locking and unlocking objects

It is possible to manually lock an object being edited in Text/??hexadecimal Editor.

When an object is locked, Text/??hexadecimal Editor has an exclusive access to it, and no other programs or
Windows can make any changes on it. Text/??hexadecimal Editor itself always locks the object itself before
writing anything on the drive and then unlocks it. But sometimes locking/??unlocking may take quite a lot of time, up
to several seconds. That is why sometimes it is a good practice to lock an object while editing it in Text/?
hexadecimal Editor. This can be done by selecting Lock on the Tools menu.

When considering locking an object in Text/?hexadecimal Editor, keep in mind the following:

· Starting from Windows 7, it is impossible to change data if it resides on a logical disk without locking the
drive. If the data is on a place outside of any logical disk (on an unmounted partition or empty space), such
lock is not necessary. Windows Vista, XP, or below do not have such restrictions.

· The Lock command tries to lock all logical disks on which the object being edited is placed. For a drive,
those are all its logical disks, for a file that is a logical disk where it resides. And if a RAID is created from
logical disks and a file is opened on that RAID, Text/?hexadecimal Editor blocks all logical disks on which
the file resides. 

Moreover:

· If a logical disk is opened in Text/?hexadecimal Editor, the Lock command locks the drive if there is no files
opened by some other programs.

· If a drive is opened in Text/?hexadecimal Editor, the Lock command locks the drive if all its logical disks
can be locked. That may cause problems is one of the logical disks is a system one.

To view/?edit an object,

1 Right-click the object and select View/?Edit on the shortcut menu

 Other ways to view/?edit the object

· Select the object and select View/?Edit on the File menu
or
· Select the object and press the Ctrl+E keys

https://www.r-studio.com/What-is-Logical-Disk.html
https://www.r-studio.com/What-is-Disk-Partition.html
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> A Text/?hexadecimal Editor panel will appear

 R-Studio Text/?hexadecimal editor

Data Parsed According to the Selected Pattern Object Properties
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Object Sector Mapping Data Shown as Various Digits

Binary view
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Text view

Find Results

List of Bookmarks

Text/?hexadecimal Editor status 

Previous Pattern

Click this button to go to the previous
pattern.

Next Pattern

Click this button to go to the next
pattern.

Save Changes

Click this button to save changes.

Code pages

Turns supported code pages on/off.

Autoflow

Click this button to turn autoflow on.

Panel view options
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You may set which panels and bars to enable/?disable.

 To enable/?disable:

ANSI data Select/?clear ANSI on the View menu

OEM data Select/?clear OEMr on the View menu

UNICODE data Select/?clear UNICODE on the View menu

UNICODE+ data Select/?clear UNICODE+ on the View menu
Toolbar Select/?clear Toolbar on the View menu
Properties View Select/?clear Properties View on the View menu
Sectors View Select/?clear Sectors View on the View menu
Data Interpreter
View

Select/?clear Data Interpreter View on the View menu

Template View Select/?clear Template View on the View menu
Bookmarks View Select/?clear Bookmarks View on the View menu
Find Results View Select/?clear Find Results View on the View menu

2 View the information and make necessary changes

Select Save Changes on the Tools menu if you want to save changes.

 Other ways to save changes

· Select Save Changes on the File menu
or
· Press the Ctrl+S keys

Viewing

There are up to four tabs showing the data in different representations. Actual number of tabs depends on the
object and property being viewed/?edited.
Std Exact attribute data. If the attribute is compressed, R-Studio decompresses it prior to

showing.
Unlimited Exact attribute data + free space of last cluster. If the attribute is compressed, R-Studio

decompresses it prior to showing.
Direct Actual data written on the drive. If the attribute is not compressed, it coincides with the Std

representation.
Allocation Resident part of the attribute.

You may view data in 4 various code pages: ANSI/?OEM/?UNICODE/?UNICODE+ by switching on/off the
respective code pages in the Code pages buttons or select the appropriate code pages on the View menu.

You may see which file is written on a particular sector. See Files and Sectors for details.

Patterns or Templates

You may select a pattern according to which the data will be parsed and shown in the parsed data pane. The
Data Interpreter shows the data selected in the Template pane in various representations.

You may find the next or previous data that matches the pattern signature on the drive. Right-click the right
pane of the editor and select either Find Template Signature Next or Find Template Signature Previous

on the shortcut menu. You may also select these items on the Edit menu.

You may also create your own patterns to parse data from various objects. 
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Navigating

Text/?hexadecimal Editor gives you various ways to navigate into an object. See the Navigating through
an Object for more details.

Data Copy

Text/?hexadecimal Editor gives you various ways to copy selected data navigate in an object. See the Data
Copy for more details.

Filling an area with a pattern

To fill an area with a pattern, select Fill on the Edit menu, and specify the pattern and area on the Fill dialog
box.

Fill dialog box

 Fill options

Fill pattern

HEX Field for the pattern to fill the area in the hexadecimal representation
ANSI Field for the pattern to fill the area in the ANSI encoding
OEM Field for the pattern to fill the area in the OEM encoding
UNICODE Field for the pattern to fill the area in the UNICODE encoding
Fill range

From (hex) Field for the start position of the area to fill with the pattern
To (hex) Field for the end position of the area to fill with the pattern

3 Click the Save Changes button to save the changes

 Other ways to save the changes made

· Select Save Changes on the Edit menu
or
· Press the F2 key

> Viewer/?Editor will save the changes on the object

YOU MUST BE ABSOLUTELY SURE OF WHAT AND WHERE YOU ARE WRITING!
Or you may completely lose all your data.

Selecting and saving an area in theViewer/?Editor

You may select an area in the Viewer/??Editor panel and save it as a file. 

To select and save an area in the Viewer/?Editor panel,

1 Right-click the beginning of the selection and select Select From on the shortcut menu

2 Right-click the end of the selection and select Select To on the shortcut menu

 Other ways to select an area

·  Select Select... on the Tools menu and specify an area to select on the Select dialog box,
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or
· Click the start point of the area and drag the mouse cursor to its end.

If you need to select an entire object, select Select All on the Tools menu or click the Ctrl+A key

Select dialog box

3 Select an appropriate item in the Tools menu to save the data in a required format and specify its file
name

Select: 
Save to Binary File... to save the data in the binary format (default extension is .bin)
Save to Hexadecimal
File

to save the data in the binary format (default extension is .hex)

on the Tools menu.

If you select an existing file, R-Studio will ask you if you want to append or overwrite the file.

If a remote computer is connected for Data Recovery over Network, the Save as... dialog box will
appear when you select a place to save the data. You may save it to the local or remote computer.

> Viewer/?Editor will save the data in the file

Loading data from an external file

You may load a data from a file and overwrite an area of the object opened in the Viewer/?Editor panel. 

To load binary data from a file and overwrite an area of the object opened in the Viewer/?Editor

panel,

1 Select an area to overwrite and select Load from File... on the Tools menu

If a remote computer is connected for Data Recovery over Network, the Open as Binary File dialog box
will appear when you select a place to open the data file from. You may open it from the local or remote
computer.

2 Select the necessary file and load the data.

> The area in the Viewer/?Editor will be overwritten with the new data.

4.2 Navigating through an Object

Navigating

You may quickly move to a particular part of the object. To move to a particular part of the object being
viewed/?edited, enter the required offset in the Go to Offset field between the buttons.
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 Type an offset to which you want to go. You may select between bytes and sectors. See the
Data Formats and Multipliers topic for more details on data formats.

If a file is opened in Text/?hexadecimal Editor , you may select data representation for that file.

 

You may also use the Go To Offset dialog box to go to a specified place in the object. Click the Offset field
on the Status bar. You may also use this dialog box to copy the offset.

Go To Offset dialog box

 Go To Offset options

From: Jump/?offset direction. For example, if you need to find the offset from the object end
for a selected byte, switch to the End (backward) option.

HEX/DEC Switch between the hexadecimal and decimal data representation.
Range Range of values that can be entered.
dec/hex: Alternative data representation. 
Offset: Flat data offset (without separation between the sector and offset in the sector).
Sector/?offset Data offset represented as a sector and offset in the sector.
Go!/OK buttons The Go! button moves the cursor to the specified positions, but the Go To Offset

dialog box remains open. The OK button closes the dialog box after moving the
cursor. 

Searching

To search for a particular string, click the Find, Find Next, or Find Previous buttons or the same items on
the Edit menu, and specify the string on the Search dialog box.

Search dialog box
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 Search options

Not Equal Search for the place which content is not equal to the string. For
example, the first byte not equal to 00 or FF.

Search for

HEX Field for the string to search for in the hexadecimal
representation

ANSI Field for the string to search for in the ANSI encoding
OEM Field for the string to search for in the OEM encoding
UNICODE Field for the string to search for in the UNICODE encoding
Match case Select this check box to make the search case-sensitive
Search area

From current position Select this check box to start search from the current position
From start position Select this check box to start search from the beginning of the

object
From Address Select this check box and specify the range in which the search

is to be carried out
Search position

Exhaustive search Select this check box to search the entire object
Search at offset Select this check box and specify the sector offset from which

the search will start
Reverse Select this check box to start the search in the reverse direction
Find all Select this check box to search for all instances of the string to

search. Search results will be shown in the Find Results pane.

Text/??hexadecimal Editor will show the search progress.

Search results are shown in the Find Results pane. You may easily move to the required found item by
clicking the item.

Features of the Not Equal option

Suppose we have an object which first 3 consecutive sectors start with:
Sector1   FILEAAAAA..............................................
Sector2   FILEBBBBB..............................................
Sector3   NOTAFILE...............................................

And the search string is Not Equal FILE.
If the Exhaustive search option is selected, the Text/?hexadecimal Editor will stop at the first A character in
Sector1.
If the Search at offset=0 option is selected, the Text/?hexadecimal Editor will stop at the N character in
Sector3.

Bookmarking

You may create bookmarks to easily move to those places. Right-click the cursor on the place you want to
bookmark and select Toggle Bookmark on the shortcut menu. The list of bookmarks appears in the
Bookmark pane. You may easily move to the required bookmark by clicking it in the list.

You may control bookmarks on the Edit menu.
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4.3 Data Copy

Text/?hexadecimal Editor gives you various ways to copy selected data navigate in an object. 
Data selected in Text/?hexadecimal Editor

Depending on what column you have control-clicked, the following commands are available in the shortcut menu:

When right-clicking any column
Copy Editor Display

Data pasted into a text editor

When right-clicking any column
Copy as File Signature

Data pasted into a text editor

When right-clicking the Binary data
column
Copy as "Binary data"

Data pasted into a text editor

When right-clicking the ANSI
column
Copy as "ANSI"

Data pasted into a text editor

When rightl-clicking the UNICODE
column
Copy as "UNICODE"

Data pasted into a text editor

4.4 Files and Sectors

You may see which file is written on a particular sector. To do so:

1 Enumerate files on a logical disk in the Drives panel.

2 Go to the tab of that logical disk and select Show Files in HexEditor on the Files menu.

3 Return to the Drives panel and select View/?Edit on the shortcut menu. 

> R-Studio will show a file that belongs to a particular section.
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File in a sector

4.5 Creating Custom Patterns

You may create your own patterns yourself.

An example of a commented pattern parsing an AVI file.
The syntax of pattern description is similar to that of the XML language. The folder where the files should be
placed is specified on the Main tab of the Settings dialog box.

Pattern structure

Pattern header

Each pattern starts with a standard header
<?xml version="1.0" encoding="utf-8"?>

Section template

Each pattern starts with a section giving to the pattern a name that will be shown in the parsed data pane.

Attributes:
name Specifies the pattern name shown in the parsed data pane

Example:

<template name="AVI File LIST">
........

</template>

Section signature 

Attributes:
align <positive
integer> 

Specifies if the data structure address is aligned (i.g., by  a sector: 512)

This section contains elements field with hex-codes of the signature. The attribute offset  specifies their
offset from the start of the record. Field length is equal to the number of hex-codes.

Example:

<signature align="1">
<field offset="0">46 49</field>
<field offset="2">4c 45</field>

</signature>

Section section 

Such sections contain all expressions and operations needed for the pattern to parse the data. A section name is
shown in the parsed data pane. In fact, sections are virtual objects used to group logically connected fields.
Sections can be nested.
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The main section is not shown in the parsed data pane.

Section contain elements field which are actual data objects. field names are shown in the parsed data pane
with their values. 

Attributes:
name Specifies the pattern name shown in the parsed data pane

Example:

<section name="JUNK">
 ....
</section>

List of All Objects in Patterns

Data types (in field)

· integer 
Sub-types:

int8 

int16 

int32 

int64 

uint8 

uint16 

uint32 

uint64 

uintX

Attributes: 
endian: (be | le

| system) 
Optional.  Default: system.

base: (decimal |

hex | octal) 
Optional. Specifies data representation. Default: decimal.

as-offset:

<expression> 
Optional. Specifies that this field is an offset and its value should be evaluated using
the expression. A special variable this returns the value of  this field.

purpose: (offset
| rsector |
sector | cluster

| rcluster) 

Optional. Specifies the type of the as-offset expression result . If this attribute is
present, the attribute  is necessary if the offset value should differ from the value of
this field (variable this ).
 rsector and rcluster  are offsets relative to the absolute position of the pattern
beginning.

assigned-
template:

<TemplateName> 

Specifies the pattern name linked with this field. Ignored if the as-offset or
purpose attributes are not specified.

var: <Name> Optional. Specifies the name under which the value of this field can be accessed in
expressions.

· binary 
Attributes: 
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display-encoding:

(hex | binary) 
Optional. Default: hex. 

size: <bytes> Mandatory.

· char 
Attributes: 

size: <bytes> Mandatory. 
codepage: (ansi |

oem | utf8 | utf16) 
Optional. Specifies which codepage is used. Default: ansi.

· filetime 
Shows time in the Win32 format (64 bits)

· unixtime 

Shows time in the Unix format (seconds from 01/01/1970)

· filetime 

Shows time in the DOS format (date: hiword, time: loword)

· bits 

Attributes: 

size: <bytes> Mandatory. 
pos: <comma
separated list of

bit positions> 

Mandatory. Specifies bit positions in a data block.

Commands

· goto 

Specifies a jump to a specified offset (either absolute or relative one)

Attributes: 
address:

<expression> 
Specifies an absolute address to jump to.

offset: <expression> Specifies a relative offset to jump by.

One and only one of the attributes should always be specified.

· if 

Evaluates a condition specified in the test attribute and, if the condition is true, reads fields specified in this
tag.

Attribute: 

test: <expression> Sets a condition to test against.

· repeat 
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Reads the fields specified in the tag until the exit condition is equal to 0 or specified times

Attributes: 

count: <expression> <expression> is evaluated one time upon entering the block. Internal
elements are read the specified number of times.

test: <expression> <expression> is evaluated upon entering the block. Similar to the C++
construction while(...) {}. 

test: <expression> <expression> is evaluated upon exiting the block. Similar to the C++
construction do {} while(...). 

· setvar 

Sets the value of an internal variable. As an example, this command is convenient to store the current offset.
The value of the current offset is stored in a predefined variable offset.

Attributes: 

var: <string> Specifies the name of the variable.
expr: <expression> Specifies an expression which result will be assigned to the variable.

Expressions

Expressions in the patterns are arithmetic expressions which syntax is similar to that of the C language, including
operation preceding. 

The following operations are supported:
+ - * / & | > < <= >= != == || &&

Predefined variables

· offset 

An offset in bytes from the pattern beginning data is currently read at. 

· start_position 

An absolute position of the pattern beginning. offset + start_position = absolute offset.

· this 
This variable exists only within the context of the ass-offset expression evaluation and is the current value
of the data field for which that expression is specified

4.6 Pattern Example I

Below is an example of a commented pattern parsing an AVI file. 
<?xml version="1.0" encoding="utf-8"?>

<!-- A pattern section. The pattern name is AVI File. -->
<template name="AVI File">

    <!-- A template signature section. Alignment is 1. -->

    <signature align="1">

        <!-- A 4-byte signature at offset 0x00. -->

        <field offset="0x00">52 49 46 46</field> <!-- ANSI: RIFF -->

        <!-- A 4-byte signature at offset 0x08. -->

        <field offset="0x08">41 56 49 20</field> <!-- ANSI: LIST -->
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    </signature>

    <!-- A data section. Its name is AVI File. This is the main data section. It is not shown in the parsing tree as
a section (its name is ignored). -->

    <section name="AVI File">

        <!-- The first 4 bytes are read and shown as an ANSI  string. -->

        <field type="char" size="4" name="Signature: RIFF" var="signature"/>

        <!--  The current position is moved to the beginning of the file. -->

        <goto offset="-4"/>

        <!-- The first 4 bytes in the file are read and shown as an unsigned integer. The internal variable signature
gets the value of the field. --> 

        <field type="uint32" base="hex" name="Signature RIFF as unsigned integer in hex
format" var="signature"/>

        <!-- A test against the condition (signature == RIFF) -->

        <if test="signature == 0x46464952"> <!-- ANSI: RIFF -->

            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable dataSize gets
the value of  the field. -->

            <field type="uint32" name="Size of the data in file" var="dataSize"/>

            <!-- A new internal variable endOfFile is created and the expr field evaluates its value.-->

            <setvar var="endOfFile" expr="offset + dataSize - 8"/>

            <!-- The next 4 bytes is read and shown as an ANSI string. -->

            <field type="char" size="4" name="File type"/>

            <!-- A new section named DATA is created -->

            <section name="DATA">

                <!-- A new internal variable chunksOffset is created, the expr filed evaluating its value. This variable
gets the absolute value of template offset. -->

                <setvar var="chunksOffset" expr="start_position"/>

                <!-- A loop is created. Its condition is set in the test field (while the endOfFile variable is greater
then the current position.) -->

                <repeat test="endOfFile > offset">

                    <!-- 4 bytes are read and shown as an ANSI string. -->

                    <field type="char" size="4" name="Signature"/>

                    <!-- The current position is moved backwards by 4 bytes. -->

                    <goto offset="-4"/>

                    <!-- The same 4 bytes are read and shown as an unsigned integer. The internal variable signature
gets this value. -->

                    <field type="uint32" name="Signature as unsigned integer"
var="signature"/>
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                    <!-- A test against the condition (signature == LIST) -->

                    <if test="signature == 1414744396"> <!-- ANSI: LIST -->

                        <!-- The section is shown. Its name is LIST -->

                        <section name="LIST">

                            <!--  The current position is moved backward by 4 bytes. -->

                            <goto offset="-4"/>

                            <!-- The 4 bytes are read and shown as an unsigned hexadecimal integer. This field has the
attributes offset and assigned-template. If the user double-clicks this field, the AVI File LIST pattern
will be invoked and the current pattern position will be moved to the address specified in as-offset.-->

                            <field type="uint32" base="hex" name="Signature LIST as unsigned
integer in hex format" as-offset="start_position + offset - 4" assigned-
template="AVI File LIST"/>

                            <!-- The next 4 bytes are read and shown as an unsigned integer. The listSize variable gets
its value.  -->

                            <field type="uint32" name="Size of the data in the list"
var="listSize"/>

                            <!-- The 4 bytes are read and shown as an ANSI string. -->

                            <field type="char" size="4" name="List type"/>

                            <!-- The current position is moved backward by 4 bytes. -->

                            <goto offset="-4"/>

                            <!-- The same 4 bytes are shown as an unsigned hexadecimal integer. The listType variable
gets its value.-->

                            <field type="uint32" base="hex" name="List type as unsigned integer in
hex format" var="listType"/>

                            <!-- A test against condition (type == movi) -->

                            <if test="listType == 0x69766f6d"> <!-- ANSI: movi -->

                                <!-- The chunksOffset variable gets the value evaluated in the expr attribute. -->

                                <setvar var="chunksOffset" expr="start_position + offset - 4"/>

                            </if>

                            <!-- The current position is moved to the address evaluated in the address attribute. -->

                            <goto address="offset + listSize - 4"/>

                        </section>

                    </if>

                    <!-- A test against condition (signature == JUNK) -->

                    <if test="signature == 1263424842"> <!-- ANSI: JUNK -->

                        <!--  The section is shown with the JUNK name. -->

                        <section name="JUNK">

                            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable
junkSize gets its value. -->
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                            <field type="uint32" name="Size of the data of the junk"
var="junkSize"/>

                            <!-- The current position is moved by junkSize bytes forward.  -->

                            <goto offset="junkSize"/>

                        </section>

                    </if>

                    <!-- A test against condition (signature == idx1) -->

                    <if test="signature == 829973609"> <!-- ANSI: idx1 -->

                        <!--  The section is shown with the idx1 name. -->

                        <section name="idx1">

                            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable
idxSize gets its value. --> 

                            <field type="uint32" name="Size of the data of the idx1"
var="idxSize"/>

                            <!-- The section is shown with the  First AVIINDEXENTRY name. -->

                            <section name="First AVIINDEXENTRY">

                                <!-- The 4 bytes are read and shown as an ANSI string. -->

                                <field type="char" size="4" name="Chunck id"/>

                                <!-- The next 4 bytes are read and shown as an unsigned hexadecimal integer. -->

                                <field type="uint32" base="hex" name="Flags"/>

                                <!-- The next 4 bytes are read ans shown as an unsigned hexadecimal integer. The offset
attribute is evaluated for this field as a sum of  the chunksOffset variable and valued of this field.  -->

                                <field type="uint32" base="hex" name="Chunk offset" as-
offset="chunksOffset + this"/>

                                <!-- The next 4 bytes are read and shown as an unsigned integer. -->

                                <field type="uint32" name="Chunk size"/>

                            </section>

                            <!-- The current position is moved by idxSiz bytes forward. -->

                            <goto offset="idxSize"/>

                        </section>

                    </if>

                    <!-- A test against the condition. &amp;&amp; is a logical AND (&&) -->

                    <if test="signature != 1414744396 &amp;&amp; signature != 1263424842
&amp;&amp; signature != 829973609">

                        <!-- An empty section is shown. Its name is Unknown signature found -->

                        <section name="Unknown signature found">

                        </section>

                        <!-- The current position is moved to the address set in the endOfFile variable. -->

                        <goto address="endOfFile"/>

                    </if>
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                </repeat>

            </section>

        </if>

    </section>
</template>

4.7 Pattern Example II

<?xml version="1.0" encoding="utf-8"?>

<!-- A pattern section. The  pattern name is AVI File LIST -->
<template name="AVI File LIST">

    <!-- A template signature section. Alignment is 1. -->

    <signature align="1">

        <!-- A 4-byte signature at offset 0x00. -->

        <field offset="0x00">4C 49 53 54</field> <!-- ANSI: LIST -->

    </signature>

    <!-- A data section. Its name is AVI File LIST. This is the main data section. It is not shown in the parsing
tree as a section (its name is ignored).-->

    <section name="AVI File LIST">

        <!-- The first 4 bytes are read and shown as an ANSI  string. -->

        <field type="char" size="4" name="Signature: LIST"/>

        <!-- The current position is moved to the beginning of the file (4 bytes backward). -->

        <goto offset="-4"/>

        <!-- The first 4 bytes in the file are read and shown as an unsigned integer. The internal variable signature
gets the value of the field. -->

        <field type="uint32" name="Signature LIST as unsigned integer" var="signature"/>

        <!-- A test against the condition (signature == LIST) -->

        <if test="signature == 1414744396"> <!-- ANSI: LIST -->

            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable listSize gets its
value. -->

            <field type="uint32" name="Size of the data in the list" var="listSize"/>

            <setvar var="endOfList" expr="offset + listSize"/>

            <field type="char" size="4" name="List type"/>

            <goto offset="-4"/>

            <field type="uint32" base="hex" name="List type as unsigned integer in hex
format" var="listType"/>

            <!-- A test against condition (listType == movi) -->

            <if test="listType == 0x69766f6d"> <!-- ANSI: movi -->

                <!-- This chunk is not to be parsed. The current position is moved to the end of the chunk. -->
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                <goto address="endOfList"/>

            </if>

            <setvar var="mediaType" expr="0"/>

            <repeat test="endOfList > offset - 8">

                <section name="CHUNK">

                    <field type="char" size="4" name="Chunk ID"/>

                    <goto offset="-4"/>

                    <field type="uint32" name="Chunk ID as unsigned integer" var="chunkId"/>

                    <if test="chunkId == 1414744396"> <!-- ANSI: LIST -->

                        <goto offset="-4"/>
        <field type="uint32" base="hex" name="LIST chunk ID as unsigned integer in hex
format" as-offset="start_position + offset - 4" assigned-template="AVI File LIST"/>

                    </if>

                    <field type="uint32" name="Size of the data in the chunk"
var="chunkSize"/>

                    <setvar var="endOfChunk" expr="offset + chunkSize"/>

                    <!-- Rounding the value of the variable endOfChunk to a number divisible by 2. -->

                    <if test="endOfChunk &amp; 1">

                        <setvar var="endOfChunk" expr="endOfChunk &amp; 0xFFFFFFFE"/>

                        <setvar var="endOfChunk" expr="endOfChunk + 2"/>

                    </if>                    

                    <if test="chunkId == 1751742049"> <!-- ANSI: avih -->

                        <field type="uint32" name="Number of microseconds between frames"/>

                        <field type="uint32" name="Approximate maximum data rate of the file"/>

                        <field type="uint32" name="Alignment for data, in bytes"/>

                        <field type="uint32" name="Bitwise combination of zero or more of the
flags"/>

                        <field type="uint32" name="Total number of frames of data in the file"/>

                        <field type="uint32" name="Initial frame for interleaved files"/>

                        <field type="uint32" name="Number of streams in the file"/>

                        <field type="uint32" name="Suggested buffer size for reading the file"/>

                        <field type="uint32" name="Width of the AVI file in pixels"/>

                        <field type="uint32" name="Height of the AVI file in pixels"/>

                        <field type="binary" size="16" name="Reserved"/>

                    </if>

                    <if test="chunkId == 1852994675"> <!-- ANSI: strn -->
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                        <field type="char" size="chunkSize" name="Stream name"/>

                    </if>

                    <if test="chunkId == 1752331379"> <!-- ANSI: strh -->

                        <field type="char" size="4" name="Type"/>

                        <goto offset="-4"/>

                        <field type="uint32" base="hex" name="Type as unsigned integer in hex
format" var="type"/>

                        <setvar var="mediaType" expr="type"/>

                        <field type="char" size="4" name="Handler (codec)"/>

                        <field type="uint32" base="hex" name="Flags"/>

                        <field type="uint32" name="Number of the first block of the stream that
is present in the file"/>

                        <field type="uint32" name="Scale"/>

                        <field type="uint32" name="Rate"/>

                        <field type="uint32" name="Start time of stream"/>

                        <field type="uint32" name="Size of stream in units as defined in Rate
and Scale"/>

                        <field type="uint32" name="Size of buffer necessary to store blocks of
that stream"/>

                        <field type="uint32" name="Quality"/>

                        <field type="uint32" name="Sample size (number of bytes of one stream
atom)"/>

                    </if>

                    <if test="chunkId == 1718776947"> <!-- ANSI: strf -->

                        <if test="mediaType == 0x73646976"> <!-- ANSI: vids -->

                            <section name="BITMAPINFOHEADER">

                                <field type="uint32" name="Number of bytes required by the
structure"/>

                                <field type="int32" name="Width of the bitmap, in pixels"/>

                                <field type="int32" name="Height of the bitmap, in pixels"/>

                                <field type="uint16" name="Number of planes for the target device"/>

                                <field type="uint16" name="Number of bits-per-pixel"/>

                                <field type="uint32" name="Type of compression for a compressed
bottom-up bitmap"/>

                                <field type="uint32" name="Size, in bytes, of the image"/>

                                <field type="int32" name="Horizontal resolution, in pixels-per-
meter, of the target device for the bitmap"/>

                                <field type="int32" name="Vertical resolution, in pixels-per-meter,
of the target device for the bitmap"/>

                                <field type="uint32" name="Number of color indexes in the color
table that are actually used by the bitmap"/>
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                                <field type="uint32" name="Number of color indexes that are required
for displaying the bitmap"/>

                            </section>

                        </if>

                        

                        <if test="mediaType == 0x73647561"> <!-- ANSI: auds -->

                            <section name="WAVEFORMATEX">

                                <field type="uint16" name="Waveform-audio format type"/>

                                <field type="uint16" name="Number of channels in the waveform-audio
data"/>

                                <field type="uint32" name="Sample rate, in samples per second
(hertz)"/>

                                <field type="uint32" name="Required average data-transfer rate, in
bytes per second, for the format tag"/>

                                <field type="uint16" name="Block alignment, in bytes"/>

                                <field type="uint16" name="Bits per sample for the Waveform-audio
format type"/>

                                <field type="uint16" name="Size, in bytes, of extra format
information appended to the end of the WAVEFORMATEX structure"/>

                            </section>

                        </if>

                    </if>

                    <goto address="endOfChunk"/>

                </section>

            </repeat>

        </if>

        <if test="signature != 1414744396">

            <section name="Invalid LIST signature found">

            </section>

        </if>

    </section>
</template>
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V Technical Information and Troubleshooting

This chapter covers various technical issues and troubleshooting.

· IntelligentScan technology

· Data Recovery Issues

· Extended Information Recovery

· Data Formats and Multipliers

· Data Recovery on HFS/HFS+ file system

· Bad Sectors

· Memory Usage

· R-Studio Switches

· Properties Tab

R-Studio Features
Contact Information and Technical Support
Data Recovery Using R-Studio
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs

Data Recovery over Network
Text/?hexadecimal Editor
R-Studio Emergency
R-Studio Agent Emergency

5.1 IntelligentScan Technology

R-Studio uses a unique IntelligentScan technology when it tries to recover the data on the area being
scanned. 

While scanning the selected area, R-Studio reads data directly from the drive, analyzes them, and tries to
determine a record to which the data belong. The following record types are possible:

· MBR/GPT records
· NTFS Boot Sector, Folder, and MFT records
· FAT/exFAT Boot Sector, folder, and file records
· ReFS Boot sector records and ReFS Meta blocks
· HFS/HFS+ Volume headers and BTree+ nodes
· APFS Super blocks, APFS Volume blocks, and APFS nodes
· Ext2/3/4FS SuperBlocks records
· UFS/FFS SuperBlock records
· Specific file signatures of Known File types for raw file carving

All these record types have different, but known, structure. Knowing valid values of record fields and relations
between them for each record type, R-Studio determines a record type for the data. If such record type cannot

https://www.r-studio.com/What-is-Raw-File-Recovery.html


R-Studio Manual301

© 2023 R-Tools Technology Inc.

be unambiguously determined, the data are assigned to the most probable record type. The same data can be
assigned to several record types, with a certain probability for each assignment. A list of possible files is
generated from these records.

R-Studio generates a record list for each record type. This list contains references to records assigned to a
record type from the list with their assignment probability. The same data can be included into different record
lists. Then R-Studio analyzes relations between elements in each list and between different lists, and generates a
list of found partitions with their parameters, such as partition start point and probable size, file system type,
cluster size, and existence probability.

Using the file list and partition list, R-Studio reconstructs file systems and files on the found partitions. One file
can be attributed to several different partitions.

When the entire drive or its part has been scanned, R-Studio shows all found partitions. Then the parameters of
the found partitions may be manually corrected, if additional information on them is available. 

Using the IntelligentScan technology, R-Studio can recover files not only on new and existing partitions. It also
can find and recover data on partitions that have been deleted or reformatted. If, for example, there was an
NTFS partition, which later was reformatted as a FAT partition, R-Studio will show two partitions on the same
place on the drive, one having the FAT file system, the other the NTFS. Then, files found on those partitions can
be recovered.

The IntelligentScan technology makes R-Studio a very powerful data recovery tool, but it is not omnipotent.
As it uses probabilistic approach to data reconstruction, it cannot guarantee 100% correct results. Moreover,
even if R-Studio has reconstructed data structure correctly, it is impossible to guarantee that all found files will be
completely and correctly recovered, as new data may be already written over the old files. See the Data
Recovery Issues topic for details.

5.2 Data Recovery Issues

NEVER TRY TO SAVE RECOVERED FILES/?FOLDERS TO THE SAME LOGICAL DISK WHERE
THEY RESIDE!!!

Or you may obtain unpredictable results and lose all of your data.

R-Studio writes directly to a drive only when writing recovered data and from its hex editor, if writing is enabled.
In all other actions, R-Studio only reads data and analyzes them, and never modifies data on the drives being
analyzed. 

Most operating systems use lazy-write. So, there is a time lag between file actions and actual changes on data on
a drive. R-Studio analyzes data on drives only. That is why it does not always detect recent changes in data
structure.

Most operating systems constantly write their service information on drives. Such writing is especially intensive
during startup and shutdown procedures. When an operating system deletes a file/?folder, it treats the space where
it has resided as empty and may write something in this place. If this happened, the file/?folder and its parameters
may be detected correctly, but its data may be lost. 

Folder names like $$$Folder58448 on NTFS partitions mean that the folder has not been found on the drive but
some references to it have been. For example, folders My documents, Work, Photos have been found and all they
have one parent folder, whose description has not actually been found on the drive, so its name is unknown and
therefore represented as $$$Folder58448. It may happen that the description of such folders was outside of the
scan area, so try to enlarge the region or scan the entire drive. If that does not help, most likely that the
description of the folder has been overwritten. 

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-disk-format.html
https://www.r-studio.com/What-is-Disk-Partition.html
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Folder names like $ROOT58448 on FAT partitions mean that some folders have been found, but they cannot
be included into the folder structure for this FAT partition. Sometimes, such folders may contain other folder
structures.

If you recover a file, and it appears that the file contains wrong data, try to do the following:

· Scan: 
the logical disk, if the file has been just deleted.

the drive, if the data structure is damaged more seriously.

· Search for the file to be restored on all found partitions and try to recover it from all found partitions.
Check each recovered file to ensure that it contains correct data. As soon as you found the partition from
which the file is recovered correctly, use this partitions to recover all other deleted files.

If there are several deleted files to be restored, you should use a file larger than 2KB to select the required
partition.

FAT file system:

Cross-Linked Folders

Often R-Studio finds several FAT folder records that contain the same data. Such folders are called cross-

linked. R-Studio marks such folders with an arrow mark: 

R-Studio attributes the content of cross-linked folders to one folder called a target folder. When recovering,
R-Studio places the content to the target folder.

To view the list of cross-linked folders,

1 Right-click a cross-linked folder and select Cross Linked Folders on the shortcut menu

> A list of cross-linked folders will appear

You may go to any folder in this list by clicking it.

To find a target folder, 

* Right-click a cross-linked folder and select Go Target on the shortcut menu, or

Select the cross-linked folder and select Goto Target on the File menu

If Go Target is gray, this folder is already the target folder.

To set the target folder manually,

* Right-click a cross-linked folder and select Set As Default Target on the shortcut menu, or

Select the cross-linked folder and select Set As Default Target on the File menu.

If Set As Default Target is gray, this folder is already the target folder.

Questionable Folders

Sometimes, R-Studio may find FAT records, which look like folders, but their content is invalid. For example,
file names have invalid characters, date, time, and size, or other file attributes may look strange. Please note that
R-Studio correctly recognizes localized names. R-Studio treats such records as folders, but does not analyze
their content and structure. You can manually scan such folders, but results may be unpredictable. Usually, such
scan reveals garbage.

R-Studio marks such folders with a question mark.

https://www.r-studio.com/What-is-Logical-Disk.html
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To re-scan an object, 

* Right-click a questionable folder in the R-Studio's Folders panel and select Rescan on the shortcut

menu, or

Select the questionable folder and select Rescan on the File menu.

ReFS, NTFS, APFS, HFS, XFS, and ext fs file systems:

Symbolic links (symlinks)

Symbolic links (of symlinks for short) are object that contains references to other files or folders directory in the
form of absolute or relative paths and that affect pathname resolution. For example, if a symlink C:
\ProgramData\Documents points to D:\Recovered Files\Root\Users\Public\Documents, entering it
will result in entering D:\Recovered Files\Root\Users\Public\Documents.

They are present in almost all modern file systems. NTFS, HFS+, APFS, and EXT FS are probably the most
popular examples.

R-Studio shows such symlinks and their targets in the following way:

Symlinks can be marked for recovery

Only symlinks on the picture above are marked for recovery. They will be recovered as real files and folders. 

Only targets (real folders) on the picture above are marked for recovery. They will be recovered as real files and
folders. 

https://www.r-studio.com/What-are-Hard-Soft-Links.html
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Both  targets (real folders) and symlinks on the picture above are marked for recovery. They will be recovered
as real files and folders and symlinks. 

The R-Studio Settings topic gives more details about symlink recovery.

Files:

Hard links 

Hard links are file system entries that give file names to files. This term is usually used when files may have several
names. R-Studio shows hard links using the following icons:

A hard link: 

The target file: 

You may find a target or hard link for a file. Right-click the file and select Links on the shortcut menu.

5.3 Extended Information Recovery

R-Studio supports recovery of compressed files, alternative data streams, encrypted files, file security and
extended file attributes. If the R-Studio host OS and the file system of the disk you are going to save file to
support any particular extended information, it will be saved with the file, too. Otherwise, the extended
information will be saved as separate files with the same name as the restored file and extension showing the type
of the extended information. Below is a quick reference for the host OS and file system of the target drive. 

Extended Information Required host OS Required target disk FS
Encrypted files Windows 2000/?XP/?2003/?Vista/?

2008/?7/?8/8.1/?10
NTFS

Alternative data streams Windows NT/?2000/?XP/?2003/?
Vista/?2008/?7/?8/8.1/?10

NTFS

File security Windows NT/?2000/?XP/?2003/?
Vista/?2008/?7/?8/8.1/?10

NTFS

Extended file attributes Windows NT/?2000/?XP/?2003/?
Vista/?2008/?7/?8/8.1/?10

NTFS or FAT/exFAT

5.4 Data Formats and Multipliers

You may enter data in all numerical fields either in sectors or in bytes. If there is no letters are after the number,
R-Studio assumes the numbers are in bytes.

Decimal numbers are entered as they are: 2372354

Hexadecimal numbers are entered as 0x23Fa67 or 23Fa67 hex.

The following case-insensitive notation is possible:

http://en.wikipedia.org/wiki/Hard_link
https://www.r-studio.com/What-are-Hard-Soft-Links.html
https://www.r-studio.com/What-are-alternate-data-streams.html
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b 1 byte
kb 1 kb = 2^10=1024 bytes
mb 1 mb = 2^20=104857 bytes
gb 1 gb = 2^30=1073741824 bytes
tb 1 tb = 2^40=1099511627776 bytes
eb 1 eb = 2^50=1125899906842624 bytes
hex A hexadecimal number
sec
(sector)

A number is in sectors

You may also select the multipliers in the drop-down boxes. 

 Type an offset to which you want to go. You may select between bytes and sectors. See the
Data Formats and Multipliers topic for more details on data formats.

If a file is opened in Text/?hexadecimal Editor , you may select data representation for that file.

 

When the multiplier has been changed, the data value will be changed according to the specific shortcut
commands for that field:

Suppose, the initial value is 1 GB, and the sector size of the object is 512 byte. The results will be the following:

Command: No recalculate

Change from GB to MB: 1

Change from GB to Sectors: 1

Command: Always recalculate

Change from GB to MB: 1024

Change from GB to Sectors: 2097152

Command: Units type recalculate

Change from GB to MB: 1

Change from GB to Sectors: 2097152

5.5 Data Recovery on HFS/HFS+ File System

When deleting a file, Mac OS X deletes system BTree+ records describing the file. Therefore, it is hard to
recover such file directly. Those records may remain in:

1. The swap file (if the deleted file has been deleted recently).
2. In the journal (if the HFS+ journaling is on, and the deleted file has been CREATED recently)

Actually, if a file has been deleted, chances that the records would be found are small. To greatly increase the
chances to recover deleted files successfully , you may actively use scanning with enabled Known Files Types.

Note: All above is correct for intentionally deleted files. In case of a corrupted file system, HFS/HFS+ can be
recovered quite successfully.

When recovering files with HFS+-specific attributes (resource fork, finder info, etc.), R-Studio saves it in the so-
called AppleDouble format. When they are copied to an HFS+ disk under Mac OS X, those attributes will be
automatically restored.

http://en.wikipedia.org/wiki/AppleSingle_and_AppleDouble_formats
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5.6 Bad Sectors

Quite often, drives from which the data are to be recovered have bad sectors, or those sectors that are very
hard, even impossible, to read, mostly due to hardware problems. R-Studio tries to read such sectors several
times. The number of tries is specified either on the Settings/?Bad Sectors dialog box, or on the Properties tab,
the Drive Control section, for each drive separately. 

When R-Studio encounters such bad sectors while performing various tasks and they appear unreadable, it
treats them as follows:

Object images:

R-Studio fills the space in the image file where the bad sectors should be with the pattern specified in the Pattern

to fill bad blocks field on the Settings/?Bad Sectors dialog box. Please note that R-Studio writes the pattern on
the image, not on the source drive. 

Files

If Skip files with bad sectors on the Recovery dialog box is cleared, R-Studio fills bad sectors in the recovered
file with the pattern specified on the the Settings/?Bad Sectors dialog box. Information about such files will
appear in the Log.

If Skip files with bad sectors on the Recovery dialog box is selected, R-Studio skips files with bad sectors and
displays their list on the Files with bad sectors dialog box when the recovery has been completed. You may
select files to immediately recover them or to mark for later recovery. You may also save this list to a text file.

Files with bad sectors dialog box

Files with bad sectors Buttons

Select All Click this button to select all files in the list.
Clear All Click this button to unselect all selected files.
Mark Click this button to mark all selected files in the list. 
Save to File Click this button to save the list of files with bad sectors to a text file. 
Recover Click this button to immediately recover selected files. The bad sectors in the

recovered files will be filled with the pattern specified in the Pattern to fill bad blocks

field on the Settings/?Bad Sectors dialog box.

Objects edited in the Text/?hexadecimal Editor/?viewer

Bad sectors in the objects viewed/?edited in the Text/?hexadecimal Editor are shown as filled with the pattern
specified in the Pattern to fill bad blocks field on the Settings/?Bad Sectors dialog box.

https://www.r-studio.com/What-are-Bad-Sectors.html
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5.7 Memory Usage

You may see how much memory R-Studio uses while performing a data recovery task. This is especially useful
when scanning large drives on a computer with limited resources. You may specify memory control options on
the Memory usage tab in the R-Studio Settings.

To view memory usage,

1 Select Memory usage on the Tools menu

> R-Studio will show the total memory in your computer and how much memory it uses

Memory usage dialog box

 Memory usage

Process Memory Shows how much memory R-Studio uses. Limit shows how much memory your
system can virtually allocate to R-Studio. Actual memory allocation depends also on
the RAM and swap file sizes.

System Memory
Physical

Shows how much RAM is in your system

System Memory
Swap

Shows how much virtual memory is in your system

5.8 R-Studio Switches

If there are problems in starting R-Studio and while working with it, you may use switches to avoid them.

The following switches are available:
-all_drives Forces R-Studio to show all logical disks in the system. Normally R-Studio shows

only local drives in the system. Some storage devices may pretend that they are not
local drives.

-debug Includes additional debug information. When this switch is used, an additional
command Create FS Snapshot on the shortcut menu appears for an object with a file
system. An FS Snapshot contains system data for the file system only (file
descriptions without file contents). If a problem appears, this snapshot can be sent to
R-Studio technical support to identify the problem. This switch greatly slows
R-Studio. You may also turn this mode on by selecting Debug Mode on the Settings

dialog box.
-flush Flushes the log file after each write to log operations. This switch is helpful when

R-Studio locks and its log file remains in memory cache unwritten to a drive. This
switch greatly slows R-Studio.

-log <filename> Started with this switch, R-Studio writes its log into the specified file. If R-Studio
locks and its log file remains in memory cache unwritten to a drive, use the -flush
switch.

-mem <size in MB> Sets memory usage limit in MB for R-Studio to reconstruct the file tree. When it
exceeds the limit, a Too many files... message appears. You may temporally stop file

https://www.r-studio.com/What-is-Logical-Disk.html
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listing and browse through found files. Then you can resume file listing. You also may
skip this file section and continue file listing. Example: -mem 400 - sets the limit to
400 MB.

-no_ide_ext Turns off the inquiry about extended information on HDDs in Wind9x/ME. This
switch may be helpful if R-Studio returns information about HDDs incorrectly
(detects HDD geometry incorrectly).

-no_int13 Turns off the disc access through Int13 in Wind9x/ME. This switch may be helpful if
the system operates incorrectly (detects HDD geometry incorrectly or lock the
system).

-no_ios Turns off the Wind9x/ME protected-mode I/O system. This switch may be helpful if
this system operates incorrectly (detects HDD geometry incorrectly or lock the
system).

-reset R-Studio resets an HDD controller each time it reads a bad sector. This switch may
be helpful if the controller locks after it attempts to read a bad sector, or returns
incorrect data.

-safe Disables automatic partition search on a drive, file system recognition on partitions,
and other potentially problematic operations. In this mode, it is necessary to use Find

partition command from the drive shortcut menu to manually find a partition.

If an unrecognized problem appears, start R-Studio with the -debug and -log <filename> switches, and
send the log and screenshot of the R-Studio main panel to the R-Studio technical support:

R-Studio Technical Support Team is available 24 hours a day, seven days a week, and has an average
response time less than 4 hours.

5.9 Properties Tab

Object size units

You may select the units in which the information on object sizes will be displayed. Some parameters can be
edited when the Debug mode is turned on on the Main dialog box of the R-Studio settings.

To select the units

1 Select Properties on the View menu

2 Select the units in which you want to see object sizes.

You may select
Show as Bytes
Show as Sectors
Show as Bytes and Sectors

1.Basic information

This section shows basic information for a drive object.

 More information...

Drive Type Device/drive type and subtype. Current R-Studio version supports the following
types:
Disk, WORM, CDROM, Optical, Changer, Floppy, RAM Disk, LDM Partition, LDM
Component, LDM Volume

and subtypes:

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Partition.html
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Device, OS File, Physical Drive, Mount Point, Partition, Volume Set, Mirror, Stripe Set,
RAID 4, RAID 5, RAID 6

Name Device/drive name

Size Device/drive size

Bus Type Device/drive bus type. Can be:
IDE/ATA, IDE/ATAPI, SCSI, Floppy, USB, 1394, SSA, FibreChannel, RAID, SMART, ABIOS

2.Information on drives and logical disks

This section shows available information on drives and logical disks. These properties depend on the drive/disk
type and appear only when applicable. Under Windows, an IDE drive/disk may be represented as a SCSI
device, that is why the SCSI Address section appears under these OSes for those drives/disks.

 More information...

OS object Appears for image files under Windows for drives/disks. An object name used by OS
to access the Device/drive.

R-Studio driver Driver names (both internal and OS) used to access this drive/disk.
Sector Size Drive/disk sector size

Physical Drive
Geometry

This section shows physical geometry for a drive. For a logical disk it shows the
physical geometry for a drive where the logical disk resides

Cylinders

Tracks Per Cylinder

Sectors Per Track

Sector Size

Device
Identification

This section shows vendor information for the drive/disk

Vendor

Product

Firmware

Bus

SCSI Address This section shows SCSI information for the drive/disk
Port Number

Path ID

Target ID

Lun

Windows 9x/ME adds the following properties:
Int13 Drive Number 128 for the first drive accessible through Int13, 129 for the second one, etc. 0...128

for drives and other devices accessible through a Windows 9x/ME protected mode
driver, if their Int13 device option is disabled. R-Studio can use Int13 disk access,
and for some drive types, like SCSI devices, Int13 access is preferable. You may
consider enabling the Int13 device option in the Windows Device Manager for such
devices.

Int13 Extension
Version

Int13 Extension Version Support for drives. Extended Int13 support is necessary for
large drives. If this property is zero, Extended Int13 is not supported, otherwise, it

https://www.r-studio.com/What-is-Logical-Disk.html
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shows Extended Int13 standard version, the large, the better.

3.Properties controlling access to drives and logical disks

This section shows properties that control access (read and write) to drives and logical disks. They are set to
their optimal values and should be altered only if access problems appear.

 More information...

Drive Control

Maximum transfer Maximum data size that can be read or written during a single access to the drive. If
there are problems with drive access, decrease the value of this property

I/O Unit Data size read or written during a single access to the drive is a multiple value of this
property. If there are problems with drive access, decrease the value of this property

Buffer Alignment Drive data transfer buffer is positioned at an address multiple value of this property. If
there are problems with drive access, increase the value of this property.

These three properties are set by OS drivers. If the drivers set incorrect values, problems may appear during
data transfer operations. You can alter them until data transfer becomes stable.
I/O Tries Number of read/write tries during access to the drive. If there are bad sectors on the

drive, increase the value of this property. This may help to successfully read those
sectors. Sometimes, if the I/O Tries parameter is set too large and there are some
unreadable sectors on the drive, the drive-controller pair may refuse to perform any
successive read/write operations with the entire drive when it fails to read/write such
sectors. In this case, set this parameter to zero.
The default value is specified in the Settings (Bad Sectors) panel.
R-Studio treats bad sectors in the following way:
It reads a certain part of drive (predefined by Windows) and
· If Default read attempts is set to 0, the entire part with bad sectors will be filled with

the specified pattern. 
· If Default read attempts is set to a non-zero value, R-Studio reads again that part

sector by sector, repeating the attempts the specified number of times. If R-Studio
still cannot read a bad sector, it fills the sectors with the specified pattern. In this case
only the bad sectors will be filled with the pattern, but that extremely slows the drive
read process.

For example, if you set Default read attempts to 1, a bad sector will be read 2 times.

4.Partition properties

A partition is a continuous area on a drive, characterized by its offset and size. There are partitions on basic
disks, dynamic disks, and recognized volumes and partitions. R-Studio treats regions like partitions.

 More information...

Partition Offset Initial offset for the partition.
Partition Size Size of the partition.
Partition Type File system type for the partition. If the record in the drive partition table is incorrect,

this property may differ from the actual file system type for this partition. Still,
R-Studio will process this partition correctly, as it does not use this property.

Partition number Appears under Windows NT/?2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10 only. Shows the
number of the partition on the physical drive.

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Partition.html
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For regions and recognized partitions, Partition Offset and Partition Type properties can be manually
corrected.

5.Compound volume properties

A compound volume is a union of several partitions or other drive objects. Each union type has its own rules,
unique for each compound volume type. Among compound volumes are: Volume Sets (RAIDs Level 0),
Mirrors (RAIDs Level 1), RAIDs4/5/6 (RAIDs Level 4/5/6), both physical and created by the user (Virtual
Volume Sets, Virtual Stripe Sets, Virtual Mirrors, Virtual RAID5).

 More information...

Main properties of compound volumes are parents (drive objects from which a compound volume is
created) and their order. These properties may be viewed in the Parents tab.  For user-created compound
volumes these properties may be altered.
Raid Block Size Data block size for compound volumes of RAID (Level 0-5) types

6.LDM disks and volumes (Dynamic Disks)

LDM disks and volumes are volumes controlled by Logical Disk Manager (LDM). They are represented on a
drive as a LDM database rather than partition tables. Under Windows ?2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10,
LDM disks are also called Dynamic Disks.

 More information...

Offset of Logical
Disk

Initial offset of a logical disk on a drive. For disks, initially formatted by LDM, this
value is often 31.5KB, for converted disks, it may be larger.

Supposed Parents
Count

Supposed number of parent partitions for compound LDM volumes. If the LDM
database is not damaged, the value of this property must be equal to the number of
parent objects in the Parents tab for the drive object.

LDM Host GUID Global Unique Identifier of a computer system where this LDM disk group has been
created.

LDM DiskGroup GUID Global Unique Identifier of the LDM disk group.
LDM Disk GUID Global Unique Identifier of the drive.
LDM Volume GUID Global Unique Identifier of the volume.
LDM Disk ID Local drive Identifier, unique within this LDM disk group.
LDM Partition ID Local partition Identifier, unique within this LDM disk group.
LDM Component ID Local component Identifier, unique within this LDM disk group.
LDM Volume ID Local volume Identifier, unique within this LDM disk group.
LDM Disk AltName Additional Alternative Name given by LDM to the drive.
LDM Disk DriveHint Last name of the volume, under which is has been mounted in the system. May be

either a letter (C:, D:, etc.), or a mount point under Windows ?2000/?XP/?2003/?Vista/?
2008/?7/?8/8.1/?10.

7.File System Volume properties

A File System (FS) volume is a disk object where a certain, supported by R-Studio, file system is present.
There are two FS volume types: FS volume on a regular drive object and a recognized volume, found by a
scan process. FS volume properties depend on volume's file system and type.

https://www.r-studio.com/What-is-disk-format.html
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7.1.NTFS Volume properties

These properties are present for all NTFS volumes and represent their main properties. For recognized
volumes, these values can be altered.

 More information...

NTFS Information Regular volumes
Recognized NTFS Recognized volumes
Cluster Size Cluster size for the NTFS volume.
MFT record size Size of one MFT record describing one file on the NTFS volume. This is an important

property of any NTFS volume. Its common value is 1KB. If this property has incorrect
value, many files may be incorrectly recovered.

Sector Size Sector size for the physical drive. This property is read from the boot sector of the
NTFS volume and does not affect R-Studio operation.

Index Block Size Index block size for the NTFS volume. This property determines binary trees used to
store NTFS folder structure. It does not affect R-Studio operation.

MFT position MFT offset from the start of the NTFS volume.
MFT Mirror Position Second MFT copy offset from the start of the NTFS volume.
Volume size Size of the NTFS volume. This property does not affect R-Studio operation.

7.2.FAT Volume properties

These properties are present for all FAT volumes and represent their main properties. For recognized
volumes, these values can be altered.

 More information... 

FAT Information Regular volumes
Recognized FAT Recognized volumes
FAT Bits (12,16,32) FAT type. 12 for the FAT12, 16 for the FAT16, 32 for the FAT32.
Cluster Size Cluster size for the FAT volume.
First Cluster Offset Offset of the first cluster from the start of the FAT volume.
Boot Directory
Cluster

(For FAT32 only.) Cluster number where the root directory starts on the FAT volume
where the logical disk resides.

Root Directory
Offset

(For FAT12 and 16 only.) Root directory offset from the start of the FAT volume.

Root Directory
Length

(For FAT12 and 16 only.) Root directory length for the FAT volume.

First FAT Offset Offset for the first FAT table on the volume. Together with the Size of One Fat Table

property, is a most important property for a FAT volume. If this property is incorrect,
many files (especially fragmented ones) may be incorrectly recovered.

Size of One FAT
Table

Size of one FAT table on the volume.

Sector Size Sector size of the drive. This property is read from the boot sector of the FAT volume
and does not affect R-Studio operation.

Number of FAT
Copies

Number of FAT copies on the FAT volume.
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Active FAT copy Active FAT table number for the FAT volume. Can be set to Disabled, Auto, 1, or 2. If
it is Disabled, R-Studio processes the volume as there is no FAT table present. This
may be useful if the volume has been reformatted and thus a new FAT table is created
and the old one is deleted. In this case, it is reasonable to recover files from the
previous volume without processing the new and irrelevant FAT table. All files will be
recovered as continuous byte chains beginning from their start cluster. Unfragmented
files will be recovered successfully. If it is 1 or 2, R-Studio uses the first or second
FAT table copy, respectively. If it is Auto, R-Studio uses both FAT table copies and
decides, which FAT table copy should be used for a particular FAT table sector. This
may be useful when both FAT tables are partially damaged. 

Major version FAT version.
Minor version FAT minor version.
Volume size Size of the volume.

7.3.Ext2/3/4FS Volume properties

These properties are present for all Ext2/3/4FS volumes and represent their main properties. For recognized
volumes, these values can be altered.

 More information...

Ext2FS Information Regular volumes
Recognized Ext2FS Recognized volumes
Block Size Block size of Ext2FS file system. A block in the Ext2/3/4FS file system is similar to a

cluster in the FAT file system.
First SuperBlock
Offset

Offset of the first SuperBlock from the start of the Ext2/3/4FS volume.

Blocks Per Volume Number of blocks in the Ext2/3/4FS volume.
INodes Per Volume Number of inodes on the Ext2/3/4FS volume. An inode is a record describing file's

size, attributes, position on an Ext2F/3/4S volume - all information about a file, except
its name, which is stored separately. Therefore, the INodes Per Volume parameter is
equal to the maximum number of files on an Ext2/3/4FS volume.

Creator OS The OS that created this Ext2/3/4FS volume. May be Linux, Hurd, Masix, FreeBSD,
Lites.

Major version Ext2/3/4FS version. Usually 1.
Minor version Ext2/3/4FS minor version. Usually 0.
Last Mount Time Last mount time for this Ext2/3/4FS volume.
Last Write Time Last write time for this Ext2/3/4FS volume.
Last Check Time Last check time for this Ext2/3/4FS volume.
Volume size Size of the volume.

7.4.Recognized Volume properties

These properties are present for all recognized volumes, regardless of their file system type. They estimate
how reliable those volumes are recognized. This is useful for fast search for, and selection of, optimally
recognized volume to recover.
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 More information... 

Parsed File Entries Number of files proving that this recognized volume existed. May have any non-
negative values. The main property characterizing the reliability of volume recognition.
The larger it, the higher probability that this recognized volume has file system
properties that have been correctly found.

Parsed Boot
Records

Number of boot records proving that this recognized volume existed. May be 0 or 1.
This is the second important property characterizing the reliability of volume
recognition.

Estimated Size Estimated size of the recognized FS partition/volume. This property shows the most
probable size of the recognized FS partition/volume. Alternatively, Size and Partition

Size are set to the highest possible values in order to recover the maximum number of
files.



R-Studio Manual315

© 2023 R-Tools Technology Inc.

VI R-Studio Emergency

R-Studio Emergency is a tool that allows you to startup a computer with a damaged startup disk and recover
data stored on its hard drives. Then restored data can either be saved on its disk or transferred to a working
computer via a network.

The R-Studio Emergency version is a part of the R-Studio software package. 

You may run this R-Studio Emergency version on a computer for which you have bought an R-
Studio license, and you may not transfer the licensed software to another computer.

R-Studio Emergency
Contact Information and Technical Support
Installing R-Studio Emergency Startup Media Creator
Creating Startup Disks

R-Studio Emergency Operation
Starting a Computer with the R-Studio Emergency Startup Disks
File Recovery
Searching for a File
Disk Scan
Disk Images

Using R-Studio Emergency as Emergency Agent

Technical Information
Network Drives
Properties and Text/Hexadecimal Viewer
Log
Devices to Store Recovered Files

Hardware Compatibility List

6.1 Contact Informaiton and Technical Support

To obtain the latest version of R-Studio Emergency, go to:

Product Site: http://www.r-tt.com
Sales Department: sales@r-tt.com

R-StudioTechnical Support Team is available 24 hours a day, seven days a week, and has an average response
time less than 4 hours.

Tech. Support: support@r-tt.com
Send your support request to: http://www.r-tt.com/Support_request.html

6.2 Creating Startup Disks

· Installing R-Studio Emergency Startup Media Creator
· Creating Startup Disks Using R-Studio Emergency Startup Media Creator

http://www.r-tt.com
mailto:sales@r-tt.com
mailto:support@r-tt.com
http://www.r-tt.com/Support_request.html
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· Creating Startup Disks for Mac and Linux Computers
6.2.1 Installing R-Studio Emergency Startup Media Creator

Attention Windows NT/2000/XP/2003/Vista/2008/7 users! You must have administrative privileges

to install R-Studio Emergency Startup Media Creator. 

If you are not sure whether you have such privileges, you almost certainly do not have them. Contact your system
administrator for assistance.

1.Run the setup file. 
2.Follow the on-screen instructions. 

You may create startup disks even before the installation ends.

6.2.2 Creating Startup Disks Using R-Studio Emergency Startup Media Creator

You need to create either 

· A startup CD/DVD disc. You may create an ISO image, or write the disc directly from R-Studio Emergency

Startup Media Creator, if there is a CD/DVD recorder in your system. You may use this disc to start both
UEFI computers (modern Windows/Mac/Linux systems) and old Windows/Mac/Linux machines.

or

· A startup FAT/FAT32 removable device recognized by your system as a bootable one. The total available size
of the device should be more than 50 MB. You may use this device to start both UEFI computers (modern
Windows/Mac/Linux systems) and old Windows/Mac/Linux machines.

or

· 5 floppy disks. You may use them to start old Windows/Mac/Linux computers

Check the Hardware Compatibility List.

If you have problems with starting you computer up from the R-Studio Emergency startup disks, select
Configure startup media troubleshooting options on the Startup media type selection dialog box. Then the
Startup Media Troubleshooting Options dialog box will appear. You may configure these options to eliminate
those problems.

When R-Studio Emergency Startup Media Creator starts, its Welcome dialog box appears:

Welcome to R-Studio Emergency Startup Media Creator dialog box

Welcome dialog box

click the Next button to see the list of all devices on which startup disks may be created.
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Startup media type selection dialog box

To create a startup CD/DVD disc directly on your CD/DVD writer (if present):

1 Run R-Studio Emergency

2 Select the CD/DVD writer on the Startup media type selection dialog box and click the Next button

3 Read and accept the License Agreement and enter the registration key on the R-Studio Emergency

Activation dialog box and click the Next button

R-Studio Emergency Activation dialog box

4 Insert a blank CD/DVD disk into the CD/DVD recorder and click the Next button

Insert a CD/DVD disc dialog box
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> R-Studio Emergency Startup Media Creator will start creating the startup CD/DVD disc showing the

progress on the Creating startup media dialog box

Creating startup media dialog box

When R-Studio Emergency Startup Media Creator finishes creating the startup CD/DVD disc, the R-
Studio Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Emergency Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Back button.

R-Studio Emergency Startup Media Creation is Finished message

To create an ISO image of a startup CD/DVD disc

1 Run R-Studio Emergency

2 Select ISO Image for a startup CD/DVD on the R-Studio Emergency Startup Media Creator dialog box

and click the Next button

3 Read and accept the License Agreement and enter the registration key on the R-Studio Emergency

Activation dialog box and click the Next button

4 Select a place and file name for the ISO image of the startup CD/DVD and click the Save button

> When R-Studio Emergency Startup Media Creator finishes writing the file with the ISO image, the

R-Studio Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Emergency Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Next button.
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R-Studio Emergency Startup Media Creation is Finished dialog box

5 Create the startup CD/DVD using your favorite CD/DVD creation software

Load the created ISO image into the CD/DVD creation software. Consult documentation for the software
for details.

To create a startup FAT/FAT32 removable device

1 Run R-Studio Emergency

2 Select the removable device on the Startup media type selection dialog box and click the Next button

3 Read and accept the License Agreement and enter the registration key on the R-Studio Emergency

Activation dialog box and click the Next button

4 Check that the FAT/FAT32-formatted device is ready and click the Next button

Ready to create startup media dialog box

> R-Studio Emergency Startup Media Creator will start creating the startup USB disk showing the

progress on the Creating startup media dialog box

When R-Studio Emergency Startup Media Creator finishes creating the startup device, the R-
Studio Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Emergency Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Next button.
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R-Studio Emergency Startup Media Creation is Finished dialog box

To create floppy disks:

You will need 5 floppy disks.

1 Run R-Studio Emergency

2 Select Floppy Disk for the startup floppy disks on the R-Studio Emergency Startup Media Creator

dialog box and click the Next button

3 Read and accept the License Agreement and enter the registration key on the R-Studio Emergency

Activation dialog box and click the Next button

4 Insert the first floppy disk and click the Next button on the Ready to create startup media dialog box

R-Studio Emergency Startup Media Creation- Floppy Disk message

> R-Studio Emergency Startup Media Creator will start creating the first startup floppy disk showing

the progress on the Creating startup media dialog box

5 Insert the second floppy disk and click the OK button when the Please insert formatted diskette #2
into drive A: message will appear

> When R-Studio Emergency Startup Media Creator finishes creating the second startup floppy disk,

the R-Studio Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Emergency Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Next button.
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R-Studio Emergency Startup Media Creation is Finished message

Startup Media Troubleshooting Options

Those options will help you if you have problems with starting you computer up from the R-Studiostartup disks.
Please, contact the R-Studio Technical Support Team for more information.

R-Studio Startup Media Troubleshooting Options dialog box

Display kernel startup
messages

if this checkbox is enabled, R-Studio Emergency displays all startup messages.
That may be useful to locate the source of the problem when your system hangs
during R-Studio Emergency startup.

Disables ACPI
Disables APIC

Select these checkboxes when your system detects some hardware incorrectly
during R-Studio Emergency startup and displays messages like: hda: lost
interrupt

Disables USB device support Select this checkbox if your system experiences problems with USB devices
during R-Studio Emergency startup.

Disables SCSI device support Select this checkbox if your system experiences problems with SCSI devices
during R-Studio Emergency startup.

Disables PCMCIA device
support

Select this checkbox if your system experiences problems with PCMCIA
devices during R-Studio Emergency startup.

Disables DMA for all IDE disk
drives

Select this checkbox if your system experiences problems with IDE disks during
R-Studio Emergency startup.

IRQ polling mode Select this checkbox to enable the IRQ polling mode to prevent locking the
system because a device generates too much interrupts for the system to handle.

PCI BIOS Select an appropriate option if your system experiences problems with PCI
cards. 

BIOS RAIDS Select an appropriate option if your system experiences problems with RAIDs
built in the system board.
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6.2.3 Creating Startup Disks on Mac and Linux Computers

To start a Mac or a Linux computer, you may use the following devices:

1. A USB device created using the R-Studio Emergency Startup Media Creator for Windows. See the Creating
Startup Disks Using R-Studio Emergency Startup Media Creator page for more details. 

2. A USB device created using a Mac or Linux computer. To create such device, download the ZIP archive of
R-Studio Emergency, unzip it, and write files to a FAT32-formatted USB device.

Please note that you cannot use this disk to start non-UEFI computers (old Macs, for example), nor can you just
copy those files to a CD/DVD disc to create an R-Studio Emergency startup disc. If you need a CD/DVD disk,
burn it using the ISO image.

3. A startup CD/DVD disc. Download the ISO image of that disk and burn it or use the R-Studio Emergency
Startup Media Creator for Windows to burn it on a Windows computer.

6.3 R-Studio Emergency Operation

Starting a Computer with the R-Studio Emergency Startup Disks
File Recovery
Searching for a File
Disk Scan
Disk Images

Using R-Studio Emergency as Emergency Agent

Technical Information
Properties and Text/Hexadecimal Viewer
Network Drives
Log
Devices to Store Recovered Files

Hardware Compatibility List

R-Studio Emergency
Contact Information and Technical Support
Installing R-Studio Emergency Startup Media Creator
Creating Startup Disks

6.3.1 Starting a Computer with the R-Studio Emergency Startup Disks

We recommended that you print out this help page and have the hardcopy on hand while you are
performing this action.

If there is a non-IDE disk controller in your system, or you plan to use network disks or external hardware
devices, first check the Hardware Compatibility List.

If you plan to use any external device, turn it on before starting the system.

If the motherboard in your computer supports the Serial ATA (SATA) devices, but IDE disks are also present,
only the SATA devices should be set to the Enhanced Mode in BIOS.
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To start the computer with the R-Studio Emergency startup CD/DVD disc or any removable
device,

1 Make sure that the first startup device in the system BIOS is the CD/DVD drive or the removable device

Disable "Secure boot" in the system BIOS if your computer is certified to run Windows 8. Refer to your
system documentation for details.

2 Insert the R-Studio Emergency startup CD/DVD disc and start your computer

If you have a Mac computer

To start a Mac computer with the R-Studio Emergency startup disk, 

1. Insert a CD/DVD disc or connect a USB disk

2. Switch the Mac on.

3. While loading, press the Option key on the Mac keyboard (the Alt key if you use a non-Apple keyboard).

The Options key

4. Select the EFI boot disk and press Enter.

The R-Studio Emergency startup disk

R-Studio Emergency will start loading.

Then a startup screen will appear:
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Select the R-Studio Emergency GUI (Graphic Mode) to run R-Studio Emergency in the graphic mode
in which its user interface is similar to the Windows version. If R-Studio Emergency cannot run in this
mode, restart the system in the Safe VGA mode (only VESA-compliant) which is compatible with most
video cards and monitors. If it fails too, select the Text mode in which the R-Studio Emergency user
interface is shown in the pseudo-graphic mode compatible with all video cards. The help describes this
pseudo-graphic mode.

> R-Studio Emergency will start and its Device/Disk panel will appear

To start the computer with the R-Studio Emergency startup floppy disks,

1 Make sure that the first startup device in the system BIOS is A (Floppy)

Refer to your system documentation for details.

2 Insert the first startup floppy disk and start your computer

> The following text will appear on the screen:

Loading
Uncompressing ... OK, starting the kernel
VFS: Insert the second boot disk and press ENTER

3 Insert the second disk and press ENTER.

> R-Studio Emergency will start and its Device/Disk panel will appear

Secure boot:

It may be impossible to start a Windows 8 certified computer with the R-Studio Emergency startup disk without
some additional actions. This happens because any computer should use a so-called "Secure boot" procedure to
comply with Windows 8 hardware certification from Microsoft. In brief, this procedure prevents computer from
booting into any operating system that isn't digitally signed with an appropriate digital signature. "Secure boot" is
claimed to prevent unauthorized modification of the boot sector by bootkits, viruses, trojans, and other malicious
software. To the date, only Windows 8, Windows Server 2012, and selected Linux distributions support this
feature. As a side effect, it also prevents most LiveCDs, rescue disks (R-Studio and R-Drive Image included),
and other OS from running.

Likely enough, the other requirement of Windows 8 hardware certification is to make it possible for the user to
disable the Secure boot procedure. Those settings can be done through the system BIOS under the Boot
options. Generally, it's enough to enable Legacy support in those options, but sometimes it may require additional
actions. Please, refer to your system documentation to learn more about disabling/enabling Secure boot.

When Secure boot is disabled, it should be possible to start the computer with the R-Studio Emergency startup
disk.

Please note that you should enable this feature back after using the startup disks because Windows 8 or Server
2012 may not start properly without the Secure boot feature enabled.
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6.3.2 File Recovery

To recover files,

1 Select a partition on the Device/Disk panel on which the files to recover reside and press the Enter key

> R-Studiowill change its panel showing the disk's folders/files structure

2 Select the file to recover on the Files View panel. Use the Tab key to switch between panes

Files View panel

3 Press the F2 key and specify the output folder on the Recover dialog box

Recover dialog box

External USB drives with the NTFS file system: R-Studio Emergency can save recovered files on
such disks if they are properly disconnected in a Windows system using the Safely Remove Hardware icon
in the system tray or while shutting Windows down. 

Searching for a File
Mapping Network Drives
Viewing object properties

6.3.3 Searching for a File

To search for a file, 

1 Select Find on the Tools menu (or press the Alt+F key)

2 Specify a file name or mask
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Find dialog box

Look at dialog box
Deleted files: If it is selected, R-Studio makes a search among deleted files/folders.
Existing files: If it is selected, R-Studio makes a search among existing files/folders.
Files: If it is selected, R-Studio includes files into a search.
Folders: If it is selected, R-Studio includes folders into a search.

To find the next file corresponding to the specified file mask, 

* Press the Alt+N key

6.3.4 Disk Scan

To scan an object

1 Select an object on the Device/Disk panel and press the F6 key

2 Specify the required parameters on the Scan dialog box and press the Enter key

Scan dialog box

Scan dialog box
Start: Sets the start point of the area to be scanned.
Size: Sets the size of the area to be scanned.
Numbers in these fields can be in bytes or sectors.
If no letters are after the numbers, R-Studioassumes the numbers in bytes. 
The following case-ignoring notation is possible: 

b
kb
mb
gb
tb

Bytes
Kilobytes
Megabytes
Gigabytes
Terabytes
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> When an object is scanned, it may be searched for files, and found files may be recovered the same
way as for a regular object

Scan results

Found objects:
Extra Found Files Entries of known file types have been found
Recognized1 Records and file entries are found for this partition
Recognized2 Only file entries are found for this partition
Recognized3 Only boot records are found for this partition

To save scan information

1 Select an object with scan information

2 Press the Alt+D key and select Save Scan Information on the Drive menu

3 Specify the output folder and file name on the Save Scan Information dialog box

Mapping Network Drives

To open scan information

1 Select an object to which scan information is to be opened

2 Press the Alt+D key and select Open Scan Information on the Drive menu

3 Specify the folder and file name with the scan information on the Open Scan Information dialog box

Mapping Network Drives

To delete scan information

1 Select an object to which scan information is to be deleted

2 Press the Alt+D key and select Delete Scan Information on the Drive menu

6.3.5 Disk Images

To create an image file

1 Select an object on the Device/Disk panel
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2 Press the Alt+D key and select Create Plain Image File or Create Compressed Image File on the Drive
menu

Create Image dialog box

Plain Image If this option is selected, R-Studio will create a simple exact copy of the
object. This image format is compatible with the previous versions of R-

Studio.
Compressed Image If this option is selected, R-Studio will create an image file compatible with

the images created by R-Drive Image, but incompatible with the previous
versions of R-Studio.

3 Specify the output folder and file name on the Create Image File dialog box

Mapping Network Drives

To load an image file

1 Press the Alt+D key and select Open Image File on the Drive menu

2 Specify the folder and file name with the image on the Open Image File dialog box

Mapping Network Drives

6.4 Using R-Studio Emergency as an Emergency Agent

R-Studio Emergency can be used as an emergency agent for R-Studio. Moreover, if you have a Mac
computer, this is the only way to start it with R-Studio Agent Emergency.

To start the computer with the R-Studio Emergency/Agent startup CD/DVD disc or any removable
device ,

1 Make sure that the first startup device in the system BIOS is the CD/DVD drive or the removable device

Disable "Secure boot" in the system BIOS if your computer is certified to run Windows 8. Refer to your
system documentation for details.

2 Insert the R-Studio Emergency startup CD/DVD disc or the removable device and start your computer

If you have a Mac computer

To start a Mac computer with the R-Studio Emergency startup disk, 

1. Insert a CD/DVD disc or connect a USB disk

2. Switch the Mac on.

3. While loading, press the Option key on the Mac keyboard (the Alt key if you use a non-Apple keyboard).
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The Options key

4. Select the EFI boot disk and press Enter.

The R-Studio Emergency startup disk

R-Studio Emergency will start loading.

Then a startup screen will appear:

Startup Options 

2 Select the R-Studio Agent Emergency to run R-Studio Emergency as an emergency agent.

> R-Studio Agent Emergency will start and its prompt will appear
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R-Studio Emergency as an Emergency Agent

If your network has a DHCP server

The computer running R-Studio Agent Emergency will be assigned an IP address automatically

A prompt with a computer address will appear. You need to remember it to access the computer via
network.

If your network does not have a DHCP server

You need to configure the interfaces and IP addresses manually. 

1. Press Enter to start configuring the settings. A prompt to select an interface will appear. Enter the selected
interface name and press Enter.

2. A prompt to enter its IP address and optional subnet mask will appear. Enter the IP address and optional
subnet mask and press Enter.

 Network Setting Configuration

3. A prompt to configure another interface, gateway, or to finish configuring the interfaces will appear. Enter
gw, enter the IP address of the gateway, and press Enter.

 Network Setting Configuration

4. Press Enter to finish configuring the interfaces, or enter the name of the next interface to configure. 
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> R-Studio Agent Emergency will show a prompt that is ready to accept connections

R-Studio Emergency as an Emergency Agent

Now the computer may be accessed by R-Studio via network.

.

Secure boot:

It may be impossible to start a Windows 8 certified computer with the R-Studio Emergency startup disk without
some additional actions. This happens because any computer should use a so-called "Secure boot" procedure to
comply with Windows 8 hardware certification from Microsoft. In brief, this procedure prevents computer from
booting into any operating system that isn't digitally signed with an appropriate digital signature. "Secure boot" is
claimed to prevent unauthorized modification of the boot sector by bootkits, viruses, trojans, and other malicious
software. To the date, only Windows 8, Windows Server 2012, and selected Linux distributions support this
feature. As a side effect, it also prevents most LiveCDs, rescue disks (R-Studio and R-Drive Image included),
and other OS from running.

Likely enough, the other requirement of Windows 8 hardware certification is to make it possible for the user to
disable the Secure boot procedure. Those settings can be done through the system BIOS under the Boot
options. Generally, it's enough to enable Legacy support in those options, but sometimes it may require additional
actions. Please, refer to your system documentation to learn more about disabling/enabling Secure boot.

When Secure boot is disabled, it should be possible to start the computer with the R-Studio Emergency startup
disk.

Please note that you should enable this feature back after using the startup disks because Windows 8 or Server
2012 may not start properly without the Secure boot feature enabled.

To connect to R-Studio's computer,

1 Press the Enter key and enter the IP address of the computer where R-Studio is running as

IPaddress:port.

The default port is 8080, and you don't have to specify it.
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2 Enter the password if required, and press the Enter key.

> When the connection is established successfully, R-Studio Agent Emergency will notify you about

this.

R-Studio Emergency as an Emergency Agent

6.5 R-Studio Emergency Technical Information

Properties and Text/Hexadecimal Viewer
Network Drives
Log
Devices to Store Recovered Files
R-Studio Emergency

R-Studio Emergency
Contact Information and Technical Support
Installing R-Studio Emergency Startup Media Creator
Creating Startup Disks

R-Studio Emergency Operation
Starting a Computer with the R-Studio Emergency Startup Disks
File Recovery
Searching for a File
Disk Scan
Disk Images

Using R-Studio Emergency as Emergency Agent

Hardware Compatibility List

6.5.1 Properties and Text/Hexadecimal Viewer

To view object properties, 

1 Select an object

2 Press the F7 key
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To view an object

1 Select an object

2 Press the F3 key

3 Press the F6 key to view and select file attributes

Press the Esc key to close the viewer.

6.5.2 Network Drives

To map a network drive,

1 On a dialog box with Map Network Drive, press the Alt+M key

> The Querying DHCP message will appear 

If the network has a DHCP server, the computer will obtain an IP address automatically. A list of adapters
and their IP addresses will appear on the Network Adapters dialog box.

If the network does not have a DHCP server, select a network adapter on the Network Adapters dialog
box and press the F4 key. Enter the IP address and network mask and press the Enter button.

Network Addresses dialog box

2 Select a configured network adapter and press the Enter key

3 Enter the required information on the Map Network Drive message message

Map Network dialog box

Server IP Address: IP address of the computer where the network drive is to reside.
Server Share Name: Name of the shared folder where the network drive is to reside.
Login: Username of a user on the computer where the network drive is to reside.
Password: User's password on the computer where the network drive is to reside.

For the network drive's path //SERVER/Net_Drive, 
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Server IP address: The IP address of the SERVER computer (192.168.1.20)

Server share name: Net_Drive. 

> The mounted network disk will appear

To disconnect a mounted network drive

1 Select a mounted network drive

2 Switch to the Disconnect button and press the Enter key

6.5.3 Log

To clear log information

* Select Clear Log on the Tools menu

To save log information to a file

* Select Save Log To File on the Tools menu

6.5.4 Devices to Store Recovered Files

R-Studio Emergency can write recovered files to the following devices:

· FAT devices such as USB sticks, memory cards, and other similar devices. Such devices are inexpensive and
easily available, they can be fully accessed by all operating systems, but they have one important drawback:
they cannot store files larger that 2GB. So, if you plan to recover large video files, this is not your option.

· exFAT devices such as large USB sticks and memory cards, external hard disks, and other similar devices.
They are fully accessed by all operating systems. Unlike FAT devices, they don't have the 2GB file size limit.

· NTFS disks (primarily used in Windows computers).

 Access without any third-party software:

Windows computers: full.

Mac computers: read. 

Linux computers: full.

· HFS/HFS+ disks (used in Mac computers). 

Access without any third-party software:

Windows computers: no.

Mac computers: full. Some access problems may appear for files written by R-Studio Emergency.

Linux computers: full. Some access problems may appear for files written by R-Studio Emergency.

· Ext2/3/4 disks (used in Linux computers). 

Access without any third-party software:

Windows computers: no.

Mac computers: no

Linux computers: full.
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· XFS disks (used in Linux computers). 

Access without any third-party software:

Windows computers: no.

Mac computers: no

Linux computers: full.

· Network disks. Such disks may be on other network computers or NAS devices. See the Network Drives

page for more details

How to solve file access problems on Macs

Finder in the OSX system shows such inaccessible folders and files in the following way:
Inaccessible folders in Finder

To get access to such data, do the following:

1. Under an administrator account, right-click the folder and select Get Info on the contextual menu.
Info of an inaccessible folder

Click the Lock icon in the Sharing & Permissions section to unlock the folder properties. The system will
ask you for the account password.



R-Studio Emergency 336

© 2023 R-Tools Technology Inc.

2. Click the Privilege column and select Read & Write on the contextual menu.
Setting the access rights for the folder

3. If this is a folder with other folders and files, click the Properties icon and select Apply to enclosed

items.

Setting access rights for enclosed items in the folder

Then click the Lock icon to lock the properties back. 

6.6 R-Studio Emergency Hardware Compatibility List

R-Studio Emergency supports the following hardware devices:

Data Storage Devices Networking Devices

Serial ATA and Parallel ATA drivers

ACPI firmware driver for PATA

AHCI SATA

ALi PATA

AMD/NVidia PATA

ARTOP 6210/6260 PATA

ARTOP/Acard ATP867X PATA

ATI PATA

CMD / Silicon Image 680 PATA

CMD640 PCI PATA

CMD64x PATA

CS5510/5520 PATA

CS5530 PATA

CS5535 PATA

Ethernet (10 or 100Mbit)

3c501 `EtherLink`

3c503 `EtherLink II`

3c505 `EtherLink Plus`

3c507 `EtherLink 16`

3c509/3c529 (MCA)/3c579 `EtherLink III`

3c515 ISA `Fast EtherLink`

3c590/3c900 series (592/595/597)
`Vortex/Boomerang`

3cr990 series `Typhoon`

AMD 8111 (new PCI lance)

AMD LANCE and PCnet (AT1500 and NE2100)

AMD PCnet32 PCI

AT1700/1720
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CS5536 PATA

Compaq Triflex PATA

Cypress CY82C693 PATA

EFAR SLC90E66

Generic ATA

HPT 343/363 PATA

HPT 366/368 PATA

HPT 370/370A/371/372/374/302 PATA

HPT 372N/302N PATA

IT8211/2 PATA

IT8213 PATA

Initio 162x SATA

Intel ESB, ICH, PIIX3, PIIX4 PATA/SATA

Intel PATA MPIIX

Intel PATA old PIIX

Intel SCH PATA

JMicron PATA

Legacy ISA PATA

Marvell PATA support via legacy mode

Marvell SATA

NETCELL Revolution RAID

NVIDIA SATA

Nat Semi NS87410 PATA

Nat Semi NS87415 PATA

Ninja32/Delkin Cardbus ATA

OPTI FireStar PATA

OPTI621/6215 PATA

Older Promise PATA controller

PCMCIA PATA

Pacific Digital ADMA

Pacific Digital SATA QStor

Platform AHCI SATA

Promise PATA 2027x

Promise SATA SX4

Promise SATA TX2/TX4

QDI VLB PATA

RADISYS 82600 PATA

RDC PATA

SC1200 PATA

SERVERWORKS OSB4/CSB5/CSB6/HT1000
PATA

Adaptec Starfire/DuraLAN

Ansel Communications EISA 3200

Apricot Xen-II on board Ethernet

Atheros L2 Fast Ethernet

Broadcom 440x/47xx ethernet

CS89x0

Cabletron E21xx

DECchip Tulip (dc2114x) PCI

Dave ethernet support (DNET)

Davicom DM910x/DM980x

Early DECchip Tulip (dc2104x) PCI

EtherExpress 16

EtherExpressPro support/EtherExpress 10 (i82595)

Generic DECchip & DIGITAL EtherWORKS
PCI/EISA

HP 10/100VG PCLAN (ISA, EISA, PCI)

HP PCLAN (27245 and other 27xxx series)

HP PCLAN+ (27247B and 27252A)

ICL EtherTeam 16i/32

Intel(R) PRO/100+

LP486E on board Ethernet

Myson MTD-8xx PCI Ethernet

NE2000/NE1000

NI5010

NI5210

NI6510

National Semiconductor DP8381x series PCI
Ethernet

OpenCores 10/100 Mbps Ethernet MAC

PCI NE2000 and clones support (see help)

RDC R6040 Fast Ethernet Adapter

RealTek RTL-8129/8130/8139 PCI Fast Ethernet
Adapter

RealTek RTL-8139 C+ PCI Fast Ethernet Adapter

SEEQ8005

SMC 9194

SMC EtherPower II

SMC Ultra

SMSC LAN9420 PCI ethernet adapter

SiS 900/7016 PCI Fast Ethernet Adapter

Silan SC92031 PCI Fast Ethernet Adapter driver
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ServerWorks Frodo / Apple K2 SATA

SiS 964/965/966/180 SATA

SiS PATA

Silicon Image 3124/3132 SATA

Silicon Image SATA

ULi Electronics SATA

VIA PATA

VIA SATA

VITESSE VSC-7174 / INTEL 31244 SATA

Winbond SL82C105 PATA

Winbond W83759A VLB PATA

SCSI low-level drivers

3ware 5/6/7/8xxx ATA-RAID

3ware 97xx SAS/SATA-RAID

3ware 9xxx SATA-RAID

7000FASST SCSI

ACARD SCSI

ARECA (ARC11xx/12xx/13xx/16xx)
SATA/SAS RAID Host Adapter

Adaptec AACRAID

Adaptec AHA152X/2825

Adaptec AHA1542

Adaptec AIC79xx U320

Adaptec AIC7xxx

Adaptec AIC7xxx Fast -> U160

Adaptec AIC94xx SAS/SATA

Adaptec I2O RAID

AdvanSys SCSI

Always IN2000 SCSI

BusLogic SCSI

DMX3191D SCSI

DTC3180/3280 SCSI

EATA ISA/EISA/PCI (DPT and generic
EATA/DMA-compliant boards)

Emulex LightPulse Fibre Channel Support

Future Domain 16xx SCSI/AHA-2920A

Generic NCR5380/53c400 SCSI MMIO

Generic NCR5380/53c400 SCSI PIO

HP Smart Array SCSI driver

HighPoint RocketRAID 3xxx/4xxx Controller

Sun Cassini

Sun GEM

Sun Happy Meal 10/100baseT

Sundance Alta

TI ThunderLAN

ULi M526x controller

VIA Rhine

WD80*3

Winbond W89c840 Ethernet

Zenith Z-Note

nForce Ethernet

Ethernet (1000 Mbit)

Alteon AceNIC/3Com 3C985/NetGear GA620
Gigabit

Atheros L1C Gigabit Ethernet

Atheros L1E Gigabit Ethernet

Atheros/Attansic L1 Gigabit Ethernet

Broadcom CNIC

Broadcom NetXtremeII

Broadcom Tigon3

DL2000/TC902x-based Gigabit Ethernet

IP1000 Gigabit Ethernet

Intel(R) 82575/82576 PCI-Express Gigabit Ethernet

Intel(R) 82576 Virtual Function Ethernet

Intel(R) PRO/1000 Gigabit Ethernet

Intel(R) PRO/1000 PCI-Express Gigabit Ethernet

JMicron(R) PCI-Express Gigabit Ethernet

National Semiconductor DP83820

New SysKonnect GigaEthernet

Packet Engines Hamachi GNIC-II

Packet Engines Yellowfin Gigabit-NIC

QLogic QLA3XXX Network Driver Support

Realtek 8169 gigabit ethernet

SiS190/SiS191 gigabit ethernet

SysKonnect Yukon2

VIA Velocity

Ethernet (10000 Mbit)

Broadcom NetXtremeII 10Gb

Chelsio 10Gb Ethernet

Chelsio Communications T3 10Gb Ethernet
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IBM Power Linux RAID adapter

IBM ServeRAID

Initio 9100U(W)

Initio INI-A100U2W

Intel/ICP (former GDT SCSI Disk Array) RAID
Controller

LSI Logic Legacy MegaRAID Driver

LSI Logic Management Module

LSI Logic MegaRAID Driver

LSI Logic MegaRAID SAS RAID Module

LSI MPT Fusion SAS 2.0 Device Driver

Marvell 88SE64XX/88SE94XX SAS/SATA

NCR53c406a SCSI

PAS16 SCSI

PMC SIERRA Linux MaxRAID adapter

PMC-Sierra SPC 8001 SAS/SATA Based Host
Adapter driver

Promise SuperTrak EX Series

QLogic ISP4XXX host adapter family

QLogic QLA2XXX Fibre Channel Support

Qlogic FAS SCSI

Qlogic QLA 1240/1x80/1x160 SCSI

SYM53C8XX Version 2 SCSI

Symbios 53c416 SCSI

Tekram DC390(T) and Am53/79C974 SCSI

Tekram DC395(U/UW/F) and DC315(U) SCSI

Trantor T128/T128F/T228 SCSI

UltraStor 14F/34F

UltraStor SCSI

VMware PVSCSI driver

Workbit NinjaSCSI-32Bi/UDE

USB support

Cypress C67x00 HCD

Datafab Compact Flash Reader

Freecom USB/ATAPI Bridge

ISD-200 USB/ATA Bridge

ISP 1760 HCD

ISP116X HCD

ISP1362 HCD

Lexar Jumpshot Compact Flash Reader

Chelsio Communications T4 Ethernet

Cisco VIC Ethernet NIC Support

Intel(R) 10GbE PCI Express adapters

Intel(R) PRO/10GbE

Mellanox Technologies 10Gbit Ethernet

Myricom Myri-10G Ethernet

NetXen Multi port (1/10) Gigabit Ethernet NIC

Neterion X3100 Series 10GbE PCIe Server Adapter

QLOGIC QLCNIC 1/10Gb Converged Ethernet
NIC Support

QLogic QLGE 10Gb Ethernet Driver Support

S2IO 10Gbe XFrame NIC

ServerEngines' 10Gbps NIC - BladeEngine

Solarflare Solarstorm SFC4000/SFC9000-family

Sun Neptune 10Gbit Ethernet

Tehuti Networks 10G Ethernet

Token Ring driver support

3Com 3C359 Token Link Velocity XL adapter

Generic TMS380 PCI

Generic TMS380 Token Ring ISA/PCI adapter

IBM Lanstreamer chipset PCI adapter

IBM Olympic chipset PCI adapter

IBM Tropic chipset based adapter

Madge Smart 16/4 PCI Mk2

Proteon ISA

SMC ISA/MCA adapter

SysKonnect TR4/16 ISA

USB Network Adapters

ASIX AX88xxx Based USB 2.0 Ethernet Adapters

CDC EEM

CDC Ethernet support (smart devices such as cable
modems)

Davicom DM9601 based USB 1.1 10/100 ethernet
devices

GeneSys GL620USB-A based cables

Host for RNDIS and ActiveSync devices

MosChip MCS7830 based Ethernet adapters

NetChip 1080 based cables (Laplink, ...)

Prolific PL-2301/2302 based cables
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OXU210HP HCD

Olympus MAUSB-10/Fuji DPC-R1

R8A66597 HCD

SL811HS HCD

SanDisk SDDR-09 (and other SmartMedia,
including DPCM)

SanDisk SDDR-55 SmartMedia

USB 2.0

USB Mass Storage

USB Monitor

USBAT/USBAT02-based storage

xHCI HCD (USB 3.0)

Block devices

Compaq SMART2

Compaq Smart Array 5xxx

Mylex DAC960/DAC1100 PCI RAID Controller

Normal floppy disk

Promise SATA SX8

IEEE 1394 (FireWire) support

Legacy alternative FireWire driver stack

Storage devices (SBP-2 protocol)

PCMCIA network device support

3Com 3c574 PCMCIA

3Com 3c589 PCMCIA

Asix AX88190 PCMCIA

COM20020 ARCnet PCMCIA

Fujitsu FMV-J18x PCMCIA

NE2000 compatible PCMCIA

New Media PCMCIA

SMC 91Cxx PCMCIA

Xircom 16-bit PCMCIA

Other devices

Microsoft Hyper-V Utilities driver

Microsoft Hyper-V client drivers

Microsoft Hyper-V virtual block driver

Microsoft Hyper-V virtual network driver

Microsoft Hyper-V virtual storage driver

SMSC LAN95XX based USB 2.0 10/100 ethernet
devices

Sharp Zaurus (stock ROMs) and compatible

Simple USB Network Links (CDC Ethernet subset)

USB CATC NetMate-based Ethernet device

USB KLSI KL5USB101-based ethernet device

USB Pegasus/Pegasus-II based ethernet device

USB RTL8150 based ethernet device
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VII R-Studio Agent Emergency

R-Studio Agent Emergency is a tool that allows you to start a network computer with a damaged startup disk
and recover data stored on its hard drives. Then restored data can be transferred to a working computer via the
network.

It works very simple: Just start the computer with the R-Studio Agent Emergency startup disk(s) and, if
necessary, manually configure a network interface for R-Studio Agent Emergency. When started, the
computer and its hard drives can be accessed by R-Studio installed on another computer on the network. 

Contact Information and Technical Support
Installing R-Studio Agent Emergency Startup Media Creator
Creating Startup Disks
Starting a Computer with the R-Studio Agent Emergency Startup Disk

Hardware Compatibility List
Disk Controllers
Network Cards

7.1 Contact Information and Technical Support

To obtain the latest version of R-Studio Agent Emergency, go to:

Product Site: http://www.r-tt.com
Sales Department: sales@r-tt.com

R-Studio Technical Support Team is available 24 hours a day, seven days a week, and has an average
response time less than 4 hours.

Tech. Support: support@r-tt.com
Send your support request to: http://www.r-tt.com/Support_request.html

7.2 Installing R-Studio Agent Emergency Startup Media Creator

You must have administrative privileges to install R-Studio Agent Emergency Startup Media
Creator. 

If you are not sure whether you have such privileges, you almost certainly do not have them. Contact your system
administrator for assistance.

1.Run the setup file. 
2.Follow the on-screen instructions. 

You may create startup disks even before the installation ends.

7.3 Creating Startup Disks

You need to create either 

· A startup CD/DVD disc. You may create an ISO image, or write the disc directly from R-Studio Emergency

Startup Media Creator, if there is a CD/DVD recorder in your system.

or

http://www.r-tt.com
mailto:sales@r-tt.com
mailto:support@r-tt.com
http://www.r-tt.com/Support_request.html
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· A startup FAT/FAT32 removable device recognized by your system as a bootable one. The total available size
of the device should be more than 10 MB.

or

· 4 formatted floppy disks

Check the Hardware Compatibility List.

When R-Studio Agent Emergency Startup Media Creator starts, its Welcome dialog box appears:

Welcome to R-Studio Agent Emergency Startup Media Creator dialog box

Welcome dialog box

click the Next button to see the list of all devices on which startup disks may be created.

Startup media type selection dialog box

To create a startup CD/DVD disc directly on your CD/DVD writer (if present):

1 Run R-Studio Agent Emergency

2 Select the CD/DVD writer on the Startup media type selection dialog box and click the Next button

3 Read and accept the License Agreement and enter the R-Studio Agent registration key on the R-
Studio Agent Emergency Activation dialog box and click the Next button

Note: You should enter the registration key of R-Studio Agent, not R-Studio itself.
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R-Studio Agent Emergency License Agreement dialog box

R-Studio Agent Emergency Activation dialog box

if you do not enter the registration key, R-Studio Agent Emergency will work in the Demo mode. You
may enter the key later when R-Studio Agent Emergency and R-Studio establish a connection

4 Insert a blank CD/DVD disk into the CD/DVD recorder and click the Next button

Insert media disc dialog box
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> R-Studio Agent Emergency Startup Media Creator will start creating the startup CD/DVD disc

showing the progress on the Creating startup media dialog box

Creating startup media dialog box

When R-Studio Agent Emergency Startup Media Creator finishes creating the startup CD/DVD disc,

the R-Studio Agent Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Emergency Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Back button.

R-Studio Agent Emergency Startup Media Creation is Finished message

To create an ISO image of a startup CD/DVD disc

1 Run R-Studio Agent Emergency

2 Select ISO Image for a startup CD/DVD on the R-Studio Agent Emergency Startup Media Creator

dialog box and click the Next button

3 Read and accept the License Agreement and enter the R-Studio Agent registration key on the R-
Studio Agent Emergency Activation dialog box and click the Next button

Note: You should enter the registration key of R-Studio Agent, not R-Studio itself.

if you do not enter the registration key, R-Studio Agent Emergency will work in the Demo mode. You
may enter the key later when R-Studio Agent Emergency and R-Studio establish a connection.

4 Select a place and file name for the ISO image of the startup CD/DVD and click the Save button

> When R-Studio Bootable Startup Media Creator finishes writing the file with the ISO image, the R-
Studio Agent Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Bootable Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Back button.
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R-Studio Agent Emergency Startup Media Creation is Finished dialog box

5 Create the startup CD/DVD using your favorite CD/DVD creation software

Load the created ISO image into the CD/DVD creation software. Consult documentation for the software
for details.

To create a startup FAT/FAT32 removable device

1 Run R-Studio Agent Emergency

2 Select the removable device on the Startup media type selection dialog box and click the Next button

3 Read and accept the License Agreement and enter the registration key on the R-Studio Agent
Emergency Activation dialog box and click the Next button

4 Check that the correct FAT/FAT32-formatted device is selected and click the Next button

Confirm device selection dialog box

> R-Studio Agent Emergency Startup Media Creator will start creating the startup USB disk showing

the progress on the Creating startup media dialog box

When R-Studio Agent Emergency Startup Media Creator finishes creating the startup device, the

R-Studio Agent Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Emergency Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Back button.
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R-Studio Agent Emergency Startup Media Creation is Finished dialog box

To create floppy disks:

You will need 4 formatted floppy disks.

1 Run R-Studio Agent Emergency

2 Select Floppy Disk for the startup floppy disk on the R-Studio Agent Emergency Startup Media

Creator dialog box and click the Next button

3 Enter the registration information and number on the Registration dialog box and click the Next button

If you leave all the field blank, R-Studio Agent Emergency will work with the Demo-version limitations

4 Insert the floppy disk and click the Next button on the Insert floppy dialog box

Insert floppy dialog box

> R-Studio Agent Emergency Startup Media Creator will start creating the startup floppy disk

showing the progress on the Creating startup media dialog box

Creating startup media dialog box
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5 Insert the second floppy disk and click the OK button when the Please insert formatted diskette #2
into drive A: message will appear

Do it with the next 2 floppy disks.

> When R-Studio Startup Media Creator finishes creating the startup floppy disk, the R-Studio Agent

Emergency Startup Media Creation is Finished message will appear. You may either exit R-Studio

Startup Media Creator by clicking the Finish button or create another startup media by clicking the

Back button.

R-Studio Agent Emergency Startup Media Creation is Finished dialog box

7.4 Starting a Computer with the R-Studio Agent Emergency
Startup Disk

We recommended that you print out this help page and have the hardcopy on hand while you are
performing this action.

Before you start the computer you should be aware that your network has a DHCP server or you
know the computer's IP address and network mask.

If there is a non-IDE disk controller in your system, or you plan to use network disks or external hardware
devices, first check the Hardware Compatibility List.

If you plan to use any external device, turn it on before starting the system.

If the motherboard in your computer supports the Serial ATA (SATA) devices, but IDE disks are also present,
only the SATA devices should be set to the Enhanced Mode in BIOS.

To start the computer with the R-Studio Agent Emergency startup disks

1 Make sure that the first startup device in the system BIOS is the device from which you plan to start
your computer (a CD/DVD drive or A (Floppy)) 

Disable "Secure boot" in the system BIOS if your computer is certified to run Windows 8. Refer to your
system documentation for details. Refer to your system documentation for details.

2 Insert the R-Studio Agent Emergency startup CD/DVD disc, a removable device, or the first floppy disk

and start your computer

> R-Studio Agent Emergency will start and its prompt will appear

If you start your computer with floppy disks, you'll see prompts to insert a next floppy disk.
-----------------------------------------------------------------
Booting R-Studio Emergency. Please wait...
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Waiting 8 seconds for PCMCIA devices to settle
Booting R-Studio Agent Emergency. Now you may remove floppy.
-----------------------------------------------------------------
Querying DHCP to configure network interfaces...
Press ENTER within 10 seconds to configure them manually.

If your network has a DHCP server

The computer running R-Studio Agent Emergency will be assigned an IP address automatically

A prompt with a computer address will appear. You need to remember it to access the computer via
network.

If your network does not have a DHCP server

You need to configure the interfaces and IP addresses manually. 

1. A prompt to select an interface will appear. Enter the selected interface name and press Enter.
2. A prompt to enter its IP address and optional subnet mask will appear. Enter the IP address and optional

subnet mask and press Enter.
------------------------[ List of
Interfaces ]--------------------------------
Name           IP Address            NETMASK            Vendor
------------------------------------------------------------------
------------
re0            Unconfigured                             RealTek
8139C+
------------------------------------------------------------------
------------
# Enter interface name, 'gw' for default gateway or just press
ENTER to finish
#>re0
# Enter IP address and optional NETMASK delimited by space
#>192.168.0.10 255.255.255.0

3. A prompt to configure another interface, gateway, or to finish configuring the interfaces will appear. Enter
gw, enter the IP address of the gateway, and press Enter.
------------------------[ List of
Interfaces ]--------------------------------
Name           IP Address            NETMASK          Vendor
------------------------------------------------------------------
------------
re0            Unconfigured                           RealTek
8139C+
------------------------------------------------------------------
------------
# Enter interface name, 'gw' for default gateway or just press
ENTER to finish
#>re0
# Enter IP address and optional NETMASK delimited by space
#>192.168.0.10 255.255.255.0

------------------------[ List of
Interfaces ]--------------------------------
Name           IP Address            NETMASK            Vendor
------------------------------------------------------------------
------------
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re0            192.168.0.10          255.255.255.0      RealTek
8139C+
gw             Unconfigured                             Default
gateway
------------------------------------------------------------------
------------
# Enter interface name, 'gw' for default gateway or just press
ENTER to finish
#>gw
# Enter default gateway IP Address
#>192.168.0.1

------------------------[ List of
Interfaces ]--------------------------------
Name           IP Address            NETMASK            Vendor
------------------------------------------------------------------
------------
re0            192.168.0.10          255.255.255.0      RealTek
8139C+
gw             192.168.0.1                              Default
gateway
------------------------------------------------------------------
------------
# Enter interface name, 'gw' for default gateway or just press
ENTER to finish
#>

4. Press Enter to finish configuring the interfaces, or enter the name of the next interface to configure. 

> R-Studio Agent Emergency will show a prompt that is ready to accept connections

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start to remote R-Studio...

Now the computer may be accessed by R-Studio via network.

Secure boot:

It may be impossible to start a Windows 8 certified computer with the R-Studio Agent Emergency startup disk
without some additional actions. This happens because any computer should use a so-called "Secure boot"
procedure to comply with Windows 8 hardware certification from Microsoft. In brief, this procedure prevents
computer from booting into any operating system that isn't digitally signed with an appropriate digital signature.
"Secure boot" is claimed to prevent unauthorized modification of the boot sector by bootkits, viruses, trojans,
and other malicious software. To the date, only Windows 8, Windows Server 2012, and selected Linux
distributions support this feature. As a side effect, it also prevents most LiveCDs, rescue disks (R-Studio and R-
Drive Image included), and other OS from running.

Likely enough, the other requirement of Windows 8 hardware certification is to make it possible for the user to
disable the Secure boot procedure. Those settings can be done through the system BIOS under the Boot
options. Generally, it's enough to enable Legacy support in those options, but sometimes it may require additional
actions. Please, refer to your system documentation to learn more about disabling/enabling Secure boot.

When Secure boot is disabled, it should be possible to start the computer with the R-Studio Agent Emergency
startup disk.

Please note that you should enable this feature back after using the startup disks because Windows 8 or Server
2012 may not start properly without the Secure boot feature enabled.
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Starting a Connection from R-Studio Agent Emergency

When you need to connect R-Studio and R-Studio Agent Emergency over the Internet, it may be necessary
to start the connection from the computer where R-Studio Agent Emergency is running.

To connect to R-Studio's computer,

1 Press the Enter key and enter the IP address of the computer where R-Studio is running as

IPaddress:port.

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start connection to remote R-Studio...
# Enter R-Studio IP address or just press ENTER to cancel>
192.168.0.25:80

The default port is 8080, and you don't have to specify it.

2 Enter the password if required, and press the Enter key.

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start connection to remote R-Studio...
# Enter R-Studio IP address or just press ENTER to cancel>
192.168.0.25:80
# Enter password or just press ENTER to connect without
one>PaSsWoRd1234

> When the connection is established successfully, R-Studio Agent Emergency will notify you about

this.

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start connection to remote R-Studio...
# Enter R-Studio IP address or just press ENTER to cancel>
192.168.0.25:80
# Enter password or just press ENTER to connect without
one>PaSsWoRd1234
Connection with 192.168.0.25:80 is established successfully.

7.5 R-Studio Agent Emergency Hardware Compatibility List

Disk Controllers
Network Cards

R-Studio Agent Emergency
Contact Information and Technical Support
Installing R-Studio Agent Emergency Startup Media Creator
Creating Startup Disks
Starting a Computer with the R-Studio Agent Emergency Startup Disk

7.5.1 Disk Controllers

R-Studio Agent Emergency is based on the FreeBSD 5.3 kernel and supports devices from the list published
at http://www.freebsd.org/releases/5.3R/hardware-i386.html.

*: Supported in the floppy version

http://www.freebsd.org/releases/5.3R/hardware-i386.html
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Disk controllers

IDE/ATA controllers ( ata driver) *

The adapters supported by the aic driver include:

Adaptec AHA-1505 (ISA)
Adaptec AHA-1510A, AHA-1510B (ISA)
Adaptec AHA-1520A, AHA-1520B (ISA)
Adaptec AHA-1522A, AHA-1522B (ISA)
Adaptec AHA-1535 (ISA)
Creative Labs SoundBlaster SCSI host adapter (ISA)
Adaptec AHA-1460, AHA-1460B, AHA-1460C, AHA-1460D (PC Card)
Adaptec AHA-1030B, AHA-1030P (PC98)
NEC PC-9801-100 (PC98)

The aha driver supports the following SCSI host adapters:

Adaptec AHA-154xB
Adaptec AHA-154xC
Adaptec AHA-154xCF
Adaptec AHA-154xCP
Adaptec AHA-1640
Adaptec AHA-174x in 154x emulation mode
DTC 3290 SCSI controller in 1542 emulation mode
Tekram SCSI controllers in 154x emulation mode

The ahb driver supports the following SCSI host adapters:

Adaptec AHA-1740
Adaptec AHA-1742
Adaptec AHA-1740A
Adaptec AHA-1742A

The ahc driver supports the following SCSI host adapter chips and SCSI controller cards:

Adaptec AIC7770 host adapter chip
Adaptec AIC7850 host adapter chip
Adaptec AIC7860 host adapter chip
Adaptec AIC7870 host adapter chip
Adaptec AIC7880 host adapter chip
Adaptec AIC7890 host adapter chip
Adaptec AIC7891 host adapter chip
Adaptec AIC7892 host adapter chip
Adaptec AIC7895 host adapter chip
Adaptec AIC7896 host adapter chip
Adaptec AIC7897 host adapter chip
Adaptec AIC7899 host adapter chip
Adaptec 274X(W)
Adaptec 274X(T)
Adaptec 284X
Adaptec 2910
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Adaptec 2915
Adaptec 2920
Adaptec 2930C
Adaptec 2930U2
Adaptec 2940
Adaptec 2940J
Adaptec 2940N
Adaptec 2940U
Adaptec 2940AU
Adaptec 2940UW
Adaptec 2940UW Dual
Adaptec 2940UW Pro
Adaptec 2940U2W
Adaptec 2940U2B
Adaptec 2950U2W
Adaptec 2950U2B
Adaptec 19160B
Adaptec 29160B
Adaptec 29160N
Adaptec 3940
Adaptec 3940U
Adaptec 3940AU
Adaptec 3940UW
Adaptec 3940AUW
Adaptec 3940U2W
Adaptec 3950U2
Adaptec 3960
Adaptec 39160
Adaptec 3985
Adaptec 4944UW
NEC PC-9821Xt13 (PC-98)
NEC RvII26 (PC-98)
NEC PC-9821X-B02L/B09 (PC-98)
NEC SV-98/2-B03 (PC-98)
Many motherboards with on-board SCSI support

The ahd driver supports the following:

Adaptec AIC7901 host adapter chip
Adaptec AIC7901A host adapter chip
Adaptec AIC7902 host adapter chip
Adaptec 29320 host adapter
Adaptec 39320 host adapter
Many motherboards with on-board SCSI support

Controllers supported by the aac driver include:

Adaptec AAC-364
Adaptec SCSI RAID 2120S
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Adaptec SCSI RAID 2130S
Adaptec SCSI RAID 2200S
Adaptec SCSI RAID 2410SA
Adaptec SCSI RAID 2810SA
Adaptec SCSI RAID 5400S
Dell CERC SATA RAID 2
Dell PERC 2/Si
Dell PERC 2/QC
Dell PERC 3/Si
Dell PERC 3/Di
Dell PERC 320/DC
HP NetRAID 4M

The adv driver supports the following SCSI controllers:

AdvanSys ABP510/5150
AdvanSys ABP5140
AdvanSys ABP5142
AdvanSys ABP902/3902
AdvanSys ABP3905
AdvanSys ABP915
AdvanSys ABP920
AdvanSys ABP3922
AdvanSys ABP3925
AdvanSys ABP930, ABP930U, ABP930UA
AdvanSys ABP960, ABP960U
AdvanSys ABP542
AdvanSys ABP742
AdvanSys ABP842
AdvanSys ABP940
AdvanSys ABP940UA/3940UA
AdvanSys ABP940U
AdvanSys ABP3960UA
AdvanSys ABP970, ABP970U
AdvanSys ABP752
AdvanSys ABP852
AdvanSys ABP950
AdvanSys ABP980, ABP980U
AdvanSys ABP980UA/3980UA
MELCO IFC-USP (PC-98)
RATOC REX-PCI30 (PC-98)
@Nifty FNECHARD IFC-USUP-TX (PC-98)

The adw driver supports SCSI controllers including:

AdvanSys ABP940UW/ABP3940UW
AdvanSys ABP950UW
AdvanSys ABP970UW
AdvanSys ABP3940U2W
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AdvanSys ABP3950U2W

The bt driver supports the following BusLogic MultiMaster ``W'', ``C'', ``S'', and ``A'' series and compatible
SCSI host adapters:

BusLogic BT-445C
BusLogic BT-445S
BusLogic BT-540CF
BusLogic BT-542B
BusLogic BT-542B
BusLogic BT-542D
BusLogic BT-545C
BusLogic BT-545S
BusLogic/BusTek BT-640
BusLogic BT-742A
BusLogic BT-742A
BusLogic BT-747C
BusLogic BT-747D
BusLogic BT-747S
BusLogic BT-757C
BusLogic BT-757CD
BusLogic BT-757D
BusLogic BT-757S
BusLogic BT-946C
BusLogic BT-948
BusLogic BT-956C
BusLogic BT-956CD
BusLogic BT-958
BusLogic BT-958D
Storage Dimensions SDC3211B / SDC3211F
AMI FastDisk Host Adapters that are true BusLogic MultiMaster clones are also supported by the bt driver.

The dpt driver provides support for the following RAID adapters:

DPT Smart Cache Plus
Smart Cache II (PM2?2?, PM2022 [EISA], PM2024/PM2124 [PCI]) (Gen2)
Smart RAID II (PM3?2?, PM3021, PM3222)
Smart Cache III (PM2?3?)
Smart RAID III (PM3?3?, PM3332 [EISA], PM3334UW [PCI]) (Gen3)
Smart Cache IV (PM2?4?, PM2042 [EISA], PM2044/PM2144 [PCI]) (Gen4)
Smart RAID IV

The adapters currently supported by the asr driver include the following:

Adaptec Zero-Channel SCSI RAID 2000S, 2005S, 2010S, 2015S
Adaptec SCSI RAID 2100S, 2110S
Adaptec ATA-100 RAID 2400A
Adaptec SCSI RAID 3200S, 3210S
Adaptec SCSI RAID 3400S, 3410S
Adaptec SmartRAID PM1554
Adaptec SmartRAID PM1564
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Adaptec SmartRAID PM2554
Adaptec SmartRAID PM2564
Adaptec SmartRAID PM2664
Adaptec SmartRAID PM2754
Adaptec SmartRAID PM2865
Adaptec SmartRAID PM3754
Adaptec SmartRAID PM3755U2B / SmartRAID V Millennium
Adaptec SmartRAID PM3757
DEC KZPCC-AC (LVD 1-ch, 4MB or 16MB cache), DEC KZPCC-CE (LVD 3-ch, 64MB cache), DEC
KZPCC-XC (LVD 1-ch, 16MB cache), DEC KZPCC-XE (LVD 3-ch, 64MB cache) -- rebadged
SmartRAID V Millennium

The amr driver supports the following:

AMI MegaRAID 320-1
AMI MegaRAID 320-2
AMI MegaRAID 320-4X
AMI MegaRAID Series 418
AMI MegaRAID Enterprise 1200 (Series 428)
AMI MegaRAID Enterprise 1300 (Series 434)
AMI MegaRAID Enterprise 1400 (Series 438)
AMI MegaRAID Enterprise 1500 (Series 467)
AMI MegaRAID Enterprise 1600 (Series 471)
AMI MegaRAID Elite 1500 (Series 467)
AMI MegaRAID Elite 1600 (Series 493)
AMI MegaRAID Elite 1650 (Series 4xx)
AMI MegaRAID Express 100 (Series 466WS)
AMI MegaRAID Express 200 (Series 466)
AMI MegaRAID Express 300 (Series 490)
AMI MegaRAID Express 500 (Series 475)
Dell PERC
Dell PERC 2/SC
Dell PERC 2/DC
Dell PERC 3/DCL
Dell PERC 3/QC
Dell PERC 4/Di
HP NetRAID-1/Si
HP NetRAID-3/Si (D4943A)
HP Embedded NetRAID
Note: Booting from these controllers is supported. EISA adapters are not supported.

Controllers supported by the mlx driver include:

Mylex DAC960P
Mylex DAC960PD / DEC KZPSC (Fast Wide)
Mylex DAC960PDU
Mylex DAC960PL
Mylex DAC960PJ
Mylex DAC960PG
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Mylex DAC960PU / DEC PZPAC (Ultra Wide)
Mylex AcceleRAID 150 (DAC960PRL)
Mylex AcceleRAID 250 (DAC960PTL1)
Mylex eXtremeRAID 1100 (DAC1164P)
RAIDarray 230 controllers, aka the Ultra-SCSI DEC KZPAC-AA (1-ch, 4MB cache), KZPAC-CA (3-ch,
4MB), KZPAC-CB (3-ch, 8MB cache)
All major firmware revisions (2.x, 3.x, 4.x and 5.x) are supported, however it is always advisable to upgrade to
the most recent firmware available for the controller. Compatible Mylex controllers not listed should work, but
have not been verified.
Note: Booting from these controllers is supported. EISA adapters are not supported.

Controllers supported by the mly driver include:

Mylex AcceleRAID 160
Mylex AcceleRAID 170
Mylex AcceleRAID 352
Mylex eXtremeRAID 2000
Mylex eXtremeRAID 3000
Compatible Mylex controllers not listed should work, but have not been verified.

The twe driver supports the following ATA RAID controllers:

AMCC's 3ware 5000 series
AMCC's 3ware 6000 series
AMCC's 3ware 7000-2
AMCC's 3ware 7006-2
AMCC's 3ware 7500-4LP
AMCC's 3ware 7500-8
AMCC's 3ware 7500-12
AMCC's 3ware 7506-4LP
AMCC's 3ware 7506-8
AMCC's 3ware 7506-12
AMCC's 3ware 8006-2LP
AMCC's 3ware 8500-4LP
AMCC's 3ware 8500-8
AMCC's 3ware 8500-12
AMCC's 3ware 8506-4LP
AMCC's 3ware 8506-8
AMCC's 3ware 8506-8MI
AMCC's 3ware 8506-12
AMCC's 3ware 8506-12MI

The twa driver supports the following PATA/SATA RAID controllers:

AMCC's 3ware 9500S-4LP
AMCC's 3ware 9500S-8
AMCC's 3ware 9500S-8MI
AMCC's 3ware 9500S-12
AMCC's 3ware 9500S-12MI
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The ncr driver provides support for the following NCR/Symbios SCSI controller chips:

53C810
53C810A
53C815
53C820
53C825A
53C860
53C875
53C875J
53C885
53C895
53C895A
53C896
53C1510D

The following add-on boards are known to be supported:

I-O DATA SC-98/PCI (PC-98)
I-O DATA SC-PCI (PC-98)

The sym driver provides support for the following Symbios/LSI Logic PCI SCSI controllers:

53C810
53C810A
53C815
53C825
53C825A
53C860
53C875
53C876
53C895
53C895A
53C896
53C897
53C1000
53C1000R
53C1010-33
53C1010-66
53C1510D

The SCSI controllers supported by sym can be either embedded on a motherboard, or on one of the
following add-on boards:

ASUS SC-200, SC-896
Data Technology DTC3130 (all variants)
DawiControl DC2976UW
Diamond FirePort (all)
I-O DATA SC-UPCI (PC-98)
Logitec LHA-521UA (PC-98)
NCR cards (all)
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Symbios cards (all)
Tekram DC390W, 390U, 390F, 390U2B, 390U2W, 390U3D, and 390U3W
Tyan S1365

The following devices are currently supported by the ncv driver:

I-O DATA PCSC-DV
KME KXLC002 (TAXAN ICD-400PN, etc.), KXLC004, and UJDCD450
Macnica Miracle SCSI-II mPS110
Media Intelligent MSC-110, MSC-200
NEC PC-9801N-J03R
New Media Corporation BASICS SCSI
Qlogic Fast SCSI
RATOC REX-9530, REX-5572 (SCSI only)

Controllers supported by the stg driver include:

Adaptec 2920/A
Future Domain SCSI2GO
Future Domain TMC-18XX/3260
IBM SCSI PCMCIA Card
ICM PSC-2401 SCSI
MELCO IFC-SC
RATOC REX-5536, REX-5536AM, REX-5536M, REX-9836A
Note that the Adaptec 2920C is supported by the ahc driver.

Cards supported by the isp driver include:

ISP1000
PTI SBS440
ISP1020
ISP1040
PTI SBS450
Qlogic 1240
Qlogic 1020
Qlogic 1040
Qlogic 1080
Qlogic 1280
Qlogic 12160
Qlogic 2100
Qlogic 2102
Qlogic 2200
Qlogic 2202
Qlogic 2204
Qlogic 2300
Qlogic 2312
PTI SBS470
Antares P-0033

Controllers supported by the amd driver include:

MELCO IFC-DP (PC-98)
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Tekram DC390
Tekram DC390T

Controllers supported by the nsp driver include:

Alpha-Data AD-PCS201
I-O DATA CBSC16
Adaptec AIC-7110 Parallel to SCSI interfaces ( vpo driver)

The following controllers are supported by the ida driver:

Compaq SMART Array 221
Compaq Integrated SMART Array Controller
Compaq SMART Array 4200
Compaq SMART Array 4250ES
Compaq SMART 3200 Controller
Compaq SMART 3100ES Controller
Compaq SMART-2/DH Controller
Compaq SMART-2/SL Controller
Compaq SMART-2/P Controller
Compaq SMART-2/E Controller
Compaq SMART Controller

Controllers supported by the ciss driver include:

Compaq Smart Array 5300
Compaq Smart Array 532
Compaq Smart Array 5i
HP Smart Array 5312
HP Smart Array 6i
HP Smart Array 641
HP Smart Array 642
HP Smart Array 6400
HP Smart Array 6400 EM
HP Smart Array 6422
HP Smart Array V100
HP Modular Smart Array 20 (MSA20)
HP Modular Smart Array 500 (MSA500)

Controllers supported by the iir driver include:

Intel RAID Controller SRCMR
Intel Server RAID Controller U3-l (SRCU31a)
Intel Server RAID Controller U3-1L (SRCU31La)
Intel Server RAID Controller U3-2 (SRCU32)
All past and future releases of Intel and ICP RAID Controllers.
Intel RAID Controller SRCU21 (discontinued)
Intel RAID Controller SRCU31 (older revision, not compatible)
Intel RAID Controller SRCU31L (older revision, not compatible)
The SRCU31 and SRCU31L can be updated via a firmware update available from Intel.
Promise SuperTrak ATA RAID controllers (pst driver)
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The hptmv driver supports the HighPoint RocketRAID 182x SATA controllers.

Controllers supported by the ips driver include:

IBM ServeRAID 3H
ServeRAID 4L/4M/4H
ServeRAID Series 5
ServeRAID 6i/6M

The following controllers are supported by the mpt driver:

LSI Logic 53c1030 (Dual Ultra320 SCSI)
LSI Logic FC909 (1Gb/s Fibre Channel)
LSI Logic FC909A (Dual 1Gb/s Fibre Channel)
LSI Logic FC919 (2Gb/s Fibre Channel)
LSI Logic FC929 (Dual 2Gb/s Fibre Channel)
The SCSI controller chips supprted by the mpt driver can be found onboard on many systems including:
Dell PowerEdge 1750
IBM eServer xSeries 335

SCSI controllers supported by the trm driver include:

Tekram DC-315 PCI Ultra SCSI adapter without BIOS and internal SCSI connector
Tekram DC-315U PCI Ultra SCSI adapter without BIOS
Tekram DC-395F PCI Ultra-Wide SCSI adapter with flash BIOS and 68-pin external SCSI connector
Tekram DC-395U PCI Ultra SCSI adapter with flash BIOS
Tekram DC-395UW PCI Ultra-Wide SCSI adapter with flash BIOS
Tekram DC-395U2W PCI Ultra2-Wide SCSI adapter with flash BIOS
For the Tekram DC-310/U and DC-390F/U/UW/U2B/U2W/U3W PCI SCSI host adapters, use the sym
driver.

The wds driver supports the WD7000 SCSI controller.

7.5.2 Network Cards

R-Studio Agent Emergency is based on the FreeBSD 5.3 kernel and supports devices from the list published
at http://www.freebsd.org/releases/5.3R/hardware-i386.html.

*: Supported in the floppy version

Ethernet NICs

Adapters supported by the sf driver include:

ANA-62011 64-bit single port 10/100baseTX adapter
ANA-62022 64-bit dual port 10/100baseTX adapter
ANA-62044 64-bit quad port 10/100baseTX adapter
ANA-69011 32-bit single port 10/100baseTX adapter
ANA-62020 64-bit single port 100baseFX adapter

The ti driver supports Gigabit Ethernet adapters based on the Alteon Tigon I and II chips. The ti driver has
been tested with the following adapters:

3Com 3c985-SX Gigabit Ethernet adapter (Tigon 1)
3Com 3c985B-SX Gigabit Ethernet adapter (Tigon 2)
Alteon AceNIC V Gigabit Ethernet adapter (1000baseSX)
Alteon AceNIC V Gigabit Ethernet adapter (1000baseT)
Digital EtherWORKS 1000SX PCI Gigabit adapter

http://www.freebsd.org/releases/5.3R/hardware-i386.html
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Netgear GA620 Gigabit Ethernet adapter (1000baseSX)
Netgear GA620T Gigabit Ethernet adapter (1000baseT)

The following adapters should also be supported but have not yet been tested:

Asante GigaNIX1000T Gigabit Ethernet adapter
Asante PCI 1000BASE-SX Gigabit Ethernet adapter
Farallon PN9000SX Gigabit Ethernet adapter
NEC Gigabit Ethernet
Silicon Graphics PCI Gigabit Ethernet adapter

The pcn driver supports adapters and embedded controllers based on the AMD PCnet/FAST, PCnet/FAST+,
PCnet/FAST III, PCnet/PRO and PCnet/Home Fast Ethernet chips:

AMD Am53C974/Am79C970/Am79C974 PCnet-PCI *
AMD Am79C970A PCnet-PCI II *
AMD Am79C971 PCnet-FAST *
AMD Am79C972 PCnet-FAST+ *
AMD Am79C973/Am79C975 PCnet-FAST III *
AMD Am79C976 PCnet-PRO *
AMD PCnet/Home HomePNA
Allied-Telesis LA-PCI
Contec C-NET(98)S (PC-98)
NEC SV-98/2-B05, B06

The lnc driver supports the following adapters:

Novell NE2100 *
Novell NE32-VL *
Isolan AT 4141-0 (16 bit)
Isolan BICC
Isolink 4110 (8 bit)
Diamond HomeFree
Digital DEPCA
Hewlett Packard Vectra 486/66XM
Hewlett Packard Vectra XU
Also supported are adapters working with the pcn driver. The lnc driver runs these in compatibility mode, thus
the pcn driver should be preferred.
SMC 83c17x (EPIC)-based Ethernet NICs (tx driver)

The ed driver supports the following Ethernet NICs:

3Com 3c503 Etherlink II
AR-P500 Ethernet
Accton EN1644 (old model), EN1646 (old model), EN2203 (old model) (110pin) (flags 0xd00000)
Accton EN2212/EN2216/UE2216
Allied Telesis CentreCOM LA100-PCM_V2
Allied Telesis LA-98 (flags 0x000000) (PC-98)
Allied Telesis SIC-98, SIC-98NOTE (110pin), SIU-98 (flags 0x600000) (PC-98)
Allied Telesis SIU-98-D (flags 0x610000) (PC-98)
AmbiCom 10BaseT card
Bay Networks NETGEAR FA410TXC Fast Ethernet
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CNet BC40 adapter
Compex Net-A adapter
Contec C-NET(98), RT-1007(98), C-NET(9N) (110pin) (flags 0xa00000) (PC-98)
Contec C-NET(98)E-A, C-NET(98)L-A, C-NET(98)P (flags 0x300000) (PC-98)
Corega Ether98-T (flags 0x000000) (PC-98)
Corega Ether PCC-T/EtherII PCC-T/FEther PCC-TXF/PCC-TXD
CyQ've ELA-010
DEC EtherWorks DE305
Danpex EN-6200P2
D-Link DE-298, DE-298P (flags 0x500000) (PC-98)
D-Link DE-650/660
D-Link IC-CARD/IC-CARD+ Ethernet
ELECOM LD-98P (flags 0x500000) (PC-98)
ELECOM LD-BDN, LD-NW801G (flags 0x200000) (PC-98)
ELECOM Laneed LD-CDL/TX, LD-CDF, LD-CDS, LD-10/100CD, LD-CDWA (DP83902A)
HP PC Lan+ 27247B and 27252A
IBM Creditcard Ethernet I/II
ICM AD-ET2-T, DT-ET-25, DT-ET-T5, IF-2766ET, IF-2771ET, NB-ET-T (110pin) (flags 0x500000)
(PC-98)
I-O DATA LA/T-98, LA/T-98SB, LA2/T-98, ET/T-98 (flags 0x900000) (PC-98)
I-O DATA ET2/T-PCI
I-O DATA PCLATE
Kansai KLA-98C/T (flags 0x900000) (PC-98)
Kingston KNE-PC2, KNE-PCM/x Ethernet
Linksys EC2T/PCMPC100/PCM100, PCMLM56
Linksys EtherFast 10/100 PC Card, Combo PCMCIA Ethernet Card (PCMPC100 V2)
Logitec LAN-98T (flags 0xb00000) (PC-98)
MACNICA Ethernet ME1 for JEIDA
MACNICA ME98 (flags 0x900000) (PC-98)
MACNICA NE2098 (flags 0x400000) (PC-98)
MELCO EGY-98 (flags 0x300000) (PC-98)
MELCO LGH-98, LGY-98, LGY-98-N (110pin), IND-SP, IND-SS (flags 0x400000) (PC-98)
MELCO LGY-PCI-TR
MELCO LPC-T/LPC2-T/LPC2-CLT/LPC2-TX/LPC3-TX/LPC3-CLX
NDC Ethernet Instant-Link
NEC PC-9801-77, PC-9801-78 (flags 0x910000) (PC-98)
NEC PC-9801-107, PC-9801-108 (flags 0x800000) (PC-98)
National Semiconductor InfoMover NE4100
NetGear FA-410TX
NetVin 5000
Network Everywhere Ethernet 10BaseT PC Card
Networld 98X3 (flags 0xd00000) (PC-98)
Networld EC-98X, EP-98X (flags 0xd10000) (PC-98)
Novell NE1000/NE2000/NE2100
PLANEX ENW-8300-T
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PLANEX EN-2298-C (flags 0x200000) (PC-98)
PLANEX EN-2298P-T, EN-2298-T (flags 0x500000) (PC-98)
PLANEX FNW-3600-T
RealTek 8029
SMC Elite 16 WD8013
SMC Elite Ultra
SMC EtherEZ98 (flags 0x000000) (PC-98)
SMC WD8003E/WD8003EBT/WD8003S/WD8003SBT/WD8003W/WD8013EBT/WD8013W and
clones
Socket LP-E
Surecom EtherPerfect EP-427
Surecom NE-34
TDK LAK-CD031, Grey Cell GCS2000 Ethernet Card
Telecom Device SuperSocket RE450T
VIA VT86C926
Winbond W89C940
C-Bus, ISA, PCI and PC Card devices are supported.

Adapters supported by the rl driver include:

Accton ``Cheetah'' EN1207D (MPX 5030/5038; RealTek 8139 clone)
Allied Telesyn AT2550
Allied Telesyn AT2500TX
Belkin F5D5000
BUFFALO(Melco INC.) LPC-CB-CLX(CardBus)
Compaq HNE-300
CompUSA no-name 10/100 PCI Ethernet NIC
Corega FEther CB-TXD
Corega FEtherII CB-TXD
D-Link DFE-530TX+
D-Link DFE-538TX (same as 530+?)
D-Link DFE-690TXD
Edimax EP-4103DL CardBus
Encore ENL832-TX 10/100 M PCI
Farallon NetLINE 10/100 PCI
Genius GF100TXR,
GigaFast Ethernet EE100-AXP
KTX-9130TX 10/100 Fast Ethernet
LevelOne FPC-0106TX
Longshine LCS-8038TX-R
NDC Communications NE100TX-E
Netronix Inc. EA-1210 NetEther 10/100
Nortel Networks 10/100BaseTX
OvisLink LEF-8129TX
OvisLink LEF-8139TX
Peppercon AG ROL-F
Planex FNW-3800-TX
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SMC EZ Card 10/100 PCI 1211-TX
SOHO(PRAGMATIC) UE-1211C

The wb driver supports Winbond W89C840F based Fast Ethernet adapters and embedded controllers
including:

Trendware TE100-PCIE *

The vr driver supports VIA Technologies Rhine I, Rhine II, and Rhine III based Fast Ethernet adapters
including:

D-Link DFE530-TX
Hawking Technologies PN102TX
AOpen/Acer ALN-320

The sis driver supports Silicon Integrated Systems SiS 900 * and SiS 7016 * based Fast Ethernet adapters
and embedded controllers, as well as Fast Ethernet adapters based on the National Semiconductor
DP83815 (MacPhyter) chip. Supported adapters include:

@Nifty FNECHARD IFC USUP-TX
MELCO LGY-PCI-TXC
Netgear FA311-TX (DP83815)
Netgear FA312-TX (DP83815)
SiS 630, 635, and 735 motherboard chipsets

The nge driver supports National Semiconductor DP83820 * and DP83821 based Gigabit Ethernet adapters
including:

SMC EZ Card 1000 (SMC9462TX)
D-Link DGE-500T
Asante FriendlyNet GigaNIX 1000TA and 1000TPC
Addtron AEG320T
LinkSys EG1032 (32-bit PCI) and EG1064 (64-bit PCI)
Surecom Technology EP-320G-TX
Netgear GA622T
Netgear GA621
Ark PC SOHO-GA2500T (32-bit PCI) and SOHO-GA2000T (64-bit PCI)
Trendware TEG-PCITX (32-bit PCI) and TEG-PCITX2 (64-bit PCI)

The ste driver supports Sundance Technologies ST201 based Fast Ethernet adapters and embedded
controllers including:

D-Link DFE-530TXS
D-Link DFE-550TX

Adapters supported by the sk driver include:

3COM 3C940 single port, 1000baseT adapter
Belkin F5D5005 single port, 1000baseT adapter
Linksys EG1032 single port, 1000baseT adapter
SK-9521 SK-NET GE-T single port, 1000baseT adapter
SK-9821 SK-NET GE-T single port, 1000baseT adapter *
SK-9822 SK-NET GE-T dual port, 1000baseT adapter *
SK-9841 SK-NET GE-LX single port, single mode fiber adapter *
SK-9842 SK-NET GE-LX dual port, single mode fiber adapter *
SK-9843 SK-NET GE-SX single port, multimode fiber adapter *
SK-9844 SK-NET GE-SX dual port, multimode fiber adapter *
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SMC 9452TX single port, 1000baseT adapter

The tl driver supports Texas Instruments ThunderLAN based Ethernet and Fast Ethernet adapters including
a large number of Compaq PCI Ethernet adapters. Also supported are:

Olicom OC-2135/2138 10/100 TX UTP adapter
Olicom OC-2325/OC-2326 10/100 TX UTP adapter
Racore 8148 10baseT/100baseTX/100baseFX adapter
Racore 8165 10/100baseTX adapter

The tl driver also supports the built-in Ethernet adapters of various Compaq Prosignia servers and
Compaq Deskpro desktop machines including:

Compaq Netelligent 10
Compaq Netelligent 10 T PCI UTP/Coax
Compaq Netelligent 10/100
Compaq Netelligent 10/100 Dual-Port
Compaq Netelligent 10/100 Proliant
Compaq Netelligent 10/100 TX Embedded UTP
Compaq Netelligent 10/100 TX UTP
Compaq NetFlex 3P
Compaq NetFlex 3P Integrated
Compaq NetFlex 3P w/BNC

The dc driver provides support for the following chipsets: *

DEC/Intel 21143
ADMtek AL981 Comet, AN985 Centaur, ADM9511 Centaur II and ADM9513 Centaur II
ASIX Electronics AX88140A and AX88141
Conexant LANfinity RS7112 (miniPCI)
Davicom DM9009, DM9100, DM9102 and DM9102A
Lite-On 82c168 and 82c169 PNIC
Lite-On/Macronix 82c115 PNIC II
Macronix 98713, 98713A, 98715, 98715A, 98715AEC-C, 98725, 98727 and 98732
Xircom X3201 (cardbus only)

The following NICs are known to work with the dc driver at this time:

3Com OfficeConnect 10/100B (ADMtek AN985 Centaur-P)
Abocom FE2500
Accton EN1217 (98715A)
Accton EN2242 MiniPCI
Adico AE310TX (98715A)
Alfa Inc GFC2204 (ASIX AX88140A)
Built in 10Mbps only Ethernet on Compaq Presario 7900 series desktops (21143, non-MII)
Built in DE500-BA on DEC Alpha workstations (21143, non-MII)
Built in Sun DMFE 10/100 Mbps Ethernet on Sun Netra X1 and Sun Fire V100 (DM9102A, MII)
Built in Ethernet on LinkSys EtherFast 10/100 Instant GigaDrive (DM9102, MII)
CNet Pro110B (ASIX AX88140A)
CNet Pro120A (98715A or 98713A) and CNet Pro120B (98715)
Compex RL100-TX (98713 or 98713A)
D-Link DFE-570TX (21143, MII, quad port)
Digital DE500-BA 10/100 (21143, non-MII)
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ELECOM Laneed LD-CBL/TXA (ADMtek AN985)
Hawking CB102 CardBus
IBM EtherJet Cardbus Adapter
Intel PRO/100 Mobile Cardbus (versions that use the X3201 chipset)
Jaton XpressNet (Davicom DM9102)
Kingston KNE100TX (21143, MII)
Kingston KNE110TX (PNIC 82c169)
LinkSys LNE100TX (PNIC 82c168, 82c169)
LinkSys LNE100TX v2.0 (PNIC II 82c115)
LinkSys LNE100TX v4.0/4.1 (ADMtek AN985 Centaur-P)
Matrox FastNIC 10/100 (PNIC 82c168, 82c169)
Melco LGY-PCI-TXL
Microsoft MN-120 10/100 CardBus (ADMTek Centaur-C)
Microsoft MN-130 10/100 PCI (ADMTek Centaur-P)
NDC SOHOware SFA110A (98713A)
NDC SOHOware SFA110A Rev B4 (98715AEC-C)
NetGear FA310-TX Rev. D1, D2 or D3 (PNIC 82c169)
Netgear FA511
PlaneX FNW-3602-T (ADMtek AN985)
SMC EZ Card 10/100 1233A-TX (ADMtek AN985)
SVEC PN102-TX (98713)
Xircom Cardbus Realport
Xircom Cardbus Ethernet 10/100
Xircom Cardbus Ethernet II 10/100

Adapters supported by the aue driver include:

Abocom UFE1000, DSB650TX_NA
Accton USB320-EC, SpeedStream
ADMtek AN986, AN8511
Billionton USB100, USB100LP, USB100EL, USBE100
Corega Ether FEther USB-T, FEther USB-TX, FEther USB-TXS
D-Link DSB-650, DSB-650TX, DSB-650TX-PNA
Elecom LD-USBL/TX
Elsa Microlink USB2Ethernet
HP hn210e
I-O Data USB ETTX
Kingston KNU101TX
LinkSys USB10T adapters that contain the AN986 Pegasus chipset, USB10TA, USB10TX, USB100TX,
USB100H1
MELCO LUA-TX, LUA2-TX
Planex UE-200TX
Sandberg USB to Network Link (model number 133-06)
Siemens Speedstream
SmartBridges smartNIC
SMC 2202USB
SOHOware NUB100
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The cue driver supports CATC USB-EL1210A based USB Ethernet adapters including:

Belkin F5U011/F5U111
CATC Netmate
CATC Netmate II
SmartBridges SmartLink

The kue driver supports Kawasaki LSI KL5KLUSB101B based USB Ethernet adapters including:

3Com 3c19250
3Com 3c460 HomeConnect Ethernet USB Adapter
ADS Technologies USB-10BT
AOX USB101
ATen UC10T
Abocom URE 450
Corega USB-T
D-Link DSB-650C
Entrega NET-USB-E45, NET-HUB-3U1E
I/O Data USB ETT
Kawasaki DU-H3E
LinkSys USB10T
Netgear EA101
Peracom USB Ethernet Adapter
SMC 2102USB, 2104USB

The axe driver supports ASIX Electronics AX88172 based USB Ethernet adapters including:

Buffalo (Melco Inc.) LUA-U2-KTX
D-Link DUBE100
LinkSys USB200M
Netgear FA120
System TALKS Inc. SGC-X2UL

The rue driver supports RealTek RTL8150 based USB Ethernet adapters including:

Buffalo (Melco Inc.) LUA-KTX
Green House GH-USB100B
LinkSys USB100M
Billionton 10/100 FastEthernet USBKR2

The udav driver supports the following adapters:

Corega FEther USB-TXC

Adapters supported by the de driver include: 

Adaptec ANA-6944/TX
Cogent EM100FX and EM440TX
Corega FastEther PCI-TX
D-Link DFE-500TX
DEC DE435, DE425, DEC DE450, and DEC DE500
ELECOM LD-PCI2T, LD-PCITS
I-O DATA LA2/T-PCI
SMC Etherpower 8432, 9332 and 9334
ZNYX ZX3xx
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Controllers and cards supported by the fe driver include:

Allied Telesis RE1000, RE1000Plus, ME1500 (110-pin)
CONTEC C-NET(98)P2, C-NET (9N)E (110-pin), C-NET(9N)C (ExtCard)
CONTEC C-NET(PC)C PCMCIA Ethernet
Eiger Labs EPX-10BT
Fujitsu FMV-J182, FMV-J182A
Fujitsu MB86960A, MB86965A
Fujitsu MBH10303, MBH10302 Ethernet PCMCIA
Fujitsu Towa LA501 Ethernet
HITACHI HT-4840-11
NextCom J Link NC5310
RATOC REX-5588, REX-9822, REX-4886, and REX-R280
RATOC REX-9880/9881/9882/9883
TDK LAC-98012, LAC-98013, LAC-98025, LAC-9N011 (110-pin)
TDK LAK-CD021, LAK-CD021A, LAK-CD021BX
Ungermann-Bass Access/PC N98C+(PC85152, PC85142), Access/NOTE N98(PC86132) (110-pin)

Adapters supported by the fxp driver include:

Intel EtherExpress PRO/10
Intel InBusiness 10/100
Intel PRO/100B / EtherExpressPRO/100 B PCI Adapter *
Intel PRO/100+ Management Adapter
Intel PRO/100 VE Desktop Adapter
Intel PRO/100 M Desktop Adapter
Intel PRO/100 S Desktop, Server and Dual-Port Server Adapters
Contec C-NET(PI)-100TX (PC-98)
NEC PC-9821Ra20, Rv20, Xv13, Xv20 internal 100Base-TX (PC-98)
NEC PC-9821X-B06 (PC-98)
Many on-board network interfaces on Intel motherboards

The ex driver supports the following Ethernet adapters:

Intel EtherExpress Pro/10
Intel EtherExpress Pro/10+
The Olicom OC2220

The ie driver provides supports the following 8 and 16bit ISA Ethernet cards that are based on the Intel
i82586 chip:

3COM 3C507
AT&T EN100
AT&T Starlan 10
AT&T Starlan Fiber
Intel EtherExpress 16
RACAL Interlan NI5210

The ep driver supports Ethernet adapters based on the 3Com 3C5x9 Etherlink III Parallel Tasking chipset,
including:

3Com 3C1 CF
3Com 3C509-TP, 3C509-BNC, 3C509-Combo, 3C509-TPO, 3C509-TPC ISA
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3Com 3C509B-TP, 3C509B-BNC, 3C509B-Combo, 3C509B-TPO, 3C509B-TPC ISA
3Com 3C529, 3C529-TP MCA
3Com 3C562/3C563 PCMCIA
3Com 3C569B-J-TPO, 3C569B-J-COMBO CBUS
3Com 3C574-TX, 3CCFE574BT, 3CXFE574BT, 3C3FE574BT PCMCIA
3Com 3C579-TP, 3C579-BNC EISA
3Com 3C589, 3C589B, 3C589C, 3C589D, 3CXE589DT PCMCIA
3Com 3CCFEM556B, 3CCFEM556BI PCMCIA
3Com 3CXE589EC, 3CCE589EC, 3CXE589ET, 3CCE589ET PCMCIA
3Com Megahertz 3CCEM556, 3CXEM556, 3CCEM556B, 3CXEM556B PCMCIA
3Com OfficeConnect 3CXSH572BT, 3CCSH572BT PCMCIA
Farallon EtherMac PCMCIA

The el driver supports the 3Com 3c501 8bit ISA Ethernet card.

The xl driver supports the following hardware:

3Com 3c900-TPO *
3Com 3c900-COMBO *
3Com 3c905-TX *
3Com 3c905-T4 *
3Com 3c900B-TPO *
3Com 3c900B-TPC *
3Com 3c900B-FL *
3Com 3c900B-COMBO *
3Com 3c905B-T4 *
3Com 3c905B-TX *
3Com 3c905B-FX *
3Com 3c905B-COMBO *
3Com 3c905C-TX *
3Com 3c980, 3c980B, and 3c980C server adapters
3Com 3cSOHO100-TX OfficeConnect adapters
3Com 3c450 HomeConnect adapters
3Com 3c555, 3c556 and 3c556B mini-PCI adapters
3Com 3C3SH573BT, 3C575TX, 3CCFE575BT, 3CXFE575BT, 3CCFE575CT, 3CXFE575CT,
3CCFEM656, 3CCFEM656B, and 3CCFEM656C, 3CXFEM656, 3CXFEM656B, and 3CXFEM656C
CardBus adapters
3Com 3c905-TX, 3c905B-TX 3c905C-TX, and 3c920B-EMB embedded adapters
Both the 3C656 family of CardBus cards and the 3C556 family of MiniPCI cards have a built-in proprietary
modem. Neither the xl driver nor any other driver supports this modem.

The vx driver supports the following cards:

3Com 3c590 EtherLink III PCI *
3Com 3c592 EtherLink III EISA
3Com 3c595 Fast EtherLink III PCI in 10 Mbps mode *
3Com 3c597 Fast EtherLink III EISA in 10 Mbps mode
Crystal Semiconductor CS89x0-based NICs (cs driver)
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The sn driver supports SMC9xxx based ISA and PCMCIA cards including:

3Com Megahertz X-Jack Ethernet PC-Card CC-10BT

The xe driver supports the following cards:

Xircom CreditCard Ethernet (PS-CE2-10)
Xircom CreditCard Ethernet + Modem 28 (PS-CEM-28)
Xircom CreditCard Ethernet + Modem 33 (CEM33)
Xircom CreditCard 10/100 (CE3, CE3B)
Xircom CreditCard Ethernet 10/100 + Modem 56 (CEM56)
Xircom RealPort Ethernet 10 (RE10)
Xircom RealPort Ethernet 10/100 (RE100)
Xircom RealPort Ethernet 10/100 + Modem 56 (REM56, REM56G)
Accton Fast EtherCard-16 (EN2226)
Compaq Netelligent 10/100 PC Card (CPQ-10/100)
Intel EtherExpress Pro/100 PC Card Mobile Adapter 16 (Pro/100 M16A)
Other similar devices using the same hardware may also be supported.

Adapters supported by the lge driver include:

SMC TigerCard 1000 (SMC9462SX) *
D-Link DGE-500SX *

The txp driver supports the following cards:

3Com 3CR990-TX-95 *
3Com 3CR990-TX-97 *
3Com 3cR990B-TXM *
3Com 3CR990SVR95 *
3Com 3CR990SVR97 *
3Com 3cR990B-SRV *

The bge driver provides support for various NICs based on the Broadcom BCM570x family of Gigabit
Ethernet controller chips, including the following:

3Com 3c996-T (10/100/1000baseTX) *
Dell PowerEdge 1750 integrated BCM5704C NIC (10/100/1000baseTX) *
Dell PowerEdge 2550 integrated BCM5700 NIC (10/100/1000baseTX) *
Dell PowerEdge 2650 integrated BCM5703 NIC (10/100/1000baseTX) *
IBM x235 server integrated BCM5703x NIC (10/100/1000baseTX) *
HP ProLiant NC7760 embedded Gigabit NIC (10/100/1000baseTX) *
HP ProLiant NC7770 PCI-X Gigabit NIC (10/100/1000baseTX) *
HP ProLiant NC7781 embedded PCI-X Gigabit NIC (10/100/1000baseTX) *
Netgear GA302T (10/100/1000baseTX) *
SysKonnect SK-9D21 (10/100/1000baseTX) *
SysKonnect SK-9D41 (1000baseSX) *

The em driver supports Gigabit Ethernet adapters based on the Intel 82540, 82541PI, 82542, 82543, 82544,
82546, 82546EB and 82547 controller chips: 

Intel PRO/1000 CT Network Connection (82547)
Intel PRO/1000 F Server Adapter (82543)
Intel PRO/1000 Gigabit Server Adapter (82542)*
Intel PRO/1000 GT Desktop Adapter (82541PI)
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Intel PRO/1000 MF Dual Port Server Adapter (82546)
Intel PRO/1000 MF Server Adapter (82545)
Intel PRO/1000 MF Server Adapter (LX) (82545)
Intel PRO/1000 MT Desktop Adapter (82540)
Intel PRO/1000 MT Desktop Adapter (82541)
Intel PRO/1000 MT Dual Port Server Adapter (82546)
Intel PRO/1000 MT Quad Port Server Adapter (82546EB)
Intel PRO/1000 MT Server Adapter (82545)
Intel PRO/1000 T Desktop Adapter (82544)
Intel PRO/1000 T Server Adapter (82543)
Intel PRO/1000 XF Server Adapter (82544)
Intel PRO/1000 XT Server Adapter (82544)

The gx driver supports Gigabit Ethernet adapters based on the Intel 82542 and 82543 controller chips:

Intel PRO/1000 Gigabit Server Adapter (82542)
Intel PRO/1000 F Server Adapter (82543)
Intel PRO/1000 T Server Adapter (82543)

The hme driver supports the on-board Ethernet interfaces of many Sun UltraSPARC workstation and server
models. Cards supported by the hme driver include:

Sun PCI SunSwift Adapter
Sun SBus SunSwift Adapter ``( hme'' and ``SUNW,hme'')
Sun PCI Sun100BaseT Adapter 2.0
Sun SBus Sun100BaseT 2.0
Sun PCI Quad FastEthernet Controller
Sun SBus Quad FastEthernet Controller

The my driver provides support for various NICs based on the Myson chipset. Supported models include:

Myson MTD800 PCI Fast Ethernet chip
Myson MTD803 PCI Fast Ethernet chip
Myson MTD89X PCI Gigabit Ethernet chip

Broadcom BCM4401 based Fast Ethernet adapters (bfe driver) *

The re driver supports RealTek RTL8139C+, RTL8169, RTL8169S and RTL8110S based Fast Ethernet and
Gigabit Ethernet adapters including:

Alloy Computer Products EtherGOLD 1439E 10/100 (8139C+) *
Compaq Evo N1015v Integrated Ethernet (8139C+) *
Corega CG-LAPCIGT Gigabit Ethernet (8169S) *
Gigabyte 7N400 Pro2 Integrated Gigabit Ethernet (8110S) *
PLANEX COMMUNICATIONS Inc. GN-1200TC (8169S) *
Xterasys XN-152 10/100/1000 NIC (8169) *

The ixgb driver supports the following cards: 

Intel PRO/10GbE LR Server Adapter *
Intel PRO/10GbE SR Server Adapter *
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- A -
Add missing drive     142

Add missing drives     145

Advanced Data Recovery     43

Advanced RAID 5 Layouts     105

Advanced RAID 6 Layout     105

Allocation     279

Apple CoreStorage/FileVault/Fusion Drive Volumes    
148

Apple RAIDs     145

Apply changes immediately     95

- B -
Bad Sectors     306

Bad Sectors settings    

Default read retries count     11

Pattern to fill bad blocks     11

Set default read retries count for all drives     11

Basic File Recovery     19

Binary (byte to byte copy)    

Copy range     195

Copy whole object     195

Offset     195

Size     195

Block order     95

Broken File Name    

Prompt:     82

Rename and change all invalid symbols to:     82

Skip     82

Broken File Name options    

Change all invalid symbols to     19

Edit broken symbols only     19

File name     19

New name     19

Button    

Clear All     306

Mark     306

Recover     306

Save to File     306

Select All     306

Buttons    

Add     43

Advanced     43

Apply     95

Auto Detect     126

Choose Variants     126

Code pages     279

Connect to Remote     5, 162

Create Image     5, 72

Create Region     5, 69

Create virtual volume sets or RAIDs     5, 95

Fast Partition Search     5

File Mask     41

Go!     285

Known File Types     43

Next Pattern     279

OK     285

Open Drive Files     5, 19

Open Image     5, 72

Open in Hex Editor     43

Open Local Drives     5, 162

Preview     34

Previous Pattern     279

Recover     19

Recover Marked     19

Refresh     5

Remove     5

Rename     19

Rename All     19

Reset     43

Save Changes     279

Scan     5, 43

Set for all     41

Set Runtime Image     203

Skip     19

Skip All     19

Stop     5

Stop Runtime Imaging     203

- C -
Connect to R-Studio settings    

Allow connection from any address     164

Allow connection from the host     164

Password     164

Port     164

Server     164

Connecting over the Internet     164
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Connecting to DeepSpar Disk Imager™ manually    
215

Contact information and technical support     4

Create menu    

Add Empty Space     95

Add Missing Drive     95

Copy object to...     195

Create Exclusive Region     70

Create Region     69

Create Virtual Block RAID & Autodetect     95

Create Virtual Mirror     95

Create Virtual Volume Set     95

Creating and saving your own RAID configuration     89

Creating Custom Patterns     289

Creating Startup Disks for Mac and Linux Computers  

 
 322

Cross-linked folders     301

Custom Recovery Lists     170

Customizing File Types     59, 61

Customizing File Types-II     64

- D -
Data Copy in Text/hexadecimal editor     288

Data Formats and Multipliers     304

Data Recovery Issues     301

Data Recovery on HFS/HFS+ File System     305

Data recovery over network     157

Connect to the remote computer     162

Data Recovery Using R-Studio     18

DDI Drive Map     215

DeepSpar Disk Imager     215

DeepSpar RapidSpar     224

DeepSpar USB Stabilizer     219

Description Files for RAID Configuration     133

Devices to Store Recovered Files     334

Dialog box    

Forensic Log Settings     227

Dialog boxes    

Broken File Name     19

Connect to Remote Computer     162

Connect to R-Studio     159, 161, 164

Copy Options     195

Create Exclusive Region     70

Create Image     72

Create Region     69

Edit Block RAID Layout Presets     89

Edit User's File Types     59

Export Recovery List     84

File mask     41

File Types     43

Files with bad sectors     306

Fill     279

Find/Mark     31

Go to     285

Go To Offset     285

Memory Usage     307

Multi-volume image     72

Open Scan Information File     43

Please configure R-Studio Agent for Mac     159

Please configure R-Studio Agent for Windows    
158

Preset name     89

Raid Parameters Detection     126

Recover     19, 80, 162

Recover (Advanced)     82

R-Studio Agent for Linux Configuration     161

Save Scan Information File     43

Scan     43

Scan Information     43

Search     285

Settings     11

There is not enough space on the disk     19

Waiting for remote connection     164

Direct     279

Disk and Volume Managers     139

Drive menu    

Connect to DDI     215

Connect To Remote     162

Create Image     72

Open Drive Files     19

Open Drive Files Sorted By     81

Open Image File     72

Open Local Drives     162

Open Scan Informaiton     43

Real File System Structure     81

Recover All Files     80

Remove Scan Informaiton     43

Save Scan Informaiton     43

Scan     43

Drive scan     5, 43

Drives Copy Wizard     195

- E -
Edit menu    
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Edit menu    

Bookmarks     285

Fill     279

Find     285

Find Next     285

Find Previous     285

Find Template Signature Next     279

Find Template Signature Previous     279

Save Changes     279

Editor tabs    

Allocation     279

Direct     279

Std     279

Unlimited     279

Enable Forensic Mode     227

Event log     42

Exclusive Region     70

Exclusive Region options    

Exclusive Regions     70

Offset:     70

Size:     70

Start:     70

Export Recovery List     84

Extended Information Recovery     304

- F -
Fast Search for Lost Partitions     58

File Already Exists    

Overwrite     82

Overwrite Bigger     82

Overwrite Older     82

Overwrite Smaller     82

Prompt     82

Rename     82

Skip     82

File Information (R-Studio Technician/T80+)     168

File Maps     201

File mask options    

Date     41

Deleted files     41

Existing files     41

Hide symbolic links     41

Match case     41

Show empty folders     41

Size from/up to     41

Use advanced options     41

File menu    

Close All Previews     34

Export Recovery List     84

Goto Target     301

Preview     34

Recover     19

Recover Marked     19

Rescan     301

Set As Default Target     301

Show Files in HexEditor     288

View/Edit     279

File search     5

File signature properties     59

File Systems settings    

Default encoding for Ext2/Ext3/Ext4/UFS volumes

 
   11

Default encoding for HFS volumes     11

Disable any sorting     11

Minimize drive access     11

Show deleted empty folders     11

File Type Signature Specification     61, 64

File Types    

Clear All     43

Reload User's File Types     43

Reset to Recommended     43

Revert to Default     43

Select All     43

Set as Default     43

File Types properties     59

Files and Sectors     288

Find and Mark Multiple Files     81

Find options    

All Files and Folders     31

Bad sectors     31

Date     31

Deleted files     31

Existing files     31

File Extensions     31

File Id     31

Files and Folders     31

Find/Mark mode     31

Find/mark objects only in real paths, ignore links
to folders     31

Look in     31

Match case     31

Recovery chances     31

Regular Expressions     31

Runtime image     31

Size from/up to     31
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Find options    

Use advanced options     31

Find/Mark options    

Find all     31

Find first     31

Find last     31

Find next     31

Find previous     31

Mark all     31

Set for all     31

Unmark all     31

Finding Previous File Versions     34

Firewall     164

Forensic Data Collection Audit Log     227

Forensic Mode     227

Found offsets pane     126

Fusion Drive Component Tab     148

- H -
Help menu    

Change Language     5

Hidden Attribute    

Keep     82

Prompt     82

Remove     82

- I -
I/O Monitor     202

Image     72

Image options    

Additional output folders     72

Create scan information file     72

Estimated size     72

Image name     72

Image split size     72

Image type     72

Password     72

Pattern to fill bad blocks     72

Plain image     72

Post Actions Options     72

Read retries     72

Image type:    

Byte by byte image to a file     72

Byte to byte image to a physical disk     72

Compressed image (R-Drive Image compatible)    
72

VMDK (VmWare Virtual Machine Disk)     72

IntelligentScan Technology     300

Introduction to R-Studio     1

- K -
Known File Types settings    

Clear All     11

Edit User's File Types     11

Reload User's File Types     11

Reset     11

Select All     11

- L -
Linux LVM     153

Linux mdadm RAIDs     151

Log settings    

Disk     11

Error     11

File name     11

File System     11

Files     11

Information     11

Maximum messages in the Event Log     11

Network     11

Partition     11

Recover     11

Save log to file     11

Success     11

Warning     11

- M -
Mac Pro RAID     105

Main settings    

Auto-refresh Drive Tree     11

Check for update     11

Debug Mode     11

Enable Write     11, 195, 279

File name     11

HexView templates path     11

Location     11

Max changes buffer size     11

Reset all hidden notifications     11
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Main settings    

User's file mask presets     11

User's file types     11

User's RAID layout     11

Mass file recovery     80

Mass File Recovery Options     82

Memory Usage     307

Automatic     11

Disable memory control     11

Process Memory     307

System Memory Physical     307

System Memory Swap     307

Messages    

Cannot connect     158

Double-click a logical disk...     19

Too many files...     19, 80, 307

Mirrors     91

Missing Drive     95

Mount options    

Drive letter     155

Mount as:     155

Mounting Virtual Objects in the System     155

Multi-pass Imaging     208

- N -
NAT     164

Nested and Non-Standard RAID Levels     115

- O -
Object Copy     195

Offset     95

Opening several disks/partitions in one tab     30

- P -
Panels    

Files     19

Folders     19

Log     19, 42

Main     5

Panes    

Bookmarks     279

Data Interpreter     279

Find Results     279

Template     279

Pattern Example I     292

Pattern Example II     296

Previewing files     34

Properties tab    

Active FAT copy     308

Block Size     308

Blocks Per Volume     308

Boot Directory Cluster     308

Buffer Alignment     308

Bus Type     308

Cluster size     308

Creator OS     308

Device Identification     308

Drive Control     308

Drive Type     308

Estimated Size     308

Ext2/3/4FS Information     308

Fat Bits (12,16,32)     308

FAT Information     308

First Cluster Offset     308

First FAT Offset     308

First SuperBlock Offset     308

I/O Tries     308

I/O Unit     308

Index Block Size     308

INodes Per Volume     308

Int13 Drive Number     308

Int13 Extension Version     308

Last Check Time     308

Last Mount Time     308

Last Write Time     308

LDM Component ID     308

LDM Disk AltName     308

LDM Disk DriveHint     308

LDM Disk GUID     308

LDM Disk ID     308

LDM DiskGroup GUID     308

LDM Host GUID     308

LDM Partition ID     308

LDM Volume GUID     308

LDM Volume ID     308

Major version     308

Maximum transfer     308

MFT Mirror Position     308

MFT position     308

MFT record size     308

Minor version     308

Name     308
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Properties tab    

NTFS Information     308

Number of FAT Copies     308

Offset of Logical Disk     308

OS object     308

Parsed Boot Records     308

Parsed File Entries     308

Partition number     308

Partition Offset     308

Partition Size     308

Partition Type     308

Physical Drive Geometry     308

Raid Block Size     308

Recognized Ext2/3/4FS     308

Recognized FAT     308

Recognized NTFS     308

Root Directory Length     308

Root Directory Offset     308

R-Studio driver     308

SCSI Address     308

Sector Size     308

Size     308

Size of One FAT Table     308

Supposed Parents Count     308

Volume size     308

- Q -
Questionable folders     301

- R -
RAID 0     91

RAID 1     91

RAID 4     95

RAID 5     95

RAID 5 Operations     95

RAID block size     95

RAID consistency     128

RAID for HP Servers     102

RAID Parameter Detection     126

RAID with Parity Delays     102

RAID10 (1+0)     115

RAID1E     117

RAID5E     119

RAID5EE     121

RAID6E     123

Recover options    

Additional Output Folders     19

Condense successful restoration events:     19

Do not recover duplicate files from Extra Found
Files     19

Ignore file mask:     19

Local computer     162

Open local folder (folders) when done     19

Post Actions Options     19

Recover all marked files     19

Recover alternative data streams:     19

Recover extended attributes:     19

Recover metafiles     19

Recover real folders structure     19

Recover security:     19

Recovered only masked marked files     19

Remote computer     162

Restore folder structure:     19

Restore from root     19

Recovery Lists     84

Region     69

Region options    

Drive size     69

Size     69

Start     69

Regular expressions     42

Remote install     158

Reverse RAID of a RAID     213

Reverse RAID of an Object     212

Reverse RAIDs     211

Rows count     95

R-Studio Agent     157

R-Studio Agent Emergency     157, 341

Contact information and technical support     341

Creating Startup Disks     341

Disk Controllers     350

Hardware Compatibility List     350

Installing R-Studio Agent Emergency Startup
Media Creator     341

Network Cards     360

Starting a Computer with the R-Studio Agent
Emergency Startup Disk     347

R-Studio Agent for Linux     161

R-Studio Agent for Mac     159

R-Studio Agent for Mac main panel     159

R-Studio Agent for Windows     158

R-Studio Agent for Windows main panel     158

R-Studio Emergency     315
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R-Studio Emergency     315

Contact Informaiton and Technical Support     315

Creating Startup Disks     316

Disk Images     327

Disk Scan     326

Emergency agent     328

File Recovery     325

Hardware Compatibility List     336

Installing R-Studio Emergency Startup Media
Creator     316

Log     334

Network Drives     333

Operation     322

Properties and Text/Hexadecimal Viewer     332

Safely Remove Hardware icon     325

Searching for a File     325

Starting a Computer with the R-Studio Emergency
Startup Disks     322

Technical Information     332

R-Studio Emergency Startup Media Creator     316,
341

R-Studio features     1

R-Studio switches     307

R-Studio Technician/T80+     167

Runtime Imaging     203

- S -
S.M.A.R.T. Info     5

Scan options    

Drive size     43

File Systems     43

Offset     43

Post Actions Options     43

Save to File     43

Scan Areas     43

Size     43

Start     43

Search options    

ANSI     285

Exhaustive search     285

From Address     285

From current position     285

From start position     285

HEX     285

Match case     285

Not Equal     285

OEM     285

Reverse     285

Search at offset     285

UNICODE     285

Searching for a File     31

Sector Map Files     202

Settings    

Bad Sectors     11

File Systems     11

Known File Types     11

Log     11

Main     11

Memory Usage     11

Symbolic Links     11

Shortcut menu    

Add Custom offset     126

Add Empty Space     95

Add Missing Drive     95

Add missing drives     153

Add to RAID     95

Always recalculate     304

Check RAID consistency...     128

Clear Log...     42

Close drive     30

Copy (Column Name)     42

Copy as "ANSI"     288

Copy as "Binary data"     288

Copy as "UNICODE"     288

Copy as File Signature     288

Copy Editor Display     288

Copy Selected Text     42

Create Exclusive Region     70

Create Image File     72

Create Region     69

Create Reverse RAID     212, 213

Create Virtual Mirror     95

Create Virtual RAID5     95

Create Virtual Stripe Set     95

Create Virtual Volume Set     95

Cross Linked Folders     301

Edit     69, 70

Exclude area     69

Export Recovery List     84

File mask     41

Find Next     31

Find Previous     31

Find Previous Versions of the File     34

Find Template Signature Next     279

Find Template Signature Previous     279
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Shortcut menu    

Find/Mark     31

Get Info     19

Go Target     301

Links     301

Log Filter...     42

Mark     19, 31

Mark All     19

Merge Down     43

Merge Down All     43

Merge Selected     43

Mount     72

No recalculate     304

Open Drive Files     19

Open Drive Files Sorted By     81

Open Scan Information     43

Preview     31, 34

Real File System Structure     81

Recheck Recovery Chances     19

Recover     19, 31

Recover All Files     80

Recover Marked     19

Remove All Scanned Information     43

Remove Region     69

Save Log to File...     42

Save Scan Information     43

Scan     43

Select From     279

Select To     279

Set As Default Target     301

Set Runtime Image     203

Show Files In Tab     30

Show password     162

Stop Runtime Imaging     203

Toggle Bookmark     279

Units type recalculate     304

Unlock encrypted drive     148

Unmark     19

Unmark All     19

Unmount     72

View/Edit     279

Smart drive copy    

Copy all partitions onto original places     195

Expand/Shrink partition to whole drive     195

Fixed active partition     195

One partition after another     195

Smart partition copy    

Copy to:     195

Copy without stretching     195

Free space before     195

Partition size     195

Partition type     195

Startup Media Troubleshooting Options     316

Std     279

Storage Pools     142

Stripe Sets     91

Symbolic links     301

Automatic recovery (Default)     11

Automatic recovery without symlink object path
conversion     11

Don't show symbolic links by default
(Technician/T80+ version)     11

Recovery as it is     11

Show symbolic links as links to their targets,
without target content     11

Symlinks     301

Syntaxis of a Description File for RAID Configurations  

 
 128

System Requirements     4

- T -
Tabs    

Parents     95

Properties     308

Technical Information and Troubleshooting     300

Text/hexadecimal editor     278

ANSI/OEM/UNICODE/UNICODE+     279

Save to Hexadecimal File     279

Tools menu    

Debug Mode     307

File mask     41

Find     31

Find All     31

Find Next     31

Find Previous     31

Goto     279

Mark All     19

Save Changes     279

Save to Binary File...     279

Save to Hexadecimal File     279

Select All     279

Settings     11

Unmark All     19
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- U -
Unlimited     279

- V -
View menu    

ANSI     279

Arrange     19

Bookmarks View     279

Contents Columns     19

Data Interpreter View     279

Device View     5

Devices     5

Event Log     5, 19

Files panel     19

Folders panel     19

Log panel     19

OEM     279

Parents Tab     5

Properties     5, 308

Properties Tab     5

Properties View     5, 279

Scan Information Tab     5

Sectors View     279

Status bar     5, 19

Template View     279

Toolbar     5, 19, 279

UNICODE     279

UNICODE+     279

Virtual volume sets and RAIDs     89

Volume sets and RAIDs     89

Volume Sets, Stripe Sets, and Mirrors     91

- W -
Windoes Storage Spaces     142

Window    

RAID consistency check     128

RAID Sequence     105

Windows Dynamic Disks     139

Wiping Objects     79

Working with RAID 6 Presets    

Reed-Solomonr     99

Working with RAID6 (Double Xor) Presets     97
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